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Copyrights and Trademark Notices
Copyright 2017, Telestream, LLC. All rights reserved worldwide. No part of this 
publication may be reproduced, transmitted, transcribed, altered, or translated into any 
languages without the written permission of Telestream. Information and 
specifications in this document are subject to change without notice and do not 
represent a commitment on the part of Telestream.

Telestream. Telestream, CaptionMaker, Episode, Flip4Mac, FlipFactory, Flip Player, 
Lightspeed, ScreenFlow, Switch, Vantage, Wirecast, Gameshow, GraphicsFactory, 
MetaFlip, and Split-and-Stitch are registered trademarks and MacCaption, e-
Captioning, Pipeline, Post Producer, Tempo, TrafficManager, VidChecker, and VOD 
Producer are trademarks of Telestream, LLC. All other trademarks are the property of 
their respective owners.

Adobe. Adobe® HTTP Dynamic Streaming Copyright © 2014 of Adobe Systems All 
rights reserved.

Apple. QuickTime, MacOS X, and Safari are trademarks of Apple, Inc. Bonjour, the 
Bonjour logo, and the Bonjour symbol are trademarks of Apple, Inc.

Avid. Portions of this product Copyright 2012 Avid Technology, Inc.

Dolby. Dolby and the double-D symbol are registered trademarks of Dolby 
Laboratories.

Fraunhofer IIS and Thomson Multimedia. MPEG Layer-3 audio coding technology 
licensed from Fraunhofer IIS and Thomson Multimedia.

Google. VP6 and VP8 Copyright Google Inc. 2014 All rights Reserved.

MainConcept. MainConcept is a registered trademark of MainConcept LLC and 
MainConcept AG. Copyright 2004 MainConcept Multimedia Technologies.

Manzanita. Manzanita is a registered trademark of Manzanita Systems, Inc.

MCW. HEVC Decoding software licensed from MCW.

MediaInfo. Copyright © 2002-2013 MediaArea.net SARL. All rights reserved. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS 
IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Microsoft. Microsoft, Windows NT|2000|XP|XP Professional|Server 2003|Server 2008 
|Server 2012, Windows 7, Windows 8, Media Player, Media Encoder, .Net, Internet 
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Explorer, SQL Server 2005|2008|2012|2014, and Windows Media Technologies are 
trademarks of Microsoft Corporation.

SharpSSH2. SharpSSH2 Copyright (c) 2008, Ryan Faircloth. All rights reserved. 
Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer.

Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution.

Neither the name of Diversified Sales and Service, Inc. nor the names of its contributors 
may be used to endorse or promote products derived from this software without 
specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS 
IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Telerik. RadControls for ASP.NET AJAX copyright Telerik All rights reserved.

VoiceAge. This product is manufactured by Telestream under license from VoiceAge 
Corporation.

x264 LLC. The product is manufactured by Telestream under license from x264 LLC.

Xceed. The Software is Copyright ©1994-2012 Xceed Software Inc., all rights reserved.

ZLIB. Copyright (C) 1995-2013 Jean-Loup Gailly and Mark Adler.
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Other brands, product names, and company names are trademarks of their respective 
holders, and are used for identification purpose only.

MPEG Disclaimers

MPEGLA MPEG2 Patent
ANY USE OF THIS PRODUCT IN ANY MANNER OTHER THAN PERSONAL USE THAT 
COMPLIES WITH THE MPEG-2 STANDARD FOR ENCODING VIDEO INFORMATION FOR 
PACKAGED MEDIA IS EXPRESSLY PROHIBITED WITHOUT A LICENSE UNDER APPLICABLE 
PATENTS IN THE MPEG-2 PATENT PORTFOLIO, WHICH LICENSE IS AVAILABLE FROM 
MPEG LA, LLC, 4600 S. Ulster Street, Suite 400, Denver, Colorado 80237 U.S.A.

MPEGLA MPEG4 VISUAL
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 VISUAL PATENT PORTFOLIO LICENSE 
FOR THE PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER FOR (i) ENCODING 
VIDEO IN COMPLIANCE WITH THE MPEG-4 VISUAL STANDARD (“MPEG-4 VIDEO”) AND/
OR (ii) DECODING MPEG-4 VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A 
PERSONAL AND NON-COMMERCIAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO 
PROVIDER LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. 
ADDITIONAL INFORMATION INCLUDING THAT RELATING TO PROMOTIONAL, INTERNAL 
AND COMMERCIAL USES AND LICENSING MAY BE OBTAINED FROM MPEG LA, LLC. SEE 
HTTP://WWW.MPEGLA.COM.

MPEGLA AVC
THIS PRODUCT IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE 
PERSONAL USE OF A CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE 
REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD 
(“AVC VIDEO”) AND/OR (ii) DECODE AVC VIDEO THAT WAS ENCODED BY A CONSUMER 
ENGAGED IN A PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER 
LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR 
ANY OTHER USE. ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA, L.L.C. 
SEE HTTP://WWW.MPEGLA.COM.

MPEG4 SYSTEMS
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 SYSTEMS PATENT PORTFOLIO LICENSE 
FOR ENCODING IN COMPLIANCE WITH THE MPEG-4 SYSTEMS STANDARD, EXCEPT THAT 
AN ADDITIONAL LICENSE AND PAYMENT OF ROYALTIES ARE NECESSARY FOR 
ENCODING IN CONNECTION WITH (i) DATA STORED OR REPLICATED IN PHYSICAL MEDIA 
WHICH IS PAID FOR ON A TITLE BY TITLE BASIS AND/OR (ii) DATA WHICH IS PAID FOR ON 
A TITLE BY TITLE BASIS AND IS TRANSMITTED TO AN END USER FOR PERMANENT 
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STORAGE AND/OR USE. SUCH ADDITIONAL LICENSE MAY BE OBTAINED FROM MPEG LA, 
LLC. SEE HTTP://WWW.MPEGLA.COM FOR ADDITIONAL DETAILS.

Limited Warranty and Disclaimers
Telestream, LLC (the Company) warrants to the original registered end user that the 
product will perform as stated below for a period of one (1) year from the date of 
shipment from factory:

Hardware and Media—The Product hardware components, if any, including equipment 
supplied but not manufactured by the Company but NOT including any third party 
equipment that has been substituted by the Distributor for such equipment (the 
“Hardware”), will be free from defects in materials and workmanship under normal 
operating conditions and use.

Warranty Remedies
Your sole remedies under this limited warranty are as follows:

Hardware and Media—The Company will either repair or replace (at its option) any 
defective Hardware component or part, or Software Media, with new or like new 
Hardware components or Software Media. Components may not be necessarily the 
same, but will be of equivalent operation and quality. 

Software Updates
Except as may be provided in a separate agreement between Telestream and You, if 
any, Telestream is under no obligation to maintain or support the Software and 
Telestream has no obligation to furnish you with any further assistance, technical 
support, documentation, software, update, upgrades, or information of any nature or 
kind.

Restrictions and Conditions of Limited Warranty
This Limited Warranty will be void and of no force and effect if (i) Product Hardware or 
Software Media, or any part thereof, is damaged due to abuse, misuse, alteration, 
neglect, or shipping, or as a result of service or modification by a party other than the 
Company, or (ii) Software is modified without the written consent of the Company.

Limitations of Warranties
THE EXPRESS WARRANTIES SET FORTH IN THIS AGREEMENT ARE IN LIEU OF ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, ANY 
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. No oral 
or written information or advice given by the Company, its distributors, dealers or 
agents, shall increase the scope of this Limited Warranty or create any new warranties.



Copyrights and Trademark Notices
7

Geographical Limitation of Warranty—This limited warranty is valid only within the 
country in which the Product is purchased/licensed.

Limitations on Remedies—YOUR EXCLUSIVE REMEDIES, AND THE ENTIRE LIABILITY OF 
TELESTREAM, LLC WITH RESPECT TO THE PRODUCT, SHALL BE AS STATED IN THIS 
LIMITED WARRANTY. Your sole and exclusive remedy for any and all breaches of any 
Limited Warranty by the Company shall be the recovery of reasonable damages which, 
in the aggregate, shall not exceed the total amount of the combined license fee and 
purchase price paid by you for the Product. 

Damages
TELESTREAM, LLC SHALL NOT BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY 
LOST PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES 
ARISING OUT OF YOUR USE OR INABILITY TO USE THE PRODUCT, OR THE BREACH OF 
ANY EXPRESS OR IMPLIED WARRANTY, EVEN IF THE COMPANY HAS BEEN ADVISED OF 
THE POSSIBILITY OF THOSE DAMAGES, OR ANY REMEDY PROVIDED FAILS OF ITS 
ESSENTIAL PURPOSE.

Further information regarding this limited warranty may be obtained by writing:
Telestream, LLC
848 Gold Flat Road
Nevada City, CA 95959 USA

You can call Telestream via telephone at (530) 470-1300.

Part number: 220672.
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Preface
To obtain product information, technical support, or provide comments on this guide, 
contact us using our Web site, email, or phone number.

Resource Contact Information

Vantage Technical 
Support

Web Site: http://www.telestream.net/
telestream-support/vantage/support.htm

Support Email: support@telestream.net

Enterprise Telephone Support: 

U. S. Toll Free: (877) 257-6245

U. S. from outside U.S.: (530) 470-2036

Europe | Middle East | Africa | Asia | Pacific:
 +49 228 280 9141

Terms and times of support services vary, per the terms of 
your current service contract with Telestream.

Vantage Information, 
Assistance, FAQs, 
Forums, & Upgrades

Web Site: http://www.telestream.net/telestream-
support/vantage/support.htm

http://www.telestream.net/telestream-support/vantage/support.htm
http://www.telestream.net/telestream-support/vantage/support.htm
http://www.telestream.net/telestream-support/vantage/support.htm
http://www.telestream.net/telestream-support/vantage/support.htm
mailto:support@telestream.net
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Telestream, LLC Web Site: www.telestream.net

Sales and Marketing Email: info@telestream.net

Telestream, LLC
848 Gold Flat Road, Suite 1
Nevada City, CA USA 95959

International 
Distributor Support

Web Site: www.telestream.net

See the Telestream Web site for your regional authorized 
Telestream distributor.

Telestream Technical 
Writers

Email: techwriter@telestream.net

If you have comments or suggestions about improving 
this document, or other Telestream documents—or if 
you've discovered an error or omission, please email us.

Resource Contact Information

http://www.telestream.net
mailto:info@telestream.net
http://www.telestream.net
mailto:techwriter@telestream.net
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Introduction to Vantage
This chapter is intended for those who use Vantage for transcoding and processing 
digital media and for system administrators who must configure Vantage.

The following topics introduce Vantage, and the Vantage programs that you’ll use in 
the course of processing your media in Vantage workflows:

■ Vantage Overview

■ Accessing Vantage Guides and Online Help

■ Vantage Domain Components

■ Vantage Domain Configurations

■ Vantage Programs and Options

■ Lightspeed Server

■ Capturing Live Video and Tape Feeds

■ Vantage Licenses

Note: Vantage licenses enable specific features and programs in Vantage, including 
optional transcoding capabilities, Lightspeed server, advanced workflow features and 
system management.

Vantage licenses allow you to download and install Vantage software at your 
convenience and purchase only those features that you need. If you need additional 
features later, you can purchase the licenses you require at any time.
Features for which you do not have a license may be disabled, or work only in demo 
mode. Topics which describe a feature that requires a license indicate that you need a 
license to use them.

You manage licenses in the Vantage Management Console. You can also add or update 
licenses directly in Workflow Designer. For a full discussion of licensing in Vantage, see 
the Vantage Licenses.
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Vantage Overview
At the simplest level, Vantage is a collection of customizable software programs that 
automate media processing via workflows. A Vantage workflow is a collection of 
actions that you design and configure to process media files in a specific manner.

The actions you can utilize in a workflow are controlled by the Vantage licenses you 
install. The following table lists some typical media processing objectives and the 
Vantage licenses that support them (these are not the only licenses you can use in 
Vantage—for a complete list, contact your Telestream representative).

Workflow Objective 
(Vantage License) Description

File-to-file transcoding Transcoding workflows automate the process of 
converting a video file from one media format to another. 
Vantage can open most video files, regardless of the 
encoding and packaging format, and create one or more 
new video files using one or more selections from an 
extensive list of encoder and packaging formats.

Live Capture Lightspeed Live Capture operates as a standalone capture 
system and can also extend live encoding capability by 
providing live capture in a number of high quality 
mezzanine formats into the Vantage Media Processing 
Platform. 

Commercial processing—
local, regional, and 
national

TrafficManager streamlines commercial and syndicated 
content handling for TV stations and cable facilities. 
TrafficManager provides a complete solution for local/
regional, and nationally syndicated and commercial 
media workflows, from ingest, review & approval, 
transcoding, dub list reconciliation, delivery for ad 
insertion servers or broadcast servers, and automation 
system notification.

Adaptive streaming 
encoding

Transcode Multiscreen includes transcoding software 
specifically designed for adaptive bit rate encoding using 
both GPUs and CPUs. It simultaneously produces multiple 
bit-rate variants of H.264/HEVC (using x264/x265 codecs) 
video and containers for deployment to HTTP adaptive 
streaming players from Adobe, Apple, Microsoft, and 
players compatible with MPEG DASH.

Automated editing and 
composition of 
advertisements

Post Producer automates the repetitive editing of assets 
for distribution, promotion and cross promotion. Post 
Producer allows you to automatically re-purpose movies 
and episodic content directly from master format for 
international and domestic distribution.
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IPTV VOD Transcoding Vantage Transcode IPTV VOD provides IPTV and Cable 
VOD transcoding with the highest possible quality at the 
lowest bit rates, reducing transmission costs. Additionally, 
Vantage provides sophisticated stream control and can 
automate the entire production process, including ingest, 
transcoding, packaging, delivery, and notification. 

Moving media between 
devices (Vantage 
Transcode Pro Connect)

Media transport workflows use Vantage native 
connections to move media between a wide variety of 
broadcast servers, edit systems, and other professional 
video devices. System integration includes HTTP Post and 
Get, for RESTful API calls in workflows. Using these 
integrations, Vantage can automate the process of 
receiving media into, or moving media between, different 
devices—ensuring the right file format at any of many 
possible destinations.

Re-timing the running-
time of media assets 
(Tempo)

Tempo is based on the Vantage platform, for re-timing 
file-based content and intelligently decreasing or 
increasing the running time of shows and segments. 

DPP File Creation (DPP 
License)

Vantage simplifies the creation of DPP-compliant media 
for the UK market. Operators enter metadata and mark 
programme segments. After that, Vantage automatically 
assembles the timeline with slates, bars and tones in the 
correct places, and programme segments aligned 
accurately. Vantage also integrates with common QC 
systems to perform Harding FPA analysis. Vantage then 
encodes the output AS-11 file with full, 16-bit video 
processing and optional GPU acceleration, while 
simultaneously inserting the metadata.

VOD Producer and VOD 
Producer | DAI

VOD Producer and VOD Producer | DAI simplify creation 
and assembly of DAI-ready CableLabs compliant VOD 
assets, enabling revenue expansion. Built on the Vantage 
platform, this system assembles final output from audio, 
video, graphics, and metadata, and creates content with 
branding to meet regulatory requirements, plus Nielsen 
watermarking for viewership measurement.

Media analysis and media-
dependent processing 
(Vantage Analysis)

Media analysis workflows use Vantage features to analyze 
media, compare the results to configured values, and make 
decisions about how media should be routed or processed.

Workflow Objective 
(Vantage License) Description
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With the appropriate licenses, Vantage workflows can incorporate the objectives listed 
in this table, as well as other workflow design and management features, which include 
the following:

• Workflow visualization—Vantage offers a highly flexible process design interface, 
with visual components that help you see what the workflow will accomplish.

• Notifications—Vantage can send emails or notify external systems when media is 
available.

• Intelligent branching—Vantage workflows can be configured to evaluate variables, 
metadata, and the results of other workflow tasks, and to execute the appropriate 
workflow branch for further processing.

• Workflow monitoring and control—Vantage programs allow you to view the status 
of jobs that have been submitted to a workflow, and you can stop, cancel, and 
restart jobs.

• Operator control—Vantage provides tools for enabling operator management. 
Operators can submit files to workflows, view the results, and submit the results to 
yet another workflow. Operators can also view the status of workflow jobs and, if 
granted permission by a Vantage administrator, stop, cancel or restart jobs.

• Scalability and Redundancy—Vantage scales to thousands of jobs and dozens of 
servers in an enterprise environment, to implement high-volume processing.

Vantage also provides many system management features, allowing you to scale a 
Vantage system to many servers, manage user access, and optimize system 
performance and reliability. The system management features are described in topics 
throughout this guide.

Additionally, as your need for features grows, you can easily add (or remove) licenses to 
activate the services, actions, and other components you need, using the Vantage 
Management Console or the Vantage Workflow Designer. 

Processing camera files Vantage offers comprehensive monitoring of card readers 
and shared storage for camera shots. Spanned clips are 
automatically stitched to reconstruct camera shots, and 
shots across an entire camera can optionally be stitched 
or time-aligned for rushes or multi-camera shoots. 
Panasonic P2 DV5, AVC-Intra, and AVC-Ultra media are 
supported.

Third-party analysis and 
specialized media processing 
(third-party connectors)

Some workflows communicate with third-party products 
(such as MediaMate Screen or Digimetrics Aurora) to 
analyze or process media.

Workflow Objective 
(Vantage License) Description
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Accessing Vantage Guides and Online Help
Vantage documentation consists of various guides, online help in the form of man 
pages, and application notes.

Installation and Domain Management Guide—You can access the domain management 
guide from the Vantage Management Console Help menu. 

User Guides—Guides are available from the Help menu of each Windows client and 
Web application.

In-program, Context-based Help—In each Windows client and Web application, click the 
 icon in the upper right-corner to display a context-sensitive topic in the relevant 

user guide, if available. In Workflow Designer, when an action inspector is open, click 
the  icon to display details about the panel you’re viewing for detailed help. Also 
hover over user interface controls to display brief tooltips.

Application Notes—Browse the Telestream Web site (at www.telestream.net/
telestream-support/vantage/support.htm) for application notes that may apply to your 
topic of interest.

Vantage Web Library—Click on the Vantage logo at www.telestream.net/telestream-
support/vantage/help.htm to display the entire Vantage documentation suite which 
includes all guides and man pages.

http://www.telestream.net/telestream-support/vantage/support.htm
http://www.telestream.net/telestream-support/vantage/help.htm
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Vantage Domain Components
Each Vantage Domain is a collection of Vantage software components. You can install 
and use multiple Vantage domains within a business or other organization. For 
example, you might install a Vantage domain for the sports department and another 
for the news department. Domains do not interact with each other—each Vantage 
domain maintains its own database, and automates its own workflows, independently 
of other Vantage domains.
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The work that you want Vantage to perform is defined in a workflow, which is created 
using the Vantage Workflow Designer program. Each workflow is made up of individual 
tasks called actions, which specify what task needs to be performed. 

A typical workflow contains actions to do these kinds of tasks:

• Monitor folders for new media to ingest and process

• Analyze and transcode input media into new media files

• Assemble a media file from an edit decision list

• Process metadata

• Deliver finished media files and metadata files to specified locations

Once a workflow has been designed, you can activate it, and it will run continuously to 
process media provided through hot folders, the Vantage SDK, or other submission 
mechanisms. 

For more information on the available actions and workflow design, see the Vantage 
User Guide.

The Vantage domain database is the control center of a Vantage domain. All workflows, 
user information, job history, and most configuration details for the domain are stored 
in the Vantage domain database. Also stored in the database are statistics and status 
information about the workflows processed by the domain and the services fulfilling 
them. Vantage domain administrators configure Vantage using the Management 
Console.

Working with the Vantage domain database, Vantage services execute workflow 
actions in a Vantage domain. Each service executes specific action types. For example, 
the Transcode Service executes the Flip action, which transcodes an input media file 
into a new file, based on the encoder and codecs you select. 

Vantage workflow actions which access input files or publish output files must have 
read and write access to these storage locations the input and output storage locations 
shown in the  figure. These locations can be folders that reside on a network server or 
workstation, a Network-Attached Storage (NAS), or a Storage Area Network (SAN). Or, 
they may be FTP or HTTP servers, or other media platforms.

A Vantage Store is a storage location designated during Vantage installation for storing 
temporary files that are created during workflow processing. Temporary files are 
automatically deleted by Vantage when they are no longer needed; you can control 
how long temporary files are retained by setting expiration rules for jobs and catalogs.
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Vantage Domain Configurations
While Vantage supports many different physical configurations, there are only two 
types of domains:

• A single node, all-in-one computer domain

• A multiple-computer array, where the Vantage services and Vantage database are 
distributed among two or more servers.

A single-node all-in-one domain is a Vantage domain in which all the basic Vantage 
components shown in the  figure are installed on a single server. An all-in-one domain 
is simpler to install and manage, but it has performance limitations which are described 
in the Before You Install Vantage chapter of the Vantage Domain Management Guide.

A multiple computer Vantage array (sometimes referred to as a distributed domain) is 
one in which the Vantage components are distributed among multiple servers. For 
example, you might install the Vantage database on one server, and install all Vantage 
services on an additional server, and a second Transcode service on the third server. 
This three-server Vantage domain separates database processing from Vantage service 
processing, which increases processing capacity for both the Vantage domain database 
and the Vantage services. 

Hosting Vantage services on multiple servers also increases capacity and supports 
load-balancing and task scheduling, which leads to better throughput.
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Vantage Programs and Options
Vantage programs allow you to manage and use the Vantage domain in various ways. 
The table below lists the Vantage programs according to the type of program and the 
Vantage management area they serve. 

Note: Some Vantage programs are available only with particular Vantage product 
licenses. To ensure you get the programs you want, contact Telestream sales for the 
latest bundling and licensing information.

From a management point of view, each Vantage program can be classified as a 
workflow management program or a domain management program. Workflow 
management programs allow you to design workflows, evaluate and forward the files 
saved by a job, and track the status of jobs. Domain management programs allow you 
to configure the Vantage domain, view status and statistics for the domain, and control 
domain operation.

Functional Area

Program Type

Client Applications Web Applications

Workflow Management Vantage Workflow Designer

Vantage Workflow Portal

Vantage Job Status Views

Vantage Workflow Portal

Live Capture Vantage Workflow Designer Lightspeed Live Capture 
web application

Transcoding Workflow 
Management

Vantage Workflow Designer Vantage Transcode

TrafficManager Dublist 
Management

Dublist Portal Dublist Portal

Domain Management Vantage Management 
Console

Vantage Dashboard

Cloud Management Vantage Cloud Manager

Dynamic Ad Insertion DAI Portal

Tempo Asset Re-timing Tempo Portal

VOD Producer VOD Producer Portal

Post Producer CML Portal

DPP DPP Portal
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Each Vantage program can also be classified by application type, which is either as a 
client program or a Web application. Client programs run on Microsoft Windows 
servers and workstations. Web applications are hosted by a Microsoft Internet 
Information Services (IIS) server and can be accessed from any computer with a 
compatible browser and a network or Internet connection to the IIS server hosting the 
Web applications.

This figure illustrates how Vantage programs fit into a Vantage domain.
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The following topics introduce the Vantage programs and options:

■ Vantage Management Console

■ Vantage Workflow Designer

■ Vantage Workflow Portal

■ Vantage VOD Portal

■ Vantage Tempo Portal

■ Vantage Web Applications

■ Vantage TrafficManager

■ Post Producer and Related Options

■ Vantage Tempo

■ Lightspeed Server

■ Capturing Live Video and Tape Feeds

Vantage Management Console
The Vantage Management Console (VMC) enables domain administrators to configure 
and manage a Vantage domain, including specifying what features Vantage users can 
access. The following is a partial list of Vantage features that administrators can control 
with the Vantage Management Console:

• Vantage catalogs and stores

• Vantage users

• Vantage licenses

• Task scheduling rules

• Vantage services (including email on service failure for all license levels)

• Action and workflow status

• Import and export of Vantage configuration components

• Application configurations, including client windows, web applications, Job Status 
views, and various portals such as the Workflow, VOD, and Tempo Portals

• Report and workorder configurations

• Dublist and Fulfillment schemes

• Vantage domain settings, backup and restore, and other utilities

The Vantage Management Console also allows you to view a variety of status 
information, including information about jobs, service status, and catalog contents.

For information about using the Management Console, refer to the Using the Vantage 
Management Console chapter in the Vantage User Guide.
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Vantage Workflow Designer
Vantage Workflow Designer enables you to design and automate workflows to meet 
your organization's transcoding and workflow automation requirements. With 
Workflow Designer, you can design workflows that do the following:

• Detect media files and related files that are ready for processing

• Evaluate the contents of media files and set variables that describe their contents

• Create decision trees that execute different branches based on variable values

• Generate email and other messages in response to workflow events

• Incorporate related metadata files or add metadata to the output

• Transcode media files to multi-screen formats, including package formats such as 
Apple HLS and Adobe HDS

• Transcode media files for use in IPTV/VOD/cable applications

• Generate new media based upon edit decision lists or editorial templates

• Perform comprehensive advertisement processing, from catch server to on-air 
server

• Perform file operations—save media output files and delete source files

• Combine any or all of the above features in hundreds of possible workflows.

A typical workflow design session requires that you pick the actions you want to 
execute, configure the sequence and settings of those actions, and then activate the 
workflow. When you activate the workflow, the Vantage domain database and Vantage 
services work together to process any source material that is submitted to the 
workflow. Each time source material is submitted, a Vantage job is started. A job 
represents a single execution of a workflow. For example, if 10 different media files are 
submitted to a workflow, 10 new jobs are executed.

The Vantage Workflow Designer also includes tools that allow you to monitor the status 
of workflows and jobs in the domain.

For detailed information on designing Vantage workflows, see the Vantage User Guide.

Open Workflows
An option to Vantage workflow functionality, Open Workflows enhance the processing 
speed of workflows by enabling most actions to begin processing before the previous 
action has completed. Specifically, Open Workflows are designed to remove the 
inherent latency that exists between actions within a workflow. For example, during 
execution of a Watch action when a new file is discovered, the next action—a Copy 
action—can begin to duplicate the file as the content is received and not wait for the 
entire file to be received. By reducing the latency between actions within a workflow, 
more jobs can be processed in the same period of time, improving domain 
productivity. See Vantage Licenses > Workflow Products in this chapter for license details.
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Vantage Cloud Manager
The Vantage Cloud Manager enables domain administrators to configure and manage 
the cloud-based Vantage domain. The following is a list of key Vantage features that 
administrators can control with the Vantage Cloud Manager:

• Cloud service provider accounts

• Domain configuration

• Domain status (starting and stopping)

• Vantage Services

• Domain status

Vantage Cloud Manager is a separately purchased application that is not included in 
the main Vantage installer. For information about using the Vantage Cloud Manager, 
see the Vantage Cloud User Guide. Various options are available. 

Vantage VOD Portal
The Video on Demand (VOD) Portal is a Vantage option that streamlines creating media 
assets. This portal allows specification of VOD-specific metadata, such as rating, V-Chip, 
and more, and allows trimming/stitching of clips to create finished media. The portal 
also allows marking of ad insertion points, allowing encoding and processing to 
support Dynamic Ad Insertion (DAI). 

Vantage Tempo Portal
Tempo ™ is a complete solution for re-timing file-based content and intelligently 
decreasing or increasing the running time of shows and segments. Tempo has the 
ability to re-time the complete asset but allows marking selected segments for 
inclusion or exclusion from the re-timing process when the overall program is re-timed. 

Operator control of Tempo is provided through the Tempo Portal, which allows 
browsing catalogs and selecting media clips to drag and drop to a Segment List. In the 
Segment List, clips can be separated into program segments via a mark in/mark out 
process and configured for re-timing or left untouched. The operator then forwards the 
program, described in an XML composition file, to a Tempo workflow, which re-times 
the media accordingly. 
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Vantage Workflow Portal
The Vantage Workflow Portal, which is implemented both as a Windows client and as a 
web application, allows operators to manually review and update media and manually 
submit jobs to workflows. Workflow designers create the workflows, and workflow 
operators use Workflow Portal to do the following:

• Search catalogs and binders which contain media

• Preview proxy media and create clip sets—setting in and out points for trimming

• Review and edit variable values, metadata labels, and embedded metadata

• Update variable values

• Submit media to workflows for processing

• In TrafficManager, search, review, and submit commercials and content for processing

• Stitch multiple files together

The Workflow Portal’s user interface allows administrators to customize it using the 
Vantage Management Console, which controls the features and resources each 
operator can access. The desktop version of the Workflow Portal is installed on 
Windows workstations. A Web version is also provided, with a subset of features.

To process media in Workflow Portal, for most configurations you must also create an 
ingest workflow to pre-process the media and register it in a Vantage catalog. 

For information about creating configurations for the Workflow Portal, see the Setting 
up Workflow Portal chapter of the Vantage Domain Management Guide. For information 
about using the Workflow Portal, refer to the Using Workflow Portal chapter of the 
Vantage User Guide.

Vantage Web Applications
The Vantage Web applications provide browser access to important Vantage functions. 
These are the Web Applications:

■ Vantage Workflow Portal Web Application

■ Vantage Dublist Portal Web Application

■ Vantage Job Status Views Web Application

■ Vantage Dashboard Web Application

■ Lightspeed Live Capture Web Portal

Note: Vantage Web applications should be installed on a different server from the 
Telestream Transcode & Analysis engine. For this reason, Web applications are 
included only with the array installer and not with the single-node installer. 
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Vantage Workflow Portal Web Application
Workflow Portal is also implemented as a Web application, which is installed separately 
from Vantage. The Web version of Workflow Portal works with most configuration types 
and allows most of the features listed above, except for submitting media from 
Windows platforms, and stitching files.

The login requirements are the same as for other clients. For information about creating 
configurations for the Workflow Portal, see the Vantage Domain Management Guide, 
and for details about using portal configurations to perform media processing, see the 
Workflow Portal Guide.

Vantage Dublist Portal Web Application
The Dublist Portal Web Application enables you to display and manage TrafficManager 
dublists processed by Dublist monitor workflows. Filters allow you to narrow the list of 
dublists displayed based on various criteria. Dublist Portal also includes a tab for 
viewing and managing dublist expirations. For more information on using the Dublist 
Portal, see the TrafficManager User Guide.

Vantage Job Status Views Web Application
The Job Status Views Web Application, which is installed separately from Vantage, 
provides Vantage operators and managers with detailed job status information about 
jobs in the domain. Using the Vantage Management Console, Vantage administrators 
can configure custom job status views, which define what information an operator sees. 
When there is a large volume of jobs or when security policies dictate, you might want 
to create custom views for individual operators or departments.

You can access the Job Status Views at http://[server name]/Vantage/JobStatusViewer/. 
The login is the same as for other Vantage applications.

For information about configuring the Vantage Job Status Views, see the Configuring 
Job Status Views chapter in the Vantage Domain Management Guide, and for 
information about using Job Status Views, see the Monitoring Workflows and Managing 
Jobs chapter in the Vantage User Guide.

Vantage Dashboard Web Application
The Vantage Dashboard Web Application, which is installed separately from Vantage, is 
designed to help domain administrators track the status and system health for the 
entire Vantage domain, as opposed to other tools which enable management of 
domain components.

The Vantage Dashboard pages help you quickly assess the health of the domain and 
progressively dig into deeper detail as needed. For example, the Summary Status page 
allows you to quickly see the workflow completion success rate and the error rate on 
servers in the domain. The information on the Summary Status page can help you 
determine if it is more appropriate to look for problems in a workflow or in a particular 
server.
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Other Vantage Dashboard pages allow you to view the status of servers, services, and 
jobs. When troubleshooting, it can be very helpful to determine if problems are system 
wide or confined to a server, a service, or a particular workflow. Vantage Dashboard 
provides the Web pages that allow you to quickly assess your domain from any Web 
client that has connectivity to your domain.

For information on using Vantage Dashboard, see the Using the Vantage Dashboard Web 
App chapter in the Vantage Domain Management Guide.

Lightspeed Live Capture Web Portal
The Lightspeed Live Capture Web Portal allows control over Lightspeed Live capture 
channels configured within a Vantage workflow for manual start.   Channels not 
configured for manual start are presented in the portal as status (read-only) views. 
Using the web application, you can select sources and control starting, pausing, and 
stopping of live video capture. 

Vantage TrafficManager
TrafficManager™ streamlines content handling for TV stations and cable facilities. 
TrafficManager provides a complete solution for syndicated and commercial media 
workflows, from ingest, review and approval, transcoding, dub list reconciliation, 
delivery for ad insertion servers or broadcast servers, and automation system 
notification. 

TrafficManager automates the entire workflow, using rules that you specify for how to 
find, process, and deliver media. When new assets arrive, TrafficManager will 
automatically identify them and execute all of the steps necessary to ensure timely 
availability for on-air, cable or web transmission. This happens without requiring 
manual labor, ensuring that media is prepared in the fastest possible manner, and 
without introducing human error.

For national ads, TrafficManager integrates with popular digital media delivery services 
including Javelin, ExtremeReach, the Comcast ADN (Radiance), and others.

TrafficManager integrates with select third-party playout automation systems to 
automate notification of incoming content and metadata.

Finally, TrafficManager dublist analysis tools let you quickly see the status of the assets 
you need. Your traffic and operations staff can see at a glance if any commercials have 
not yet arrived, narrowing their search to only the assets which need attention.

Vantage Dublist Portal
Dublist Portal is a TrafficManager-licensed program which allows users to manage 
dublist processing. It allows you to view a list of dublists for recently active Dublist 
Monitor workflow actions, manage dublist expiration, and test dublists to pre-qualify 
them for workflows. For more information on using the Dublist Portal, see the 
TrafficManager User Guide.
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Post Producer and Related Options
Post Producer™ fully automates production processes by assembling multi-layered 
video deliverables from content sources and masters. With Post Producer you can 
construct finished, branded assets to automatically re-purpose media for today’s multi-
language, multi-platform distribution.

Post Producer and related products and options are ideal for:

• Frame accurate clipping and montage assembly of video sources

• Dynamic assembly of composition visuals from video and graphics sources and cre-
ation of titles

• Selecting, mapping and combining audio channels to match output requirements

• Inserting ancillary metadata for closed captions, subtitles, Vchip and dynamic 
advertising 

VOD Producer with Dynamic Ad Insertion
VOD Producer DAI is built on the Vantage platform. It automates the assembly of 
CableLabs VOD content and provisions it for Dynamic Ad Insertion. The VOD Portal 
enables operator-driven production, including viewing of clips and marking the ad 
insertion points. VOD Producer generates the necessary metadata files for Nielsen and 
Canoe, and encodes the media to support ad insertion during VOD playback.

Vantage DPP Packager
Vantage significantly simplifies the DPP file production process by offering a complete, 
automated and easy-to-use solution for creating DPP files quickly and effectively. 
Operators simply enter metadata and mark programme segments. After that, Vantage 
automatically assembles the timeline with slates, bars and tones in the correct places, 
and programme segments aligned accurately. Vantage also integrates with common 
QC systems to perform Harding FPA analysis. Vantage then encodes the output AS-11 
file with its award-winning full 16-bit video processing and optional GPU acceleration, 
while simultaneously inserting the metadata. 

Vantage can also automate delivery to the final destination, allowing you to quickly 
scale your DPP file production with a minimum of manual labor. 

Vantage® offers a complete solution to perform these DPP functions:

• Allow data entry of DPP metadata, including automatic validation and administra-
tor-defined data entry rules

• Assemble a DPP time line, generating bars, slates, tones, and aligning programme 
segments correctly

• Transcode to create a DPP-compatible AS-11 MXF file, including metadata and time 
code

• Automate delivery to multiple locations
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Post Producer Titler Engine
The Vantage Post Producer™ Titler Engine, powered by NewBlueFX®, is an optional, 
licensed feature designed to automate versioned titling of video assets. 

Titler Engine uses templates created in NewBlue’s Titler Pro™ Editor, which is available 
as a Windows and Mac OS program, or as a plug-in for top non-linear editors including 
Adobe Premiere. Together with these powerful video editing tools, Titler Engine 
enables high-level titling capabilities, including animation, and scalable and flexible 
titling applications.

Vantage Tempo
Tempo™ is a complete solution built on the Vantage platform for re-timing file-based 
content, intelligently decreasing or increasing the running time of shows and segments. 

Tempo utilizes new time compression algorithms that deliver superior quality and 
faster turn-around times because it is designed to leverage new methods of media 
analysis. It does not throw frames away. Rather, it intelligently interpolates the desired 
time change over the duration of the content in a way that produces no noticeable 
visual or audible artifacts. 

Tempo has the ability to re-time the complete asset but allows marking selected 
segments for inclusion or exclusion from the re-timing process when the overall 
program is re-timed. 

Operator control of Tempo is provided through the Tempo Portal, which allows 
browsing catalogs and selecting media clips to drag and drop to a Segment List. In the 
Segment List, clips can be separated into program segments via a mark in/mark out 
process and configured for re-timing or left untouched. The operator then forwards the 
program, described in an XML composition file, to a Tempo workflow, which re-times 
the media accordingly. 
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Lightspeed Server
The Telestream® Lightspeed Server can serve as the hardware platform for a Vantage 
domain or be added to any Vantage domain to accelerate video processing and x264 
transcoding. Lightspeed Server accelerates processing with GPUs and multi-core CPUs 
to provide the best image quality in the least amount of time. Housed in an efficient 1 
rack-unit server, Lightspeed Server reduces rack space, power and cooling 
requirements while meeting increased output capacity needs. 

Lightspeed Server accelerates compute-intensive image processing in Vantage 
workflows, including scaling, deinterlacing, frame rate conversion, motion vector 
calculation, and other tasks that require computation and analysis to modify or create 
new video frames. Faster video preprocessing improves the output quality of all video 
output formats.

There are several Lightspeed Server models, each pre-configured to your order. You can 
order Lightspeed configured as an all-in-one single-node server containing a complete 
Vantage system and licenses, ready to run. You can also order multiple Lightspeed 
Servers with various Vantage components and licenses installed, ready to network 
together to create a Vantage array. 

For more information about the Lightspeed Server, see Lightspeed Server on the 
Telestream Web site. 

Lightspeed Live Stream
Lightspeed Live Stream delivers enterprise-class live streaming for media and 
entertainment companies, corporations, government agencies and educational 
facilities. Lightspeed Live Stream provides efficient and superior quality adaptive bit 
rate encoding for SD, HD and UHD sources into AVC and HEVC. This integrated 
hardware and software appliance combines multiple CPU and GPU cores as well as 
targeted ASIC CODEC acceleration to deliver flexible and efficient encoding 
performance. Input support is available for SDI as well as IP sources, offering future-
proof operation as delivery mechanisms change. Output can be delivered via RTMP or 
as HTTP Live Streaming (HLS) and MPEG DASH packages.

Lightspeed™ Live Stream can be deployed as a stand-alone solution for live, 
multiscreen services or combined with the Vantage Media Processing Platform via the 
optional Lightspeed Live Capture product. 

http://www.telestream.net/vantage/lightspeed-server.htm
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Capturing Live Video and Tape Feeds
Telestream offers the latest and fastest in live capture products for media and 
entertainment companies, corporations, government and education. 

Lightspeed Live Capture
Lightspeed Live Capture offers a real-time, enterprise-class video capture system to 
answer the increased demand for news, sports, and special event broadcasters to 
simultaneously push live programs over the Internet.

Lightspeed Live Capture independently records multiple channels of SD, HD or a single 
UHD channel. By integrating parallel file-based open workflows in Telestream’s Vantage 
platform together with the combined CPU/GPU power of the Lightspeed Live server 
and applications, the fastest possible delivery of all assets is realized.

Lightspeed Live Capture can receive content via four 3G baseband SDI (1080p/60) 
channels or one 4K UHD channel via four SDI ports. Live Capture can supply a number 
of high quality mezzanine formats to Vantage, allowing simultaneous use of the full 
range of video manipulation that the Vantage Media Processing Platform offers.

Lightspeed Tape Capture
Lightspeed Tape Capture, a feature of Lightspeed Live Capture, supports tape log and 
capture functionality via 4 Sony standard RS422 machine interface ports, 4 SD/HD/UHD 
SDI inputs, and an HTML 5 browser client added to Vantage Web Apps. The client allows 
logging multiple tapes, marking clips to extract from tape, and capturing clips from 
tapes into output media files using a selectable container/codec. A Tape action added 
to Vantage enables Vantage workflows to fully take advantage of the tape interface.

Tape Capture supports metadata labels and variables, includes full VTR transport 
controls with keyboard shortcuts, and provides audio meters with 8 selectable 
stereo pairs. User accounts provide password protection to prevent unauthorized 
application access.

Pipeline
Using a Telestream Pipeline encoder as part of your Vantage system, Vantage can ingest 
live or tape feeds into Vantage workflows. Combining Pipeline’s baseband capture with 
a Vantage system, you can create high-quality real-time or near real-time output in any 
format supported by Vantage. 

For example, you can simultaneously create high-res files for storage while creating a 
low-res proxy, or create any number of additional file formats in real-time or near real-
time. Transcoding occurs simultaneously while ingesting the captured media, ensuring 
the fastest possible turnaround time for media processing. Pipeline also preserves 
important metadata, such as ancillary data, throughout your transcoding workflow. 
Pipeline encoder channels allows for a high degree of scalability and flexibility.

For more information about utilizing Pipeline in Vantage workflow see Using Vantage 
Publish within Pipeline Control on the Telestream Web site. 

http://www.telestream.net/pdfs/app-notes/app_Pipeline_Vantage.pdf
http://www.telestream.net/pdfs/app-notes/app_Pipeline_Vantage.pdf
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Vantage Licenses
Vantage licenses enable specific Vantage features or feature sets. All Vantage software 
is available on the Telestream web site. Vantage allows you to download and install 
Vantage software in demo mode without licenses. At your convenience you can 
purchase licenses and add them to Vantage for only those products you need. If you 
need additional products later, you can purchase licenses for additional options. 

Note: Some Vantage programs and features are available only with particular 
Vantage product licenses. To ensure you get the features you want, contact Telestream 
sales for the latest bundling and licensing information.

Product licenses do not include maintenance and support, which must be ordered 
separately.

The following topics introduce the available licenses (see the Telestream web site for 
the latest licensing information): 

■ Transcoding Products

■ Transcoding Product Options

■ Workflow Products

■ Workflow Third Party Connectors

■ Vantage System Management Products

■ Vantage Post Producer

■ VOD Producer Dynamic Ad Insertion (DAI)

■ VOD Portal

■ Tempo Content Re-Timing Software

■ Lightspeed Servers

■ Lightspeed Options and Bundles

■ Lightspeed Live Capture

Transcoding Products
The following are the transcoding license configurations:

• Vantage Transcode—Includes Vantage Workflow Designer, SD & HD New Media, 
Edit, VOD transcoding format support, FTP/network folder workflow support, and 
enhanced video processing. GPU acceleration is available for this product when 
running on a Lightspeed Server. This is a software only, single server license.

• Vantage Transcode Pro—Includes Vantage Workflow Designer, SD & HD New Media, 
Edit, VOD, Broadcast Server, IPTV and MXF transcoding format support, FTP/net-
work folder workflow support, and enhanced video processing. GPU acceleration is 
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available for this product when running on a Lightspeed Server. This is a software 
only, single server license.

• Vantage Transcode Connect—Includes Vantage Workflow Designer, SD and HD New 
Media, Edit, Populate plug-in, Web Services Notify, and VOD Transcoding Format 
support. Provides broadcast server monitoring, XML metadata transformation and 
delivery, and Web Service notification. Also includes Amazon S3 File System sup-
port. GPU acceleration is available for this product when running on a Lightspeed 
Server. This is a software only, single server license.

• Vantage Transcode Pro Connect—Includes Vantage Workflow Designer, SD and HD 
New Media, Edit, Populate plug-in, Web Services Notify, VOD, Broadcast Server, 
IPTV and MXF transcoding format support. Includes broadcast server monitoring 
and delivery, Avid Send to Playback and Interplay delivery, AAF for MediaComposer 
and Interplay delivery via TransferEngine, XML metadata transformation and deliv-
ery, and Web Service notification. Includes enhanced video processing. Also 
includes Amazon S3 File System support. GPU acceleration is available for this prod-
uct when running on a Lightspeed Server. This is a software only, single server 
license.

• Vantage Generic Catch Monitor—The Generic Catch Monitor for Vantage Transcode 
Pro and Transcode Pro Connect receives news clips from media delivery services, 
such as Extreme Reach Pathfire delivery service and transcodes to specified broad-
cast server or news system, and processes the XML sidecar into Vantage. 

– Requires Vantage Transcode Pro or Transcode Pro Connect 

– Automates ingest of content from media delivery system 

– Associated XML metadata is processed through Vantage 

– Files and metadata are delivered directly to on-air servers or newsroom 
production systems 

• Vantage Transcode IPTV VOD— IPTV and cable VOD transcoding for HEVC, H.264, 
MPEG-2 and MPEG-1 Transport Stream files. Includes Manzanita Systems multiplex-
ing and x265 HEVC and x264 H.264 encoding. Also includes Vantage Workflow 
Designer, enhanced video processing, and FTP/network folder workflow support. 
GPU acceleration is available for this product when running on a Lightspeed Server. 
This is a software only, single server license.

• Vantage Transcode Multiscreen—Multiscreen transcoding for Apple HLS, Adobe 
Dynamic Streaming, Microsoft Smooth Streaming, and MPEG DASH. Includes x265 
HEVC and x264 H.264 encoding technologies, adaptive bit rate packaging, encryp-
tion for DRM and full workflow automation. Also includes Vantage Workflow 
Designer, enhanced video processing, TAR creation, FTP/network folder workflow 
support. This is a software only, single server license.

For information on the encoders and packagers provided with each license, refer to the 
Telestream Web site: http://www.telestream.net/telestream-support/vantage/support.htm.

http://www.telestream.net/telestream-support/vantage/support.htm
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Transcoding Product Options
Transcode options extend Vantage transcoding capabilities:

• Multiscreen ABR Optimize—Enables adaptive bitrate package optimization for one 
Vantage Multiscreen node (Multiscreen sold separately). Includes SSIMplus by 
SSIMWave to intelligently construct adaptive-bitrate (ABR) packages to set and 
maintain a guaranteed quality of experience (QoE). The ABR option reduces deliv-
ery bandwidth and distribution cost for service providers and content creators 
while ensuring a high level of perceived quality. Each license for ABR Optimize 
allows a server to run concurrent actions up to the Multiscreen service session limit, 
comparing reference video to up to 12 Multiscreen encoded variants. Licenses may 
float across available servers. To enable ABR optimization for multiple Transcode 
nodes, one ABR Optimize option must be purchased for each node. Does not 
include first year's Annual Maintenance and Support, which must be ordered at 
time of purchase.

• Avid Interplay Option—Enables delivery of files and metadata into Avid Interplay 
using Vantage Transcode Pro Connect. Enables AAF/MXF media encoding, meta-
data insertion, and delivery via Avid TransferEngine and Avid Interplay Web Ser-
vices. Metadata insertion includes ability to add timeline locators and descriptive 
metadata into Interplay. Also includes additional Avid Web Services features for 
updating existing metadata and adding multi-resolution encoded versions to exist-
ing assets. This option is available for Vantage Transcode Pro Connect only. A 
Transcode Pro Connect license is required. Does not include first year's Annual 
Maintenance and Support, which must be ordered at time of purchase. Please 
include list price when calculating maintenance and support.

• Cinnafilm Tachyon and Cinnafilm Dark Energy Options—Tachyon® Video Processing 
Library (VPL) and Dark Energy from Cinnafilm® are available as separate or com-
bined optional add-ons to Telestream Vantage Transcode and Transcode Pro. For 
professionals who deal in mixed standards and formats, the Tachyon option pro-
vides Vantage media workflows access to high-quality format and standards con-
versions tools. Tachyon and Dark Energy require Telestream K20 or better 
Lightspeed servers running Vantage. Dark Energy® can be used for removing 
unwanted noise/film grain, and for creating image upscaling and down-sampling. 
Down-samples are alias-free and up-res’d images are scaled with heavy consider-
ation to the image texture at the new raster size.

• Comprimato JPEG2000—Enables GPU encoding and decoding of JPEG2000 video 
files. Available for the Transcode Pro option only, and requires a Lightspeed K20 
server or better, both purchased separately. 

• Dolby E Decode Option for Vantage Transcoding—Decodes Dolby E.

• GraphicsFactory Upgrade—Upgrade that can be added to any Vantage Transcode. 
Includes engine, template creator and submit tool.

• GraphicsFactory Template Creator—Provides node-locked seat of the Graphics Fac-
tory Template Creator, which can be run on a separate computer. Does not have to 
be run on a Vantage server.
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• Vantage Camera Ingest Option—Offers significant time savings for post-production 
and news users by enabling hands-free batch ingest, processing, time-alignment, 
and stitching of camera media. Camera ingest software automates and simplifies 
camera ingest, transcoding and importing of shots in an editing system, freeing 
editors to focus on editing, instead of manually finding, importing and stitching 
clips. 

• Dublist Portal—Dublist Portal for Vantage is a software option that provides the 
ability for Vantage users to monitor for incoming content, and compare that 
against a Dublist, which is a CSV file that includes media information. The Dublist 
Portal shows found and missing content and makes it easy for operators to identify 
missing files. Requires Vantage Transcode Pro or Transcode Pro Connect. 

• Nielsen Watermarking Option—Allows insertion of Nielsen NAES2 and Nielsen 
Watermarking audio watermarks for measurement of D4 or D7 ratings for VOD con-
tent and also for commercial monitoring with Nielsen’s Sigma and KeepingTrac ser-
vices. A single license allows up to four concurrent watermarking jobs to execute 
simultaneously. Requires use of the Vantage SDK or the Workflow Portal and Van-
tage Analysis; please see the Nielsen Application Note for more information.

• Timed Text Flip—Timed Text Flip is an optional module that can be accessed 
through the Vantage Workflow Designer. The option offers an automated subtitle 
and captioning service that runs on the Vantage Media Processing Platform, pro-
viding an interface to read, write, and adjust subtitle and caption data. 

Supports the import of data from multiple file types including EBU-STL, SRT, SCC, 
MCC, TTML (DFXP / SMPTE 2052), WebVTT, Lambda CAP, PAC, and source video files 
containing CEA-608/708 caption data. Supports the re-timing and frame rate con-
version of caption and subtitle files with starting timecode, re-time rate percent, 
and timecode offset parameters to match source media file or transcode workflow. 

Exports from Timed Text Flip include TV and Internet caption and subtitle formats: 
SCC, MCC, SRT, Subtitle Overlay, TTML (DFXP / SMPTE 2052), WebVTT, and Same as 
Source outputs embeds CEA-608/708 caption data into video files. In addition, the 
Subtitle Overlay function generates graphics for burn-in subtitles in SD, HD, UHD, 
4K, and custom resolutions. Subtitle Overlay output parameters include font style 
selector, text color, background color/opacity, text outline color/thickness. Also 
shows safe title margins. Timed Text Flip workflows require a transcoder to burn-in 
the subtitle graphics into a deliverable media file. 
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Workflow Products
The workflow licenses enable various features specific to automating media workflows:

• Vantage Analysis—Includes analysis for curtains, letterboxing, Telecine, black detec-
tion, slate/spot detection, macroblocking, loudness measurement with dialog 
detection and gating controls for compliance with CALM Act, ATSC A/85, BS-1770-3 
and EBU R128, and more. Includes PSNR measurement for comparing two files. This 
is a software only, single server license.

• Vantage Analysis Pro—Includes all capabilities of Vantage Analysis, with additional 
capabilities for Dolby E audio detection and analysis, compliance checking, PDF 
reporting, and integration with MediaInfo for extended media properties. This is a 
software only, single server license.

• Upgrade from Analysis to Analysis Pro—Upgrades from Vantage Analysis to Vantage 
Analysis Pro. This is a single license upgrade.

• Vantage Open Workflows—The Open Workflows license enables workflows and 
actions to operate in open mode, which allows open-eligible actions to operate 
concurrently rather than serially. This feature greatly improves workflow processing 
speed and efficiency. 

The license must be installed before the feature can be enabled. Open Workflows 
are licensed on a per server basis. For example, if you have a 5 node array and 3 
license seats of Open Workflows, then 3 out of the 5 servers will be Open-capable.

If a user would like to release an Open Workflows license seat from a server in order 
to make it available to a different server, the user may put all the services on a 
machine that has an Open Workflows license seat in and out of maintenance mode. 
This will cause the license seat to be acquired by a different server that previously 
did not have an Open Workflows license seat.

Lightspeed Live Servers include Open Workflows at no extra charge. However, 
Lightspeed Live servers are limited to a small subset of the Vantage services.

• Vantage Workflow Portal—The Vantage Workflow Portal allows operators to browse 
assets in the Vantage catalog, construct EDLs, enter metadata, and submit jobs to 
Vantage workflows. Each Vantage Workflow Portal license allows one instance of 
client access from any client machine; the total number of licenses in the Vantage 
database determines how many clients can connect simultaneously. This is a one 
client access floating license. Note: This product requires either a Metadata, 
Transcode Connect, or Transcode Pro Connect license.

• Vantage Metadata Conversion—Enables ability to transform XML files, create or 
populate metadata labels, and perform Web Services notification. Includes: Web 
Services notification, Populate, Transform, Gather and Archive actions. This is a soft-
ware only, per server license.
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• Vantage TrafficManager™ for Broadcast—Controls and automates the ingest, man-
agement and production of commercials and content. Includes the following:

– Catch server integrations with DG, Javelin, Extreme Reach, Hula MX and more

– Customizable web page for local and regional submissions via web upload

– Automated dub list processing to trigger commercial processing

– Vantage Analysis for smart transcoding and ITU 1770.3 loudness correction

– Vantage Workflow Portal for Windows client and web-based commercial and 
syndicated content inventory management (5 users included)

– Vantage Transcode Pro Connect for transcoding & delivery to broadcast, edit, 
and web formats. 

This is a software only, single server license. Requires 3 days on-site installation, 
purchased separately. N+1 Redundancy may be added with Vantage Array. Addi-
tional user accounts may be added with Vantage Workflow Portal. 

Fully compatible and extensible with Vantage transcoding, workflow, partner inte-
grations and system management products. GPU acceleration is available for this 
product when running on a Lightspeed Server. 

• Vantage TrafficManager™ for Cable/IPTV—Controls and automates the ingest, man-
agement and production of commercials and content. Includes the following:

– National catch server integrations with DG, Javelin, Extreme Reach, Hula MX and 
more

– Customizable web page for local and regional submissions via web upload

– Automated dub list processing to trigger commercial processing

– Vantage Analysis for smart transcoding and ITU 1770.3 loudness correction

– Vantage Workflow Portal for Windows client and web-based commercial and 
syndicated content inventory management (5 users included)

– Vantage Transcode IPTV VOD for transcoding & delivery to IPTV and cable ad 
insertion

– Vantage Transcode Connect for transcoding to web, edit and mobile formats, 
and XML transformations

Requires 3 days on-site installation, purchased separately. N+1 Redundancy may be 
added with Vantage Array. Additional user accounts may be added with Vantage 
Workflow Portal. Fully compatible and extendable with all Vantage transcoding, 
workflow, partner integrations and system management products. GPU accelera-
tion is available for this product when running on a Lightspeed Server. This is a soft-
ware only single server license.
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• Post Producer™ —Allows automated editing and assembly of finished content from 
one or more input media files. Includes media trimming, stitching, overlays, audio 
mixing and metadata insertion for a wide variety of formats (please see Post Pro-
ducer data sheet for a full list of supported formats and features). Includes Conform 
action support for CML message submission and Compose action support for 
TSEDL and AN2 inputs. Includes Vantage Workflow Designer, and FTP/network 
folder workflow support. May be combined with any Transcode product, sold sepa-
rately. GPU acceleration is available for this product when running on a Lightspeed 
Server. This is a software only, single server license.

• Post Producer™ Titler Engine, powered by NewBlueFX®, is an optional, licensed fea-
ture designed to automate versioned titling of video assets. 

Workflow Third Party Connectors
Connectors allow Vantage to submit and monitor jobs to third party systems. Except 
where noted, a Connector license allows four (4) concurrent jobs on the partner system. 
Additional Connector licenses may be purchased to allow additional jobs.

• Vantage Agility ECS Connector—Allows a Vantage server or array to submit jobs to 
an Agility ECS. License allows connection to one ECS.

• Vantage Aspera faspex™ Delivery Connector—Provides automated delivery of media 
and associated files directly to Aspera faspex™ Servers. Aspera fasp™ transport tech-
nology can achieve delivery speeds many times faster than standard FTP and HTTP 
to an address list or an Aspera drop box. Does not include Aspera Faspex server. 
This is a software-only license that allows up to four concurrent file transfers.

• Vantage Aspera Enterprise Server Integration—Enables Vantage to interactively 
browse, upload, and download media content with any Aspera server endpoint, 
whether that is a fully featured Enterprise Server system or a Point-to-Point node. 
Allows for automated high-speed transfer of files processed into and out of any 
Vantage workflow. Does not include Aspera Enterprise Server software.

• Avid Interplay Option—See Avid Interplay Option in Transcoding Product Options.

• Vantage Minnetonka AudioTools Connector—The Vantage AudioTools Connector 
integrates within Vantage's file-based framework using AudioTools Server to sup-
port fundamental loudness control workflows and custom, predefined workflows 
for broadcasters. AudioTools Server (ATS) is a highly configurable and modular sys-
tem and the Connector allows Vantage to drive audio processing workflows and 
jobs directly from the Vantage workflow designer. 

• Vantage Digimetrics Aurora Connector—Allows integration of Digimetrics Aurora 
software with Vantage. This connector allows up to four (4) concurrent QC sessions 
to be triggered by, and monitored within Vantage. Does not include Digimetrics 
Aurora. Note: Aurora should not be run on the same machine as a Vantage 
Transcode or Analysis product. The Vantage Aurora Connector service must be 
installed on the Aurora machine.
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• Vantage Baton Connector—Allows integration of Interra Baton software with Van-
tage. This connector allows up to four (4) concurrent QC sessions to be triggered 
and monitored by Vantage. Note: Baton cannot be run on the same machine as a 
Vantage Transcode or Analysis product. The Vantage Baton Connector service must 
be installed on the Baton machine. Does not include Baton software.

• Vantage Cerify Connector: Allows integration of Tektronix Cerify QC software with 
Vantage. This connector allows up to four (4) concurrent QC sessions to be trig-
gered and monitored by Vantage. The Cerify software cannot be run on the same 
machine as a Vantage Transcode or Analysis product. The Vantage Cerify Connector 
service must be installed on the server running Cerify. This option does not include 
the Cerify software.

• Vantage Connector for Civolution NexGuard Watermarking—Enables Civolution Nex-
guard Pre-release Watermark Embedder capability within Transcode or Transcode 
Pro, allowing four (4) concurrent sessions. This license does not include the Civolu-
tion NexGuard license which must be purchased directly from Civolution. Requires 
Vantage Transcode or Transcode Pro.

• Vantage Connector for Civolution NexGuard Manager Server—Enables Vantage con-
nection to Civolution NexGuard Manager Server, allowing updates of Civolution 
database as watermarking is performed. Only one license is required per Array. 
Requires Civolution NexGuard Manager Server, available from Civolution directly.

• Vantage Dolby DP600 Connector—Allows integration between Vantage and a Dolby 
DP600. One connector allows up to four (4) concurrent work sessions (jobs) on the 
DP600. Note: Does not include Dolby DP600.

• Vantage Emotion Connector—Allows integration of Emotion Systems software with 
Vantage. This connector allows up to four (4) concurrent Emotion sessions to be 
triggered and monitored by Vantage. Note: The Emotion Systems software cannot 
be run on the same machine as a Vantage Transcode or Analysis product. The Van-
tage Emotion Systems Connector service must be installed on the server running 
Emotion. 

• Vantage FileCatalyst Integration—Allows integration of FileCatalyst for delivering 
files to FileCatalyst servers. This connector allows up to four (4) concurrent file 
transfers to be performed by Vantage. Does not include FileCatalyst server.

• Screen Open Subtitle Graphics Generation—Open subtitling solution where the sub-
title text is permanently burnt-in and visible in the video portion of the media. Only 
available within Transcode or Transcode Pro. Note: This option requires Vantage 
Transcode or Transcode Pro to burn in the subtitles.
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• Pitchblue Monitor for Vantage—The Pitchblue Monitor for Vantage Transcode Pro 
and Transcode Pro Connect receives content from Pitchblue media delivery service 
and transcodes to a specified broadcast server, and processes available XML sidecar 
metadata into Vantage. 

– Requires Vantage Transcode Pro Connect 

– Automates ingest of content from Pitchblue media delivery system 

– Some associated metadata can be processed through Vantage 

– Files and metadata are delivered directly to on-air servers 

• Vantage Pulsar Connector—Allows integration of Venera Pulsar software with Van-
tage. This connector allows up to four (4) concurrent QC sessions to be triggered 
and monitored by Vantage. Note: Pulsar cannot be run on the same machine as a 
Vantage Transcode or Analysis product. The Vantage Pulsar Connector service must 
be installed on the Pulsar machine. Does not include Pulsar software.

• Nexidia QC Integration—A Vantage Nexidia connector and action provide access to 
Nexidia QC functionality within Vantage workflows. Nexidia QC provides auto-
mated closed caption and video description verification, closed caption alignment, 
and language identification for broadcast and IP workflows.

• Vantage Screen MediaMate Connector—Allows Vantage to connect to external 
MediaMate systems. Allows up to four (4) concurrent jobs to be performed in 
MediaMate, managed by Vantage. Note: This option does not include Screen 
MediaMate. Use of this Connector requires the purchase and installation of custom 
MediaMate models, and a dongle from Screen. These models are purchased from 
and installed by Screen. 

• Vantage Signiant Integration—Allows integration of Signiant for delivering files to 
Signiant Content Transfer Engine and Media Exchange server locations. This con-
nector allows up to four (4) concurrent file transfers to be performed by Vantage. 
Note: This option does not include Signiant Content Transfer Engine or Media 
Exchange server software. 

• Vantage Social Media Connector—Adds the ability to post Vantage workflow out-
puts directly to YouTube, Vimeo, LinkedIn, and Twitter, either automatically or oper-
ator-controlled through the Vantage Workflow Portal. 

• Vantage VidChecker Connector—Allows integration of Vidchecker software with 
Vantage. Note: Vidchecker cannot be run on the same machine as a Vantage 
Transcode or Analysis product. The Vantage Vidchecker Connector service must be 
installed on the Vidchecker machine. This connector allows up to four (4) concur-
rent QC sessions to be triggered and monitored by Vantage. Does not include Vid-
Checker software.
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Vantage System Management Products
The Vantage System Management license allows you to install Vantage services on 
multiple Windows or Telestream Lightspeed servers, increasing the capacity and 
reliability of your Vantage domain. Vantage array features include the following:

• Redundancy—Multiple Vantage array servers can host the same service, increasing 
the processing capacity of the Vantage domain.

• Session-based load balancing—When a Vantage service is enabled on multiple Van-
tage array servers, individual workflow actions can be executed by any Vantage 
array server that is configured for the supporting service. Action execution is sched-
uled based on CPU availability and priority.

• Priority acceleration for transcoding actions—Vantage servers, both single node and 
arrays, can pause lower priority actions hosted on the same service, execute the 
higher priority action, and then resume the lower priority action.

• N+1 failover protection—Vantage array servers communicate with each other and 
can redistribute the workload if a Vantage array server fails. If a job fails to complete 
due to a Vantage array server failure, another Vantage array server restarts the job.

• Support for mirrored SQL Standard and SQL Enterprise with Clustering databases—
provides redundancy and failover protection for the Vantage domain database.

If the current domain is an all-in-one domain, the activation of a Vantage Array license 
changes the Vantage server to a Vantage array server. You can then create a distributed 
domain by adding Vantage array servers. In a Vantage array, every Vantage server is a 
Vantage array server and requires the Vantage Array license.

Additional System Management options to the Vantage Array license are:

• Advanced Task Scheduling—Adds advanced task scheduling to Vantage, including 
the new Task Based load balancing and the legacy Cost Based load balancing. 
Increases overall system throughput by optimizing server usage for all Actions 
across all services in a Vantage array while Cost Based load balancing provides opti-
mization of Actions only across like services. Task Based load balancing is the new 
recommended load balancing methodology. Array is sold separately. 

• Vantage Reporting & Analytics—Enables CSV reporting and workflow analytics in 
Vantage. Includes Populate and Web Services Notify. This is a software only, per 
array license (entire array). 

• Vantage System Dashboard—Web dashboard enables remote visibility into overall 
system health and status for administrators, and allows remote maintenance of the 
Vantage Array. This is a software only license with options for per node or unlimited 
server licensing.
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Vantage Post Producer
Vantage Post Producer™ allows automated editing and assembly of finished content 
from one or more input media files. Includes media trimming, stitching, overlays, audio 
mixing and metadata insertion for a wide variety of formats (please see Post Producer 
data sheet for a full list of supported formats and features). Includes Conform action 
support for CML message submission and Compose action support for TSEDL and AN2 
inputs. Includes Vantage Workflow Designer, and FTP/network folder workflow 
support. May be combined with any Transcode product, sold separately. GPU 
Acceleration is available for this product when running on a Lightspeed Server.

Titler Engine Option for Post Producer
The Titler Engine option for Vantage Post Producer is a software installer intended for 
installation on one or more nodes of Vantage Post Producer. This option provides a 
means for creating rich, animated titles using the NewBlue Titler Creator tool (not 
included) to create templates that can be processed by Post Producer to create 
automated variations using a workorder and a Post Producer template. 

The Titler Engine requires Post Producer and runs on Windows Server 2012 on 
Lightspeed servers. This option is sold per-node, it can run on one or more nodes of 
Post Producer. 

VOD Producer
Automates the creation of VOD assets to simplify and scale the process of VOD asset 
creation. Assembles complex VOD compositions from video, audio, graphic and 
metadata elements. Accessible through a graphical user interface and automation 
interface. 

License Includes: 

– VOD/DAI Operator Portal Network license which enables all portals in a Vantage 
Domain (V-VOD-PORTALSW) 

– 1 Operator portal seat license (V-PORTAL) 

– 1 Post Producer Content Assembly Automation license (V-PRODUCER-SW) 

– 1 IPTV/VOD Transport Stream Encoder license (V-XCODE-IPTV-SW) 

– 1 Transcode license (V-XCODE-SW) 

– 1 Metadata license (V-METADATA-SW 

– Vantage Workflow Designer 

– Vantage Management Console 

GPU Acceleration is available for this product when running on a Lightspeed Server. 

Does not include first year's Software Annual Maintenance and Support which must be 
ordered at time of purchase. 
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VOD Producer Dynamic Ad Insertion (DAI)
DAI is a single server license software option to Vantage Post Producer. Provisions VOD 
content for Dynamic Ad Insertion and measurement during the creation process. User 
defined DAI ad breaks are inserted during the VOD assembly process. VOD Producer 
DAI creates multilayer video compositions with DAI ad breaks and Nielsen D4 audio 
watermarking and produces the metadata documents for DAI ecosystem partners, 
Canoe Ventures and Nielsen. Accessible through a graphical user interface and 
automation interface. 

License Includes: 

– VOD/DAI Operator Portal Network license which enables all portals in a Vantage 
Domain (V-VOD-PORTALSW) 

– 1 Operator portal seat license (V-PORTAL) 

– 1 Post Producer DAI Content Assembly Automation license (V-PRODUCER-DAI-
SW) 

– 1 IPTV/VOD Transport Stream Encoder license (V-XCODE-IPTV-SW) 

– 1 Transcode license (V-XCODE-SW) 

– 1 Metadata license (V-METADATA-SW 

– 1 Nielsen Watermarking license (V-NIELS) 

– Vantage Workflow Designer 

– Vantage Management Console 

GPU Acceleration is available for this product when running on a Lightspeed Server. 

Does not include first year's Software Annual Maintenance and Support which must be 
ordered at time of purchase.

VOD Portal
The VOD Portal is a paid option that allows creating VOD media assets supporting VOD 
metadata such as rating and V-Chip, stitching and trimming of clips, and DAI.

Tempo Content Re-Timing Software
Tempo is a solution for re-timing file-based content and intelligently decreasing or 
increasing the running time of shows and segments. Tempo utilizes sophisticated video 
and audio time compression algorithms that deliver superior quality and faster turn-
around times. Tempo runs on the Vantage media processing platform and offers all of 
the benefits of complete integration with the world’s best workflow management and 
transcoding system.

Tempo Software is an option for Vantage and includes:

– Tempo Content Re-timing software

– One (1) Workflow Portal seat (V-PORTAL-SW)

– Metadata option for Vantage (V-METADATA-SW)
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The Tempo product requires Vantage Transcode or Transcode Pro in addition to 
Vantage Analysis or Analysis Pro. Also requires 2 days on-site installation, purchased 
separately. N+1 Redundancy may be added with Vantage Array license and compatible 
hardware. Fully compatible and extensible with all Vantage transcoding, workflow, 
partner integrations and system management products. Does not include first year's 
Software Annual Maintenance and Support which must be ordered at time of 
purchase. 

Lightspeed Servers
The Lightspeed servers are Windows machines designed to run Vantage at optimum speeds. 
Vantage comes pre-installed on the Lightspeed server and ready to run (software sold 
separately.) These servers accelerate video processing for all Vantage Transcode products 
(Transcode, Pro, and Pro Connect), Post Producer and TrafficManager. Vantage v4.0 or later is 
required. Multiple models include the K20, K40SSD, K80, and K80SSD. For details about model 
features and differences, please see the Telestream.net web site and the Lightspeed Server 
Guide.

Vantage automatically adds a Lightspeed system variable to any Lightspeed-aware services 
running on a Lightspeed server. Actions can use the variable to implement Run On rules or to 
report or record job information. 

Lightspeed Options and Bundles
Lightspeed fallback rules are included in all models of Vantage. Various Lightspeed 
options are available, including Ethernet adapters, Fibre Channel HBA options, and SSD 
drive upgrades. Lightspeed bundles are available to combine Lightspeed servers with 
Transcode Multiscreen, Transcode IPTV VOD, Transcode Connect, and Transcode Pro 
Connect Vantage software combinations. Contact Telestream Sales for more 
information.

Lightspeed Live Capture
Lightspeed Live Capture uses a Lightspeed server with capture card and software to capture 
live media to files. Four input channels of SD/HD or 1 channel of 4K/UHD via SDI (1080p/60) 
with 4 ports 10Gb Ethernet in a GPU accelerated capture platform for ingesting multiple video 
formats, creating mezzanine and AVC MP4 or MXF RDD 25 proxy files simultaneously, and 
storing them locally or on external networked storage. Operates as a standalone device or as 
part of a Vantage domain with Capture as an Origin Action in Vantage. Supports SDI inputs 
and a broad range of file output formats. 

Platform Specifications: 1RU rack mount chassis includes dual Intel multi-core processors, 4x 
3Gb/s SDI inputs, 4x 10GigE ports, GPU acceleration, over 4TB internal storage, RAID 5 
protected, for a total of over 3TB of usable storage. Option to add more than 3TB of additional 
storage. Hot swappable dual power supplies. 

http://www.telestream.net/purchase/store.htm
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Vantage Client Programs 
Overview 
This chapter provide general information about using Vantage client programs, 
including starting and stopping, logging in to a Vantage domain, and best practices for 
accessing Windows files in Vantage.

Note: You manage Vantage licenses in the Management Console. For details on 
adding, updating, or activating licenses, see Enabling a Vantage License in the Vantage 
Domain Management Guide. Depending on how you purchase Vantage features, 
Telestream may send you additional license files or an updated license file. Follow the 
instructions accompanying the license file for adding or updating license files.

 Adding Demo Licenses

 Windows Vantage Client Program Management

 Web Application Management

 Paths for Vantage Storage Overview
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Adding Demo Licenses
You should, as a general rule, manage your licenses using the Management Console. 

However, for convenience, you can also import demo license files to your domain 
directly in Workflow Designer.

When you receive a demo license (an XML file), install it using these steps:

1. Store the demo license file in a location that is accessible to your Vantage domain 
server.

2. Store a second copy of the file in a safe place.

3. In Workflow Designer, select File > Add/Update Demo License to display the Add/
Update Demo Licenses dialog.

4. Navigate to and select one or more licenses, and click Open.

5. Restart Workflow Designer and any other client programs that are open.
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Windows Vantage Client Program Management
Vantage provides the following Windows programs:

• Management Console

• Workflow Designer

• Workflow Portal

• Dublist Portal

These programs are Windows application programs, and they interact with the Vantage 
domain database to set up and configure, control, and operate the domain. They are 
often referred to collectively as client programs for short. 

Note: Vantage Cloud Manager is not described in this topic. For details about using 
Vantage Cloud Manager, see the Vantage Cloud User Guide.

The following topics describe general Windows client program tasks:

 Starting and Stopping Client Programs

 Displaying Program Tips & Warnings

 Displaying the Version of a Windows Client Program

 Displaying your Domain’s Database Version

 Configuring Server 2008 to Solve Display Problems for Vantage Programs

 Selecting Vantage Domains and Logging In

 Changing Vantage Users in Windows Client Programs

 Changing Passwords in Windows Client Programs

 Changing or Reloading A Configuration in Workflow Portal

 Accessing Vantage Help from Workflow Designer

Starting and Stopping Client Programs
All Vantage Windows client programs connect directly to the Vantage domain 
database, and thus—can only be used on a Windows computer which has access to the 
domain.

Vantage client programs start and stop like typical Windows programs.

Some client programs require configuration by an administrator before they can 
function. For example, Workflow Portal and Dublist Portal require application 
configurations, which are created in the Management Console.

 Starting Workflow Designer

 Starting Workflow Portal

 Starting Dublist Portal

 Stopping Vantage Windows Client Programs
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Starting Workflow Designer
To start Workflow Designer, use one of these methods:

• Select Start > Programs > Telestream > Vantage > Vantage Workflow Designer

• Double-click the Vantage Workflow Designer shortcut on your desktop.

Note: If you are launching Workflow Designer for the first time, you’ll be prompted to 
select and log in to a Vantage domain. See Selecting Vantage Domains and Logging In 
for details.

Starting Workflow Portal
Workflow Portal is an optional, licensed Vantage client program that allows operators 
to browse catalogs or Windows servers to select media, enter/update metadata and 
variables, and submit jobs. When you start Workflow Portal, if no license is available, it 
advises you, and operates in demo mode. When operating in demo mode, you cannot 
submit jobs or edit metadata labels.

You can run multiple instances of Workflow Portal on one computer (and one license), 
so that you can use multiple configurations at the same time. For example, you may be 
reviewing and submitting assets in one, and setting trim points in another. 

User authentication is used to control user access to Workflow Portal configurations. 
Administrators can choose which Vantage users can utilize a specific configuration. 
Administrators can also make certain configurations available to everyone.

To start Workflow Portal, do one of the following:

• Select start > Programs > Telestream > Vantage > Vantage Workflow Portal

• Double-click the Vantage Workflow Portal shortcut on your desktop.

Note: If you encounter an error when launching the Workflow Portal, please see 
Troubleshooting Workflow Portal for assistance.

If you are launching Workflow Portal for the first time, you’ll be prompted to select and 
log in to a Vantage domain and choose a Workflow Portal configuration. See Selecting 
Vantage Domains and Logging In for details.
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Starting Dublist Portal
Dublist Portal is provided as part of TrafficManager. You can run multiple instances of 
Dublist Portal on one computer, so that you can use multiple configurations at the 
same time.

User authentication is used to control user access to Dublist Portal configurations. 
Administrators can choose which Vantage users can utilize a specific configuration. 
Administrators can also make certain configurations available to everyone.

To start Dublist Portal, do one of the following:

• Select start > Programs > Telestream > Vantage > Vantage Dublist Portal

• Double-click the Vantage Dublist Portal shortcut on your desktop.

If you are launching Dublist Portal for the first time, you’ll be prompted to select and 
log in to a Vantage domain. See Selecting Vantage Domains and Logging In for details.
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Stopping Vantage Windows Client Programs
To stop any of the Vantage Windows client programs, use the usual Windows 
convention—select File > Exit (Control+Q). 

You typically don’t need to explicitly save work you have performed, because all 
information is stored in the Vantage domain database, and updated automatically as 
you make changes. However, when you are editing data (for example, metadata, in the 
Management Console or Workflow Portal), you do need to save it explicitly. If you 
attempt to close a dialog window or the program without saving the data, you’ll be 
warned.

Displaying Program Tips & Warnings
Both Workflow Designer and Workflow Portal provide tips and warnings in tooltips and 
dialogs. To hide these tips and warnings, Check the Hide checkbox on one of the 
dialogs, or select Options > Hide Tips & Warnings. To reset them to their default 
behavior, select Options > Restore Tips & Warnings.

Displaying the Version of a Windows Client Program
To determine which version of a Vantage Windows client program you’re using, select 
Help > About.

Displaying your Domain’s Database Version
To determine a Vantage domain’s database version number, in Workflow Designer 
select Help > Database Version.

Configuring Server 2008 to Solve Display Problems for 
Vantage Programs

When using Workflow Designer on Windows Server 2008, you may have problems 
minimizing windows you’ve maximized by dragging them to the top of your monitor. 
To disable this Windows AeroSnap feature, open the Control Panel > Ease of Access 
Center > Change how your mouse works, and check Prevent windows from being 
automatically arranged when moved to the edge of the monitor.

In addition, for Workflow Designer to display as designed, the Windows theme on 
Server 2008 R2 should be set to Windows 7 Basic. This theme is only available when the 
Desktop Experience feature is installed. If Remote Desktop Connection is used to 
connect to the server, then the Remote Desktop Services > Remote Desktop Session 
Host > Desktop Composition role feature must be installed in order for the Windows 7 
Basic theme to be available.

The Themes service must be started and set to the automatic startup type. If the 
Themes service hasn't been started before, the computer must be restarted for it to 
take effect and for the Windows 7 Basic theme to be made available.
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Selecting Vantage Domains and Logging In
These tasks are described in the following topics:

 Selecting the Vantage Domain

 Logging In to a Vantage Domain

 Creating a Workflows Category in Workflow Designer

 Selecting a Configuration in Workflow Portal or Dublist Portal

Selecting the Vantage Domain
You may have multiple Vantage domains in your environment. (For example, domains 
for different departments, shows, or geographic locations, or for scaling your encoding 
capacity or using a Vantage Lightspeed server.) Each Vantage domain is a separate, 
stand-alone Vantage system, whose Vantage domain database and services do not 
interact with other domains. 

You might need to manually select a domain from a Vantage client program for the 
following reasons:

• You are starting a Vantage client Windows program for the first time.

• Your work requires that you connect to a different Vantage domain.

After you select a Vantage domain, the program remembers it and connects to the 
domain automatically each time you restart the program. You can change domains at 
any time.

To select a domain, do the following:

1. In any client program, select File > Change Vantage Domain (in Workflow Designer, 
you can also right-click in the Workflows panel away from any buttons and select 
Change Vantage Domain from the context menu).

The program displays the Select Vantage Domain panel.

Take one of two actions: 
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2. If you know the domain’s identity or the domain isn’t listed during a search, click 
Specify Vantage Domain Name/IP Address to expand the dialog. 

a. Enter the Vantage domain’s server name (for example, VantageServer203) or IP 
address and Vantage database instance name if different than the default, and 
click OK to connect. If you do not know what to enter, contact your Vantage 
domain administrator.

3. If you don’t know the domain’s identity, click Search to locate all domains on your 
network.

a. Select the domain you want to connect to, and click OK. 

If connection is successful and you’re prompted to enter a user name and pass-
word, see Logging In to a Vantage Domain.

When you change domains, the program closes its connection (if any) with the cur-
rent domain and connects to the new domain.
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Note: If your domain isn’t listed or you can’t connect, contact your Vantage domain 
administrator and/or refer to Connecting to an Unlisted Domain or Connecting with 
Custom Login Settings.

Connecting with Custom Login Settings

If the Vantage domain is using a SQL database where the default settings for the MS 
SQL server account were changed during installation, open Connection Settings to 
display the SQL Server login and password settings.

The program displays the SQL Server login and password settings.

Enter the Vantage database SQL server account user name and password (obtained 
from your Vantage administrator), and click OK to connect.

Logging In to a Vantage Domain
To access a Vantage domain, you may need to log in, providing your user credentials. 
Your Vantage administrator will either provide you with a Vantage user name or 
configure Vantage to work with your Windows user name.

Note: Administrators can enable or disable user authentication. They can also choose 
whether or not to use Windows user names by enabling or disabling Windows Active 
Directory. Both settings are configured in the Vantage Management Console.
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Note: If you don’t have a Vantage user name, ask your Vantage administrator to 
create one for you or add your Windows user as an authorized Vantage user.

If login is required, the Vantage Domain Login dialog displays.

Enter your user name, and password if required, and click OK to connect.

In Workflow Designer, you may be prompted to create a new category—see Creating a 
Workflows Category in Workflow Designer below.

In Workflow Portal and Dublist Portal, you’ll be prompted to select a configuration 
before you can continue—see Selecting a Configuration in Workflow Portal or Dublist 
Portal.

Creating a Workflows Category in Workflow Designer
When you log in, the only categories that display are those that you are authorized to 
access. (If your user has administrative privileges, all workflows in the domain are 
displayed.) Access to workflow categories by user is controlled in the Management 
Console.

When you log in, if there are no categories available then you will be prompted to 
create one. If you’re prompted to create a new category, click OK to display the Create 
New Category dialog.

Enter the name for this category, and click OK. 

Selecting a Configuration in Workflow Portal or Dublist 
Portal
If a configuration has been previously selected, it is loaded and used automatically. 
Otherwise the Select Configuration window displays, enabling you to select a 
configuration to use during this session. 

This dialog is for a domain 
not using Active Directory.

This dialog indicates that 
the domain is using Active 
Directory.
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Note: The configurations in the list include public configurations (usable by any 
Vantage user), plus those that your Vantage user account is authorized to use. Access 
to configurations is controlled by the Vantage domain administrator.

Select a configuration from the list and click OK.

Changing Vantage Users in Windows Client Programs
When you are logged in to a Vantage domain that has User Administration enabled (in 
the Vantage Management Console), you can change to another Vantage user or Active 
Directory user (depending on your User Administration settings. 

Select File > Change Vantage User to display the Vantage Domain Login dialog.

Enter your user name, and password if required, and click OK to log in.

Changing Passwords in Windows Client Programs
When you are logged in to a Vantage domain that has User Administration enabled (in 
the Vantage Management Console) and Windows Active Directory is not being used, 
you can change the password of the Vantage user currently logged in.
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Select File > Change Password to display the Set Password window.

Enter a new password, confirm the password, and click OK to update the password for 
this user. The next time you log in to the Vantage domain with this user, you’ll need to 
use the new password.

Changing or Reloading A Configuration in Workflow Portal
To change configurations when you need to perform other tasks in the same domain or 
when you have changed a configuration and need to obtain the current version, follow 
these steps:

1. Select File > Change/Reload Application Configuration.

Workflow Portal displays a list of configurations for this domain.

2. Select the configuration you want to use or update, and click OK.

Workflow Portal opens the configuration, and displays the appropriate user interface 
for this configuration.

Accessing Vantage Help from Workflow Designer
These topics describe how to access Vantage help systems from Workflow Designer:

 Displaying the Vantage User Guide

 Displaying Context-Sensitive Help Topics

 Displaying Man Pages
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Displaying the Vantage User Guide
There are several ways to access the Vantage User Guide in Workflow Designer:

• Select Help > Getting Started to display the Tours topic in the Vantage User Guide. 
The tours introduce you to Workflow Designer and describe how to create and con-
figure workflows, submit jobs, and monitor jobs.

• Select Help > Contents to display the Vantage User Guide table of contents.

• Select Help > Index to display the Vantage User Guide index.

• Select Help > Search to display the Vantage User Guide search tab, where you can 
enter search criteria to locate topics you want to read.

• If you have access to the Internet, select Help > Online Help to display the Vantage 
Online Help section of the Telestream web site, where you can access all Vantage 
documentation.

Displaying Context-Sensitive Help Topics
In Workflow Designer, you can click the help button  (see the figure below) to display 
the topic in the User Guide that relates to the specific program feature that has focus.

If the topic is not available, you can search the entire User Guide for information.

Displaying Man Pages
In Workflow Designer action inspectors, man pages are context-sensitive help topics 
that provide detailed information for action configuration options.

Help 
button
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To open the man page for any action inspector panel, click the  button.

When the man page window is open as you proceed through a series of Inspector 
panels, the man page changes as necessary, as you display each panel.

Man page 
button
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Web Application Management
Vantage provides the following web applications:

• Web Dashboard

• Job Status Views Web Application

• Workflow Portal Web Application

• Dublist Portal

• Dublist Portal

The following topics describe general web application tasks:

 Web Application Browser Requirements

 Starting & Stopping Vantage Web Applications

 Logging In or Changing Domains from Web Applications

 Returning to the Vantage Web Applications Menu

 Logging Out of a Vantage Domain

 Changing Passwords in Web Applications

 Displaying Version Information

 Accessing Vantage Help in Web Applications

Web Application Browser Requirements
Vantage web applications are implemented for execution in Microsoft IIS. JavaScript 
and cookies must be enabled to use Vantage web applications properly.

Telestream recommends the following web browsers for use with Vantage web apps:

• Internet Explorer 11—32-bit or 64-bit (Windows only)

• Chrome—current version (MacOS X and Windows)

• Safari—current version (MacOS X only).

To configure Internet Explorer for use with Vantage web applications, do the following:

1. Enable Active Scripting—Open Internet Explorer, select Tools > Internet options, 
select the Security tab, click Custom level, scroll down to Scripting, click Enable 
under Active scripting, click OK, and click OK to close the Internet Options dialog.

2. In Internet Explorer, disable Enhanced Security Configuration (ESC) using the 
Windows Server Manager. Enter the hostname or IP address into the address bar 
that is used to set up the HTTP alias. For example, if you use a hostname to set up 
the alias, then you use that hostname to browse to the web apps. If you use an IP 
address, you should use that address to browse to them. For example, http://
192.168.0.1/Vantage/Portal/ConfigSelect.aspx. The use of localhost is not supported.

3. When using the Workflow Portal Web Application on a Windows Server platform, 
you must install the Desktop Experience feature in order to view proxy media in the 
HTML5 Media Player.
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Starting & Stopping Vantage Web Applications
For information on starting and stopping web applications, see the following topics:

 Starting Web Applications

 Licensing Issues When Starting Workflow Portal

 Stopping Web Applications

User authentication may be used to control user access to Workflow Portal 
configurations. Administrators can choose which Vantage users can utilize a specific 
configuration. Administrators can also make certain configurations available to 
everyone. (These functions are performed in the Vantage Management Console.)

Starting Web Applications
Logging in to a Vantage domain from a web application is a bit different than logging 
in from a Vantage Windows client, such as Workflow Designer. When you log in from a 
web application, you first start the web application by accessing the web server via a 
browser. Then, you actually log in to the Vantage domain after that.

To start Vantage web applications from the Vantage home page, do the following:

1. Open your web browser and enter the Vantage web application home page URL:

http://<IISServerName>/Vantage/

where <IISServerName> is the DNS name of the IIS server (or its IP address)—by 
default, the same as the Vantage domain server.

Note: If you do not know the name of the Vantage IIS server (by default, the same 
server where the Vantage domain database is hosted), contact your Vantage 
administrator or IT department.

2. If you are prompted to select a domain, select the domain name, and click OK.

The first time you connect to a Vantage domain from this computer (or you deleted 
your browser’s cookies), select the domain from the list and click OK to continue. 
Refer to Logging In or Changing Domains from Web Applications for more informa-
tion.

3. Enter an authorized user name and password.
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Vantage displays the Vantage web applications menu (or home page). 

Click the web application you want to use.

You can also launch each web application directly, by using its URL:

• Dashboard—http://<ServerName>/Vantage/Dashboard/

• Job Status Views—http://<ServerName>/Vantage/JobStatusViewer/

• Workflow Portal—http://<ServerName>/Vantage/Portal/

• Dublist Portal—http://<ServerName>/Vantage/DublistPortal/

• Live Capture—http://<ServerName>/Vantage/CapturePortal/

Licensing Issues When Starting Workflow Portal
Workflow Portal is an optional, licensed web application. When you start it, if no license 
is available, it advises you, and operates in demo mode. When operating in demo 
mode, you cannot submit jobs or edit metadata labels.

You can also run multiple instances of Workflow Portal on a single computer, so that 
you can use more than one configuration at a time—and each running instance 
requires its own Workflow Portal license. For example, you may be reviewing and 
submitting assets in one configuration, and setting trim points in another.

Stopping Web Applications
To stop a web application, close the web page tab, close the web browser, or simply go 
to another web site.
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Logging In or Changing Domains from Web Applications
When you start a web application, you may need to complete additional tasks before 
you can begin working. If additional tasks are required, Vantage will prompt you to 
complete those tasks, which are described in the following topics:

 Selecting the Domain

 Logging In

Selecting the Domain
Each Vantage domain is a separate, independent Vantage system. As a Vantage user, 
you might need to select a domain for the following reasons:

• You are starting a web application for the first time on a given computer.

• Your work requires that you connect to a different Vantage domain.

After you log in to a Vantage domain, the web app remembers it and connects 
automatically each time you restart the program. You can change domains at any time.

To select a domain, do the following:

1. In any web app where you want to change Vantage domains, select Change 
Domain in the application title panel.

The web application displays the Select Vantage Domain dialog.

2. To select a listed domain, select a domain in the domain list, and click OK.

When you change domains, your web application closes its connection and con-
nects to the new domain.

If your domain is not listed, or your connection attempt is unsuccessful, contact your 
Vantage domain administrator and refer to the following topics:

 Connecting to an Unlisted Domain

 Connecting with Custom Login Settings

Vantage 
domains on 
your network.
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Connecting to an Unlisted Domain

If the domain you want to connect to is not in the list, click Advanced. To connect to an 
unlisted domain, do the following:

To connect to an unlisted domain, do the following:

1. In the Select Vantage Domain dialog, click Advanced.

2. If the domain is not in the list, click My Vantage Domain is not Listed to display the 
Vantage domain server Name/IP field (see the figure below).

3. Enter) the domain database server’s computer name (for example, 
VantageServer203) or its IP address and click OK to connect.

4. Specify the name of the Vantage database instance, if different than the default 
VANTAGE instance.
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Connecting with Custom Login Settings

If the Vantage domain is installed on a SQL database where the default settings for the 
MS SQL server account were changed during installation, open Connection Settings to 
display the SQL Server login and password settings.

Select Use Custom Credentials, and enter the Vantage database SQL server account 
user name and password (obtained from your Vantage administrator), and click OK to 
connect.

Logging In
If you are accessing a Vantage domain for which user login is required, Vantage displays 
the Vantage Login dialog shown in this figure:

Note: If you do not have an authorized user name, contact your Vantage domain 
administrator.
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To log in to the Vantage domain, do the following:

1. Enter your Vantage user name and password (if required) or use your Active 
Directory user name and password and click OK to connect. Your Vantage 
administrator will either give you a user name, or instruct you to use your Windows 
user name.

2. If you are prompted to select a domain, select the domain name, and click OK.

The first time you connect to a Vantage domain from this computer (or after you 
delete browser cookies), select a domain from the list, and click OK to continue. 
Refer to Logging In or Changing Domains from Web Applications for more informa-
tion.

3. Enter the user name and password assigned by your Vantage Administrator, then 
click Log In.

Note: The default user name is Administrator without a password.

4. Check Remember me next time to store the authentication token in a persistent 
cookie in the browser. This keeps you authenticated if you close your browser and 
reopen it again.

If you entered the Vantage URL, Vantage displays the Vantage web application menu 
(see the figure below), so you can select any Vantage web application. Otherwise, your 
web application displays.

Returning to the Vantage Web Applications Menu
To return to the main web applications menu so that you can run another Vantage web 
application, click on the home button in the title panel.

If the title panel is hidden, click the show/hide control.
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Logging Out of a Vantage Domain
If you are viewing information that is sensitive, or viewing an operational application 
(vs. a view-only application), you might want to log out when you leave your computer 
on and unattended. You must log out when you want to change domains.

To log out of any web application, click Logout in the title panel.

Changing Vantage Users in Web Applications
When you are logged in to a Vantage domain and User Administration is enabled (in 
the Vantage Management Console), you can change user names. To log in with a 
different user, do the following: 

1. Select Log Out (upper right corner) to display the Domain Login dialog (in this 
figure, it depicts logging into the Dashboard as a sample).

2. Enter your user name, and password if required, and click OK to log in.

Changing Passwords in Web Applications
If you are logged in using a Vantage user name (not a Windows user name), you can 
change your password. Do the following: 

1. Click Change Password (upper right corner) to display the Set Password dialog.

2. Enter your new password, confirm the password, and click OK to change it.

The next time you log in to the Vantage domain, use your new password.
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Displaying Version Information
To display version information in a web application, click About in the Help menu.

Accessing Vantage Help in Web Applications
The Help menu in the web applications is at the bottom of the left, command column.

These menu items provide access to the following information and documents:

• About—Displays the web application’s version number.

• User Guide—Displays the Vantage User Guide (this guide) in PDF format. The PDF 
version contains bookmarks, and you can use the PDF search option to search for 
one or all occurrences of a term. This is also the best format for printing.l

• Web Help—Displays the Vantage User Guide (this guide) in HTML format. Web Help 
features include Contents, Index, Search, and Favorites pages. You can use Favorites 
to save links, so that you can quickly display an important topic.

To open the User Guide PDF or the web library, do the following:

1. Locate the Help menu in the left panel of the web application.

2. If no entries display under Help, click the control to the right to display the list.

3. To open the PDF version of this guide, click User Guide.

4. To open the web library, click Web Help.

Version 
Information
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You can also view help directly on the home page (applications that display depend on 
the licenses you own—Dublist Manager, for example).

For each application, you can click on the User Guide, or click Web Help for the specific 
application you’re interested in.
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Paths for Vantage Storage Overview
Vantage stores are named locations for temporary files. They are used in Vantage to 
conveniently store and access working media and attachment files, and to write media 
and other output files. Many Vantage services require access to files; Windows clients 
such as Workflow Portal also read and write files. These programs (both Windows 
programs and services) may run on one computer. Usually, however, they are 
distributed on many computers in a Vantage array. In distributed Vantage arrays, file 
access must be managed to ensure that the all programs can function correctly.

Vantage stores can be specified on Windows computer using the following forms:

• UNC paths (shares): \\ComputerName\Sharename

• Drive-letters: C:\folder\folder

If all Vantage services, clients, Vantage stores and folders are on the same server (an All-
in-one domain), you can use either form. However, Telestream recommends that you 
always use the UNC path form to reduce file access problems. It is a requirement when 
you are operating in a Vantage array.

Drive-letter paths are defined in the context of a local computer; it does not identify the 
computer that hosts the drive. This prevents them from being useful in arrays. For 
example, if you specify a Vantage store on drive C using a drive letter, and a Workflow 
Portal operator on a different computer tries to view files in that store, Workflow Portal 
will search for files on drive C on the operator’s computer, not the Vantage server.

In another example, you create a workflow in Workflow Designer installed on Computer 
A. It has a Watch action, which is executed by a Vantage Monitor Service running on 
Computer B. You specify a hot folder on drive C on Computer A, where Workflow 
Designer is installed. When the service executes the Watch action, it attempts to locate 
the hot folder on Computer B’s C drive, which does not exist.

When any Vantage service or client program needs to access and use Vantage storage 
or a directory on a different computer, you must specify the path using the UNC form. 
When services or clients will access Vantage storage from another computer, the 
Vantage storage location or directory must be published as a share, and access must be 
granted to the appropriate Windows users. For more information, see Windows 
Authentication Guidelines in the Vantage Domain Management Guide.

When you want to use a SAN system, be aware that some SAN systems expose the 
shared drive as a letter (mapped) drive (for example, X:) that is visible on any client of 
the SAN. You can utilize SAN drives via a letter drive reference, provided that each 
Vantage server is a client of the SAN and that all mount points use the same letter.

Note: If you are creating a store to hold proxy files viewed in Workflow Portal, be sure 
to reference the store with a UNC path. Some SAN clients do not allow frame-accurate 
representation of proxies when using shared drives.
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Vantage Workflow Designer 
Tours
These tours are designed to help you learn how to create and configure workflows in 
Workflow Designer, and submit media for processing. As you gain hands-on experience 
with Workflow Designer in Vantage, you’ll become familiar with important Vantage 
concepts, develop a working knowledge of Vantage and its components, and gain 
proficiency in using it to meet your media processing requirements.

Note: Sample workflows with short media samples are provided on the Telestream 
web site: http://www.telestream.net/telestream-support/vantage/workflow-
examples.htm. Unzip the zip file and save the media in a convenient location. The XML 
files are sample workflows that you can import using the Workflow Designer > File > 
Import Workflows menu selection. Some of the tours in this chapter use the samples, 
and some of the tours require you to build the workflows yourself.

Tours
 Tour 1: Creating and Configuring Workflows
 Tour 2: Processing Media in a Workflow
 Tour 3: Using the Workflow Design Workspace
 Tour 4: Transcoding Files
 Tour 5: Using Nicknames to Identify Files
 Tour 6: Processing Attachments in Workflows
 Tour 7a: Using Catalogs and Binders in Ingest Workflows
 Tour 7b: The Workflow Portal and Trim Workflow
 Tour 8: Controlling Workflow Execution with Variables
 Tour 9: Decision Making in Workflows
 Tour 10: Analyzing and Modifying Media Files
 Tour 11: Understanding and Using Open Workflows

Note: You can take tours 1-4 without a Vantage license. For tour 5 and others, you’ll 
need a trial license to run workflows. Also, without a license, you can only decode 
WMV files in workflows. For a trial license, contact sales@telestream.net.

http://www.telestream.net/telestream-support/vantage/workflow-examples.htm
http://www.telestream.net/telestream-support/vantage/workflow-examples.htm
http://www.telestream.net/vantage/help
mailto:sales@telestream.net
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Tour 1: Creating and Configuring Workflows
This tour takes about 15 minutes and provides a hands-on introduction to the concept 
and process of creating a typical Vantage transcoding workflow. In the following tour, 
you’ll submit some media to transcode, monitor your job as it executes, and then play 
the new media that Vantage produced using the workflow.

Vantage Workflow Designer is an intuitive, flexible, visual workflow design tool for 
creating and configuring workflows—the workhorses of Vantage. With visual workflow 
design and job status views, Workflow Designer provides a powerful, simple way to 
build an automatic video transcoding process from ingest to transcoding to output and 
distribution.

A workflow in Vantage is a series of connected actions arranged in a specific order to 
automate a media processing task: transcoding a file from one format to another, for 
example, moving the file to a desired location, and sending a completion message to 
the user. In addition, metadata processing, analysis and data extraction, and other 
workflow functions can all be performed in the same workflow.

Vantage provides many types of actions (the smallest amount of work you can specify 
in Vantage) which you can use to implement a specific media processing solution. For 
example, a Watch action continually polls a hot folder (such as a media server directory 
or a local or network folder) for incoming media to process—which Vantage performs 
by automatically submitting a job to the workflow you've created. Likewise, a Flip 
action transcodes media, and a Copy action replicates a file to another location.

The task specified by each type of action (Watch, Flip, Copy, etc.) is actually executed by 
a Vantage service (a special type of Windows program)—for example, the Watch action 
is executed by the Vantage Monitor service.

In this tour, you’ll log on to your Vantage domain using Workflow Designer, and create 
and configure a workflow to encode a QuickTime file.
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Starting Workflow Designer and Logging In
You can run Workflow Designer directly on your Vantage server, or you can install and 
run it on another Windows workstation on the LAN.

1. Double-click the Vantage Workflow Designer shortcut on your desktop or select 
Start and search Programs for Vantage Workflow Designer.

2. First Time Use—Click Search in the Select a Vantage domain window that opens to 
get a list of domains. 

After connecting the first time, Workflow Designer remembers the last domain you 
used, and connects automatically.

3. Select the domain you want to use, and click OK.

(A Vantage domain is identified by the computer that hosts the Vantage domain 
database—you are actually connecting the Workflow Designer client to the 
domain database. For example, if your Vantage domain database is on a server 
named Vantage_01, select that name from the domain list to make the connection.) 

If you have problems connecting to the domain, see Connecting to an Unlisted 
Domain or Connecting with Custom Login Settings, or contact your IT department or 
Vantage administrator for assistance.

4. If the Vantage Domain Login dialog is displayed, enter your Vantage user name and 
password in the login dialog to proceed.

This is the list of domains 
running on your network. 
Select a domain and click 
OK.

Click Search to populate 
the list of domains.
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Note: If you need a user account, obtain it from the administrator or create one 
yourself in the Management Console. For assistance, run the console and select Help 
> Online Help. The default Vantage user name is Administrator, with no password.

Once you’re logged in, Workflow Designer displays the main window.

Creating a Workflow Category
When Vantage is installed, there are no categories or workflows stored in the Vantage 
domain database. So, the first user that logs in to a new domain is prompted to create a 
new category and workflow.

Note: Even if categories are present, you should make a category for use during these 
tours, so that your practice workflows don’t interfere with the work of others, and that 
they remain separate from production workflows.

If you’re prompted to create a new category, click OK. Otherwise, select File > Create 
New Category to display the Create New Category dialog.

Enter <Your Name> Tutorial Workflows and click OK. 

Note: For these tours, the category is referenced simply as Tutorial Workflows. 
Workflow Designer displays help tips as you use it, to help you become familiar with its 
features. If you don’t want Workflow Designer to display them, check Don’t show me 
this again.
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Creating a Workflow
Now, let’s create your first workflow to convert files to a small-frame (proxy) QuickTime 
file for preview purposes. 

1. If you’re prompted to create a new workflow, click OK. Otherwise, select File > 
Create New Workflow. Workflow Designer displays the Create New Workflow 
dialog.

2. Select the category you just created, from the list at the top of the dialog.

3. Enter the name Simple Transcode (in your Tutorial Workflows category), and click 
OK. (There’s no need to change the expiration policy settings now.)

Your new workflow is automatically added to the list in the Workflows panel under 
the category you created earlier.

When you create a workflow, it is automatically placed in edit mode, so you can begin 
adding actions.

You do not need to explicitly save workflows you create or modify. The changes you 
make as you create (or update) a workflow are saved automatically in the database.
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A Quick Look at the Workflow Designer Main Window
Now that you have a category and workflow created, take a minute to familiarize 
yourself with Workflow Designer.

Workflow Designer has a comprehensive set of menus, and several tabbed workspaces 
or panels.

On the left is the Workflows panel, with all of the domain’s workflows organized by 
category. To the right are several workspaces, identified by tabs—Workflow Design, 
Monitor Status, Job Status, and Domain Monitor Status, Domain Job Status, and 
Workflow Analytics. Each of these tabs displays a workspace for specific tasks you’re 
performing. In this tour, you’ll be working in the Workflow Design workspace, where 
you can create and configure your workflows.

Zoom control

Workflows panel—displays your 
workflows by category.

Use the Workflow Design workspace to 
construct and configure workflows.

Actions toolbar—
drag actions onto 
design area to add to 
workflow.

Zoom control

Workflow design in 
progress.

Nicknames | 
Variables View

Workflow Designer 
has workspaces for 
each key activity.
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Adding Actions to Your Workflow
You add actions and connect them together to form a workflow. Every workflow starts 
from an origin action (such as a Watch action monitoring a hot folder for new media to 
process) and continues execution of all other connected actions, each of which execute 
in left-to-right order when a job is submitted by the origin action.

All of the actions in Workflow Designer are arranged in functional groups in the Actions 
toolbar at the top of the Workflow Design workspace. The actions displayed in your 
Workflow Designer may vary from what is shown here if some actions are unlicensed.

Note: To re-arrange the groups in the actions toolbar, right-click in the toolbar and 
select Sort by Name or Sort by Behavior.

1. Open the Monitor group in the actions toolbar (click the arrow in the upper left 
corner of the group)—to display the Watch action and Associate action.

2. Click and drag a Watch action down onto the Workflow Design workspace to add 
your first action to the workflow. (Notice that it automatically centers itself—
Workflow Designer visually optimizes workflow actions automatically.) A Watch 
action polls a hot folder (which you need to specify) for new media files placed in 
the folder, and starts a job to execute the workflow using that file.

Note: You can also copy and paste actions in a workflow to duplicate them. Right-
click an action in the workflow and select Copy, then right-click in an empty area in the 
workspace and select Paste.

Actions are 
grouped by 
category. 
Click the arrow to 
open or close the 
group.
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3. Open the Transcode group and—rather than dragging an un-configured Flip 
action onto the workflow—click the Flip action one time to display a 
comprehensive list of pre-set Flip actions. (You can either use an un-configured 
action, or select a pre-configured action, which may make configuration easier.)

4. Select Web > QuickTime > QuickTime H.264 with AAC. The (pre-configured) action 
is added to the workflow and is arranged just to the right of the Watch action.

Connecting Your Actions Together
To create a chain of actions which execute in sequence, you connect them together. 
Here are ways you can connect actions together:

• Click and drag a connecting line from one connector pin to another

• Click and drag an action (either from the actions toolbar or one already in the work 
area) and bump it into the edge of the action you want to connect it to—until a 
pale blue vertical line displays. (You must drag your mouse pointer up to the edge 
of the action you’re connecting to).

• Copy an action, and right-click on a connector line and select Paste to add the cop-
ied action between the two actions. Or, drag an action onto a connector line until it 
displays as a larger line. Then, drop it to connect it between the two actions.

There are also two ways to disconnect actions:

• Hover over the center of the connecting line until a red X displays; click the red X to 
delete the line, or right-click and select Delete. 



Vantage Workflow Designer Tours
Tour 1: Creating and Configuring Workflows

91
Try connecting your actions now:

1. Click and drag a connector line from the yellow connector pin on the right side of 
the Watch action to the yellow connector pin on the left side of the Flip action. 
(Connector pins display in yellow until they’re connected.)

2. Next, open the Transport action group and drag the Copy action out onto the 
canvas.

3. Now, click and drag the Copy action so that your mouse is directly over the right 
side of the Flip action (a connector bar displays in pale blue, as shown below). 

4. When the pale blue bar displays, release the mouse—the Copy action 
automatically connects to the Flip action.

5. Now, delete the Copy action, because it is not required for this workflow. Select it 
and press Delete—or click the X button in the upper right corner—and confirm the 
Delete dialog.

Note: Workflow Designer automatically saves your workflow in the database as you 
modify it. You do not have to save workflows manually.
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Configuring the Watch Action
Each action in a workflow performs a specific task or function (copy a file, for 
example)—and must be configured to perform the function specifically the way you 
want for a given workflow. 

You configure actions using the Inspector. The Inspector is one or more panels with 
configuration options—and the Inspector for each action varies, according to 
requirement of the action. For example, you configure a Watch action very differently 
than a Flip action.

Each action displays an i (for Inspector) button  in the top left corner; the color 
yellow indicates that it has not yet been configured (or configured correctly)—it 
displays blue when properly configured).

Vantage can process a broad array of media types and formats, and access all major file 
systems. In addition to standard file systems including Windows and FTP, Vantage 
intelligently works with several complex media types such as Avid reference movies, 
and P2 camera media files.

You’ll configure this Watch action to poll for any type of media file placed in a specified 
folder on a Windows server.
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1. Click on the  button of the Watch action (or, just double-click the action) to 
open the Inspector, and display the first panel.

This first panel allows you to choose a special media type to watch for (such as an 
Avid reference movie). Or, you can select Any Media which will work for most media 
types.

2. Select Any Media to poll for any type of new media and click Next. (Media files is 
checked by default.) Workflow Designer displays the next panel in the Inspector.

Note: Entries in these lists that are disabled have not been licensed, and thus, are not 
available to use.

This second panel allows you to choose which type of file system (such as FTP or 
Windows) that the action will be watching (monitoring).

File formats supported by 
Vantage—those in gray 
have not been licensed.
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3. Select Windows as the type of file system to monitor, and click Next to display the 
next panel in the Inspector.

Note: If you’re using a Vantage array, where Vantage services and clients are 
distributed among several servers and workstations—or you access or deliver media 
on network servers—you must use UNC paths to identify media locations. The path 
must be a share with proper permissions (for example, \\MyDomainServer\HotFolder). 
Otherwise, your workflows will not function because it can’t find the path. Be sure to 
read Paths for Vantage Storage Overview for guidance. 

4. Open Windows Explorer and create a folder directly on the Vantage domain server 
for this workflow and name it VantageTourOneIn. If you plan to reference it as a 
share, display Properties and enable sharing.

5. Return to Workflow Designer and click Browse to navigate and select the fully-
qualified path in this field. Or, enter the share path manually. 
This is now the hot folder for this workflow.

Click Browse to navigate to 
and select your hot folder or 
manually enter the path.
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6. Click Next. Workflow Designer displays the configuration panel.

7. Take a moment to review these settings. (You can place your mouse cursor over the 
controls to display tooltips which describe each setting.) You don’t need to make 
any changes to this panel.

8. Select a nickname for the incoming file—in this case, Original is already selected, so 
you don’t need to change it. (You’ll learn more about nicknames in Tour 5.)

9. Click the  button at the top right of the panel to open context-sensitive help (a 
man page) with detailed information about configuring this Inspector. Wherever 
you see the context-sensitive help button, you can click it to display details about 
the part of Workflow Designer you’re focused on. (Click the  icon to display the 
User Guide—the document you’re reading.)

10. Click Next and then click Finish to save this configuration of the Watch action.

Now that you’ve configured the action, notice that the Inspector button is hidden to let 
you know that it has been configured. Move your mouse back over the action—
Workflow Designer displays the Inspector button again—in blue. You can always re-
open the Inspector to review or change its settings.

You must select or enter a nickname in 
every action that acts on or creates a 
file, to uniquely identify and track this 
file instance throughout the workflow.



Vantage Workflow Designer Tours
Tour 1: Creating and Configuring Workflows

96
Configuring the Flip Action
The Inspector button on the Flip action is yellow as well—meaning, it must be 
configured. Why does it need to be configured, given that you selected a pre-
configured action? Because the output file’s nickname hasn’t been specified.

1. Double-click the action to open the Flip Inspector, and note the red asterisk by the 
Output media file nickname field, indicating that a nickname is required.

2. Click the menu to view the list of nicknames for output files. Enter QuickTime H264 
AAC as the nickname for the file this action creates. Now, all subsequent actions in 
the workflow can reference the output from this Flip action, simply by referring to 
the nickname QuickTime H264 AAC.

Some of the nicknames in the list are key Vantage nicknames— they enable certain 
Vantage features or are required in certain actions. When you create your own nick-
names, they should be meaningful in the context of your workflow.

Note: The nickname you assign a file has no effect on the output file name (which by 
default, will be the same as the input filename, except for the extension). For example, 
if you submit test.mpg, this Flip action will create test.mov. The input file in this 
workflow is always referenced by the nickname Original and the output file is always 
referenced by the nickname QuickTime H264 AAC. 

You must select or 
enter a nickname 
in every action 
that acts on or 
creates a file, to 
uniquely identify 
and track this file 
through the 
workflow during 
execution of the 
job.
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3. Take a moment to click on each of the video stream, audio stream, and H.264 and 
AAC codec components, as well as the QuickTime Movie container component in 
turn, and review the details panel for each component (the details panel displays 
below the building blocks). Also note the toolbar directly above the building 
blocks. This is the comprehensive user interface for configuring Flip (transcoding) 
actions in Workflow Designer.

4. Click Save to save this configuration of the Flip action, and note that the yellow 
Inspector button no longer displays. 
Now, when you hover over the action, the Inspector button displays in gray, and 
when you hover over the Inspector button itself to select it, it displays in blue.

Conclusion
Congratulations! You’ve just learned how to create a workflow, and learned the basics 
of configuring actions using Workflow Designer’s Inspector. You’ve created a complete 
workflow which can detect new media files placed in a hot folder, and convert them to 
QuickTime format.

In the next tour, you’ll learn how to activate workflows, submit jobs, and monitor them.
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Tour 2: Processing Media in a Workflow
This tour takes about 15 minutes, and shows you how to process media in your 
workflow—which involves activating a workflow, submitting media to transcode, 
monitoring the job as it executes—and viewing the new media it generates.

You can start a job from an active workflow in various ways:

• Place a media file in a hot folder to submit a job automatically

• In the Watch action Inspector, check Process Existing Media. Then, select a hot 
folder which already has one or more media files, and activate the workflow—this 
causes Vantage to process all existing media in the directory, rather than ignore the 
existing files.

• Click the Submit Job button (at the bottom of the window) and select the file (or 
files) to submit manually. Just follow the steps in each panel.

• Drag and drop a file (or files) directly onto the origin (Watch or Receive—or Catch 
or Dublist in TrafficManager) action of a workflow. 

There are other, specialized ways to start jobs, but these are the main ones. In this tour, 
we’ll drop a media file in a hot folder to start a job automatically.

Activating a Workflow
To activate a workflow, follow these steps:

1. If you closed Workflow Designer, open it again.

2. Select your Simple Transcode workflow in the Workflows panel on the left.

3. Click the Activate button at the bottom of the window. 

Click Activate to release the workflow from editing, save 
it, and activate it to start the Watch action.
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Workflow Designer releases it from edit mode and the Vantage Monitor Service starts 
the Watch action in your workflow, polling the hot folder you specified, searching for 
new media files to process. A job is started for each new file placed in this folder.

Monitoring your Workflow Status
When you activate a workflow, Workflow Designer automatically displays the Monitor 
Status workspace to show you the status of all Watch actions. (You can always select 
any workflow and view its monitor (or job) status, including a record of past jobs.)

• Notice that the action state of the Watch action is listed as In Process, which indi-
cates it has started executing, and it is polling for new files. 

• When a new file is discovered, a job is created that executes the Simple Transcode 
workflow. 

• Actions may also be Waiting—the state that the transaction enters while Vantage is 
determining which service should process it. A transaction remains in Waiting state 
until it is accepted by a service for processing.

• If you deactivate the workflow, the Watch service stops monitoring the hot folder, 
and the record is saved in the database for history. When you re-activate the work-
flow, a new record is added to the list. 

• You can double-click the Watch action entry in the table to display more detailed 
information. You can confirm that it is polling the directory that you specified, and 
that no new files are detected—or that you’ve made an error in the file path that 
needs to be fixed, for example.
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Note: You may have also noticed the Domain Monitor Status workspace—the only 
difference is one of scope—it displays all of the monitors in the entire domain.

When jobs are started, each action is executed by a corresponding Vantage service, and 
can be optimized for execution if multiple services (for example, multiple Transcode 
services) are in your domain.

Now, submit a job by following these steps:

1. Drag a file to your hot folder to submit a job. We suggest that you use one of the 
sample media files provided, which are located at <InstallDrive>:\VantageStore 
(typically, C:\VantageStore), in an All-in-one domain. (If sample media was not 
installed, just use your own.)

2. Click the Job Status tab to display the Job Status workspace to monitor the status of 
running jobs.

m
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3. Click on the new job entry in the table, and observe each action change color as the 
entire job executes each task specified by the actions in the workflow. 

Actions display specific border colors to identify each action’s state. For example, a 
yellow border indicates the action hasn't started executing yet. A green border 
indicates the action is currently executing, and a blue border indicates the action 
has completed without errors. For a complete list of colors and their meanings, see 
Using the Jobs Table.

4. Move your mouse over actions in the workflow in the Job Status workspace. 

5. Click the Inspector button or just double-click the action to display run-time 
information about the action in the Status/History window.

6. Click on each succeeding status line in the Status/History window to display details 
about the action. Close this window when you’re done.

When all actions are outlined in blue, the job has completed successfully.

Playing Your New File
Now that the job has completed, Vantage has encoded a new QuickTime file.

Note: You didn’t configure the Flip action to tell it where to save new files. So, where 
are the new files saved? The short answer: unless otherwise specified, new files are 
written to a Vantage store—a pre-defined directory for storing temporary files.

1. In the Job Status workspace, make sure your job entry is selected in the Jobs table 
at the bottom.
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2. Click on the Binders  button to display the binder for this job.

A binder in Vantage keeps track of the location of media files associated with a job, 
plus metadata labels and other attachments (files).

3.  Right-click the output file labeled QuickTime H264 AAC. This is the file your 
workflow transcoded into QuickTime. 

4. Click the green Play button in the preview window or double-click the file to open 
your default video player and play the file.

Deactivating a Workflow
In an upcoming tour, you’ll use a copy of this same workflow. You should deactivate this 
workflow so that you can use the same hot folder in the next workflow, without the 
Simple Transcode workflow ingesting new media you add to the hot folder. 
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Select the Simple Transcode workflow in the Workflows panel, and click Deactivate at 
the bottom of the window.

If you want to edit the workflow again, select File > Edit Workflow or click Edit at the 
bottom of the window. When you’re done editing a workflow, you should click Release 
so that it can be edited or executed by others in the organization.

Conclusion
Congratulations! You’ve just learned how to automatically submit media to a workflow, 
monitor its execution, and view the transcoded media file.

In the next tour, you will explore how to use the Workflow Design workspace 
effectively.
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Tour 3: Using the Workflow Design Workspace
Now that you know how to create workflows and submit media, let’s take a moment to 
learn some techniques for using the Workflow Design workspace effectively. This tour 
takes about 10 minutes.

Some workflows—like Simple Transcode—have only a few actions in them; others may 
have dozens of actions. Sometimes you’re working on the big picture of a workflow—
laying out actions and connecting them together. Other times, you’re working on 
action details—configuring the details of a transcode task, for example. 

In each case, you may want to zoom in or out, scroll around, or center the work area, to 
help you focus directly on the work you’re performing at the moment.

Types of Workflow Actions
There are many different types of actions you can use to build your workflows, each 
designed to help you create comprehensive, powerful media processing tools. Here’s 
an overview of major groups and actions.

Monitor—includes actions such as Watch, for ingesting media (or media descriptor) 
files and starting jobs for the workflow. These monitor directories on a wide variety of 
computers and media-centric file systems and platforms. The Workorder action enables 
batch submission multiple input files to a given workflow.

Traffic—for processing local and regional, and national commercials to on-air or 
broadcast, including interacting with catch servers. Actions include the Catch action 
and Dublist action. These actions are part of TrafficManager.

Live—the Capture action is the origin action; it sets up Vantage to ingest streaming 
media. This service works only on a Lightspeed Live Capture server.

Cloud—the Cloud action moves media to the Telestream Cloud platform for processing 
in Cloud-based workflows.

Metadata—includes actions (Populate action and Transform action) which allow you to 
automatically edit and update metadata labels, and transform labels and attachments.

Catalog—includes actions (Register action and Exist action) which allow you to register 
media in Vantage’s catalog for safekeeping and further processing and analysis by 
other workflows.

Timed Text—Transcodes media while extracting captions or converting a caption or 
subtitle file.

Transcode—Flip actions includes a broad suite of encoders and codecs, and allow you 
to encode media on a file-by-file basis.

Analysis—includes a wide variety of actions which allow you to examine video and 
audio for specific characteristics and metrics, and extract the results for use in building 
intelligent, adaptable workflows.
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Multiscreen—the Multiscreen Flip action allows you to encode adaptive- or multi-
bitrate packages such as Apple HLS and MPEG DASH.

IPTV VOD—The IPTV Flip action allows you to encode Transport Stream containing 
MPEG-1, MPEG-2, H.264 and HEVC (H.265). It uses Manzanita multiplexing technology 
to give you fine control over Transport Stream creation.

Edit—Includes the actions for Post Producer. The Conform action renders complex 
editing timelines into output media files, allowing you to automate the production of 
hundreds of customized outputs. The Compose action allows you to import timelines 
from editing systems such as Final Cut, Adobe, and Avid.

Transport—includes actions which allow you to copy, move, and delete files, and 
deploy them to external systems.

Common—utility actions for building complex logical and branching workflows: 
Compute, Construct, Decide, etc.

There many other categories and actions, as well as third-party actions for interaction 
with third party systems: Aurora, Signiant, Aspera, and others.

Take time to browse through the groups—open them up, and drag their actions onto 
the design space and review their Inspectors to gain a solid understanding of Workflow 
Designer’s comprehensive workflow building blocks.

Zooming In and Out on a Workflow
There are three ways to zoom in and out on a workflow:

• Drag the zoom slider bar at the bottom left of the workflow

• Repeatedly press Control+/- (the plus and minus keys)

• Use the scroll wheel on your mouse while pressing the control key.

To zoom a workflow, do the following:

1. If you closed Workflow Designer, open it again, and select the Simple Transcode 
workflow from your category in the Workflows panel (on the left).

2. With your Simple Transcode workflow selected and displayed in the Workflow 
Design workspace, click Edit at the bottom of the window.

3. Use the zoom slider bar at the bottom left corner to zoom in and out to suit your 
viewing and editing needs.

Use the zoom slider bar to zoom 
your workflow in and out.
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Moving the Workflow Around in the Workspace
A workflow with many actions may be larger than you can view effectively in your 
workspace, when viewed at the zoom level you’re currently using. 

To move the workflow around in the workspace, click and hold anywhere on the 
workflow canvas (do not click on an action). When the cursor changes to a compass, 
continue to hold down the mouse button and drag the workflow in the appropriate 
direction.

Centering the Workflow in the Workspace
To center the workflow in your workspace, right-click in the workspace and select 
Recenter Workflow from the context menu. Alternatively, you can press Control-R on 
the keyboard.

Before you continue, take a few moments to practice zooming, moving, and centering 
the workflow—you’ll use these features frequently, especially as you create larger and 
more complex workflows. Becoming familiar with them now will make it easier to focus 
on the design process.

Using Auto Arrange
Use the Auto Arrange feature to assist you in visually optimizing and organizing the 
layout of actions in your workflow. Auto Arrange automatically moves actions into 
position for best layout as you place them on the canvas.

To disable automatic arrangement of actions while you're adjusting actions in a 
workflow (especially a large one—30 actions or more), click the Auto Arrange button, 
located at the bottom of the Workflow Design workspace, to toggle it off. While Auto 
Arrange is off, the Auto Arrange button displays the phrase Auto Arrange SUSPENDED 
in yellow, and actions will not automatically organize themselves.

Click the button again to toggle auto arrangement back into effect.

Enable or disable Auto Arrange to 
suit your construction style.
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Displaying and Updating Workflow Details
To display or hide a workflow’s details panel, do one of the following:

• Select File > Workflow Details panel.

• Click in the Workflow Design workspace’s title bar.

When you display the workflow’s details panel, Workflow Designer obscures the tabbed 
workspaces to display details about the workflow.

In the workflow details panel, you can use the following controls to manage the 
workflow information, including expiration, execution of the workflow in open mode, 
and automatic report generation. 

The information that displays below the Apply button includes creation and 
modification dates, and job statistics. The Expected Variables list indicates which 
variables are being utilized by actions in this workflow. If an action parameter in the 
workflow binds to a variable, it displays here.

Conclusion
Congratulations! You’ve just learned how to use some of the features in the Workflow 
Design workspace. In the next tour, you will learn how to set up a workflow’s 
transcoding actions to use the settings that you want.
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Tour 4: Transcoding Files
This 20-minute tour adds to your workflow design and configuration skills. It’s an in-
depth look at how effectively Vantage deals with the complexities of media transcoding. 

Duplicating a Workflow
It is often easier to duplicate a workflow and make minor modifications to it, rather 
than starting over with a new one. To duplicate a workflow, do the following:

1. If you quit Workflow Designer after the last tour, start it again. In the Workflows 
panel, open your Tutorial Workflows category. 

2. Select the Simple Transcode workflow.

3. Select File > Duplicate Workflow (or right-click and select Duplicate...). Workflow 
Designer displays the Duplicate Workflow dialog.

4. Name the new workflow Complex Transcode. Click OK to create the new workflow 
and close the dialog.

Workflow Designer automatically selects the new workflow, places it in edit mode and 
displays it in the Workflow Design workspace.
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Adding a Branch to a Workflow
Now, let’s add a second, pre-configured Flip action to your workflow. Recall that 
Workflow Designer has many pre-configured actions, making it easier to build 
workflows.

Let’s add this Flip action so that Vantage can encode two separate output files 
simultaneously, in a single workflow. By creating a branch with parallel Flip actions, 
each Flip is executed independently as soon as the Watch action completes (making 
the resources available). This design is more time-efficient than if one Flip action 
followed the other. Creating branches for parallel encoding is an important part of 
Vantage scalability and high-volume transcoding. To add a branch, do the following:

1. Open the transcode action group on the action toolbar.

2. Click on the Flip action and select Mobile > 3GPP 300KBit H.264 with AAC preset 
from the menu to add it to the workflow, as shown here:

3. Connect the new Flip action to the Watch action—click and drag a connector line 
from the out connect pin (yellow dot) on the right side of the Watch action to the in 
connect pin (yellow dot on the left side) of the new Flip action—creating a new 
branch in the workflow.

4. Open the new Flip action’s Inspector and specify an output file nickname to identify 
the new file you’re encoding—Mobile 3GPP. 

5. Click Save to update the workflow in the database and close the Inspector.
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Writing Output Files to Specific Locations
As this workflow is currently designed, newly-encoded media is saved in a Vantage 
store, because you have not explicitly configured the workflow to place the media in a 
specific folder. In order to use the new file after the workflow has completed—for 
example, on a broadcast server or QA server—you need to explicitly move it to a known 
location on your network.

Let’s add a Move action to each branch, so that the workflow places the new media in a 
specific folder. Move actions are part of the Transport group, and are file system actions. 
A Move action actually copies the file to the new location, then deletes the original. 
(Alternatively, if you want to keep the original file, you can use a Copy action, which 
places a copy of the file in the new location while keeping the file in the old location.)

Move actions (and other file system actions) utilize a special feature called the Vantage 
folder address book, which enables you to store output locations, IP addresses, folder 
names and credentials in a single place. This makes it easier to manage destination 
locations for files.

To move the new files:

1. Open the Transport action group on the action toolbar. Drag a Move action onto 
the QuickTime branch, and another onto the 3GPP branch, connecting each to the 
Flip action, so that each Move executes after the Flip action.

2. Open the QuickTime branch’s Move action Inspector.

3. Select the QuickTime H264 AAC file by nickname, to identify the file to move.
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4. Click on the browse  button to the right of the Path field. Workflow Designer 
displays a browse window for selecting the destination folder for the media output. 

When specifying the path to the file, use a UNC path. A UNC path includes the 
server name. For example, here’s a UNC path, including the server LS3-Techpubs:

\\ls3-techpubs\C:\Users\chuckp\Videos\ 

For a discussion of using UNC paths, see Paths for Vantage Storage Overview.

Vantage Folder Address Book
As an alternative to browsing for a path every time, you can create a new Vantage 
Store in whatever location you like and add it to the Vantage Folder Address Book 
(shown below). The Address Book contains lists of frequently used Vantage Store 
addresses.
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• Vantage Folder Address Book simplifies directory referencing by allowing you to 
specify a fully-qualified output location by a simple name. 

• Vantage Folder Address Book also allows you to update a path or credentials cen-
trally, and automatically update all actions using that Vantage folder.

• For example, you might have a folder on a given server for HD MPEG2 content: 
\\Voyager\SunupCampaign\Darwin\WaitingApproval\HDMPEG2. You can create a 
Vantage folder in the address book for this path, and name it SunupHDWaitingAp-
proval. 

• If you need to change the path or any password associated with the address, you 
can simply change it in the address book and all actions will automatically update.

To add a destination to the Vantage Folder Address Book:

a. Select the Vantage Store/Folder (middle selection under Select the destination).
b. Click the button at the far right end of the Vantage Store/Folder selection to 

open the Vantage Folder Address Book.
c. Create a new Vantage folder—click the Add Folder button in the address book 

toolbar (the new folder button at far left):

d. Enter the folder name in the Name text box: VantageOut.
e. Click Modify to specify the directory that this Vantage folder address points to. 

Workflow Designer displays the Folder Location Editor.
f. Choose Windows File System and click Next. (Vantage folders can be defined for 

any supported file system.)
g. Click Browse to select a directory (for example, in Windows Explorer make a 

folder named VantageOut) where you want the output media file copied, and 
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click Select Folder. (Don’t use drive letters on a distributed Vantage array or 
distributed clients—they won’t work.)

h. Click Finish to close the Folder Location Editor dialog. (You may have to click OK 
on the local folder warning dialog.)

i. Click OK to add this new Vantage folder and close the Add New Folder dialog.
j. Click Select to specify this new folder as the destination for the Move action.

5. Click Save to save the destination configuration and close the Inspector.

6. Repeat the preceding steps for the 3GPP Move action—select the Mobile 3GPP 
nickname for the file you’re moving, and select the same destination—VantageOut.

When you’re done, your workflow should look like this:

7. Activate this workflow.

8. Automatically submit a media file to the hot folder for this workflow.
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Configuring a Flip Action
Now, let’s look at the original QuickTime Flip action that you added in Tour 2 in more 
detail, and learn how to change Flip action settings.

To change settings in this action, do the following:

1. Click Edit to deactivate the workflow and enter editing mode.

2. Display the Inspector of the QuickTime Flip action.

3. Click the Encoder menu to display the list of codecs you can use in the Flip action.

4. Click the Edit Filename Pattern button to control the output file name. By default, 
Flip actions name the files they create using the same root name as the original 
file’s name plus an appropriate extension, based on the encoder. For example, a 
QuickTime movie flipped from FlipDemo.mss is named FlipDemo.mov.

5. Leave the Decoder set for Auto to automatically decode the incoming format.

6. Click on the Video Stream component to display the Processor menu in the details 
panel below, where you select which video processor to use: Legacy 8-bit RGB, 
4:4:4, Multi-core 16-bit YCbCr 4:4:4:4, or Lightspeed Accelerated 16-bit YCbCr 
4:4:4:4, and others. 

7. At the right of the video stream, click the Video Codec menu to display the video 
codecs that are available. (Click the gear icon to cycle through the selection.)

8. To the right of the audio stream, click the Audio Codec menu to display the audio 
codecs that are available.

Encoder menu 
displays all 
encoders in the 
domain.

Video button & 
codec menu.

Audio button & 
codec menu.

Container button 
and menu.

Video and Audio 
stream buttons.

Video Processor 
selector.

Video/Audio 
Decoder button.
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9. At the far right of the Video and Audio Stream components, click the Container 
menu to display the containers that are available (notice that the QuickTime 
encoder only provides a QuickTime container).

Note: As you click on the video codec, audio codec, and container buttons to select 
them, configuration details change in the configuration panel at the bottom of the 
window. For example, the Video Codec configuration panel enables you to set frame 
width, height, and bitrate for the video in the QuickTime file.

When you select a stream (by clicking the audio or video stream buttons, far left), 
you can also add processing filters.

10. Select the Video Stream button in the toolbar, and then click on the Video Filter 
menu to display a list of video filters.
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11. Select the Chroma Settings filter. Workflow Designer adds it to the video stream 
and its controls display in the bottom panel. 

Notice that there are other filters for audio and other functions (mouse over them 
without clicking to see descriptions). These filters are available to provide control 
over how the transcode operates.

12. Click on the Video Codec at the far right to display the codec settings at the bottom 
of the window.

Video codec 
button
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13. Click the Frame Size/Frame Rate drop-down arrow to open and view the settings. 
Notice that you can change the frame width, height, and frame rate.

14. Finally, click the Encoder menu at the top to display the encoders that you can 
select. (Recall that you can configure a Flip from scratch, or you can select a 
template—which you did earlier when you added the 3GPP Flip action).

15. Click Cancel to close the Inspector without making any changes. 

Conclusion
In this tour, you’ve learned how to duplicate an existing workflow, how Vantage 
performs multiple simultaneous encodes, and how to create and use Vantage folder 
addresses. You’ve also learned how to configure Flip actions to perform encoding tasks.
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Tour 5: Using Nicknames to Identify Files
This tour rounds out your knowledge of nicknames, and how you use them to easily 
track and process multiple files action by action in a workflow. It takes about 10 or 15 
minutes to complete.

Overview
A key feature of Vantage workflows is the notion of nicknames. A nickname in Vantage 
provides a convenient means of referencing a file, using only a word or logical phrase—
such as Original or QuickTimeH264AAC.

• In the context of a workflow, all files are referenced by a nickname which you assign 
as you either ingest (usually with a Watch or Associate action) or create a file (for 
example, with a Flip action). 

• Nicknames are used in every action that creates, accesses, or operates on a file.

• Nicknames provide an brief way to tell an action which logical file it should use to 
perform a task without fully listing the file path. 

• Vantage automatically keeps track of files and their associated nicknames as jobs run.

• Vantage provides a set of default nicknames which can be used in certain types of 
workflows or to enable certain Vantage features. 

• You can also assign your own nicknames which are meaningful in the context of your 
workflow. 

• Nicknames can be used over and over again in multiple workflows because they only 
have scope, or relevance, during the execution of the workflow, and have no context 
outside the workflow itself.

Note: For some complex media types—such as Omneon reference files or P2 camera 
files—media is actually a collection of files, all of which are necessary to make the 
media work. In this case, the nickname refers to the entire collection of media files; 
Vantage tracks all the video and audio files which comprise the media automatically.

Deleting a File Using its Nickname
To reinforce the notion of using nicknames, let’s make one more change to the 
Complex Transcode workflow. The Delete action is a file system action which you use to 
delete a file that is no longer needed, using the nickname of the file. Let’s use it to 
delete the original file that was ingested by the Watch action, at the end of the 
workflow.

1. Select the Complex Transcode workflow—duplicate it as Complex Transcode Delete.

2. Open the transport actions group, and click and drag a Delete action into the new 
workflow, without connecting it to any action. Notice that no nicknames display on 
this action.
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3. Connect the Delete action to the top Move action. 

Note: Notice that the nicknames now display on the Delete action. The list on the left 
are files available before execution; the list on the right are files available after 
execution. (After configuration, the files used in this action are highlighted.)

4. Open the Delete action Inspector (click the yellow i in the top left corner). 

The Delete action accepts one parameter: The nickname of the file that you want to 
delete. This list displays the nicknames of all files in the workflow that it knows of at 
the moment, based on its connection—Original (from Watch) and QuickTime H264 
AAC (from the connected Flip action).

5. Select Original (which identifies the input file) and click Save to close the Inspector.

Workflow Designer immediately highlights the other Flip action’s Original nick-
name in red, indicating an error. In this case, you’re attempting to delete a file that is 
being used by the Flip action in the other branch! By using nicknames, Workflow 
Designer can help you discover many workflow design issues automatically.

6. Connect the Move action to the Delete action to merge the branches, (see below).

When the workflow branches are merged, the Flip actions are synchronized. As 
designed, the workflow waits for all upstream workflow branches to complete before 
executing the first action in the merged branch. 

Nicknames of files 
in this workflow 
before execution of 
this action.

Nicknames of files 
in this workflow 
after execution of 
this action.
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Thus, the Delete action will not execute until both Flip actions have completed. If it 
executed right after the top Flip action, it might delete the file (or attempt to delete it 
and fail) before the 2nd Flip had completed.

Also notice that the nicknames on the Delete action have been updated to include the 
file from the second Flip—Mobile 3GPP.

The Mobile 3GPP 
nickname is added 
to the list.
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Tour 6: Processing Attachments in Workflows
This 15-minute tour shows you how you can add attachment files—files associated 
with media files—to a workflow, and process them. 

• An attachment might be an XML file, a PDF, DOC, or any other file that needs to be 
stored with the media file as part of a job requirement.

• For example, a media file containing a news story might be accompanied by the 
text of the story with timecode markings in the text for use during video editing. 

• The Associate action, which is the subject of this tour, is used to watch hot folders 
for general attachment files, just like you use Watch actions to watch for media files.

• The Associate action discovers and pairs the attachment that contains the name of 
the media file with the media file so they can be processed together.

• Other actions, such as Workorder, Dublist, and Timed Text Flip also process attach-
ments for specific file types. 

• Workorder and Dublist are traffic management actions and are explained in the 
TrafficManager Guide.

• The Timed Text Flip action, which is used to add captions from an SCC or STL file to 
a media file, is covered in an application note on our web site.

The following simple example shows how to associate an XML file to a media file so the 
two can be processed together during and after transcoding.
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File Associate Workflow Description
Follow these steps to associate an XML file with a media file:

1. Launch Workflow Designer.

2. Create the workflow shown below, using Watch, Associate, Flip, and Copy actions. 
Name it File Associate.

1. Click the inspector button  on the Watch action and configure it to monitor a 
folder for incoming media files. If you need help, see Tour 1, Configuring the Watch 
Action. 

2. If you expect to receive media files and attachments in the same folder, you will 
need to set up the File Match Pattern in the Inspector for the types of media files 
you expect. This enables Vantage to recognize the difference between media files 
and attachments. See the figure below or hover the cursor over the Accept field for 
instructions. The File Match Pattern is set to accept only files with names matching 
the pattern *.[EXTENSION] where * is a wildcard representing any file name.

3. Click the inspector button  on the Associate action (or just double-click on the 
action itself ) to open the Inspector. The Inspector opens in read only mode.

On the first panel, note that Attachments is selected. (You can select other media 
files, but you cannot transcode them when ingested by an Associate action.)
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4. Click Next two more times to view the second and third Inspector panels. 

As in the Watch Inspector, these panels allow you to select the file system (select 
Windows) and specify the folder to watch for attachment files. Note that this can be 
the same folder being watched for media files or a different folder.

5. Click Next to view the fourth Inspector panel (below).

In this panel the incoming attachment file is assigned the nickname XML. Notice 
also that the File Match Pattern is set to accept only files with names matching the 
pattern [NAME]*.xml. 

Additionally, the Match file name is set to Original—the nickname of the matching 
media file ingested by the Watch action that started the job. These settings ensure 
that only XML attachment files with a root name that matches the media file name 
will be accepted. 

6. Click Next and Cancel to close the Associate Inspector.
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7. Click the Flip action inspector  to open it. 

On the open Inspector panel, set the Encoder for the type of media file, nickname 
the Input media file Original, and nickname the output media file Output. The spec-
ified output location is VantageOut--the store you created in previous tours. 

Click on each of the selections in the middle area to see the many transcoding and 
filtering options available, and also notice the additional parameters at the bottom 
of the panel that change with each selection in the middle area. 

Click Save to save your changes and close the Inspector.
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8. Click the Copy action Inspector to open it.

In the Select the nickname of the file to copy menu, select XML.

In the Select the nickname for the copy menu, enter XMLOutput.

In the Select the destination menu, select Vantage Store/Folder: VantageOut.

Click Save to save your changes and close the Inspector.

This action will copy the XMLOutput file into the same VantageOut store location as the 
transcoded media file.



Vantage Workflow Designer Tours
Tour 6: Processing Attachments in Workflows

126
Running the Attachment Workflow
Now it’s time to test the workflow:

1. Locate or create a media file and a matching XML file. For testing, you can create a 
text file with the same name as the media file and change the file extension to xml. 
Ensure that the files are named identically except for the extension. 

2. Activate the workflow, and drop the media file and matching XML file into the 
Watch folder, or if they are already in the folder, use Submit Job in the Workflow 
Design window to start a job by selecting the media file.

3. Click on the Job Status tab and select the job to watch it execute (below). 
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4. Double click the job in the Job Status table to open the binder. 

The concept of a binder is used to identify and group together all the files belong-
ing to a particular job. Notice that the binder Media Files tab lists the Original and 
Output media files, both of which were used in this particular job. 

You can select the output file and play it in the binder’s preview player by clicking 
the green play button. 

Since a binder is a temporary collection of the files used in a job, when you delete 
the job, the binder is deleted also. (Binders are saved by using a Register action to 
register the binder into a Vantage catalog, as explained in a later tour.) 

5. Click the binder Attachments tab and notice that the XML and XMLOutput files are 
listed.

6. Right-click the XMLOutput file in the binder, and select Open Containing Folder to 
see the Output media file and its matching XML file in the VantageOut folder. 

The Flip action placed the Output media file in the VantageOut folder, and the Copy 
action copied the XMLOutput file there also.

7. Deactivate the workflow when you’re finished.
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Conclusion
In this tour, you learned about the following:

• Using a Watch action to discover a media file.

• Using an Associate action to discover an attachment file associated with the media 
files found by the Watch action.

• Using a Flip action to transcode the media file and place it in an output folder.

• Using a Copy action to copy the matching attachment file to the same output 
folder as the matching media file.

Using these principles, you can associate any file with a media file having a matching 
name, and keep the two of them together throughout the workflow, including using a 
Copy action to send the attachment to the same output folder or destination as the 
transcoded media file. Note that you can also use other Transport actions, such as Move 
and Deploy to place files in other desired locations.
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Tour 7a: Using Catalogs and Binders in Ingest 
Workflows

In the last tour, we touched on catalogs and binders. You saw that when you view a 
completed workflow in the Job Status panel, you can double-click the job listed in the 
table to see the binder and the files that it includes. 

This tour introduces you to the concept of catalogs as an organizing principle for 
binders in Vantage. As you take the tour, you will create a catalog and a workflow to 
ingest media, create thumbnail and proxy files from the Original, and register all three 
in the catalog. These items—catalog, binder, original, thumbnail, and proxy are all 
needed in order to manually manage video projects using the Vantage Workflow 
Portal. Using the Portal, operators can make changes to the video and audio and then 
manually submit the media to another downstream workflow for transcoding and 
deployment.

The workflows and configuration files for both tours are available for download from 
the Telestream web site. Search the web site and download the General Workflows zip 
file. Extract the workflows from the file and import the workflows listed below:

• Tour 7a: Using Catalogs and Binders in Ingest Workflows covers creating catalogs 
and the ingest workflow to create an original, thumbnail, and proxy. Use the work-
flow named Ingest to Catalog.xml, or you can create the workflow following the 
steps provided.

• Tour 7b: The Workflow Portal and Trim Workflow describes a downstream workflow 
for transcoding and deploying files submitted to it from the Workflow Portal, which 
is the operator’s tool for video monitoring and management. Use the workflow 
named Trim from Catalog.xml and the Workflow Portal configuration file named 
Trimming Workflow Portal Configuration.xml or you can create the workflow and 
portal configuration using the steps provided.

To import workflows using the Workflow Designer, select File > Import Workflows... and 
select the workflow XML file. The workflow will appear in the left panel Workflows list.

To import a Workflow Portal configuration, open the Vantage Management Console, 
select Application Configurations > Workflow Portal, and use the blue Import down-
arrow button above the Configuration window to import the XML configuration file.
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Overview
A binder is a collection of file and metadata information, created for each job that 
Vantage executes. Each binder contains media and attachment file references and 
metadata labels that were ingested or created during the job. Binders allow files to be 
preserved (for access and further processing within Vantage) after the job completes.

Binders are not file folders—and are not part of the Windows file system—they are 
records in the Vantage database. Thus, binders do not contain media or attachment 
files; they only identify the paths to these files.

Catalogs help you organize binders. Catalogs are created in the Management Console. 
You can create binder expiration policies to help manage media, and catalogs can 
optionally be transient—that is, they can be automatically deleted when all of the 
binders have been removed and the catalog is empty. 

You use the Register action in a workflow to add binders to a catalog, and you use the 
Exist action to determine if a specific binder has already been added to a catalog. 
Binder names usually match the name of the file that started the job. Binders that are 
not explicitly registered are accessible to users only in Workflow Designer, in the Job 
Status workspaces, and if the job is deleted, the binder is deleted also.

Binders that have been registered are accessible by operators using Workflow Portal. 
Binders remain in a catalog until deleted manually or by expiration policies you set up.

Note: For management purposes, you can also view binders in the Vantage 
Management Console, and manually create them there—or delete them, but the 
Management Console is not designed to manage binders for production purposes.
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Ingesting Media
For the purpose of this tour, let’s examine a typical application of Vantage--to ingest 
media clips and register them into a catalog so that they can be processed 
downstream. Once media is prepared in this way, the catalog and binder can be passed 
on to operators who are responsible for examining the clips and preparing them for 
editing or broadcast. 

To ingest and register clips into Vantage catalogs, we’ll create the following 
components:

Trim Catalog—this catalog is intended to store binders created by a file ingest 
workflow. Catalogs are created using the Management Console.

Trimming Label—this label creates placeholders for information about the video that is 
filled in when the media is ingested and which can then be modified by operators 
using the Workflow Portal

Ingest to Catalog Workflow—ingests files and registers them in the Default Catalog.
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Creating a Catalog and Label
Catalogs are created using the Vantage Management Console. 

1. Launch the Vantage Management Console from the desktop icon.

2. Click Catalogs near the top of the list in the left panel.

3. Click the New Catalog icon to create a new catalog.

4. Type over the existing name to change it from New Catalog to Trim Catalog.

This completes catalog creation. 

Next, to make a Metadata Label, keep the Vantage Management Console open:

1. Select Workflow Design Items > Metadata Labels in the left column.

2. Select Create a new Metadata Label in the right Metadata Labels panel.

3. Name the label Trimming Label, and save it (blue floppy disk icon). Labels hold 
metadata that can be modified in the Workflow Portal and submitted to a workflow.
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4. In the Design section of the Trimming Label, use the New Parameter button to add 
these new parameters to the label and set the Value Type of each to Timecode: 

• Trim Group X IN

• Trim Group X OUT

• Trim Group X DURATION

You can also add a description to each parameter, if you like, such as “Enter Start/
End/Duration timecode here”.

This completes catalog and label creation. Later, in the workflow for this tour, you will 
register binders and metadata labels into the catalog using an ingest workflow.

The Ingest Workflow
In this typical ingest workflow, the Watch action monitors a hot folder for incoming 
clips. Set up the Watch action as described in previous tours to monitor a folder, 
discover the type of media file you want to detect, and nickname it Original.
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Thumbnail Flip
The center Flip action creates a JPEG thumbnail media file by capturing a single video 
frame from the Original video source:

• Encoder: Keyframes

• Input nickname: Original

• Output nickname: Vantage Thumbnail

• Select an Output Location
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Proxy Flip
The top Flip action creates a proxy for previewing and editing:

• Encoder: QuickTime Encoder

• Input nickname: Original

• Output nickname: Vantage Proxy

• Select an Output Location

This produces a 720 x 480, 29.97 H.264/AAC QuickTime movie encoded using the 
QuickTime encoder, with the required nickname of Vantage Proxy to allow playing in 
the preview player and the Workflow Portal.
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Populate Action Creates Label with Timecode
The Populate action creates a Trimming Label, with begin and end timecodes for 
multiple segments of video.

• Select Label from Variable

• Select Trimming Label

Be sure to check the segments that you will use for your trimming label after the 
Trimming Label is selected.
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Register Binders into Catalogs
The Register action registers the binders produced by this workflow into the Trim 
Catalog, so that the assets can be accessed and processed by an operator, using the 
Workflow Portal. The Register action ensures that the binder created by the job will 
exist after the job expires.
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Running the Catalog Workflow
Now we’re ready to run the workflow:

1. Locate or create a media file for testing. If you are using the sample workflows from 
the Telestream.net web site, use the Demo.mp4 file supplied with the workflows.

2. Activate the workflow, and drop the media file into the Watch folder, or if it is 
already in the folder, use Submit Job in the Workflow Design window to start a job.

3. Click on the Job Status tab and select the job to watch it execute (below). 

4. Double-click the job in the Job Status table to open the binder. In the binder Media 
Files panel, you should see an Original, a thumbnail, and a proxy. In the Metadata 
Labels panel, you should see the Trimming Label with parameters for multiple 
segments of video. This shows that the binder was created.

5. Open the Vantage Management Console, click on Catalogs, and click on the Trim 
Catalog. In the Media Files panel, you should see the same binder as in the previous 
step with the Original, Vantage Thumbnail, and Vantage Proxy, and you should see 
the same Trimming Label in the Metadata Labels panel. This shows that the binder 
was added to the catalog.

Conclusion
In this tour, you’ve created a catalog, a metadata label, and an ingest workflow. The 
workflow checks the video, makes a thumbnail and proxy, and registers the binder 
containing the original, thumbnail, and proxy into the catalog. These are the elements 
that need to be present in a typical ingest workflow that produces files to be monitored 
and managed using the Workflow Portal.

Next, this tour continues with the second half of the process—another workflow 
processes the video by trimming segments to the desired lengths. The operator sets 
the segment lengths by playing and adjusting the timecode in each segment in the 
Workflow Portal and then submits the marked video to a production workflow, which 
actually trims the segments to the desired lengths. See Tour 7b: The Workflow Portal 
and Trim Workflow.
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Tour 7b: The Workflow Portal and Trim Workflow
In the second half of Tour 7, you will submit the catalog, binder, and label created in the 
Ingest to Catalog workflow to a Trim from Catalog production workflow. The resulting 
output will be a trimmed media file. You can import both workflows and even a media 
sample from the General Workflows samples provided on the Telestream web site. 

To submit to the production workflow, you will use the Vantage Workflow Portal 
application. The Portal is an operator’s application allowing manual monitoring and 
adjustment of ingested video and manual submission to downstream workflows.

The Production Workflow
In the Trim from Catalog example production workflow, the Watch action is replaced by 
a Receive action, because this workflow only executes when media is submitted to it by 
an operator using the Workflow Portal. A Receive action is required when submitting 
media to a workflow from another application, such as the Workflow Portal.

Figure 1. Trim from Catalog Production Workflow

The Populate action converts the Trimming Label into variables for use in the workflow. 
Variables are covered in a later tour. 

Next, a Flip action executes the trim process on the Original media. The action uses the 
Media Trim movie filter and the begin and end timecode variables to trim the clip, and 
convert it into an MPEG-2 program stream. An operator enters timecode for the trim 
points using the Workflow Portal before submitting the media to the workflow.
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The Workflow Portal Configuration
Now that we understand the functionality of the production workflow, let’s briefly 
review the Workflow Portal configuration required to take the output of the first 
workflow and submit it to the second workflow. 

You can import this configuration (Trimming Workflow Portal Configuration.xml) from 
the General Workflows samples available by searching the Telestream web site, or you 
can create the workflow and portal configuration using the steps provided. To import 
the configuration using the Vantage Management Console, select Application 
Configurations > Workflow Portal > blue Import down-arrow button.

Workflow Portal Overview and Configuration
The Workflow Portal is a client program that can be customized to enable operators to 
manually modify media, metadata, and variables and submit them to workflows.

Customization is implemented in the Vantage Management Console, where Vantage 
administrators select user interface features and save them as a Workflow Portal 
configuration. Multiple configurations can be created for different operator tasks.

When operators launch the Workflow Portal, they select the configuration appropriate 
to the task at hand, and Workflow Portal dynamically implements the user interface 
specified in the configuration file, and provides access to the specified workflows, 
categories, and functions—specifications which are all part of the configuration.
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In this configuration, the mode is set to Browse Catalogs (Copy Binder). In this mode, 
when you submit a catalog and binder to the production workflow, the binder is 
duplicated when submitted—leaving the original binder intact in its original catalog. 

If you set the mode to Forward Binder instead of Copy Binder, the original binder from 
the original catalog is forwarded to the production workflow when a job is submitted, 
which may alter the files in the binder. 

If you don’t know which mode to use, Copy Binder is the safest choice, since it preserves 
your original catalog and binder. If you need to delete the binder later to prevent 
unneeded files from accumulating, you can do so manually or automatically by setting 
an expiration date for the binder.

Specifying the Catalog to Use
At the bottom of the configuration panel, note that (in the Browsable Catalogs tab) the 
catalog selected is the Trim Catalog. The catalog you specify here must be the same as 
the catalog where media is being registered by the Ingest to Catalog workflow.

Specifying the Label to Use
As shown below in the Labels tab, select the Trimming Label and use the center 
buttons to move it to the right panel to specify the label to use in the portal. The 
Trimming Label is already in the Visible to user column if you imported the sample 
workflow and configuration.

Specifying the Variables to Use
No variables are required because the workflows were designed to store the job values 
in a label. As an alternative, you could create variables and have the operator work 
directly with them if you wanted to. Variables are covered in a later tutorial.
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Specifying the Workflow to Use
As shown below in the Workflows tab, the operator can submit workflows to the Trim 
from Catalog production workflow, and it is required (checked).

This workflow must be activated in Workflow Designer in order to receive jobs after the 
operator has submitted them.

Specifying the Binder Details to Display
As shown below in the Binder Details View tab, the operator can view certain 
information and Workflow Portal controls.

All of the binder columns are displayed for the operator, plus the video Play button—so 
that the operator can scrub the video for in and out points and the keyframe timecode. 
The Submit button enables the operator to submit the media to the Trim from Catalog 
production workflow after updating all of the metadata.

Be sure to save the Workflow Portal configuration (blue floppy disk icon) when you are 
finished configuring it.
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When you are finished configuring and you have run the ingest workflow to create and 
register the binder, you are ready to use the Workflow Portal. 

Follow this procedure to access and operate the Workflow Portal:

1. Double-click the Workflow Portal desktop icon to start the application.

2. When you open the portal for the first time, it asks you to load the Configuration file 
you created previously, or select File > Change Reload Application Configuration. 

3. Click on the Trim Catalog in the upper left quadrant of the Workflow Portal, and 
click on the clip you intend to modify in the Trim Catalog clip list. 

The Workflow Portal should look like this. 

4. Click Submit at the bottom to open the Trimming Label parameters for editing.

5. Select and play the proxy video in the lower left quadrant to identify the trim points 
you want to use. 

6. Manually enter the timecode values for each segment in the Trimming Label, or use 
the Mark buttons. To manually enter timecodes, click on the start and end 
timecodes and type the timecode values.

7. Click Submit and select the Trim from Catalog workflow. This will send the binder 
and trim label to the workflow for processing to trim the actual media.
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Conclusion
In this tour, you learned that catalogs are used to register binders—media versions and 
related file and metadata, for processing in operator-intervention media processing 
systems. An ingest workflow containing a Register action affiliates the media and 
metadata with the binder. 

You also gained your first exposure to the Workflow Portal, which is an easy-to-use 
operator interface for intervening between workflows to perform manual checks and 
modifications to media and metadata.

Finally, you created a simple production workflow to create a trimmed output media 
file that is transcoded from one input format to a different output format by the Flip 
action. 
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Tour 8: Controlling Workflow Execution with 
Variables

This 30 minute tour introduces you to variables in workflows. Variables are used for 
passing important job information between actions, controlling execution flow, 
changing action priority, and controlling job routing.

Overview
In Vantage, a variable is a named unit of data (for example, an integer named Video 
Width) that only lasts as long as the job is executing. Variables can be used to pass data 
between actions. For example, an Analysis action might publish a variable named 
Video Width containing the width of the frame in a particular media file, and a Decide 
action might make a decision based upon the value of Video Width.

You can create and define variables in the Vantage Management Console, or you can 
define them directly in Workflow Designer, as you are configuring an action.

A variable can be supplied a default value, and the value of the variable may also 
change during the course of workflow execution. You can also use the current value of 
a variable without changing it—for example, determining if a numeric value (in the 
variable Video Width) is 720.

Each variable has three key characteristics that you define when you create it:

• Name (such as Number of Audio Channels)

• Type (such as Integer Number)

• Default value (such as 50)

Variable values can be changed in actions that are designed to use variables, such as 
the Analysis, Populate, Watch and Associate actions. 

Variables are passed from action to action through action connections. When an action 
creates (or sets) a variable, all downstream actions that use variables can access the 
variable’s current value. 

If an action creates a variable but doesn’t explicitly set its value, the variable’s default 
value (which is set in the Management Console) is used. For example, in the Complex 
Transcode workflow, you could set the Priority variable to 100 (higher priority) in one of 
the Flip actions; the other could use the default value of 0 (lower priority).

Finally, variables are temporary; the information only lasts as long as the job is 
executing—and is known only in the context of the running job. 

Variables can be used in several ways:

• To dynamically control settings or change configurations in actions

• For routing tasks for execution on specialized platforms

• For decision-making to determine which branch of actions execute

• To determine the priority of a particular action.
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Setting a variable in an action on one branch of a workflow does not affect the value of 
a variable with the same name on the other—because these are actually two different 
copies of the variable, in different branches.

Important Note: If workflow branches merge, variables with the same name collide in 
the first merged action. The value from the branch which completes last is updated 
last—and it is the value that is passed on. Because the branch which finishes last 
cannot be known when you create the workflow, Telestream recommends that merged 
branches have actions which explicitly reset colliding variables, before using them 
again downstream. If you need both variable values past the merge, you should start 
with two different variables; one on each branch.

Starting the Vantage Management Console
The Vantage Management Console is the program you use to configure and administer 
your Vantage domain—including Vantage services, licenses, and workflow design 
items, including variables. Vantage user accounts are also created in the console.

1. Double-click the Vantage Management Console shortcut to launch it.

2. Select a domain and log in using a Vantage user with administrative privileges 
(default: Administrator, no password), unless User Administration is disabled. 

Creating Variables
1. Select Workflow Design Items > Variables to display the Variables panel.

The Variables panel displays a list of variables, which includes default variables plus 
those created by Vantage users in this domain. You can use the default variables in 
workflows as-is, and you can create your own.

2. Select the Curtained variable to display its details (which you can configure) at the 
bottom of the panel. (When focus is on the table, you can use keyboard keys to 

New Variable button in the toolbar
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locate a given variable by name—for example, press R to go to the first variable in 
the list that starts with R.)

Rather than using a default variable, let’s create a new Date variable called File Mod-
ification Date.

3. To start, click the New Variable button in the toolbar (far left button).

4. Vantage displays the Create New Variable dialog. Select the type of variable you 
want to create—Date.

5. In the details panel, enter the name File Modification Date, and leave the 
default value unchanged.

6. Click the Save button  to save your variable.

Note: There is nothing special about the name File Modification Date—you can create 
variables with any name that is not already in use. In this workflow, we will use this 
specific variable to store the modification date of the file, so we’ll name it descriptively.

Using System Variables
Vantage provides system variables as a domain-wide resource. These variables cannot 
be renamed, and they should not be deleted. 

The Priority variable is a system variable. The value of the Priority variable sets the 
priority of any actions that receive it to determine task balancing. Priority is a number, 
where larger numbers mean higher priority (for example, priority 10 is a higher priority 
than 1) over other actions competing for the same resource. You can set the Priority 
variable value in any action in the workflow—for example, Watch—to control priority 
of execution of all downstream actions in that workflow.

The Lightspeed, K20 and K80 system variables are assigned automatically to Lightspeed-
aware services, when they start up on any Telestream Lightspeed server. Their value is 
set to True. When a job runs, an action in that job can query these variables and use 
them for run-on rules or for reporting purposes.
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The VantageMachineName system variable is automatically added to each Vantage 
service as it starts up on a server; it’s value is set to the name of the host upon which the 
service is running.

Setting Variable Values in a Workflow
The power of variables is that their value can change dynamically during execution of a 
workflow. There are several ways that a value changes:

• As the result of an action executing. For example, analysis (and many other) actions 
can publish their results as variables—such as determining the number of pixels 
that compose a letterbox. Similarly, Watch and Associate actions can publish infor-
mation about files that they detect, using variables.

• From external metadata. Specifically, the Populate action can set variables based 
upon metadata label values found in external files.

• From a Compute action, which can create variables from other variables. For exam-
ple, Compute can add two number variables to create a new variable.

• As a pre-step to an action executing; any action can set the value of any variable 
prior to execution.

• As a pre-step to a server executing an action; any service on any server can be con-
figured to set a variable before executing an action.

Let’s experiment with two of these. First, let’s modify one Flip action in the Complex 
Transcode workflow, so that Vantage processes it with a higher priority than the other.

1. Open Workflow Designer, and duplicate the Complex Transcode Delete workflow 
from Tour 5 as Complex Transcode Tour 8.
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2. Right-click the QuickTime Flip action and select Add Variables from the context 
menu to display the Add Variables dialog.

3. Click the Add Variable(s) button in the toolbar to display the Select Variables dialog.

4. Scroll through the list (or press the first letter of the variable—in this case P) and 
select the Priority variable—click OK to add it to this action.

Now, the Priority variable is attached to the workflow and its default value is 0. You 
can change the value of the variable at the bottom of the panel—higher numbers 
indicate higher priority, lower numbers indicate lower priority. 
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5. Enter a large number (for example, 100) and click OK to make this variable setting 
permanent.

Next, let’s configure the Watch action to set the value of the File Modification Date 
variable that you created earlier, each time it picks up a file and submits a job.

6. Open the Watch action Inspector and click Next three times to display the 
Configure Settings panel.

7. Under Generate Variables, check the File Modified Date checkbox.

8. Use the menu to the right to select File Modification Date, the variable that you 
created in the Management Console earlier in the tour. You could also add the new 
variable right here in the dialog.

9. Click Next, then click Finish.

Now, your Watch action will assign the file modified date value of each file that it 
submits for processing to the File Modification Date variable. You’ll see how we can use 
this variable in the next tour.

Conclusion
In this tour, you learned about managing and creating variables, as well as how to set 
variable values in a workflow. In the next two tours, you’ll learn about how to use 
variables for decision-making, and how to use them to pass information between 
actions in a workflow.
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Tour 9: Decision Making in Workflows
This hands-on tour takes about 20 minutes and introduces you to decision-making 
using variables to control the logical flow of media through a workflow.

Action States
As actions execute, they are passed the job’s action state from the previous action. If 
the action executes, they also set the action state before passing it on. Monitor actions 
represent an exception—as an origin action, they do not inherit an action state. Actions 
set one of three action states: Success, Ignore, or Fail. Some actions (Decide, Examine, 
Compare, and Identify, for example), allow you to configure a state. However, most 
actions’ state is set automatically—by the service that executes it.

The action state is automatically passed from one action to the next so that each action 
may determine whether or not to execute, based upon the incoming state. This pattern 
repeats throughout the execution of the entire workflow.

Action states also enable decision-making—causing actions (or entire branches of the 
workflow) to not execute.

To understand how to implement and utilize action states for decision-making and 
logic, it’s important to understand their precedence, whether an action receives states 
from one or multiple incoming actions (a merge of multiple branches):

• If at least one incoming action state is Fail, regardless of other incoming states, the 
action inherits Fail and must pass it on whether the action executes or not—Fail has 
precedence over all action states. Most actions will not execute if they inherit Fail. If 
one action fails, the entire job fails.

• If there is no Fail state, but at least one Success state, then the action inherits Suc-
cess—which has precedence over Ignore. Usually, actions execute when they 
inherit Success. After execution, the action may emit Success, Fail, or Ignore.

• If all incoming states are Ignore, the action inherits Ignore. Ignore has lowest prece-
dence of the three states. An action may or may not execute when inheriting an 
Ignore, based on its state execution setting. If an action receives an Ignore state and 
does not explicitly fail, then it emits a Success state. Otherwise, it emits a Fail state 
unless it is an action which can emit Ignore, and you have configured it to do so.

Generally speaking, actions only execute if (1) none of their predecessors set the Fail 
state, and (2) at least one of the predecessors set the Success or Ignore state.

Similarly, if an action sets Ignore, the next action is unlikely to execute. Most actions, 
excluding Watch and Receive (since they are origin actions), can be configured to 
perform on certain states—to send an email for example, if they detect a failure.

Note: Actions can be configured to execute upon Fail or Ignore—for example, to 
send an email notification. To configure an action’s execution based on the incoming 
action state, right-click and select Perform On. You can also set an action to execute 
regardless of the state: Right-click and select Perform On > Any.
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The Decide Action
The Decide action inspects selected incoming variables and sets the action state based 
upon the result of the value. Decide effectively acts as a gatekeeper to control 
branching by setting a Success, Ignore, or Fail state, which is passed on to the next 
actions, which can be set to conditionally execute, based on the incoming action state.

Because variable values are often specified at run-time, Decide enables you to perform 
an analysis and set its state at run-time as well—and thus, the workflows may behave 
differently for every job processed by the workflow. Decide is a powerful action 
allowing you to build data-driven processing into a workflow.

Note that if you want to have multiple branches in a workflow, and only execute 
specific branches for each job, then you’ll need multiple decides—one acting as a 
gatekeeper for each branch in the workflow.

Processing New Files
Let’s look at an example (start Workflow Designer if it isn’t already open).

1. Open the Complex Transcode Tour 8 workflow and duplicate it as Complex Transcode 
Tour 9. We’ll update this workflow to process only new files that are in the hot 
folder. 

Recall that in Tour 8 the Watch action was configured to publish a variable named 
File Modification Date. We’ll use this variable to process only those files created or 
modified after January 1st, 2010. 

2. Open the Watch action in the Complex Transcode Tour 9 workflow and set File 
Modified Date to publish the File Modification Date variable.

3. In the actions toolbar, open the Common category and drag a Decide action onto 
the workflow so that the Decide action follows Watch, and all remaining actions 
follow the Decide action, as shown in the following figure.

4. Open the Decide action Inspector. 

5. The Decide action is designed to perform evaluations upon variables, and set a 
state if they meet all the conditions that you specify. 

6. In the top left, click Select Variables and add the File Modification Date variable.
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7. Select the > (Greater) operator and set the test value to January 1, 2016, 12:00:00 
AM. 

8. Verify that the state selection is Success—meaning that if the date is later than 
January 1st, this action will emit a Success—and that the Otherwise state is Ignore. 

9. Click Finish to close the Inspector and update the workflow.

Now—because actions by default operate only when the incoming action state is 
Success, your workflow will process files created after January 1st, but will not process 
files created on or before this date. 

Filtering Old Files
But what if you wanted to simply delete old files?

Let’s modify the workflow to delete old files. To do that, you’ll create a new branch off of 
Watch, with a Decide action and Delete action, as shown in this figure.

1. Add the Decide action, connected to the Watch on a separate branch. 

2. Now, open the Decide action Inspector, and configure similarly to the previous 
one—add the File Modification Date variable, select the reverse operator <= (Less 
Than or Equal), and set the date to January 1, 2016 12:00 AM. If this is true, Success is 
set; if false, Ignore is set. 

3. Click Finish to close the Inspector.

4. After the Decide action, add a Delete action and configure it to delete the Original 
file. It executes by default only on Success states.

This workflow now has two branches, each controlled by a Decide action—one will 
process only new files, the other will process only old files. Because of the way we 
configured the Decide actions, each file submitted will only be processed in one branch 
in this workflow.
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Conclusion
In this tour, you’ve learned how to assign values to variables, to test those values, set 
action states, and use the Decide action to make run-time decisions—all features 
designed to enable you to add control to your workflows, based on information you’ve 
gleaned from your input file.
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Tour 10: Analyzing and Modifying Media Files
This hands-on tour takes about 15 minutes and introduces you to the concept of 
dynamic parameters in Vantage, and how they can be used to pass information 
between actions in a workflow.

Note: To execute workflows you create in this tour, you’ll need a license—certain 
features (the Examine action, for example) will not execute without one. For a trial 
license, contact sales@telestream.net.

Thus far, when we have configured our actions in a workflow, parameters have been set 
at a fixed value. For example, the frame size of a transcode output is 320x240. 
Obviously, by using fixed values the action performs the task the same way each 
time—creating an output file that is 320x240—every time this action executes.

How would workflow processing improve, if we could change these settings and 
parameters job-by-job, on the basis of the media being processed?

Vantage supports this capability to dynamically change the value of parameters and 
settings by binding parameters to variables. Recall that variables are metadata that is 
only known at run-time, and this metadata may be different for every single file. In 
Vantage workflows, you can configure almost any parameter, in almost any action, to 
use a variable (and its current value) as its input.

Automatically Detecting and Cropping Curtains
Let's build a real-world example. In this example, we know that some of our content has 
black on the left and right—curtains—that we want to crop. However, the amount of 
black is likely to be slightly different for every file being processed in Vantage. Instead 
of creating many workflows to deal with each situation—and manually measuring the 
black before processing, we'll build a workflow to crop the curtains automatically, as 
appropriate for each incoming media file, by combining an Examine action with a 
transcode with filters implemented.

1. Open the Complex Transcode workflow from Tour 4 again, and duplicate it as 
Complex Transcode Tour 10. 

2. Open the Analysis group and add an Examine action—connect it between the 
Watch action and the QuickTime H.264/AAC Flip action. (You can place the action 
directly on the connector line and it will automatically connect to both, replacing 
the line.)

3. Open the Examine action Inspector.

4. Click the Analyzer menu and select Curtain Detection. Workflow Designer displays 
the configuration setting for this analysis tool.

5. Open Generate Variables and configure this action to publish two variables (by 
checking them): Suggested Crop Left (select the Curtained Left Pixels variable) and 
Suggested Crop Right (select Curtained Right Pixels). 

mailto:sales@telestream.net
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Note: Vantage provides many predefined variables for use in your actions. While this 
is convenient, you’re certainly free to create your own variables and you may often 
need to in order to support your specific applications.

6. Under Input Media File Nickname, select Original as the file to analyze. 

7. Click Save to update the action and close the Inspector.

8. Open the Inspector of the Flip action immediately after Examine.

9. Click on the Video Stream button, then click the triangle in the Video Filter button 
(2nd from the right) to display the video filters you can use. Add a Resizing video 
filter to the transcode. 

10. Select the Resizing filter to display its parameters at the bottom of the window.

11. Expand Cropping and Padding, and select Manual from the drop-down menu.

12. Click the green variable buttons beside Crop Left and Crop Right, and bind those 
values to the Curtained Left Pixels and Curtained Right Pixels variables, respectively.

13. Click Save when you’re done. 

14. Choose a media file that contains curtained material, submit a job for processing, 
and view the results.

You should see a dynamic transcode that automatically adjusts Resizing settings based 
upon incoming curtain data from the curtain detection Examine action. The resulting 
media file has full-screen video with the curtains removed from the sides. Because 
variables are used instead of fixed curtain definitions, transcoding automatically adapts 
to the curtain width of each media file, cropping the output to full screen regardless of 
variations in curtain width!

Take a moment to explore the rest of the transcode settings in this Inspector, and 
notice the bind buttons on many parameters. You’ll find the bind button in other 
actions as well, allowing you to define many values with variables that detect actual 
values in the media files rather than using fixed values.

Conclusion
In this tour, you learned how to create dynamic parameters that use variables as their 
inputs. This feature enables you to create powerful, dynamic workflows that adaptively 
change what they do based on the metrics of the media being processed.
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Tour 11: Understanding and Using Open Workflows
With Vantage 7.0 Telestream introduced the Open Workflows licensed option, a new 
way to gain much greater processing efficiency and speed from Vantage workflows. 
Using Open Workflows your Vantage workflows can run many times faster on the same 
hardware because of concurrent processing. 

How does it work? With Open Workflows, open-enabled actions in a workflow can run 
in parallel, unlike the serial operation of traditional Vantage closed workflows. 

Looking at the figures below, you see a closed workflow running serially in the upper 
view. The Flip action is running while the second Copy action waits for the Flip action to 
finish. In the lower view, the open Copy and Flip actions run concurrently. The 
differences in processing and other details about closed versus open workflows are 
explained in detail in the next topic.

Closed Workflow

• Existing Vantage behavior     • Actions execute sequentially

• Throughput is constrained    • Run time is cumulative

Open Workflow

• Optional open capability   • Actions may run concurrently

• Throughput is dynamic      • Run time is greatly reduced



Vantage Workflow Designer Tours
Tour 11: Understanding and Using Open Workflows

158
Closed and Open Workflow Processing
Prior to Vantage 7.0, action processing was closed, which means that each action 
cannot begin processing until the previous action has completed. A closed workflow 
enables you to systematically control the processing flow, especially when you want to 
use Service Limits and to have explicit control over Vantage nodes. 

The workflow shown below illustrates closed workflow operation: 

• The blue actions have completed.

• The Flip action has begun working.

• The subsequent Copy action is waiting for the Flip Action to complete. 

The inherent latency of this job is expressed as follows:

the time of the first Copy + the time of the Flip + the time of the second copy

If the first Copy (labeled Localize) pulls from a remote file system with poor throughput 
and this action takes 10 minutes to complete, the Flip action cannot begin processing 
for 10 minutes. If the Flip action transcodes the file in 3 minutes and the final Copy 
takes 5 minutes, the total job time is 10 + 3 + 5 or 18 minutes. 

Latency refers to the serial nature of how one action must wait until the preceding 
action completes. This process incrementally increases the overall job time at each step. 
The cumulative nature of this sequential processing is illustrated below:
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The Open Workflow Difference
In contrast to closed workflows, Open Workflows permit most actions to operate 
concurrently. That is, the current action can be performed while the previous and 
subsequent actions are also being executed. This removes the inherent latency 
associated with the discrete steps of a traditional closed workflow.

Refer to the following workflow in which Open Workflows is enabled. You can see that 
the Copy, Flip and the final Copy are all working at the same time as shown by their 
green Job Status. Once the media blocks have been written to disk in the first Copy, the 
Flip action is able to read these media blocks and begin the transcoding process. When 
the Flip action finishes processing and writes the resultant transcoded media blocks to 
disk, the final Copy action moves them to the appropriate destination.

Using the numbers from the closed workflow example, the first Copy action will still 
take 10 minutes. However, since the Flip action and the final Copy action can begin 
processing the incoming file almost immediately, the overall job will be completed in a 
time that is much closer to 10 minutes. The figure below illustrates the concurrent 
nature of this execution:
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Open Workflow Indicators
Open Workflows include certain visual characteristics so you can recognize open 
actions. As shown below, connectors are hollow, and the nicknames are italicized if an 
action is operating in open mode. Actions in closed mode look the same as they always 
have, with filled connectors and regular type.

Open Actions
Many actions can execute in Open mode—but not all. Additionally, in some instances, 
the inbound processing to the action may be open but the outbound is closed, and 
vice versa. The following table summarizes the actions supported by Open Workflows.

Hollow connectors 
for open mode

Oblique font for 
open mode

Service Actions
Open 
Inbound

Open 
Outbound Notes

Monitor Watch N/A Yes Windows, FTP, HTTP and Aspera; other file 
systems as the need arises. On Windows 
only, the file being submitted can be an 
open, growing file (one that is being 
written). On other file systems, the file 
must be complete and closed before it 
can be submitted.

Transport Copy Yes Yes Input and output may be TIFO, Transport 
Stream or Program Stream files; only valid 
when using the Windows File System.

Transcode Flip Yes Yes Input only for supported file formats 
(below)

Note: In order to localize a file from a file system other than Windows in open mode, the file must 
already be complete. For example, in the following workflow: Watch (FTP) > Copy (local Vantage 
store) > Flip, the Copy and Flip actions will run in open mode when the source file on the FTP server 
is a complete, closed TIFO file, since the Flip action only supports TIFO open inbound.

Multiscreen Multiscreen Flip Yes No Input only for supported file formats 
(below).

IPTV IPTV Flip Yes Yes Input only for supported file formats 
(below).
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Open File Formats
Only file formats that are able to be read while being written (aka “growing files”) can 
be supported by Open Workflows. This is fundamentally controlled by both the file 
wrapper and the codec selected for transcoding operations.

Note: In order for a transcoding action to ingest media an input in open manner, the 
decoder must be configured for a format that supports Open Workflows.

The following file formats are supported for both reading and writing in all open 
transcoding actions listed in the preceding table:

• All actions that are open capable support open TIFO for inbound, outbound, or 
both depending on the action

• Open Transport Stream is only supported for IPTV Flip and Flip actions outbound

• Open Program Stream is only supported for Flip actions outbound

• Flip actions only support PCM audio for inbound

Choosing an appropriate file wrapper greatly enhances the speed of execution for an 
Open Workflow. The Telestream Intermediary Format (TIFO) offers a good choice for file 
wrapping as it supports Open Workflows and all codecs. When you are capturing live 
content from a Telestream Pipeline HD Dual or the Lightspeed LiveCapture server, the 
media can be a TIFO wrapped file that can immediately be consumed by a Vantage 
Open Workflow for extremely fast live content deployment.

If you need additional speed, adding a Telestream Lightspeed Server will further 
increase processing speed and reduce the time to produce media assets.

Open Workflows are ideal for scenarios where media residing on external systems (S3 
buckets, FTP locations, and Aspera servers) is to be localized, processed, and delivered 
to external storage locations, Files processed on S3, FTP or Aspera systems are limited 
to complete, closed files in TIFO format.

Edit Tempo, Conform No Yes Input only for supported file formats 
(below).

Live Capture No Yes Outbound only.

Metadata All Actions (Populate 
and Transform)

Yes No Instantaneous, no media dependency; 
XML files are closed.

Common Compute, Construct, 
Decide

Yes Yes Instantaneous, no media dependency, 
actions will not run until input variables 
are all available.
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Open Workflows are also ideally suited for Vantage workflows in which one action is 
creating a mezzanine file for the purpose of a second action creating a specific 
rendition. For example, Post Producer might create a high resolution mezzanine file 
followed by employing the Cable IPTV Flip to produce a vendor specific Transport 
Stream.

Licensing Requirements
Licenses are required for Open Workflows. These licenses may be enabled for an entire 
domain, or for individual nodes within a Vantage array. If Open Workflow licenses are 
acquired for specific nodes, then Workflow jobs that need to take advantage of Open 
Workflow processing can be submitted to these specific nodes.

Creating Open Workflows
You create an Open Workflow using the Workflow Designer in the same way as a 
standard workflow. However, Open Workflows must be enabled in three places:

• Enable domain level in Vantage Management Console Settings & Options > General

• Enable workflow level in Workflow Designer, workflow drop-down

• Enable action in context menu (right click) Workflow Mode

These are the steps to create your first Open Workflow:

1. Open the Vantage Management Console, select Settings & Options, select the 
General tab, and check Enable Open Workflows.

2. Open the Workflow Designer and create a new workflow, such as this one.

Enable Open Workflows
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3. Select the workflow drop-down menu, and check Options: Open mode.

4. Right-click each action in your workflow, select Workflow Mode, and check Open.

That’s all there is to it. You can submit jobs and use the workflow as you normally 
would. Notice that the Job Status shows some of the open actions operating 
simultaneously.

Conclusion
In this tour, you learned about Open Workflows and how they differ from the closed 
workflows Vantage has previously employed. Now you can begin analyzing your 
existing workflows to see what kind of efficiency gains might result if you convert some 
of them to Open Workflows.

Enable Open Mode

Workflow Drop-down Menu
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Managing Workflows
Vantage Workflow Designer is the primary client program in Vantage: you use it to 
design and configure workflows to meet your media transcoding requirements. 
Workflow Designer combines a wide range of workflow design and media processing 
capabilities into a single program, enabling you to create workflows to solve a broad set 
of operational media processing problems.

Workflow Designer also allows you to activate and deactivate workflows, and allows 
you to submit media, and monitor the jobs that are created as workflows process the 
media you've submitted for processing.

Use this chapter to learn how to use Workflow Designer to create, construct, and 
configure workflows to perform specific media processing tasks in your organization.

Note: For basic information on starting/stopping Workflow Designer, and changing 
domains and user names and passwords, see Vantage Client Programs Overview.

Telestream recommends that you also take the Vantage Workflow Designer Tours to help 
you become familiar with creating and configuring a wide variety of workflows.

 Starting Workflow Designer

 Workflows Overview

 Using the Workflow Design Workspace

 Managing Workflows

 Constructing Workflows

 Configuring Actions

 Specifying Action Settings

 Implementing Processing Logic in Workflows

 Managing Vantage Folders

 Troubleshooting Workflow Designer

Note: Vantage Transcode (a licensed, workflow design web app) can also be used to 
create simple transcoding workflows.
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Starting Workflow Designer
To start Workflow Designer, do one of the following:

• Double-click its shortcut on your desktop

• Click Start > All Programs > Telestream > Vantage > Workflow Designer.

Next, select a domain and log in.

Note: For complete information on managing Windows clients, including starting 
and stopping the program, logging into and changing domains, changing Vantage 
users and passwords, and selecting configurations, go to Windows Vantage Client 
Program Management.
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Workflows Overview
A workflow in Vantage is a set of connected actions (each of which performs a specific 
task). Vantage provides over four dozen different actions, which you use as the building 
blocks of workflows. Workflows can be designed and configured to perform a 
controlled, automated media processing application. Workflow Designer organizes its 
actions by category (and incidentally, by the service which executes them), for ease of 
use. While most workflows center around the process of decoding and encoding video, 
you can also construct workflows that—while still media-centric—don’t flip media. 
Instead, they might process metadata files, or perform other tasks.

These topics provide information about workflows you’ll find helpful before starting 
the construction and configuration process.

 Workflow Basics

 Workflow Design & Configuration Overview

Workflow Basics
You construct and configure workflows in Workflow Designer using the Workflow 
Design workspace, by adding various types of actions (Watch action, Flip action, Copy 
action, etc.) and connecting them together to form a logical chain of successive tasks. 
Workflows are stored in the Vantage domain database, and actions in the workflow are 
executed by Vantage services.

A valid workflow must start with an origin action (for example, a Watch action or 
Workorder action—those actions in the Monitor category, plus the Receive action), and 
consist of at least two actions, which must be connected. Single actions that are not 
connected to another action do not execute—a single, disconnected action invalidates 
a workflow, which prevents it from being activated for use.

Note: The Capture action is an exception to the two-action rule. The Capture action 
can be the single action in a workflow. This action enables SDI live streaming capture 
on a Live Capture server.

Workflows may have more than one origin action, but each origin action will function 
independently of the others. Multiple origin actions permit different methods (or 
locations) in which to submit jobs to the same workflow.

Workflows are not required to end with a terminating action—an action without an 
output pin. The only formal terminating action is the Forward action. The Forward 
action permits you to pass control directly from one workflow to another workflow, 
which must have a corresponding Receive origin action. This enables you to create 
simpler, general purpose workflows, and chain them together to provide more 
automation.
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Workflows are executed by jobs, which are created whenever a new file is discovered by 
the workflow’s Watch (or other origin) action, or when you submit a job manually 
(Manually Submitting Files Directly in Workflow Designer).

Generally, you construct a workflow in stages: first, conceptualize and design the 
workflow and then add the actions, connecting them together to control execution. 
Finally, you configure each action in the workflow to perform exactly the way you want. 
Now, you can test your workflow, and fine tune it as necessary. 

Once you have constructed and configured a workflow, you click Activate so it can be 
utilized. To edit it again—or just disable it—you just deactivate it. Then, click Edit, and 
when you’re done, you click Release. When you are editing a workflow, others using 
Workflow Designer can view—but not edit—the workflow. These buttons are all 
displayed at the bottom of the main window.

To activate, deactivate, edit, or release multiple workflows at one time, see Performing 
Batch Workflow Operations.
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Workflow Design & Configuration Overview
Before constructing a workflow, it is helpful to have a solid understanding of its 
objective or application—what you want to accomplish with it. You’ll have to 
determine what actions (tasks or steps) are necessary to implement the objective; 
where the media (and optionally, metadata and associated files) originate; what 
transcoding and metadata processing is required; where any new copies of media, 
metadata, and associated files should be stored or deployed, etc.

You should also know in advance what external systems these jobs will interact with (if 
any), and whether you want to register and track the output files and metadata related 
to each job in a Vantage catalog for future use; for example, a second workflow. 

Armed with these details, you can construct the workflow, and configure each action to 
correctly perform its assigned task. Of course, if you don't have all this information at 
the start, you can configure the workflow later. 

Once you have tested a workflow, you have to click Activate so it can be utilized. To edit 
it again—or just disable it—you just deactivate it. Then, click Edit, and when you’re 
done, you click Release. These buttons are all displayed at the bottom of the main 
window.
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Using the Workflow Design Workspace
This topic provides general information about using the Workflow Design workspace.

 Design Panel Overview

 Viewing and Specifying Workflow Details

 Displaying Nicknames, Variables, or Run On Rules

 Displaying Action Summary Information

 Showing and Hiding Grid Lines

 Moving the Workflow Around in the Design Space

 Centering a Workflow

 Zooming In and Out on a Workflow

 Automatically Arranging Workflow Actions

 Automatically Validating Workflows

 Action Toolbar Display Options

 Using Context Menus in the Workflows Panel

 Controlling Workflow Status

Design Panel Overview
You use the Workflow Design workspace (click the tab or select File > Workflow Design) 
to view, construct, and configure workflows, and activate workflows for job processing. 

The figure below illustrates the layout and main components of this panel (the 
Workflows panel (left) is not part of the panel, but is shown here for clarity).



Managing Workflows
Using the Workflow Design Workspace

171
At the top of the Workflow Design workspace is the actions toolbar, categorized in 
groups by action type. To sort them, right-click in the toolbar and select Sort by Name 
or Sort by Behavior.

Click the arrow to open each action group and display the set of actions in this group.

Zoom control

Workflows panel—displays your 
workflows by category.

Use the Workflow Design workspace to 
construct and configure workflows.

Actions toolbar—
drag actions onto the 
workspace to add to 
workflow.

Zoom control

Nicknames | 
Variables | Run On 
Rules View

Workflow Designer 
has workspaces for 
each key task.
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Viewing and Specifying Workflow Details
To display or hide the selected workflow’s details panel, do one of the following:

• Select File > Workflow Details Panel 

• Click in the Workflow Design panel’s title bar

This panel displays details and statistics about the workflow, plus settings you can 
configure:

 Configuring General Workflow Settings

 Enabling Automatic Job Reports

 Viewing Expected Variables

Configuring General Workflow Settings
Use the following controls to manage workflow information and settings:

• Name—Edit the workflow name.

• Description—Edit an optional description for the workflow.

• Expiration—Modify to configure the job and binder expiration time.

• Options—Check to enable open workflow mode, when enabled in the domain.

Click Apply to save your configuration changes. Click Close to hide the workflow details 
panel.
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Details that displays directly below the Apply button includes creation and 
modification dates, the current owner (which client is working with the workflow) and 
the workflow’s GUID in the database, along with basic job statistics.

Note: For SDK submission, you can select the GUID and then copy and paste it into 
other applications as required.

Enabling Automatic Job Reports
You can configure a workflow to automatically generate a job report each time the 
workflow processes media. Each time a job is processed through the workflow, a new 
job row is automatically added to the specified report file(s).

Note: You can also manually generate a job report on any job in your job history (see 
Generating Job Reports Manually).

Job reports are based on a job report configuration; these can be created in Workflow 
Designer or the Vantage Management Console (see Managing Job Report 
Configurations).

To add an automatic job report for this workflow, do the following:

1. Click Modify to display the Automatic Reports dialog.

2. Click the New Report button in the toolbar.

3. Select the job report configuration you want to use from the Report menu. (Click 
the Browse button to display the Job Report Manager to create a new report 
configuration or edit an existing one (see Managing Job Report Configurations).

4. Specify a directory path where the job report file should be created (the first time a 
job runs) or updated.

5. Optionally, click Filename Pattern to edit the file name pattern.

6. Check Enable.

7. Click OK to save the automatic report.

Viewing Expected Variables
The Expected Variables table displays a list of variables that are being utilized by 
actions in this workflow. If a variable is utilized—the setting in an action is bound to a 
variable—it displays here, along with its description, type, and default value.

The Expected Variables table can be used to determine which variables must be 
provided to the workflow: from another workflow, a workorder, added to an upstream 
action; Workflow Portal, or from a third party program using the Vantage API.

The Default Value column displays the current (static) default value for this variable. The 
value may change during the course of workflow execution.
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Note: Variables that have been added to a workflow but are never utilized by any 
action in the workflow are not displayed in this table. For example, you manually add a 
variable to a Watch action—it is emitted for use downstream, but never used—
consequently, it is not a required variable, so it is not displayed.

Displaying Nicknames, Variables, or Run On Rules
In detailed action view (right-click in the workflow design workspace to display the 
workflow context menu or press Ctrl-D to toggle it on and off ), you can display three 
different sets of information directly on the actions:

• The nicknames of media files, attachments, and metadata labels that are available 
to the action

•  Variables that are utilized in the action

• Run on rules that have been applied to the action (automatically or manually).

Nickname View—To display nicknames, select View > Action Details > Nicknames or 
select Nicknames from the menu in the bottom right corner of the Workflow Design 
panel. In Nicknames view, each action displays a list of file nicknames and metadata 
labels (in italics), plus attachments, that are available to the action before it executes 
(on the left), and those that are emitted by the action and available downstream when 
the action completes (on the right).

Nicknames (and labels) that are too long to display in the action display an ellipses (...). 
To view the full nickname, hover over it on the action.

Nicknames/labels displayed in bold indicate that they are utilized in that action; as 
input files on the left or output on the right. Nicknames in italic are not used, either as 
input or output, as indicated. 

In the example above, the Original nickname in the IPTV Flip action has been specified 
as an input file and is passed out. Likewise, the TIFO file has been specified as an output 
file in the IPTV Flip action. In Copy, Original is not used, but TIFO is specified as an input 
file. Original and TIFO are simply passed out, but TIFOTOO is specified as the output file.

Items on an action change color based upon the validity of the workflow. Nicknames 
displayed in red represent an error.

Input 
nicknames

Output 
nicknames
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Note: Nicknames and labels that are used or affected by the action are highlighted. 
Nicknames and labels also change color indicating whether or not the workflow is 
valid.

For example, if you configure an action to utilize nickname Copy7 provided by an earlier 
action and then delete the action that created Copy7, then Copy7 displays in red on the 
now-invalid action.

Variable View—To display variables used in this action, select View > Action Details > 
Variables or select Variables from the menu in the bottom right corner of the Workflow 
Design panel. Unlike nicknames that are always displayed when available, variables are 
not presented if they are not utilized in the action.

Variables that are too long to display in the action display an ellipses (...). To view the full 
name of the variable, hover over it on the action.

Variables displayed in bold indicate that they are utilized in that action; as input files on 
the left or output on the right. Nicknames that are not used, either as input or output, 
are not displayed, although they are passed through. 

Run On Rules View—To display run on rules used in this action, select View > Action 
Details > Run On Rules or select Run On Rules from the menu in the bottom right 
corner of the Workflow Design panel. 

Displaying Action Summary Information
To display action summary data, hover over the inspector icon as shown in this figure: 

The summary displays the action type, description (editable), and a high level 
description of how the action is configured.

Inspector 
button
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Showing and Hiding Grid Lines
To toggle the grid lines, do one of the following:

• Select View > Show Grid Lines (Control-G).

• Right-click in the workspace (but not on an action) and select Show Grid Lines to 
display horizontal and vertical grid lines.

Repeat to hide the grid lines.

Moving the Workflow Around in the Design Space
A workflow with lots of actions may be larger than your workspace when viewed at the 
zoom level you’re using. 

To move the workflow around in the workspace, click and hold anywhere on the design 
area other than directly on an action. The cursor displays as a compass: you can drag 
the workflow in the appropriate direction, and release it when done.

Centering a Workflow
To center a workflow in your workspace, do one of the following:

• Right-click in the workspace and select Recenter Diagram (Control-R)

• Select View > Recenter Diagram to position the workflow in the middle of the work 
area.

Zooming In and Out on a Workflow
You can zoom the design space based on the current position of actions, or you can 
select an action and center the design space on that action as you zoom.

Zooming In—To zoom in on a workflow so you can better view details, do one of these 
actions:

• Drag the zoom slider bar to the right

• Select an action, press Shift, and drag the zoom slider bar to the right to zoom in 
directly on the selected action

• Select View > Zoom In

Zoom in or out to get a better view 
of your workflow and actions.
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• Repeatedly press Control-+ (the Plus key)

• Press Control and move the mouse scroll wheel up

Zooming Out—To zoom out on a workflow so you can see more actions, do one of these 
actions:

• Drag the zoom slider bar to the left

• Select an action, press Shift, and drag the zoom slider bar to the left to zoom out on 
the selected action

• Select View > Zoom Out

• Repeatedly press Control-- (the Minus key)

• Press Control and move the mouse scroll wheel down

Automatically Arranging Workflow Actions
Use the Auto Arrange feature to assist you in visually optimizing and organizing the 
layout of actions in your workflow.

To disable automatic arrangement of actions while you're adjusting actions in a 
workflow, click the Auto Arrange button, located at the bottom of the Workflow Design 
workspace, to toggle it off. While Auto Arrange is off, the Auto Arrange button displays 
Auto Arrange SUSPENDED in yellow. 

Click the button again to toggle auto arrangement back into effect.

Automatically Validating Workflows
By default, Workflow Designer monitors how actions are connected and organized in 
your workflow. Workflow Designer notifies you of problems, and prevents activation in 
the case of an improperly-organized or incorrectly configured workflow.

Disabling validation allows new actions to be connected or inserted in large workflows 
(those with about 30 or more actions) much faster. It also makes it faster to delete 
action connections.

To disable workflow validation, select Options > Auto Validate Workflow. When Auto 
Validate Workflow is disabled, validation is deferred until you open an action inspector, 
activate the workflow, or switch workflows. In addition, an orange indicator displays at 
the bottom of the tab, which you can use to re-enable validation. 

Enable or disable Auto Arrange 
to suit your construction style.
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When you create a workflow with 30 actions or more, Workflow Designer displays a tip 
to inform you about the Auto Validate capability.

Action Toolbar Display Options
Use the context menu to display the Action toolbar to suit your preferences. Right-click 
anywhere in the toolbar to select a menu item.

Toolbar Display Size—To reduce the size of the Action toolbar at the top of the design 
area, select Icons only. To display the action names (making the toolbar a bit larger), 
select Icons and Text.

Action Group Display Order—To display the action groups in alphabetic order, select 
Sort By Name. To display the action groups by functionality and (generally) in order of 
utilization in a workflow, select Sort By Behavior.

Expand/Collapse Option—To open all action groups, select Expand All. To close all 
action groups, select Collapse All. 

Using Context Menus in the Workflows Panel
The Workflows panel’s context menu displays in three variations, depending on the 
item you click on: title bar, category, or workflow. Here’s an example:
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Right-click in the Workflows panel to display the following context menus, depending 
on where you click:

In the Title of the Panel

Click in the title bar (or the empty space below the list of categories) to use this edition 
of the context menu to:

• Change the Vantage domain

• Create a new workflow category or workflow

• Import individual workflows or categories of workflows

• Open a workflow you’ve used recently 

• Expand and collapse all of the workflow categories.

On a Workflow Category

When you right-click on a category, you can use this edition of the context menu to:

• Create a new workflow

• Rename or delete the category

• Import or export workflows to or from the category

CAUTION: When you delete a workflow category, all workflows in this category are 
permanently removed from the Vantage domain’s database.

On a Workflow in the Workflows Panel List
• Right-click directly on a workflow to use this context menu to:

• Change the status of the target workflow (Edit | Release | Lock)

• Activate or deactivate the workflow

• Rename, delete, move or duplicate the workflow

• Display the Details panel for more details about the workflow

• Print the workflow

• Export the workflow

• Upgrade the workflow, if permitted.

• Manually submit a job if the workflow is activated.

For detailed explanations of all workflow operations, see Managing Workflows.
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Controlling Workflow Status
This topic describes the four workflow status commands and how and when to change 
a workflow’s status. You change the workflow status via menu items in the File menu or 
by using the buttons at the bottom of the main window.

Each state has a unique icon (or combination), as shown below, in the Workflow States 
and Icons table.

Note: With user administration enabled, only Vantage users with Administrator 
authority can lock workflows in an idle or active state to prevent unauthorized 
changes or deletion. To lock a workflow, select File > Lock Workflow or right-click on 
the workflow and select Lock. Workflow Designer displays a lock icon beside the 
workflow. Locked workflows can be activated and deactivated. However, they can’t be 
edited, updated, or deleted. When user administration is disabled, anyone can lock or 
unlock workflows.

Edit—Select File > Edit Workflow or click the Edit button to modify the selected 
workflow. If the workflow is currently active (a Watch or Receive action is running and 
the workflow can process jobs), Vantage displays a warning dialog that it is about to 
deactivate the workflow. Click OK to continue. To edit or release multiple workflows at 
one time, see Performing Batch Workflow Operations.

The Actions toolbar displays at the top of the panel when in design mode, so that you 
can add new actions to the workflow.

When you are editing a workflow, other Workflow Designer users can view the 
workflow, but cannot edit or activate it.

Release—When you’re done editing a workflow, select File > Release Workflow or click 
the Release button. Released workflows can be activated, and can also be edited by 
others. To edit or release multiple workflows at one time, see Performing Batch Workflow 
Operations.

Activate—Select File > Activate Workflow or click the Activate button on a deactivated 
workflow to start a Watch or Receive action so that jobs can be submitted and 
processed by this workflow. To activate or deactivate multiple workflows at one time, 
see Performing Batch Workflow Operations.
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Deactivate—Select File > Deactivate Workflow or click the Deactivate button to 
deactivate the workflow. New jobs cannot be submitted and media cannot be 
processed by the workflow in this state. Existing jobs using this workflow continue 
executing to completion. To activate or deactivate multiple workflows at one time, see 
Performing Batch Workflow Operations.

The table below shows the icon or icons associated with a given workflow state, and 
provides a general description.

Workflow States and Icons 

Workflow State Icon Description

Idle Indicates that this workflow is not being 
edited, but it is not running either. To set the 
idle state, either click the Release button (when 
editing), or click the Deactivate button (when 
the workflow is active).

Editing Indicates that the workflow is being edited by 
you. To edit a workflow, click the Edit button. 
When you are editing a workflow, it cannot 
accept media and others cannot edit it.

Active Indicates that the workflow’s origin action is 
currently executing and the workflow will 
accept media and start jobs. When a workflow 
is active, it cannot be edited.

Editing by other user Indicates that the workflow is being edited 
(and thus, owned) by a different user. 

Locked The workflow has been locked. With user 
administration enabled, only users with 
Administrator authority can unlock it. Locked 
workflows can be activated and idled, but not 
edited, deleted, or updated.

Idle, locked The workflow has been idled. With user 
administration enabled, only users with 
Administrator authority can unlock it. Locked 
workflows can be activated and idled, but not 
edited, deleted, or updated.

Active, locked The workflow has been activated. With user 
administration enabled, only users with 
Administrator authority can unlock it. Locked 
workflows can be activated and idled, but not 
edited, deleted, or updated.
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Managing Workflows
This topic describes how to organize, add, rename, and delete workflows and 
categories, change their states, and perform batch operations and other workflow-
related operations.

Note: Whenever you are performing a workflow operation, you can select the 
workflow directly from the Workflow panel or select File > Recent Workflows, and 
select the workflow from the list.

 Managing Workflow Categories

 Creating a New Workflow

 Renaming a Workflow

 Deleting a Workflow

 Moving Workflows Between Categories

 Finding or Filtering Workflows

 Duplicating a Workflow

 Exporting Workflows

 Importing Workflows

 Printing Workflows

 Performing Batch Workflow Operations

 Upgrading Actions After Installing a ComponentPac or Upgrading to a Newer Ver-
sion

Note: To set the status of a workflow, see Controlling Workflow Status.

Managing Workflow Categories
Vantage provides workflow categories so that you can organize your workflows by 
categories that you design, and so that you can isolate and control workflows by 
Vantage user accounts (which is performed in the Management Console).

Note: Administrators can prevent Vantage specific users from seeing (and therefore 
using) workflows by category. To select workflow categories and specify which users 
have access to them, use the Vantage Management Console.

The following topics describe how to manage workflow categories:

 Creating a Workflow Category

 Renaming a Workflow Category

 Deleting a Workflow Category
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Creating a Workflow Category
Create categories to store related workflows together. 

Note: All workflows are stored in categories, so you must create at least one category 
before you can create a workflow.

To create a new category, do the following:

1. Select File > Create New Category, or right-click in the Workflows panel (left side of 
the main window) away from any categories or workflows, and select Create New 
Category to display the dialog of the same name:

2. Enter the name of the category you want to create, and click OK.

Workflow Designer creates the category in the database, and displays it in the 
Workflows panel.

Renaming a Workflow Category
To change the name of a category, right-click on the category name in the Workflows 
panel and select Rename. Workflow Designer makes the text editable so you can 
change it. Press Enter or just click away from the field when you’re done.

Deleting a Workflow Category
To delete a category, right-click on the category name in the Workflows panel and 
select Delete. Workflow Designer displays a warning that you are about to delete the 
category and all workflows stored in this category. Click OK to delete the category and 
its workflows, if any.

CAUTION: This action deletes all workflows in the category, and cannot be undone.



Managing Workflows
Managing Workflows

184
Creating a New Workflow
To create a new workflow, select File > Create New Workflow, or right-click in the 
Workflows panel (on the left side of the main window) away from any category or 
workflow and select Create New Workflow. Workflow Designer displays the Create New 
Workflow dialog:

Category—Select the category for this workflow from the list at the top.

Name and Description—Enter the name of the workflow you want to create and an 
optional description in the Name and Description fields.

Expiration Policy—If checked, specifies (in hours) the time that elapses before job 
records for jobs submitted by this workflow are deleted from the database. The time for 
expiration is based on the last updated time in the job record—not the job submission 
time. Once the expiration period has elapsed, the jobs are subject to automatic 
deletion by the system.

OK | Cancel—Click OK to create the new workflow. Workflow Designer creates the 
workflow in the database, adds it to the specified category, and displays it in the 
Workflow Design workspace in edit mode—that is, deactivated and editable.

Renaming a Workflow
To change the name of a workflow, right-click on the workflow name in the Workflows 
panel and select Rename. Workflow Designer makes the text editable so you can 
change it. Press Enter or just click away from the field when you’re done.

Note: You can only rename a workflow when it is in edit mode.

Select the category where 
you want to save the 
workflow.

Enter the name of the new 
workflow and click OK.
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Deleting a Workflow
To delete a workflow, select File >Delete Workflow or right-click on the workflow name 
in the Workflows Panel and select Delete. Workflow Designer displays a warning that 
you are about to delete the workflow and all job history for this workflow. Click OK to 
delete the workflow and its history.

To delete multiple workflows at one time, see Performing Batch Workflow Operations.

CAUTION: This action deletes the workflow and its job history, and can’t be undone.

Moving Workflows Between Categories
To move a workflow from one category to another, select File > Move Workflow or 
right-click on the workflow and select Move. Workflow Designer displays a Category 
dialog. Select the category you want to move the workflow to, and click OK.

To move multiple workflows at one time, see Performing Batch Workflow Operations.

Finding or Filtering Workflows
To find a workflow by name—or to filter workflows by some phrase or string value in its 
name—use the Filter icon in the bottom left corner of the Workflows panel.

Enter a phrase or string, or select a previously-entered string. Workflow Designer 
displays only those workflows that meet the filter criteria. Delete the string to return to 
a complete display of all workflows in the domain.

Duplicating a Workflow
To duplicate a workflow, select File > Duplicate Workflow or right-click on the workflow 
and select Duplicate. Workflow Designer displays a Category dialog. Select the 
category you want to create the new workflow in, enter a name, and click OK.

Use the Filter display only 
workflows with the specified 
phrase or string.
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Exporting Workflows
When you export workflows, the following items are also exported, if they are used in 
the workflow:

• Media nicknames

• attachment nicknames

• Variables

• Metadata labels

• Stores

• Output folders

Exporting a Single Workflow—To export the selected workflow, select File > Export 
Workflow or right-click on the workflow and select Export Workflow. Workflow 
Designer displays a File System dialog. Navigate and select the location where you 
want to save the workflow XML file, and click Save. Workflow Designer exports the 
workflow as an XML file.

Exporting Workflows by Category—To export all workflows in a given category, select 
File > Export Workflows by Category. Workflow Designer displays a dialog with all 
categories listed. Check the ones you want to export, and click OK. In the File System 
dialog, navigate and select the location where you want to save the workflows. 
Optionally, create a new folder, and click OK. 

Workflow Designer creates a folder for each category in the domain, then exports each 
workflow in each category, as an XML file.

Importing Workflows
You can import workflows which have been previously exported (as XML files) from this 
or other domains.

You can import workflows into your domain that have the same name as another 
workflow in a different category. However, if you import a workflow into a category 
which already has a workflow with the same name, Vantage assigns the imported 
workflow an incremental copy number. You can’t have two workflows of the same 
name in the same category.

Importing a workflow can create a problem with duplicate variables: The variable 
already exists, but the imported variable has a different default value. When this 
happens, the original value remains intact.

Note: You cannot import a workflow that includes any action whose service is not 
running in the domain.
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To import workflows, use any of the following options:

 Importing Workflows into a Category You Select

 Importing Workflows by Category

 Importing Workflows into a Specific Category

Importing Workflows into a Category You Select
Use this method when you want to select the workflow or workflows, and then select a 
category or create a new one:

1. Select File > Import Workflows.

Workflow Designer displays a File System dialog.

2. Navigate to the directory where the previously exported workflows are located.

3. Select one or more workflows and click Open.

Workflow Designer displays the Import Workflow Category dialog.

4. Select the category or check Use Folder Name to create a new category and click 
OK.

Workflow Designer imported the selected workflows into the category.

Importing Workflows by Category
Use this method when you want to import a category or categories of workflows (for 
example, when importing all workflows you’ve exported from another domain). The 
workflows you are import should be organized into folders, with the folder name being 
the name of the category you want to use or create.

To import workflows by category, follow these steps:

1. Select File > Import Workflows by Category.

Workflow Designer displays the File System dialog.

2. Navigate to the directory directly above the folders of exported workflows (where 
each folder is named the same as the workflow category) and click Select Folder.

Workflow Designer displays the Import Workflows by Category dialog.

3. Check each folder that you want to import the workflows from and click OK. 

If a category already exists in this domain, the workflows in that folder are 
imported. If the category does not exist, a category of the folder name will be cre-
ated, and the workflows imported.

Importing Workflows into a Specific Category
Use this method when you want to import selected workflows directly into a specific 
category:

1. Right-click on the category title in the Workflows panel, and select Import 
Workflows.

2. Navigate to the directory where the previously exported workflows are located.
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3. Select one or more workflows and click Open.

Workflow Designer imports the workflow into the selected category. You can now 
rename and edit the workflow as appropriate.

Note: When importing workflows that have been created and exported from another 
domain, you may end up with duplicate variables in your domain. For example, you 
might end up with two Agency variables. This is typically not a problem. However, to 
determine which workflows use a particular variable—so that you can correct them to 
use only one definition of it—go to the Management Console > Workflow Design 
Items > Variables. Select the variable you want to search workflows for, and click the 
Find Workflows Using this Variable button in the toolbar (5th from left).

Printing Workflows
Select File > Print Workflow to print the selected workflow using the current workflow 
settings. The workflow is scaled to fit on a single page (with landscape or portrait mode 
preset based on workflow shape), unless the workflow is sufficiently large to make it 
difficult to read when scaled to a single page. Then, Workflow Designer provides you 
the option of printing across multiple pages.

Performing Batch Workflow Operations
You can select multiple workflows and initiate these tasks: edit/release, lock/unlock, 
activate/deactivate, delete, move, or upgrade actions. Secured Version Control allows you 
to upgrade workflows or lock workflows to prevent upgrades until you are ready.

Note: This feature is enabled only by users with Administrator privileges.

To change the status of (or operate on) multiple workflows, do the following:
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1. Select File > Batch Workflow Operations.

Workflow Designer displays the Batch Workflow Operations dialog, which lists 
every workflow in the domain.

2. Select one or more workflows (using shift and control keys).

3. Click one of the buttons at the bottom of the dialog to perform the task.

4. When you’re done, click Close.

Upgrading Actions After Installing a ComponentPac or 
Upgrading to a Newer Version

During a Vantage upgrade (you are converting your domain to a newer version) or after 
installing a ComponentPac, some actions may have new or modified extensions—for 
example, a Flip action with an updated WMV encoder, or an Analyze action with a new 
filter. You can update the copies of these actions in your existing workflows as well, 
although you are not required to.

Actions implemented by the following Vantage services can be upgraded:

• Analysis

• Edit

• IPTV VOD

• Monitor

• Multiscreen

• Timed Text Flip

• Traffic

• Transcode

Actions with only changes to the action itself (a new check box, for example) upgrade 
automatically, when new versions are installed. When you open a workflow, Workflow 
Designer, checks to make sure that the actions are current. If not, the action’s title 
displays in italics to indicate that you can upgrade it.

Note: In addition, you can hover over an action to display the tooltip, which indicates 
which ComponentPac version is being used.

When the title is displayed 
in italic, right-click and 
select Upgrade.
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Right-click the action and select Upgrade to upgrade it. Or, right-click outside of an 
action and select Upgrade to upgrade all upgradeable actions in the workflow. Then, 
open the inspector and review your configuration, making changes as appropriate, 
based on the action’s new or changed controls.

The Upgrade menu item is hidden when there are no upgrades available (for any 
actions in the workflow). The Upgrade menu item is grayed out when upgrades are 
available, but can’t be performed now (for example, when the workflow is not editable).

To upgrade multiple workflows at one time, see Performing Batch Workflow Operations.

Note: Once an action is upgraded it can't be directly downgraded. However, you can 
restore workflows to their pre-upgraded state by importing the automatic backup 
copy that Vantage places in the C:\VantageWorkflowBackup directory (local to the 
Workflow Designer client). Beginning with Vantage 7.0 UP1, a log file describing the 
upgrades is also included in that directory. 
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Constructing Workflows
The following topics describe the operations you’ll use to construct workflows, which is 
done by creating actions, arranging them in order of execution, and connecting them 
together. One operation—exporting an action—can only be performed on Flip actions. 
It is used in conjunction with implementing an SDK-based Vantage application.

Note: Before you can edit a workflow (work with actions or change configuration), it 
must be deactivated and editable. When you first create a new workflow, Workflow 
Designer places it in edit mode automatically.

 Adding Actions

 Controlling the Order of Action Execution

 Deleting Actions

 Removing Line Crossings

 Re-ordering Actions

Adding Actions
There are several ways to add actions to a workflow, depending on the situation. 

New action—to add an un-configured action, open the appropriate category in the 
Actions toolbar and drag the desired action onto the design area. When you drag an 
action from the toolbar, it must be configured before you can use the workflow.

Action template—many actions have action templates—pre-configured actions that 
make it easier to assemble workflows. Vantage provides many built-in action templates, 
and you can also make and use your own. For details, see Creating Action Templates.

To add an action template, click on the action in the action group, select an action 
template from the list, and drag it onto the workflow. The configuration of a template 
may be exactly what you need, or you may need to make minor configuration changes.

Copy and paste—to copy and paste actions in a workflow, first right-click the action you 
want to copy and select Copy. To select multiple actions, control-click and drag across 
the desired actions in the design work space.

Next, right-click on the design area, right-click and select Paste to add the copied action 
or actions to the workflow. 

To paste an action’s configuration into an action of the same type, right-click and select 
Paste—this configures the action identically with the copied action.
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Note: An origin action (Watch or Receive action) is required as the first action in a 
workflow, even if you plan to manually submit jobs to this workflow.

When you drag an action onto the design area, Vantage may automatically align it near 
where you dropped it (unless auto-arrange is off; see Automatically Arranging Workflow 
Actions). Until you connect an action to other actions, you can move it anywhere you 
want on the work area. If you bump the action you’re adding right next to an existing 
action, Workflow Designer will automatically connect the two.

Generally, it’s easiest to drag and drop actions in a pattern similar to the flow of the 
desired workflow, working from left to right (on each branch, if more than one). 
However, you can drag actions anywhere, and connect them as desired later.

Vantage will tidy up actions—moving them and organizing them by column. Once an 
action is connected, you can move it vertically (up or down) but it cannot be moved 
from its column. Alternatively, Vantage can also attempt to optimize the workflow, 
removing as many line crossings as possible. 

Controlling the Order of Action Execution
You connect actions together linearly in a workflow to control the order of execution 
relative to other actions in the same workflow, and to control the flow of variables and 
files from one action to another.

Job execution proceeds action by action, from left to right: When a workflow executes, 
the origin action (at the far left) executes first to start the job, and each action following 
the previous action executes next.

Connecting Your Actions Together
You connect actions together from the output pin (right-side) of one action to the input 
pin (left side) of the action you want to execute next in the workflow. 

Actions can only be connected from an output pin (on the right side of the action) to an 
input pin (on the left side of the action), and control (file or logic) flows from output to 
input—from left to right.

Here are ways you can connect actions together:

• Click and drag a connecting line from one connector pin to another

• Click and drag an action (either from the actions toolbar or one already in the work 
area) and bump it into the edge of the action you want to connect it to—until a 
pale blue vertical line displays. (You must drag your mouse pointer up to the edge 
of the action you’re connecting to).

• Copy an action, and right-click on a connector line and select Paste to add the cop-
ied action between the two actions. Or, drag an action onto a connector line until it 
displays as a larger line. Then, drop it to connect it between the two actions.
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Certain connections are not permitted:

• You cannot form recursive loops, by connecting actions to themselves or to the 
input of preceding actions in the workflow.

• You cannot connect one input (left) pin to another input pin, or one output pin 
(right) to another output pin.

Note: When you connect actions by clicking and dragging a connection, Workflow 
Designer can display a popup message that provides connection details. To enable or 
disable this feature, select Options > Show Connection Helper.

You can connect one action to multiple succeeding actions, creating logical branches, 
as shown in the figure following. When you do, none of the actions you connect can 
execute before the preceding action upon which they depend completes. 

When you have branches in a workflow, you can optionally, use a Synchronize action as 
a visual connector at either end of the branches, to better organize them. Synchronize 
does not perform any special task, it merely aids in design. In this example, three Copy 
actions execute in parallel after the Watch action completes.

These three Copy actions execute independently of each other, and their start time and 
completion time relative to each other is non-determinant. They execute in parallel 
from the perspective of the actions which precede and follow these actions.
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You can also connect multiple actions (branches) back to a single succeeding action, as 
shown in the following figure. When you do, each of the actions you connect must 
execute before any succeeding common action can execute. 

In this example, all Copy actions must execute before the Message action executes.

You can also create multiple, independent action branches—each branch starting with 
an origin action. Each origin action creates its own job. Although this is not generally 
recommended, you may have situations where it is the best solution.

In this example, two independent sets of actions are in this workflow. As each origin 
action detects new files to process, a separate job is initiated.
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Note: Although this is a legitimate workflow, it is an unusual configuration. Typically, 
two completely independent processes would be better defined as two separate 
workflows.

Deleting Actions
To delete an action, select it and press Delete or right-click the action and select Delete. 
When you delete an action, Workflow Designer connects the preceding and 
succeeding actions, unless you uncheck Fill connections after delete in the Delete 
confirmation dialog.

To select multiple actions, control-click each additional action or control-click and drag 
across them in the design work space. When the appropriate actions are selected, 
delete them using one of the following options:

• Press Delete.

• Right-click one of the selected actions, and select Delete.

Removing Line Crossings
On occasion, you might connect two actions on rows in the layout that are more than 
one row apart—resulting in an unintended line crossing. To manually optimize the 
workflow layout, select View > Remove Line Crossings or right-click and select Remove 
Line Crossings. Workflow Designer reformats the workflow and optimizes the layout of 
the actions in a grid.

Re-ordering Actions
To re-order actions vertically, drag one or more of the actions up or down in the design 
area to the location where you want it. To select multiple actions, control-click each 
additional action or control-click and drag across them in the design work space. 
Workflow Designer adjusts the other actions to accommodate the manual placement 
of the other action.
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Configuring Actions
Each action (except the Synchronize action, which is simply a common connecting 
point) has a specifically-designed action Inspector—which you use to configure the 
action to perform its task in a particular way. 

Most action inspectors use the Wizard model; a series of one or more panels, with 
standard Previous, Next, Finish, and Save buttons. 

Some action inspectors—specifically, the Flip action, and other Telestream Media 
Framework-based transcoding actions such as the Multiscreen action—display the 
entire inspector in a single, multi-paneled window.

The panel’s organization and the layout of building blocks is pretty simple. The different 
controls in editor panels is insignificant. What matters is that you use the panels to 
select inputs, encoders, and outputs and configure filters, select nicknames, and make 
other selections specific to the formats you've chosen. 

 Displaying the Action Inspector

 Using the Flip Action Inspector

 Using the Telestream Media Framework Action Inspectors

 Using the Filename Pattern Editor

Displaying the Action Inspector
To access the action inspector on any action, choose one:

• Click the inspector button (the round i button), which displays on the upper left 
corner of each action

• Double-click the action

• Right-click the action and select Configure. 

Until an action has been configured (or configured correctly), the inspector button 
displays yellow; a workflow cannot be activated until all actions have been configured 
correctly and no yellow inspector icons display. When an action is correctly configured, 
the inspector button disappears. Hover over the top left corner to display it—a 
correctly configured action displays a blue inspector button. If you hover directly over 
the button, a summary of the action displays. 

Unconfigured actions display 
their inspector button in yellow 
to alert you to a problem.
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The inspector panels vary, depending on the type of action, and the configuration 
choices you make. For example, here is a simple inspector—the inspector to configure 
a Copy action:

However, the inspector for a Watch action typically consists of about 7 or more panels, 
depending on the file system you’re configuring it to monitor.

When you’re viewing an inspector of an action in a workflow that is activated or 
someone else is editing it, the term Read Only displays in the inspector’s title bar. Also, if 
you have changed the configuration, an asterisk (*) displays immediately before the 
action name: For example, *Watch.

Note: Detailed, context-specific help (as shown above) is available on each inspector 
panel: Click the  icon to display its man page. Click the  icon to display this topic 
(the one you’re currently reading) in the Vantage User Guide. Once in the guide, you 
can also search for other topics. You can also hover over any control for a tooltip.

Using the Flip Action Inspector
The Flip action inspector is unique in Vantage, and comprehensive. It contains a variety 
of general settings, a graphic representation of the transcoding process comprised of 
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building blocks, and a settings detail panel for configuring each building block the way 
your require it for your application.

The general Flip action controls at the top of the inspector window enable you to select 
an encoder and create a file name pattern for naming the encoded file (for details, see 
Using the Filename Pattern Editor). You must specify an input and output media 
nickname. You use the Output Location controls to specify where to write the output 
media file. For details, see the man page.

The media file panel is comprised of building blocks, and a toolbar for adding other 
streams and filters. 

Here are the building blocks (ordered left to right):

Decoder
Video & Audio 
Streams

Movie, Video, and Audio Filters

Codecs
ContainerToolbar
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• Decoder—on the left edge of the stream panel; you can use the auto decoder or, 
under certain circumstances, select a specific decoder for specialized decoding.

• Video and Audio Streams—to the right of the decoder, as supported by the selected 
encoder. 

• Movie, Video, and Audio Filters—a wide variety of filters, overlaid on video and audio 
streams; added using the toolbar.

• Codecs—at the right side of the video and audio streams, listing all supported 
codecs for the selected encoder. 

• Container—at the far right of the stream; specifies the container /file format for the 
media.

Below the stream panel is the setting details panel. It displays the settings for the 
selected building block: decoder, various movie, video, and audio filters, codecs, etc. In 
this example, the Caption Conversion filter is selected and its controls display in the 
setting details panel.

Using the Media Stream Toolbar

Use the icons in the toolbar to add streams and filters; the list varies by encoder.

To add any supported type of stream for the encoder, select it from the toolbar. To add 
a filter, select the video stream or audio stream and then add the selected movie, video, 
or audio filter from the list.

If you directly click on the icon, it will add the next available filter at the top of the drop 
down list. If you click on the menu arrow on the right side of the icon, the list will 
displays and you can select the appropriate filter.

To remove any building block, select it and then click the Delete icon or just select it 
from the list again.

Using the Telestream Media Framework Action Inspectors
Vantage includes several Telestream Media Framework transcoding actions, including 
Multiscreen Flip, IPTV VOD Flip, Post Producer Conform, and others. Each action’s 
inspector is designed to enable you to specify the discrete components required in an 
action’s functionality (inputs, converters, transcoders, etc.) on the left side, and detail 

Video Stream
Audio Stream
Video Filters
Audio Filters
Movie Filters
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panels for configuration of the selected components (and the streams inside them) on 
the right.

Each type of action’s components vary. The categories are represented by a panel—in 
this example there are four categories of components: Inputs, Converters, Transcoders, 
and Outputs. You can add one or more components to each category, depending on 
the action. For example, in the Multiscreen Flip action you can add several input 
processes, an Audio Mixer Converter, one or more transcoders and one or more 
outputs.

To remove any component, select it and then click the Delete icon.

Configuring Components

Each component you add displays its own panel, including the video and audio 
streams, as appropriate.

To configure the component, click to select it (as shown above, with the white border).

The setting details panel displays on the right, enabling you to configure it.

Use the same process to configure each video and audio stream.
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Specifying and Configuring Transcoder Filters

Transcoder components enable you to specify filters that you want to enable. To 
manage filters, select the transcoder. The inspector displays the filters in the settings 
detail panel on the right.

Check each filter that you want to enable. 

To configure the component, click the expander button to display its settings.

Configure the settings as required to accomplish your workflow requirements.

Using the Filename Pattern Editor
Actions that create new files provide a filename pattern editor, so that you can 
customize the pattern for file name generation, based on the task and the workflow 
requirements. The filename pattern editor is implemented in transcoding actions such 
as Flip, IPTV VOD, and Conform, and in file operation actions, including Move, Copy, etc.
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Here’s an example—the Edit Filename button—displayed in the Outputs panel of one 
of the actions:

To display the editor, click the Edit Filename button:

Use the editor to implement a filename generator pattern for your workflow. To 
produce the name generator pattern you require, you can include raw text (for 
example, .xml) and any combination of the following: base name, any supported 
variable you want to select, plus date and time.

Note: In all transcoding actions, the Base Name element is the base name of the 
source file without the extension (for example, myfile for a file named myfile.mpg). In 
file operations actions (Copy and Move, for example), the Base Name is the full name 
of the file, including the extension. For example, myfile.mpg.

Binding Settings to a Variable
Most settings in an action are configured with a static value—one that doesn’t change 
from job to job. For example, you configure a Watch action to poll a specific directory—
and job after job, this directory never changes—that is, the fully-qualified path string is 
a static value.

However, many actions also have settings whose values do change from job to job—
typically, based on the media being processed.

For example, you have a Message action that sends email—the To address should be 
the address of the producer, which is provided in metadata and assigned to a variable 
in a previous action. Or, a variable is updated by an Analysis action to specify the 
number of black lines are at the top of a frame; a crop filter in the workflow uses the 
variable to crop the video appropriately for that job.
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To support dynamic values, Vantage enables appropriate settings to be bound to a 
variable, allowing the workflow to dynamically update the value on a job-by-job basis.

Settings that can be bound to a variable display a green Browse button:

Click the green Browse button to display the Select Variable dialog, shown here.

The list of variables includes those variables of the appropriate type (text, true/false, 
etc.) in the domain. For example, the subject line only accepts text variables; the email 
address only accepts email address variables.

Select the variable to bind to this setting, and click OK.

Click the green variable browse button to 
select a variable to supply the variable’s value 
to this control. In this case, an email address.
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Note: Click Create New Variable to if you need to make a new one. For details, see 
Creating New Variables. (You can also create variables in the Management Console.

Now, the setting displays with a green border, indicating that its value is derived from 
the current value of the variable instead of the setting (in the case of a check box or 
radio button) or a manually-entered or selected static value.

When you bind a setting to a variable, the value or state displayed is the default for the 
variable definition in the domain and the value is read only. If you remove the binding, 
the value returns to the setting’s original editable value.

Settings bound to a variable display a green 
border.
Click the button again to unbind a variable or 
change the variable you want to use.
You can hover over a bound setting to display 
information about the binding—for example, 
the name of the variable.
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Specifying Action Settings
The following topics describe how to specify action settings. These settings are all 
accessed by right-clicking an action and selecting the setting from the context menu.

 Setting Conditional Action Execution

 Adding Variables to an Action

 Configuring an Action’s Run On Rules

 Configuring an Action’s Fallback Rules

 Specifying Automated Retry Settings

 Modifying Resource Costs

 Generating Execution Metrics

 Changing Action Descriptions

 Highlighting a Branch in a Workflow

 Creating Action Templates

 Exporting a Flip Action

Note: Not all actions provide each of these settings.

Setting Conditional Action Execution
The action state describes the condition of an action during execution or after 
completion. During execution, an action may be in a variety of states, as indicated by a 
colored border (for a detailed list, see the jobs table’s Viewing Actions in Detailed Action 
View).

You can configure most actions to only execute when the upstream action or actions 
pass a specific action state to the downstream action. Obviously, you cannot test action 
states or set conditional execution in origin actions—the first actions of a workflow—
Watch, Receive, Dublist, and the Workorder action, for example.

 Action States Overview

 Setting The Execution Action State

Action States Overview
After execution, an action’s final state is assigned: Success | Ignore | Fail. These keywords 
may be tested by the action immediately following it (using the Perform On function—
see Setting The Execution Action State), to determine whether or not this action should 
execute. Each action’s final (post-execution) state is passed to the next action or actions 
in the workflow.

If an action fails, the next action inherits the Fail action state and (in most cases) will not 
execute—unless its Perform On state is set to Fail.
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Some actions can be configured to set the Ignore state. The next action inherits the 
Ignore state and will likely not execute (unless it has been explicitly set to execute on 
Fail). Most actions, such as Message, can be configured to perform on certain states—
this allows workflows to send an email if they detect a failure.

If an action receives states from two incoming actions (such as a merge of two 
branches), then states are given the following priority:

• If at least one incoming state is Fail, regardless of other incoming states, the action 
will inherit the Fail state—Fail has precedence over all action states.

• If there is no Fail state, but at least one Success state, then the action will inherit the 
Success state—Success has precedence over Ignore states.

• Only if all incoming states are Ignore, will the action will inherit the Ignore state. 

Ignore has lowest precedence of the three states.

Setting The Execution Action State
To set the conditions (states) under which an action will execute, right-click and select 
Perform On > Success | Failure | Ignore | Any. The Any option is not a state—it is a 
selection to indicate this action should execute regardless of the state passed to it.

By default, actions only execute when the action state (as set by upstream actions) is 
Success. Success means that the upstream actions have completed normally and the 
incoming state is Success. 

The Fail state indicates that at least one action has executed and failed to complete 
normally or completed normally, but was explicitly set to Fail. If you have an action 
configured to execute on Fail, it only executes if at least one upstream action has 
reported a failure.

You can also configure an action to execute on the Ignore state by selecting Ignore.

Adding Variables to an Action
Sometimes, you need to provide information to one or more actions (or directly to a 
job, when you’re manually submitting it) that is independent of the functionality of the 
actions. To do so, you can manually add a variable and set a static value. These variables 
can be used by downstream actions or by other Vantage components such as services, 
to execute the workflow appropriately.

For example, you can add a variable to set the execution priority of one workflow 
branch to high, and another to low.

 Variables Overview

 Adding Variables

 Creating New Variables



Managing Workflows
Specifying Action Settings

207
Variables Overview
In Vantage, a variable is a container for temporary job information—a symbolic name 
(or identifier) which contains some data: a quantity, string, or element of information; a 
value. You use the variable name to reference the current value; this separation of name 
and content allows the name to be used independently of the information it references.

Each variable has a name (such as Number of Audio Channels), a type (Integer Number, 
for example), and a default value, all of which are defined when the variable is created. 

Note: To display variables used in your actions, in detailed action view, select View > 
Action Details > Variables or select Variables from the menu in the bottom right corner 
of the Workflow Design panel. 

You can change variable values in a variety of ways. For example, a variable value can 
be changed in actions that are designed to use variables, such as the Analysis, Populate, 
Watch and Associate actions. Variable values can also be changed when adding a 
variable to an action in a workflow or when manually submitting a job.

Variables are passed from action to action according to the action connections. When 
an action creates a given variable, all downstream actions that use variables can access 
the variable and its current value.

Variables are used by some actions to control their functionality and execution—and 
thus, implement workflow logic. (Variables are also used by Vantage services as defined 
by the Vantage domain administrator.)

Many settings in an action can be bound to a variable, allowing the workflow to 
dynamically update the settings on a job-by-job basis. For details on binding settings to 
variables, see Binding Settings to a Variable.

When a variable is set to a specific value, that variable value is only available to actions 
within the same branch as the one that set the variable and actions in downstream 
branches.

Note: If two branches merge to a common action, and both have set a value for the 
same variable, then the last upstream action to finish executing will set the variable for 
the common action. The last action to finish can not be determined from job to job.
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Adding Variables
To manually add a variable to an action, right-click and select Add Variables. Workflow 
Designer displays the Add Variables window.

In the Add Variables window, you can add variables to the action prior to execution. 
Values set in this window are available to this action, and all downstream actions 
(including actions in connected workflows).

Click the Add Variables button in the toolbar to display a list of variables.

Select the variable to add and click OK.

Note: Click Create New Variable to create a variable if you need a new one. For details, 
see Creating New Variables.

Next, with the variable selected, modify its default static value if necessary, and click OK 
to add it to the variable for use in the workflow.

Add Variable & Delete Variable toolbar buttons.
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Creating New Variables
Vantage includes some default variables, and you can create variables directly in 
Workflow Designer. Vantage domain administrators can also create variables using the 
Vantage Management Console (Workflow Design Items > Variables).

On variable selection windows in Workflow Designer, click the Create New Variable 
button. Workflow Designer displays the Create New Variable dialog shown here.

Configure the new variable as follows:

1. Enter an appropriate name for the variable in the Name text box.

2. Enter a description in the Description text box. (This is optional.) 

3. Select a variable type from the Value Type dropdown list.

4. Enter a value for this variable in the Default Value text box.

5. Click OK to save the variable.

Configuring an Action’s Run On Rules
Most actions have a set of rules called run on rules, which can be configured to 
determine if its service has the features or characteristics which enable it to execute the 
action. Unlike qualification rules, which are service-centric, run on rules are action-
centric.

Note: To display run on rules used in actions in your workflow, in detailed action view, 
select View > Action Details > Run On Rules or select Run On Rules from the menu in 
the bottom right corner of the Workflow Design panel. 

Run on rules provide explicit control over which service can execute a particular action 
in a workflow. As you design a workflow, you can indicate that you need to have a 
particular action executed by a specific service (or set of services). To implement this, 
you assign a True/False variable the value of TRUE to indicate that the service must 
satisfy the requirement. Assign this variable to the service or services that qualify, in the 
Vantage Management Console > Services > Variables.

For example, you are designing an HD transcoding workflow, and the Flip action must 
be executed by a Transcode Service deemed HD-capable—that is, it is running on a 
server with a processor set capable of adequately handling HD media transcoding. For 
this example, it’s a server named Vantage_HD_Transcoder.
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Note: In addition to setting up specific rules on an action, Vantage domain 
administrators can set up service-based qualification rules using the Vantage 
Management Console.

Creating Run On Rules
In Workflow Designer, open your HD workflow, right-click on your Flip action and select 
Run On Rules to display the Run On Rules dialog.

Click the Add Run On Rules button in the toolbar at the top, and create an HD_Capable 
variable and set its value to TRUE, as shown below. 

Next, click OK to create this variable, and click OK to save the Run On Rule.

In the Vantage Management Console, select Services > Variables and add the 
HD_Capable variable to the Transcode Service running on the Vantage_HD_Transoder 
server.

Note: When a variable is added to a service, that variable is added to the job if the 
service executes it. Be careful about which variables you use for run on rules, and 
which are used for decision-making; generally you will want to use different variables.
Run on rules only analyze variables explicitly set by a service. They do not analyze 
variables already set in a job. This ensures that run on rules only execute actions on a 
service that explicitly sets them.
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Now, return to Workflow Designer and open your HD workflow again. Right-click on 
your Transcode action and select Run On Rules to display the Run On Rules dialog.

Click Check Services to verify that the Vantage_HD_Transcoder now responds correctly 
to queries about being HD-capable.

Configuring an Action’s Fallback Rules
Actions that have been configured to utilize the Lightspeed Server (for example, by 
selecting the Lightspeed Accelerated VPL), by default, will use the Legacy Telestream 
VPL when:

• No services are available to run the Lightspeed Accelerated VPL. 

• The queue length of jobs waiting for Lightspeed Servers is larger than a configu-
rable number. 

To enable Lightspeed fallback rules, right-click on the action and select Fallback Rules 
to display the Fallback Rules dialog.

Check the Fallback if Queue Greater than option, and select the maximum number of 
actions already in queue you will accept, before running this action on a capable 
service running on a standard Vantage server. The rule will be activated if every capable 
service has a queue length greater than the number you have selected.

Specifying Automated Retry Settings
Certain actions (typically, those that deal with files or other network-accessible 
computer systems) which may fail due to file system latency or network delays, can be 
configured to automatically execute multiple times in an effort to overcome a 
temporary problem, according to user-specified parameters, called retry rules.

Analyze Copy Message

Archive Delete Move

Associate Deploy Multiscreen Flip

Automate DPP Validate IPTV Flip

Chronicle Examine Notify

Cloud Flip Faspex Delivery Process MMF

Colocate Flip QC
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Retry Rules Overview
Default retry rules are set for each action type by the Vantage domain administrator. For 
example, the Vantage domain administrator might specify a default retry rule (in the 
Vantage Management Console) so that all Flip actions retry one time after five minutes.

The default retry rules can be modified for an action in Workflow Designer, and the 
action retry rules override the default rules. For example, you might specify that a 
specific Copy action in a workflow should retry three times: once after five minutes (in 
case of a SAN blip), once after an hour (in case of Internet congestion), and up to a 
certain number of times after two days (in case of complete Internet failure).

It is important to keep in mind that individual action retry rules specified in Workflow 
Designer override the default retry rules specified in the Vantage Management 
Console. If an action does not have override retry rules, the default retry rule for the 
action type is used instead. If there are no override rules specified for an action, and no 
default rules for its action type, then a failed action is not retried.

Each time an action is executed, it may be executed according to either task scheduling 
rules or resource cost settings, depending on what type of load balancing is enabled in 
the domain, and it may be assigned to a different service for execution.

If you restart a job that is in the Stopped by User or Failed state, the actions execute as a 
first-time execution. For example, you have an action with retry after 4 hours. Restarting 
this job results in immediate execution, because the action is executing on its first try.

Configuration Details
Right-click on an action and select Retry Settings to view or configure retry rules. 
Workflow Designer displays the Automated Retry Settings dialog.

Compare Gather Report

Compose Identify Tempo

Conform MediaInfo Timed Text Flip



Managing Workflows
Specifying Action Settings

213
This dialog supports the following options:

• No Retry—Override any default retry settings, and not retry execution on failure. 

• Default—Utilize the default retry settings specified by the Vantage domain admin-
istrator. 

• Custom Limited Retry—Configure up to three retry settings. 

• Custom Recurring Retry—Configure the time and priority (which is optional) 
between retries, and optionally, stop after a certain number of iterations.

Modifying Resource Costs
When you right-click an action, Resource Cost is among the selections. The following 
topics explain the Resource Cost selections.

 Cost-Based Load Balancing

 Task Based Load Balancing

 Setting Action Resource Cost

Cost-Based Load Balancing
Cost-based load balancing is a legacy load balancing system available with the 
Advanced Task Scheduling license and is disabled by default. To determine if cost-
based load balancing is enabled, contact your Vantage domain administrator.

Note: When cost-based load balancing is disabled (the legacy, default setting), 
Vantage uses session-based load balancing and resource cost settings are ignored. For 
information on configuring load balancing, see the Vantage Domain Management 
Guide.

When cost-based load balancing is enabled, each action has a default cost and a 
custom cost. The default cost value is defined by the Vantage domain administrator. 
The custom cost is defined by the workflow designer in the workflow itself. When you 
define a custom cost, that cost overrides the default value.

Cost-based load balancing provides a way to control how action processing is 
distributed among multiple services. During workflow processing, the action cost 
defines the relative resources that must be available on a Vantage service to process 
the action. If there are multiple services that can process an action, and if one service 
does not currently have the resources to process that action, another service with 
available resources will process the action.

The resource cost is an integer value that has an ordinal relationship to the other action 
costs and to a target resource usage value defined by the domain administrator. A 
higher resource cost in an action means that fewer actions can run simultaneously on 
the same service. A lower resource cost allows more actions to run simultaneously. The 
actual values you enter for a workflow action must conform to the service settings 
defined by the Vantage domain administrator. To determine the range of resource cost 
settings available to you, consult with your Vantage domain administrator.
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Task Based Load Balancing
Vantage Task Based load balancing is Vantage’s most advanced load balancing 
capability and augments the existing Vantage Session Based load balancing and the 
Vantage Cost Based load balancing. Task Based load balancing ensures that all Vantage 
servers remain fully utilized, maximizing server efficiency and increasing workflow 
throughput. Task Based load balancing also helps avoid the situation where some 
Vantage servers are over-utilized and others are under-utilized.

The older cost-based method discussed previously is limited to a single service on a 
single machine. This method can prevent a service from becoming overloaded, but it 
cannot effectively balance between different types of actions on a single machine, and 
it does not offer a global way of managing sessions across multiple machines.

Task based load balancing is a separately licensed option that provides a single set of 
metrics shared across all services for scheduling tasks and balancing workload on a 
single machine or all the machines in a domain. 

These are the key features of task based load balancing:

• Each metric can be edited and has machine scope (across all services on the 
machine) or global scope (across all services on all machines). 

• Each metric has two inputs: Cost (set for each action) and Capacity (set per 
machine, or globally). You can edit both on a per-machine basis (for per-machine 
metrics) or for the entire Vantage Domain (for global metrics).

• A default metric called System Resources is pre-configured to provide a per-
machine metric. This metric cannot be deleted and must remain per-machine. 
However, you may set the capacity for this metric on each machine, and you may 
remove the metric from an individual action.

• You can create and name your own new metrics.

• By default, each metric has machine scope, but you can edit this after creation.

• The default capacity is 100 “units” for each machine, allowing each cost to indicate 
the resource percentage an action will use. The capacity can be changed.

• You can choose which metrics are relevant to an action, and you can set the cost for 
each action.

• When executing a task:

Vantage evaluates all metrics that you attach to the action. If a metric is not 
attached to an action, it is not considered.

Vantage tracks the aggregate cost of all executing actions on a machine, across all 
machine-based metrics, and will track the aggregate cost of executing actions 
across the entire system for global metrics.

Vantage only executes an action when the aggregate cost of executing current 
actions, plus the new task, does not exceed the capacity of any of the metrics 
attached to the task.

Vantage will never execute a task when the aggregate cost of executing actions, 
including the new task, would exceed the capacity of any metrics attached to the task.
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• When tasks are queued, they may be preempted only by higher priority actions:

Certain high priority tasks will pause low priority tasks (executing on the same ser-
vice on the same machine) to free up sufficient resources across all metrics, to allow 
that high priority task to execute. If doing so would exceed the maximum number 
of paused jobs specified by the user, then the high priority task will wait until a dif-
ferent set of tasks are present which may be paused. Pauses will not occur across 
multiple machines; they occur only for actions hosted by the same service.

The new task based load balancing capability allows you to define custom task 
scheduling rules which allow jobs to be controlled/allocated based on criteria on a 
given machine or across an entire domain.

Vantage task based load balancing is enabled via the settings panel in the Vantage 
Management Console. As with other system level settings, when task based load 
balancing is enabled (or changed), services must be restarted.

Task based load balancing includes capabilities that replace and extend the Cost based 
load balancing mode. The new capabilities replace the existing action cost 
mechanisms, and are used in-conjunction with the existing service capacity to provide 
more granularity on when and where an action may run.
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Setting Action Resource Cost
The preceding topics about Cost-Based and Task-Based load balancing provide the 
background you need to make action Resource Cost decisions, as this topic explains.

1. Right-click the action and select Resource Cost.

2. Select either Resource Cost Settings or Configure Task Scheduling.

a. If you select Resource Cost Settings, Workflow Designer displays the Resource 
Cost Settings dialog, shown here. Select Default to use the default resource cost. 
Select Custom to set your own resource cost.

b. If you select Configure Task Scheduling, the Task Scheduling Rules dialog opens. 
Select Default to apply existing system rules, or select Custom and choose the 
custom rules you’ve created that you wish to apply. Also specify a cost and click 
Done.

For details about creating Task-Based rules using the Vantage Management Con-
sole, refer to the Vantage Domain Management Guide, “Managing the Vantage 
Domain” chapter.

3. Click OK to save.
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Generating Execution Metrics
For most actions, you can collect execution metrics, and assign them to variables for 
processing downstream. For example, you can generate start and end times, total 
elapsed time, and final action state, among other values. You can use these metrics to 
enhance your ability to fine tune your system, and improve throughput, or identify 
bottlenecks. 

To generate execution metrics for a given task, right-click the task and select Execution 
Metrics. Vantage displays the Execution Metrics dialog.

Check the metrics you want to collect, and assign each one to a variable. Then, 
downstream you can access these variables for analysis.

Changing Action Descriptions
You can change an action description by directly clicking on the description text field at 
the bottom of the action, or right-click and select Description. Enter the new text and 
then click away.

Highlighting a Branch in a Workflow
In a complex workflow, it might be difficult to determine at a glance exactly which 
actions are in a specific branch of the workflow. To see all of the actions which will 
execute on a given branch clearly, right-click on the farthest downstream action that 
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you want to see in the context of its branch and action execution path, and select 
Highlight Path.

All of the actions in this branch that precede the target action are temporarily 
highlighted in yellow so that you can identify them.

 Creating Action Templates
Vantage provides many actions with a variety of action templates, which you can use 
(along with your own) to make workflow construction easier. 

To make your own action template, follow these steps.

1. Add an action to a workflow. 

2. Configure it as appropriate.

3. Edit the description (at the bottom of the action), which is used to name the action 
template.

4. Right-click and select Create Template to save the selected action as a template.

5. Enter a description (this is optional).

6. Add or select a group, or select None and click OK.
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Grouping allows you to organize your action templates. If you want more than one 
level of grouping, separate each group with a vertical bar (|)—for example, Broadcast 
Servers | Grass Valley. The description of the action displays as the name of the action 
template.

The action template is added to the template list, and can be selected by clicking on 
the action.

Exporting a Flip Action
When you are creating a custom Vantage application using the Vantage SDK, you can 
create and configure a Flip action and then export it as an XML file, for use as a template 
in your application.

To export a Flip action, first create and configure the action to meet your requirements. 
Next, right-click the Flip action and select Export. Workflow Designer displays a File 
Save dialog, where you can navigate and save the XML file with a name you choose. 

You can use this XML file (which contains a definition of your Flip action) in your 
Vantage SDK-based application. You can also edit the XML file separately from 
Workflow Designer, of course. 

Note: Only Flip actions can be exported using this feature.
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Implementing Processing Logic in Workflows
Many workflows consist of several actions connected in a single line—thus, each action 
is executed, in turn, for the entire workflow.

However, you may want to create branching workflows that are intelligent and flexible, 
so that they can process media files with differing processing or output requirements 
automatically. These workflows can collect information about the media or the file itself 
at runtime (using the Analyze action, for example), and store that information in 
variables. Then, you can add a Decide action to examine the values in the variable or 
variables, and pass control to one branch or the other, based on the value. (You can also 
use the Compute action to perform string processing and math operations on the 
metadata.)

Generally, controlling the flow of media through a workflow is achieved by three 
things: adding variables and assigning them values, using a Decide action to evaluate 
variables, then setting an action state for each branch that follows the Decide action, so 
that only the appropriate branch executes for each job.

Branching workflows are scalable; you can add as many decide actions and branches as 
you need, to further refine your processing choices.

In this example, some metrics about the input file are being examined by the Watch 
action—file modification date, for example. The Decide action determines if the date is 
prior to or later than a given date, and sets Success or Fail, based on the answer. 

The top branch’s Flip action only executes on Success (processing those files whose 
modification date is prior to the test date), and the lower branch’s Flip action only 
executes on Fail (processing those files whose modification date is later than the test 
date).



Managing Workflows
Managing Vantage Folders

221
Managing Vantage Folders
Vantage folders are aliases (or alternate names) for actual file system directories or 
folders. You can create (and name) Vantage folders to identify specific paths you use 
frequently. Vantage folders simplify directory referencing by allowing you to specify a 
short, descriptive folder name instead of a long, complex file path. Vantage folders also 
allow you to update a path or credentials once, and automatically update all actions 
using that Vantage folder.

For example, you might have a folder on a given server for HD MPEG2 content: 
\\voyager\SunupCampaign\Darwin\WaitingApproval\HDMPEG2. You can create a 
Vantage folder in the Vantage folder address book for this path, and name it 
SunupHDWaitingApproval. If you need to change the path or any password associated 
with the address later, you can simply change it in the address book and all actions will 
automatically update.

Telestream recommends using UNC paths instead of drive letter paths, and it is 
required in Vantage arrays. For a detailed discussion, see Paths for Vantage Storage 
Overview.

Now when you create a workflow that generates media you want saved in this folder 
path, you simply select SunupHDWaitingApproval in the Flip action’s inspector.

You can create Vantage folders in both the Vantage Management Console and in 
Workflow Designer.

To create and manage Vantage folders in Workflow Designer, do the following:

1. Click on the browse  button to the right of any location field that accepts Vantage 
folders.

For example, open a Flip action and open the Output Location panel to see a 
Browse button to the right of the Vantage Store/Folder field. 

Vantage displays the Vantage Folder Address Book, shown here:
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2. Click the Add Folder toolbar button (the new folder button at far left).

3. Name—Enter the Vantage folder name.

4. Location—Click Modify to display the Folder Location Editor.

5. Select a file system and click Next.

6. Click Browse to navigate and select the directory that this Vantage folder address 
should reference. Or, enter the fully-qualified path manually, preferably in UNC 
form (be sure to only use drive letters when the domain is a single machine.). When 
manually entering a fully-qualified path, the text displays in red if it does not 
conform to the proper convention for the supported file system.
For a detailed discussion, see Paths for Vantage Storage Overview.

7. Click Finish to close the Folder Location Editor dialog. (You may have to click OK on 
the local folder warning dialog.)

8. Click OK to add this new Vantage folder address to the domain and close the Add 
New Folder dialog.

9. Collision Resolution—Select Create Unique Name | Overwrite | Set Failure State to 
specify what Workflow Designer should do when a file of the same name already 
exists in this location.

– Create Unique Name—Workflow Designer adds a suffix to the filename, making it 
unique, then saves the file in the location.

– OverWrite—Workflow Designer deletes the current file and saves the new file in 
the location.

– Set Failure State —Workflow Designer does not save the file; it sets the action 
state to Fail so that downstream actions may detect the error and perform a 
specified task under this condition.

10. Click Select to close the dialog and use the currently-selected folder address, then 
press OK to save changes. Click Close to simply close the Vantage Folder Address 
Book dialog with changes.
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Troubleshooting Workflow Designer
When opening Workflow Designer for the first time, depending on the design of your 
network and the location of your workstation and Vantage database server, the 
Domain login dialog may not display the domain. If this is the case, you can log in by 
using the name or IP address of the server.
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Vantage Actions
This chapter describes each of the action groups and their actions. Workflow Designer 
groups actions according to the service that executes them, with one exception. The 
actions in the Common group can be executed by all Vantage services.

Some actions require a specific license, and are noted appropriately.

Note: For detailed, implementation-oriented help, open the Inspector on any action 
and click the  icon to display its man page.

 Agility Actions

 Analysis Actions

 Aspera Faspex Delivery Action

 AudioTools Action

 Aurora Action

 Baton Action

 Capture Action

 Catalog Actions

 Cerify Action

 Cloud Flip Action

 Common Actions

 Communicate Actions

 Edit (Post Producer) Actions

 FileCatalyst Action

 IPTV Flip Action

 MediaMate Action

 Metadata Actions

 Monitor Actions

 Multiscreen Actions

 Nexidia Action
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 Pulsar Action

 Signiant Delivery Action

 Staging Actions

 Timed Text Flip Action

 Traffic Actions

 Flip Action

 Transport Actions

 VidChecker Action
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Agility Actions
Use Agility actions in workflows where you have an Agility ECS system and you want to 
submit jobs to it for processing. You can use Agility actions to create workflows, submit 
and monitor jobs, process MMF files, and control jobs during execution in Agility.

Note: Before you can use Agility actions, the Agility ECS must be identified in the 
Management Console: Settings & Options > Agility ECS, and you must have an Agility 
ECS Connector license installed.

Agility actions are executed by the Agility Service:

 Job Profile Action

 Job XML Action

 Process MMF Action

Job Profile Action
Use the Agility Job Profile action to obtain and display a list of Agility profiles from an 
Agility ECS (which must be configured in the Vantage Management Console and 
available at design time), from which you can select and configure, to submit jobs.

Job XML Action
Use the Job XML action to submit the job described in the specified XML to the Agility 
system for processing. This is an alternative to Vantage-based configuration using the 
Job Profile action, and is intended for use primarily by Agility users with SDK 
implementations to generate XML-based job profiles for Agility execution.

Process MMF Action
Use the Process MMF action to process an attached MMF file in Agility, and generate 
variables from it.
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Analysis Actions
Use these actions (executed by the Analysis Service on behalf of the Telestream 
Transcode & Analysis Engine) in workflows when you want to perform measurements 
on media files, compare media files, or identify the characteristics of media files, and 
publish the results as variables or metadata labels, or set the state of the workflow 
based on the results.

You can publish analysis results in a metadata label within the binder, or you can 
publish results as variables so that they can be used for decision-making, or to supply 
values to settings in other actions. In some cases, you can also set the action state of the 
action based on the results of the measurement.

 Analyze Action

 Compare Action

 DPP Validate Action

 Examine Action

 Identify Action

 MediaInfo Action

 QC Action

 Report Action

Analyze Action
Use the Analyze action to perform analysis on media using a variety of analysis tools, 
and variables for use downstream, with the result of the analysis. 

Compare Action
Use the Compare action to examine two media files and determine their differences.

DPP Validate Action
The DPP Validate action is part of the optional DPP license. You can use the DPP 
Validate action to confirm compliance of a DPP metadata XML file. If the XML file passes 
validation, TRUE is generated; otherwise FALSE is generated. You can test the results of 
the action downstream to change the workflow’s actions based on the validation 
results. Optionally, you can also generate a report.

Examine Action
Use the Examine action to analyze the video and audio of a media file, by selecting a 
given analyzer (black detection, macroblocking analysis, slate detection, etc.).
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Identify Action
Use the Identify action to examine and identify certain media characteristics, or extract 
the properties of a media or attachment file (for example, file name, extension, size, or 
path) or to generate an MD5 hash of a media or attachment file, which you can use to 
compare two files downstream, or in other workflows.

You can also extract metadata (such as Author or Title) from media files.

In addition, you can extract a comprehensive set of properties from media files (for 
example, frame size, frame rate, codec, bitrate, number of audio channels, etc.). 

Extracted values are assigned to variables (which you create in Vantage Management 
Console or directly in Workflow Designer), for use later in a workflow. You can also set 
the workflow state as a result of execution conditions.

MediaInfo Action
Use the MediaInfo action to perform 2 tasks, based on its analysis of the media file and 
its streams: Create variables from properties via the MediaInfo API, and create a report 
of the properties and their values.

In each category, you can produce variables of selected metrics with the results the 
analysis.

QC Action
Use the QC action to perform analysis on media using a variety of analysis tools. The QC 
action is similar to the Analyze action, with additional features in addition to generating 
variables for each property.

In each tool, you can test various properties for True/False, min/max values, allowable 
values, or ranges, and then set pass/fail and other variables based on the results of the 
analysis. You can use these variables in downstream actions.

Option, you can also produce a report on the analysis.

Report Action
Use the Report action to generate a report file which contains a list of variables and 
their values.
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Aspera Faspex Delivery Action
Aspera servers and applications enable secure, high-speed batch file transfers of 
various file types, including media and metadata files. The Aspera action is an optional, 
licensed feature in Vantage; it is used to deliver media or other files to Aspera systems.

The Faspex Delivery action is used to deliver media or other files to Aspera Faspex drop 
boxes and users.
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AudioTools Action
The AudioTools action is an optional, licensed feature in Vantage. It uses the AudioTools 
Service to enable Vantage workflows to utilize and interact with various AudioTools 
products from Minnetonka Audio Software. The AudioTools Custom Workflow executes 
a selected, pre-defined AudioTools Server workflow. AudioTools Loudness Control 
executes the typical loudness processes, including hitting multiple target parameters 
using an iterative processing pass.
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Aurora Action
The Aurora action is an optional, licensed feature in Vantage. It uses the Aurora Service 
to utilize and interact with various QC tests provided by the Digimetrics Aurora 
software. The tests provide the ability to determine whether a particular input media 
(specified by nickname) either passes or fails a particular QC check. Each test also 
generates a report file that may be utilized during later stages of the workflow.
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Baton Action
The Baton action is an optional, licensed feature in Vantage. It uses the Baton Service to 
enable Vantage workflows to utilize and interact with various QC tests provided by the 
Baton software. The tests provide the ability to determine whether a particular input 
media (specified by nickname) either passes or fails a particular QC check. Each test also 
generates a report file that may be utilized during later stages of the workflow.
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Capture Action
The Capture action is an origin action; Capture actions are executed by the Vantage Live 
Service on a Lightspeed Live Server equipped with the Live Capture option. Capture 
actions support Open Workflows on the outbound side and are used to capture 
Lightspeed Live Capture server's live SDI input or an IP media stream delivered over 
Ethernet, and output captured media files to Live Storage using the specified output 
container and encoder.

The Capture action may be included in workflows created in Vantage domains with the 
Live Capture option installed on a Lightspeed Live Capture server. The Capture action 
inspector allows you to select and configure live streams for processing, filtering, 
transcoding, and output. See the Lightspeed Live Server Guide for more details.
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Catalog Actions
Catalog actions enable you to query a Vantage catalog to determine if a binder exists, 
and also to register a binder in a catalog. These actions executed by the Catalog 
Service.

 Remove Action

 Exist Action

 Register Action

Remove Action
A Remove action is executed by the Catalog Service, and is used to permanently 
remove a binder from the catalog and set the associated file resources to expired. If the 
action succeeds, it emits an action state of Success; otherwise, Failure. 

This action is open workflow capable if the Open Workflows license is installed.

Exist Action
Use the Exist action to determine if a binder of the same name already exists, thus 
indicating that a job has already run on the same media file. 

This action is open workflow capable if the Open Workflows license is installed.

Register Action
The Register action adds the workflow binder generated by each job to a specified 
Vantage catalog. This allows Vantage to preserve the binder—and all files it 
references—even after a job expires (which deletes the associated binder by default). 
This is also how binders become accessible to operators in Workflow Portal. For details 
about Workflow Portal, see Using Workflow Portal. 

This action is open workflow capable if the Open Workflows license is installed.
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Cerify Action
The Cerify action is an optional, licensed feature in Vantage. The Cerify action enables 
Vantage to interact with the Tektronix Cerify suite of QC components.
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Cloud Flip Action
The Cloud Flip action is used to submit media to the Telestream Cloud platform from 
Vantage workflows via the Telestream Cloud API to a particular profile that a user 
specifies. The Cloud Flip action is executed by the Telestream Cloud service. As part of 
the submission, the specified input file is uploaded and then processed according to 
the rules associated with the specified Telestream Cloud profile.
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Common Actions
Common actions are typically light-weight, short duration, utilitarian actions, and do 
not have a dedicated Vantage service to execute them. Instead, these actions are 
implemented in every Vantage service, so that any service available can execute them 
efficiently and instantaneously.

 Compute Action

 Construct Action

 Decide Action

 Forward Action

 Receive Action

 Synchronize Action

Compute Action
A Compute action uses variables to set other variables. For example, you can use 
Compute to add two numbers and assign the result to the selected variable. Compute 
can perform mathematical operations such as addition, subtraction, division and 
multiplication. It can also convert variables between types (such as converting a time 
code to a string), string manipulation, such as appending strings together into an 
output variable, and comparison functions. 

This action is open workflow capable if the Open Workflows license is installed.

Construct Action
A Construct action enables you to construct complex strings, paths, and math 
expressions from literals, variables, and tokens, for use in downstream actions. 

This action is open workflow capable if the Open Workflows license is installed.



Vantage Actions
Common Actions

239
Decide Action
A Decide action sets the action state based upon variables. It is commonly used to 
determine whether or not a branch in a workflow should execute (it sets the Success 
state) or not (it sets the Ignore state).

For example, if one branch is for HD, it will start with a Decide action that will set the 
state to Success for HD content, ignore otherwise; if another branch is for everything 
else, it will start with a Decide action that performs the opposite behavior.

Forward Action
A Forward action starts a new job for the target workflow, delivering a binder and all 
current variables from the originating. A Forward action can only be added to the end 
of a workflow, and requires that the target workflow has a Receive action as its first 
action.

The Forward action is the only terminating action in Vantage—it does not have a 
connecting pin on the right side. Thus, once you add a Forward action to a workflow (or 
branch in a workflow), you cannot add any more actions, because control has passed to 
another workflow with a Receive action as its origin action.

Typically, workflows are created with a Receive action when they are intended for 
execution by another workflow that immediately precedes this one. This ability to chain 
workflows enables you to create run-time customizable workflows consisting of smaller 
workflow building blocks.

Receive Action
The Receive action is similar to a Watch action in that it starts jobs. Unlike a Watch 
action, it allows you to ingest a file from an external source and submit it for processing.

Methods you can use to submit jobs to a Receive-based workflow:

• Another workflow

• A Vantage SDK-based program

• Workflow Portal
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• Drag and drop a file on it. 

The ability to chain workflows enables you to create run-time, customizable workflows 
consisting of smaller workflow building blocks. When you chain workflows, you can 
also pass binders and variables between them.

Note: An origin action is required as the first action in a workflow, even if you plan to 
only manually submit jobs to this workflow.

Synchronize Action
The Synchronize action is used in workflows where multiple actions connect to 
multiple subsequent actions. Synchronize provides a common connection point, where 
all upstream actions need to be connected to all downstream actions.
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Communicate Actions
Communicate actions are used to communicate with external systems. They are 
executed by the Communicate Service.

 Automate Action

 Message Action

 Notify Action

Automate Action
The Automate action, which is executed by the Communicate Service, is similar to the 
Notify action. It contains system-integration extensions which are relevant to 
TrafficManager workflows, enabling you to save job or other metadata to a file and 
interface/integrate with external automation systems. This capability ranges from 
writing XML-based material to a file system to direct integration with specific 
automation systems.

In TrafficManager applications, this action is useful to notify automation systems that a 
commercial has been processed and is available for air. For example, a Notify action can 
create text or CSV dublists and provide them to automation systems that are capable of 
processing dublists in that format. 

Each extension has specific features which are detailed in the manual page for the 
extension.

Message Action
A Message action enables you to generate and transmit an electronic message—an 
email, for example. You must configure Vantage to use an SMTP server before email can 
be utilized; this can be done in the Vantage Management Console. 

This action is open workflow capable if the Open Workflows license is installed.

Notify Action
A Notify action transfers job information to external systems via Web Services or other 
methods to transfer data. The job information may also be transferred via an XML file or 
files of other formats. You can also use the Notify action to invoke a command shell. 

This action is open workflow capable if the Open Workflows license is installed.
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The Notify action is extensible, and can communicate with a wide variety of systems 
and generate various files, including:

– Automation Files

– BXF Files

– Dolby DP600

– Dump XML Files

– External Command Shell

– HTTP server

– Avid Interplay

– Avid MOBID Generator

– Civolution NexGuard

– SeaChange MVL

– Text/CSV Files

– General Purpose Web Services Notification

The TrafficManager-centric extensions are implemented in the Automate Action, but are 
also available in the Notify action for backward-compatibility.
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Edit (Post Producer) Actions
Edit actions are components of Vantage Post Producer, an optional, licensed feature. 
These actions are executed by the Edit Service, and may run on a Vantage Lightspeed 
Server or a standard Vantage server. 

 Chronicle Action

 Colocate Action

 Compose Action

 Conform Action

 Tempo Action

Chronicle Action
The Chronicle action converts a post-rendered Composition XML file into formats for 
use in other systems—ad-insertion systems, for example.

Colocate Action
The Colocate action converts a Composition XML file with non-file-based URLs (for 
example, Amazon S3) and localizes the media and produces a modified CML file with 
the URLs converted to the localized file paths. 

This action is open workflow capable if the Open Workflows license is installed.

Compose Action
The Compose action converts various media descriptor file formats: Anystream AN2, 
Final Cut Interchange XML, Simplified Avid AAF, QuickTime Reference, Adobe FC7XML, 
and Telestream TSEDL) into a Composition XML file so that it can be used by the 
Conform action to compose media. 

This action is open workflow capable if the Open Workflows license is installed.

Conform Action
The Conform action assembles and optionally transcodes multiple video and still 
image files into a single output file, applying filters as specified by you. The input files 
and related instructions for the output file are all defined in a Composition XML file.

This action is open workflow capable if the Open Workflows license is installed.

Tempo Action
The Tempo action is part of the Edit group. All actions in the Edit group are executed by 
the Edit service. The Tempo action is included in Tempo, a time-adjusting encoding 
solution built on the Vantage platform. The Tempo action uses the Edit Service for re-
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timing file-based content and intelligently decreasing or increasing the running time of 
shows and segments. 

This action is open workflow capable if the Open Workflows license is installed.
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emotion Action
The emotion action is an optional, licensed feature in Vantage. The emotion action 
enables Vantage to utilize and interact with Emotion Systems Emotion Engine audio 
software.



Vantage Actions
FileCatalyst Action

246
FileCatalyst Action
The FileCatalyst action is an optional, licensed feature, which enables Vantage 
workflows to access and deliver files to FileCatalyst servers via integrated FileCatalyst 
client software.
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IPTV Flip Action
The IPTV Flip action (in the IPTV VOD category) is included with the Cable / IPTV version 
of TrafficManager. IPTV transcoding is designed for generating MPEG2 Transport Stream 
files and meeting multiplexing requirements. The IPTV Flip action is executed by the IPTV 
VOD Service, which can optionally run on a Lightspeed Server for GPU-accelerated x264/
x265 encoding and video processing. 

The IPTV Flip action and IPTV VOD Service supports the features required to handle 
varying IPTV, set-top box and cable encoding requirements, and ancillary metadata 
specific to cable ad splicing and cable/IPTV set-top box environments. Transcoding is 
performed by the Telestream Media Transcode and Analysis Engine on behalf of Vantage.

This action is open workflow capable if the Open Workflows license is installed.
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MediaMate Action
The MediaMate action enables you to implement screen subtitling. This is an optional, 
licensed feature. The MediaMate action is used to provide screen subtitling, by utilizing 
various subtitling systems from Screen.

Note: The MediaMate action is only supported on the 64-bit version of Windows 
Server 2008.
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Metadata Actions
Metadata actions are an optional, licensed feature available in certain Vantage editions. 
They are used to perform conversions between attachment files, metadata labels, and 
variables. These actions executed by the Metadata Service.

 Populate Action

 Transform Action

Populate Action
Populate actions transform data between variables, attachment files, and metadata 
labels. During ingest, metadata labels can be added to ingested media and generally 
include trim information, audio levels, file properties, and commercial metadata. The 
metadata labels can then be reviewed and modified by operators using Workflow 
Portal. At any stage of a workflow, Vantage can extract information from labels using 
the Populate action, allowing Vantage to, for example, trim clips during a transcode or 
use audio level limits to dampen audio when creating a broadcast asset. 

This action is open workflow capable if the Open Workflows license is installed.

Transform Action
A Transform action transforms data between XML files (ingested into the job as 
attachment files) and labels. XSL style sheets are used to perform these 
transformations. 

This action is open workflow capable if the Open Workflows license is installed.

Note: The Transform action is available in Metadata and Transcode Connect licenses. 
You can only use style sheets that have been imported into the database; you cannot 
reference XSL files directly. The Vantage administrator manages your XSL style sheets 
using the Vantage Management Console (Vantage Domain > Workflow Design Items 
> Style Sheets).
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Monitor Actions
Monitor actions are used to identify and ingest files to be processed by a workflow, and 
in the case of the Watch action, start jobs for this workflow. They are executed by the 
Monitor Service.

 Associate Action

 Camera Ingest Action

 Watch Action

 Workorder Action

Associate Action
An Associate action uses the Monitor Service to poll a target location (a directory, for 
example) on a device or file system (FTP, network folder, etc.) to discover new files in the 
context of a job.

Often, an Associate action follows a Watch action, and utilizes the file name of an 
existing media file or attachment as the basis for discovering new files; for example, if 
media file Vantage.mpg is currently in the workflow, then the Associate action may look 
for Vantage.scc. The Watch action can publish the file name as a variable, and pass it to 
the Associate action to pick the corresponding file (the file extension must be dropped 
to accomplish this). The required file match pattern can be configured in the Associate 
action's Inspector dialog.

When Associate actions are executing, subsequent actions must wait until a file is 
found or a time-out occurs. When a new file is discovered, the Associate action ingests 
the file, assigns a nickname, and makes the file available to other actions in the 
workflow.

Note: An origin action is required as the first action in a workflow, even if you plan to 
manually submit jobs to this workflow—Associate is not an origin action.

Camera Ingest Action
A Camera Ingest action is an origin action; it uses the Monitor Service to regularly poll a 
target location (a directory, for example) on a card reader device or Windows file system 
to discover new camera files of supported formats, including reference files. You can 
also manually submit jobs to workflows beginning with a Camera Ingest action.

Note: Each Camera Ingest action is configured to detect a specific camera file format. 
If the target contains both P2 AVC-Intra and XDCAM EX files, two Camera Ingest 
actions are required.

When a new file or shot is discovered, the Camera Ingest action submits a job for the 
workflow which it is part of, for processing.
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The Camera Ingest action has features including stitching individual shots (including 
self-contained, split, and spanned clips), and controlling whether camera content is 
broken into individual sections, or treated as a single unit.

Watch Action
A Watch action is an origin action, which uses the Monitor Service to continually (and at 
regular periods) poll a target location (a directory, for example) on a device or file 
system (FTP, network folder, etc.) to discover new files. 

The Watch action submits a job to the workflow which it is part of, when:

• A new file is discovered in the target folder

• You manually submit a file to the workflow

• You drag and drop a file on the Watch action in the workflow.

Note: An origin action is required as the first action in a workflow, even if you plan to 
manually submit jobs to this workflow.

This action is open workflow capable if the Open Workflows license is installed.

Workorder Action
A Workorder action is an origin action; it uses the Monitor Service to regularly poll a 
target Windows directory for new workorder files to process. The Workorder action 
provides a simple and highly effective method of submitting multiple, similar jobs 
without using the SDK. 

When a new file is discovered, the Workorder action submits one job for each row in the 
file.
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Multiscreen Actions
Multiscreen actions are used to produce high-quality, adaptive-bitrate (ABR) packages 
in industry-standard adaptive rate streaming formats. They are executed by the 
Multiscreen Service.

 ABR Optimize Action

 Multiscreen Flip Action

ABR Optimize Action
The ABR Optimize action is designed to produce high-quality, adaptive-bitrate (ABR) 
packages which significantly reduce delivery bandwidth and distribution costs while 
ensuring perceived viewing quality. Multiscreen Flip actions are executed by the 
Multiscreen Service. Based on the SSIMplus quality measurement suite from SSIMWave, 
service providers and content creators can use the ABR Optimize action to set 
guaranteed quality levels using a measurement technique that closely tracks actual 
viewer perception.

Multiscreen Flip Action
The Multiscreen Flip action is an optional, licensed feature. Multiscreen Flip actions are 
executed by the Multiscreen Service. The Multiscreen service may run on a Vantage 
Lightspeed Server or a standard Vantage server. 

This action is open workflow capable if the Open Workflows license is installed.

The Multiscreen Flip action allows you to encode and package decoded digital 
baseband media into industry-standard adaptive rate streaming formats, including 
Adobe HDS, Apple HLS, Microsoft HSS, and others. Transcoding is performed by the 
Telestream Media Transcode and Analysis Engine on behalf of Vantage.
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Nexidia Action
The Nexidia action is an optional, licensed feature in Vantage. It uses the Vantage 
Nexidia Service to interact with Nexidia QC servers running Nexidia QC software. The 
specified input files are passed to the Nexidia QC software where they are analyzed 
using the test profile selected.
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Pulsar Action
The Pulsar action is an optional, licensed feature which enables broadcasters to 
integrate the Pulsar suite of content verification components directly in Vantage 
workflows.
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Signiant Delivery Action
The Signiant Delivery action is an optional, licensed feature which enables Vantage 
workflows to deliver files to Signiant-enabled servers. The Signiant Delivery action is 
executed by the Signiant Service, and uses the Signiant Content Transfer Engine (CTE) 
feature, which must be licensed on the Signiant server.
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Staging Actions
The optional, licensed Staging Service actions are responsible for file operations in 
preparation for moving files to other systems/platforms with special packaging 
requirements. They are executed by the Staging Service:

 Archive Action

 Gather Action

Archive Action
Use the Archive action to convert the selected input file to another format, usually in 
preparation for copying, moving, or deploying a file to a given system that has special 
file format requirements. The Gather action is only enabled with the optional, licensed 
Metadata option.

Gather Action
Use the Gather action to collect one or more files from a specified server and directory 
(and optionally, its sub-folders), and bring them into the workflow as attachments. Use 
of a file matching pattern allows you to select only certain types of files. The Gather 
action is only enabled with the optional, licensed Metadata option.
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Timed Text Flip Action
Use the Timed Text Flip action to automate caption file-type conversions, extract 
caption data from media with embedded captions, create subtitle overlay graphics, and 
manipulate the timecode of caption data to match media. 
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Traffic Actions
The following actions are executed by the Traffic Service and are a component of 
TrafficManager, an optional, licensed feature. Catch and Dublist actions monitor catch 
servers and dublist servers for new files. These actions are both origin actions. The 
Syndicate action processes metadata files for syndicated media processing.

 Catch Action

 Dublist Action

 Syndicate Action

Catch Action
Use the Catch action (an origin action) to select a catch server, and configure the action 
to monitor it for new commercials and syndicated content arriving from the publisher, 
expose all relevant metadata, and submit the commercial for processing in 
TrafficManager workflows. The Catch action is part of TrafficManager; an optional, 
licensed feature of Vantage.

The Catch action submits a job to the workflow which it is part of, when:

• A new file is discovered in the target folder.

• You manually submit a file to the workflow.

Note: An origin action is required as the first action in a workflow, even if you plan to 
manually submit jobs to this workflow.

Dublist Action
Use the Dublist action (an origin action) to perform dublist processing in 
TrafficManager workflows. The Dublist action is part of TrafficManager, an optional, 
licensed feature of Vantage.

In the Dublist action’s inspector, you can select a dublist system or server as the target, 
and configure the action to monitor it for new dublists, which it resolves with the 
standing dublist. 

The Dublist action submits a job to the workflow which it is part of, when:

• A new file is discovered in the target folder

• You manually submit a file to the workflow

Note: An origin action is required as the first action in a workflow, even if you plan to 
manually submit jobs to this workflow.

The Dublist action uses the binder name as the unique identifier for the commercial, so 
it should be set to the Ad ID.
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Syndicate Action
Use the Syndicate action in syndicated media ingest workflows to convert sidecar 
metadata XML files to a mezzanine format for use in downstream actions in the 
workflow, or for use in Syndicated Workflow Portal applications. The Syndicate action is 
part of TrafficManager, an optional, licensed feature of Vantage.

In the Syndicate action inspector, you can specify the type of metadata file being 
transformed, and configure the action to utilize specific templates for processing. 
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Flip Action
The Flip action is a broadly-used, general-purpose transcoding action, executed by the 
Transcode Service (which in turn utilizes the Telestream Transcode & Analysis Engine). 
Use the Flip action to create media of a new format, and save it as a file, using a 
prescribed codec profile. How you configure the encoder depends on the encoder you 
choose. 

This action is open workflow capable if the Open Workflows license is installed.
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Transport Actions
Transport actions are executed by the Transport Service and perform file operations on 
specified files.

 Copy Action

 Move Action

 Delete Action

 Deploy Action

Copy Action
Use the Copy action to duplicate a file from one directory to another directory on a 
given file system. The new file can be tracked by the workflow—that is, referenced in 
the binder. As a result, the new file must be given a nickname. 

This action is open workflow capable if the Open Workflows license is installed.

Move Action
Use the Move action to remove a file from one directory and place it in another. You can 
optionally specify a different destination nickname during the move.

Delete Action
Use the Delete action to delete a file on the specified file system. This action also 
removes the file reference from the binder.

Deploy Action
The Deploy action copies one or more files to a destination in a single step, and may 
perform additional custom steps depending upon the type of deployment.

Deployed files are not referenced in the binder, and are not tracked after the action 
completes.
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VidChecker Action
The VidChecker action is an optional, licensed feature which enables broadcasters to 
integrate VidChecker, automated QC and intelligent automated correction, directly in 
Vantage workflows.
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Monitoring Workflows and 
Managing Jobs
The topics in this chapter describe how to submit jobs, monitor workflows, and manage 
jobs in Workflow Designer.

 Submitting Jobs to Workflows

 Checking Workflow Activation Status & History

 Monitoring and Managing Jobs

 Generating Job Reports Manually

 Managing Job Report Configurations

 Viewing Binders

 Controlling Action Execution in Jobs

 Viewing Action Status

Note: In addition to submitting jobs in Workflow Designer, you can also submit jobs 
by dropping media files into target directories, or by using the Dublist Portal and the 
Workflow Portal clients. You can also submit jobs from other programs using the 
Vantage SDK. 

Note: You can also monitor and manage jobs using the Job Status Views web 
application. See Using the Job Status Views Web Application.
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Submitting Jobs to Workflows
This topic discusses the various methods used to submit media or other files to Vantage 
workflows. You can submit jobs in the following ways: 

• Directly in Workflow Designer using various methods. See Manually Submitting Files 
Directly in Workflow Designer, following.

• Automatically, by adding files to directories monitored by active workflows.

• As a batch, by submitting a workorder file to a Workorder-based workflow. See Sub-
mitting Files as a Batch, following in this topic.

• From Workflow Portal and the Workflow Portal Web Application. See Using Work-
flow Portal.

• From Dublist Portal. See the TrafficManager User Guide.

• From third-part or custom programs using the Vantage SDK.

Manually Submitting Files Directly in Workflow Designer
To submit files manually to a workflow for processing directly in Workflow Designer 
(which starts a new job for each file submitted), do one of the following:

• Drag and drop the selected file or files from a Windows Explorer directory directly 
onto the origin action of the target workflow. See Submitting Files via Drag and 
Drop.

• Select the workflow and click the Submit Job button to submit one or more files. 
See Submitting Files via the Submit Button.

Note: The file you are submitting doesn’t have to be a media file; though it usually is. 
You can manually submit any file that the workflow can process. It might be some 
form of XML (metadata, for example). Or, it might be a workorder file for a Workorder 
action workflow, for submitting several jobs at once. It might be some other form of 
file, based on your workflow.

Submitting Files via Drag and Drop
To submit files for processing using drag and drop, follow these steps:

1. In Workflow Designer, select the target (it must be active) workflow and display it in 
the Workflow Design workspace.

2. In Windows Explorer, navigate to the directory where the file or files that you want 
to process are stored.
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3. Select one or more files and drag them over the origin action in the workflow.

4. When the origin action highlights (displays a bright green border), drop them onto 
the action to submit them for processing.
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Vantage displays a confirmation dialog when all jobs have been submitted:

Click OK to dismiss the dialog, and display the Job Status workspace to track your jobs.

Submitting Files via the Submit Button
To submit a file to an activated workflow manually, follow these steps:

1. Select the target (activated) workflow in the Workflows panel.

2. Click the Submit Job button as shown below.

In a multiple origin action workflow, Workflow Designer displays a dialog that lists 
the origin actions. 

Click the Submit Job 
button to select 
media files for 
processing with the 
selected workflow.
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3. Select the action you want to start the job, then click Next to continue.

For a multi-file workflow (for example, a Receive-based workflow that expects more 
than one file), Workflow Designer displays this Submit Job dialog:

Enter or browse and select the file for each nickname and proceed to Step 6. 

For a single-file workflow, Workflow Designer displays the Submit Job dialog:
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4. Select the type of file system (or a Vantage folder) where the input file or files are 
stored, and click Next.

Workflow Designer displays the Windows Explorer window:

5. Navigate to the server and directory, and select one or more directories and/or files 
for processing and click Open. Click Browse to add more files or click Clear to start 
over. As you select files, they are added to the list:
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6. When the list is correct and you’re ready to submit them, click Next. 

7. Optionally, click Variables to manually add variables with values for this job. The 
variables must be identified in actions. These variables are initialized to the default 
value of the variable definition in the domain, and the value may be changed by 
actions in the workflow. For details, see Adding Variables to an Action.

8. Click Submit to submit the file(s) for processing.

Vantage displays a confirmation dialog when all jobs have been submitted:

When you have submitted the job(s), you can view their progress in the Job Status 
workspace (see Monitoring and Managing Jobs).

Submitting Files as a Batch
To submit a batch of files to a workflow for processing (which starts a new job for each 
file entry in the workorder submitted), you use a Workorder action as the origin action 
in the workflow, and you create workorder files (a CSV file) to identify those files you 
want processed. Next, you can use any method you like to submit the file for processing 
to the active workflow.

The Workorder action enables automated submission of multiple jobs in batches. For 
example, you can use a workorder-based workflow to process multiple media files, 
without manually adding the files to a target directory—instead, you just submit a 
workorder file, which contains a job entry for each media file you want to process. The 
Workorder action initiates one or more jobs each time a new workorder file is 
discovered (based on the number of job entries in the file) and passes control to the 
next action in the workflow. Workorder files must be conform to the schema specified 
in the selected workorder scheme. Workorder schemas are created in the Management 
Console.
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Workorder files are a simpler, automated submission alternative to job submission via 
the Vantage SDK. A Workorder file is a text file containing one or more work orders, or 
job descriptions. The format of workorder files is CSV-based. Each job description is 
comprised of a fully-qualified reference to one or more media files, attachments, plus 
variables-all the input needed for the workflow performing the processing. At least one 
workorder scheme must be created (either directly in the Workorder action or in the 
Vantage Management Console) in order to properly identify the workorder schema and 
submit the jobs in a Workorder action-based workflow.

Jobs may be of any type, including Post Producer jobs, where the job identifies a CML 
file for processing. (Post Producer jobs require a special license.) While workorder files 
may be manually created (in an Excel spreadsheet, or a text editor of some kind, for 
example), ideally a system component responsible for submitting media to Vantage for 
processing will dynamically and automatically create workorder files and deliver them 
to the target share for submission and processing.
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Checking Workflow Activation Status & History
To check on the status and activity history of workflows, use one of these tabs:

• Select a workflow and click the Monitor Status tab (or select File > Monitor Status).

• Click the Domain Monitor Status tab (or select File > Domain Monitor Status).

The Monitor Status workspaces are useful when you’re performing operator-related 
tasks or when you’re managing or performing domain-wide production media 
processing. The only difference between the two tabs is one of scope.

The Monitor Status tab displays all activation records for the selected workflow, 
indicating the dates and times when the workflow was active. Each time a workflow is 
activated, a new activation record is added. It displays each origin action’s execution 
(for example, Watch actions) in the selected workflow, and indicates its current status.

The Domain Monitor Status tab displays all of the workflows currently active in the 
domain. Because this tab’s focus is domain-wide, it also displays two additional 
columns of information not found in the Monitor Status tab: Workflow and Category.

Static information in the activation record includes the origin action, resource cost, and 
several date/time stamps, including when the action will expire. The state is real time 
information, indicating the state of the action: In Process (currently executing), 
Completed, etc.

Click any column to make it primary, sorting it in ascending/descending order.

These topics provide information on using the Monitor Status tab:

 Viewing the Monitor Status of Camera Ingest Actions

 Using the Monitor Status Toolbar

 Viewing Origin Action Record Details

Each row is an active origin action, indicating status and other details.

Monitor Status toolbar
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Viewing the Monitor Status of Camera Ingest Actions
For workflows beginning with a Camera Ingest action which has been configured to 
monitor multiple locations—a card reader with multiple drives, for example—the 
Monitor Status workspace displays additional details.

In the status column, you can determine the number of shots being processed—as well 
as incomplete shots where the action is waiting for files before submitting the job. The 
Source column identifies the location—for example, drive letters on a card reader.

Using the Monitor Status Toolbar
The Monitor Status workspace provides the following buttons in the toolbar:

• Show in Groups button —Click to organize records for the selected action by 
group, based on the primary column—the one selected. Click again to turn group-
ing off. For example, if you select State as the primary field in the table and display 
Groups, Workflow Designer sorts the records by state: In Process and Complete. 

When displayed in groups, click the Down arrow on the table entry to display the 
origin records in this group (In Process, or Complete, for example).

• Delete button —Click to delete the selected record(s). Or, right-click on the record, 
and select Delete. You can only delete records whose origin actions are complete—
that is, the session has ended because the workflow was deactivated.

• Status button —Click to display the selected workflow’s origin action details. Or, 
right-click and select View Status.

Viewing Origin Action Record Details
To display details about the origin (the first) action for the selected workflow, double-
click the row (or select a row and click the Status button ).
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The Status/History dialog (the  figure and the  figure) provides details about the status 
of the origin action.

When an action is complete, the Status/History dialog displays information on each 
aspect of the action’s execution. You can use this information to review details about its 
execution, and when an action fails, you can use this information to determine why and 
correct the problem.

The text in the upper panel of the Status/History dialog provides a summary of some 
aspect of action execution. To display more information related to a line in the upper 
panel, click on the line. The detailed information appears in the lower panel. 

Click the symbol to the left of the summary lines in the upper panel to hide or display 
subordinate summary lines.

When an action is In Process, (Queued, Paused, In Process, or Waiting states), the Status/
History dialog displays a progress bar, the path of the target directory, and the status.

For jobs in the Success, Ignore, and Failure states, the Status History dialog displays the 
following buttons:
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• Export—Click Export to display a File System dialog, and save the status/history 
information as an XML file. You can send these files to Telestream for support issues, 
or export them for processing in other systems.

• Session Log—To display a session log, select a session in the upper panel and click 
Session Log.

The session log displays session activity entries, if any, including which variables have 
been provided to each action. This information can be helpful when debugging the use 
of variable, or when working on an issue with Telestream Customer Service.

Click Done to close the window.

Select
Click
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Monitoring and Managing Jobs
To monitor and manage jobs, display one of these two workspaces:

• Select a workflow and click the Job Status tab (or click File > Job Status)

• Click the Domain Job Status tab (File > Domain Job Status).

The Job Status and Domain Job Status workspaces each display a list of jobs and 
provide job details. Use these workspaces to monitor media processing, set priorities, 
view binders and associated files, and to pause and resume jobs in progress.

Note:  When the Include Completed Jobs option is enabled in the Console (under 
Settings & Options), these tables also display all jobs that have completed. 

These workspaces are useful when you’re performing operator-related tasks or when 
you’re managing or performing domain-wide production media processing. The only 
difference between the two tabs is one of scope.

The Job Status workspace allows you to select a workflow in your user account and 
display all of this workflow’s jobs. The Domain Job Status workspace displays all the 
jobs currently executing in the domain, plus all completed jobs, if the Include 
Completed Jobs in Domain Job Status is enabled (Vantage Management Console > 
Settings & Options).

When an action is executing, it is displayed with a green border, and a progress bar 
displays at the bottom of the action, indicating execution progress. This indicator 

Each row is a job processed by the selected workflow, indicating 
status and other details.

Job Status toolbar

Real-time view of transaction processing.
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provides a relatively accurate prediction of how far along the total execution has 
progressed.

The following topics provide additional information for using the job status 
workspaces:

 Viewing Actions in Detailed Action View

 Using the Jobs Table

 Using the Job Status Table’s Toolbar and Context Menu

 Stopping All Jobs in the Domain

Viewing Actions in Detailed Action View
To view actions in detailed action view, select View > Detailed Action View. In this view, 
each action displays its state, creation and update dates, and resource costs directly on 
the action.

The progress bar indicates progress for this action.
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Action States
Each action in the selected workflow displays a color-coded border to identify its 
current status in real time or final status at the end of the job:

• Green—In Process. The action is currently executing.

• Blue—Complete. The action completed successfully. 

• Red—Failed. This action has failed or an upstream action failed, causing this action 
to not execute, and replicate the failed state.

• Black—Ignored or Waiting on License. This action was not executed due to a Per-
form On state mismatch or is executing in some exception-processing way (action-
dependent) because a license is not present.

• White—Idle. The action is ready to execute pending the assignment of a service to 
execute it.

• Yellow—Pending or Waiting for Intervention. The action is ready to execute pend-
ing the availability of the required resources or the execution was interrupted for 
some reason, and the service requires intervention from a user.

• Light Gray—Paused or Suspended. The action has been paused by a user or sus-
pended by a higher-priority action.

• Magenta—Stopped by User. The action was stopped by user intervention.

• Orange—Waiting to Retry. The action attempted unsuccessfully to execute to com-
pletion, and is currently waiting to re-execute.

• Purple—Waiting on a Service. No service of the required type is running that can 
execute the action. For example, no Transcode Service is running to execute a Flip 
action.

• Light Green—Waiting due to Run On Rule. The action is waiting due to a run-on rule 
that must be satisfied before it can execute. For example, a Flip action requires a 
Lightspeed server, but no Lightspeed servers are online.

• White—The action is waiting to be assigned to a service. Upstream actions have not 
yet completed execution.

• Yellow—Waiting execution. Even though the action has been accepted by a service, 
there is no slot in which to run the action. 

Note: At any time before an action starts executing, it may be re-assigned (re-
balanced) to another service which can execute it.
Completing without errors does NOT mean that the action performed the task—an 
action may be configured to execute ONLY when a previous action succeeded or 
when a previous action failed—thus, an action may complete without errors, and 
perform no task at all.
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Using the Jobs Table
Click any column title in the Jobs table to make it the primary column and sort it in 
ascending or descending order. The Jobs table presents information about the job in 
the following columns:

Job—The Job column displays the name of the file submitted to start the job, and the 
type of submission: Manual Submit, for example.

Workflow (Domain Job Status Only)—The Workflow column displays the name of the 
workflow that is processing or has processed this job.

Category (Domain Job Status Only)—The Category column displays the category of the 
workflow.

Note: Because the Domain Job Status workspace displays all of the jobs in the 
domain, the Jobs table also displays two additional columns of information not found 
in the Job Status workspace: Workflow and Category. It also displays an Emergency 
Stop button in the bottom right-corner. For details, see Stopping All Jobs in the 
Domain.

State—This column displays color-coded key words to identify the status of the job:

• In Process—the job is active (being processed).

• Paused—the actions in this job have been paused.

• Complete—all of the actions in this job have completed successfully.

• Failed—one or more of the actions in this job have failed.

• Waiting—the job is active, but is currently waiting for a resource (a service) to 
accept and process one of the actions in the workflow.

• Stopped by User—the job was stopped by a user.

• Waiting to Retry—the job is active, but is currently waiting for one of the actions in 
the workflow to re-execute.

Progress—The information displayed in the Progress column depends on the Detailed 
Job Progress setting in the Vantage Management Console.

If Detailed Job Progress is disabled, the Progress column displays the percentage of 
actions that are complete at the moment. For example, if you have a 10 action workflow 
and the 4th action is currently executing, Vantage will report the workflow as 30% 
complete.

If Detailed Job Progress is enabled, the progress column displays a percentage value of 
the current amount of time consumed compared to the total estimated time for the job 
to complete. Using the job’s start time to determine how long the job has been 
executing, you can use the progress percentage to extrapolate the approximate 
completion time, assuming the load on the domain remains relatively constant.
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Note: To change the Detailed Job Progress setting in the Vantage Management 
Console, start the console and click on Settings & Options > General Tab to set the 
Detailed Job Progress check box.

Started—Displays the time the job started by date and time.

Updated—Displays the last time the job record was updated (typically, when the job 
ended) by date and time.

Expires—Displays the time the job expires, and will be removed from the database 
(along with its binder). To change the expiration period for a workflow, select it and 
click on the title to display its detail panel, where the Expiration period is displayed. See 
Viewing and Specifying Workflow Details.

Using the Job Status Table’s Toolbar and Context Menu
The toolbar and context menu provide a variety of commands for managing jobs. The 
toolbar is displayed directly above the table.

The context menu has the same set of commands, with the exception of the Jobs Filter 
button (at far right in the toolbar), which is not specific to the selected job. To display 
the context menu, right-click on any job in the table.

• Show in groups —Organizes jobs by group, based on the primary column—the 
one you have selected. Click again to turn grouping off.

• Stop —Halts processing on this job. When you stop a job in process, each action 
for that job is notified to stop its own transaction. When all actions have been 
stopped, the job is considered complete, in a user-stopped state.

• Restart —If a job was stopped or it failed, re-starts and continue processing 
where it was stopped. Actions that fail or are stopped by a user are re-executed. 
When you restart a job, it is started as a first-time job again. This affects the execu-
tion of retry rules.

• Set expiration —Modifies the default expiration time for this job. Workflow 
Designer displays the Set Job Expiration dialog—specify a new expiration date and 
click OK.

• Delete —Deletes the selected job row(s). Or, right-click and select Delete.

• View Binder —Displays the selected job’s binder. Or, right-click an action or the 
job row in the table, and select View Binder. For details, see Viewing Binders.

• View Job Errors —Displays details about errors encountered in the job.

• Job Report —Creates a job report. Select one or more jobs in the table, and click 
on the Job Report button. For details, see Generating Job Reports Manually.

• Jump to Workflow —This button only displays in the Domain Job Status work-
space. To jump directly to the workflow for this job, select a job in the table and 
click the button.
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• Jobs Filter —Displays only jobs that contain specific text in the job name. Enter 
the text to begin filtering displayed jobs. Delete the text (or just close the filter by 
clicking the filter button) to display all jobs again.

Stopping All Jobs in the Domain
If you get in a situation where you need to immediately stop all running and queued 
jobs in the domain, you can use the Emergency Stop button, which is located in the 
bottom right corner of the Domain Job Status workspace.

Note: If possible, Telestream recommend using the Management Console to place 
the services in maintenance mode (or the Windows Services Console to stop the 
services) before using this command. 
After issuing a command to stop all jobs, it may take several minutes to complete. The 
time to completion is dependent on the volume of affected jobs in the database and 
the consequent load on the computers in the domain.

To stop all running and queued jobs in the domain using this button, follow these steps

1. Click the Domain Job Status workspace.

2. Click on the Emergency Stop button in the bottom right corner. 
Workflow Designer displays a warning dialog.

WARNING: The Emergency Stop button stops all active jobs in the domain, and can not 
be reversed. This will lead to a potential loss of work and/or data. You should only utilize 
this command in an emergency. (For example, mistakenly submitting thousands of jobs.) 
Ideally all services should be in maintenance mode before executing this command.

After clicking the 
Emergency Stop button 
to stop all of the jobs in 
the domain, Workflow 
Designer displays a 
warning dialog.

Emergency Stop button.
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3. Click Yes to Continue.

Workflow Designer issues the Emergency Stop command to the domain database.
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Generating Job Reports Manually
Workflow Designer allows you to generate job reports for the selected job or jobs, as 
comma-separated value (CSV) files. You can open these reports in spreadsheet 
programs and other programs that display CSV files, or you can use them in other 
systems, such as databases or media asset management systems.

Note: You can also configure a workflow to automatically generate a job report each 
time the workflow executes. See Enabling Automatic Reports in the Domain 
Management Console.

Each job report is based on a job report configuration you select (see Managing Job 
Report Configurations).

Note: If there are no job report formats, Workflow Designer displays a dialog that 
enables you to create one. Click OK to display the Job Report Manager (Managing Job 
Report Configurations).

To create a job report, follow these steps:

1. Select one or more jobs in the Job Status table.

2. Click on the Job Report button  in the toolbar (or right-click the jobs and select 
Create Report). Workflow Designer displays the Create Job Report dialog.

3. In the Create Job Report dialog, select a report format from the list and click OK. 

You can also click the browse  button to display the Job Report Manager window. 
For information about this window, see Managing Job Report Configurations. 

4. After selecting a report format, select where you want to save the CSV report file for 
the selected jobs, as shown in the following figure.
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Vantage displays the File System dialog, which you can use to select the server and 
directory where you want the CSV report file for the selected job or jobs stored, as 
shown in the following figure.

Optionally, enter a new name for the job report file (or append a date or other 
significant qualifier) and click Save to process the report and save the file as a CSV file. 

When the report file has been generated, Vantage displays a dialog to indicate where 
the file was saved. Click OK to close the dialog.



Monitoring Workflows and Managing Jobs
Managing Job Report Configurations

284
Managing Job Report Configurations
Before you can generate job reports, you must create at least one job report 
configuration. You can create multiple configurations; one for each type of job report 
you want to generate.

You use the Job Report Manager to create, edit, and delete job report configurations. 
(The Job Report Manager is also available in the Vantage Management Console.)

The following sections describe these tasks:

 Displaying the Job Report Manager

 Creating a New Job Report Configuration

 Choosing the Report Columns

 Duplicating a Job Report

 Deleting a Job Report
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Displaying the Job Report Manager
To display the Job Report Manager, follow these steps.

1. Display the Job Status or Domain Job Status workspace.

2. Select a job from the Job table.

3. Click the toolbar Job Report button  to display the Create Job Reports dialog:

4. Click the browse  button to the right of the report menu.

Workflow Designer displays the Job Report Manager window.

Toolbar buttons:
Create | Delete | Save | Duplicate
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Creating a New Job Report Configuration
To create or edit a job report configuration, do the following:

Note: Vantage domain administrators can also create report formats with the 
Vantage Management Console.

1. To create a new job report configuration, click the Create report button .

Workflow Designer adds a new report to the report list and selects it.

2. To edit a job report configuration, select it from the list.

3. Enter a name in the Name field.

4. Optionally, enter a report description in the Description field.

5. Click the Save button .

To include or exclude a header row in the job report:

1. Check the Add Header Row check box to include the header row, or clear the 
checkbox to exclude the header row.

2. Click the Save button .

Choosing the Report Columns
You can configure reports to include or exclude the following columns:

• Job ID

• Job Name

• State

• Progress

• Started

• Updated

• Expires

• Workflow Name

• Additional columns for metadata label parameters

When you choose to display a column for a metadata label, the column displays the 
label value.
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To define which columns appear in a report, do the following:

1. Under Columns, check (display) or clear (hide) the check boxes for the columns you 
want to display.

2. To add or delete columns for metadata labels, do the following:

a. Click the Add Column button  to display the Select Label Parameters for 
Columns dialog.

b. In the Labels panel, select a label for which you want to display parameters.
c. In the Parameters panel, check the checkbox for any parameter you want to 

display, and clear the checkbox for any parameter you do not want to display.
To toggle the display of parameter by category, click the Category button . 
One display state displays parameters with category headings; the other displays 
them without category headings.

d. Repeat parameter label selection until all labels are properly selected.
e. Click OK.

3. To change the displayed order of parameter labels, select a label in the list and use 
the green up  and down arrow  buttons to move the label in the list.

The top item in the list appears to the right of the columns listed in the Columns 
row, and to the left of all the other label columns. The last item in the list becomes 
the last column on the right.

4. Click the Save button .

Duplicating a Job Report
When you duplicate a job report, a new report is created with a modified report name. 
All settings in the duplicate report match those in the original report.

To duplicate a job report, do the following:

1. Select the report to duplicate.

2. Click the Duplicate button .

3. In the Name text box, enter a name for the duplicate report.

4. In the Description text box, optionally enter a description for the duplicate report.

5. Click the Save button .

Deleting a Job Report
To delete a job report, select the report and do the following:

1. Click the Delete button .

2. When the confirmation dialog displays, click OK.
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Viewing Binders
The Binder panel displays information about files ingested or generated in a job (or 
subsequent jobs, when the Register action is configured to overwrite binders when a 
file of the same name is submitted (Conflict Resolution)).

Assets in a binder can include media files, metadata labels, and attachment files.

To view the binder for the selected job, choose:

• Click the binder button  in the toolbar

• Right-click on any action, or job row in the table, and select View Binder. 

• Double-click the job row in the table.

Media Files tab—Displays a list of media files ingested or created in the job, including 
the file’s path, nickname, and filename. To the right is a WMV player, where you can 
preview the selected file provided that it is playable by Windows Media Player 
(typically, WMV, AVI, and ASF files, depending on your configuration).

Alternatively, you can right-click on any file and select one of two options:

Open Containing Folder—displays the Windows directory where the file is stored.

Open With Default Program—opens the file in the program specified as the default 
program to open these types of files.

Note: When running Workflow Designer on Windows Server 2008, unless the 
Desktop Experience feature is installed, you can’t review media. For details, see 
Windows Server 2008 Requirements in the Vantage Domain Management Guide.
See also Configuring Server 2008 to Solve Display Problems for Vantage Programs.

Metadata Labels tab—Displays metadata labels in the binder, their parameters and 
values. (You cannot edit values in this viewer.) 
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Attachments tab—Displays a list of attachment files, including each file’s path, 
nickname, and filename.
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Controlling Action Execution in Jobs
These topics describe how you can control actions in your jobs:

 Pausing and Resuming Flip Actions

 Pause for Priority in Flip Actions

 Setting Action Execution Priority

Pausing and Resuming Flip Actions
To pause and resume Flip actions in a job in progress, right-click on the action and 
select Pause from the context menu. To resume a paused action, right-click on the job 
and select Resume from the context menu.

You cannot pause actions in certain states or in certain workflows. For example, you 
cannot pause an action that has failed. Also, you cannot resume an action downstream 
of another failed action, without restarting the first failed action, etc.

Pause for Priority in Flip Actions
Pause for Priority is an automatic feature of Flip actions. If a Transcode Service is 
saturated (that is, it is performing the maximum number of jobs it is set for); then 
Vantage will queue up incoming jobs and wait for a slot to become available. 

For example, a Transcode Service is configured to run 2 simultaneous jobs; it receives 
three jobs (A, B and C); jobs A and B begin execution (the service was idle prior to this) 
and C is queued until either A or B completes, at which point C will execute).

Pause for Priority comes into play if job C has a higher execution priority than job A or B. 
in this case, job A is paused and job C begins processing immediately. When Job C or B 
completes; then A (which was previously paused) returns to processing.

Setting Action Execution Priority
You can modify the execution priority of actions in a running job, when they are in the 
Wait, Pause, or Running states. You cannot set an action priority for a completed action. 
To change the priority of an action that has not completed, do the following:

1. Right-click the action and select Priority to display the Action Priority dialog.

2. Change the priority value (larger numbers means higher priority), and click OK to 
modify the action’s priority in this job.
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Viewing Action Status
To view details about the status of any action in a job, select the job in the jobs list, 
right-click the target action in the workflow, and select Status.

The Status/History dialog provides details about each aspect of the action’s execution. 
You can use this information to gather details about its execution, and when an action 
fails, you can use this information to determine why and correct the problem.

Each line in the upper panel of the Status/History dialog provides a summary of some 
aspect of action execution. To display more information related to a line in the upper 
panel, click on the line. The detailed information appears in the lower panel. 

The symbol to the left of the summary lines in the upper panel allow you to hide or 
expose subordinate summary lines. Click a symbol to hide or display subordinate 
summary lines.

Export—Click Export to display a File System dialog, and save the status/history 
information as an XML file. You can send these files to Telestream for support issues, or 
export them for processing in other systems.

Session Log—To display a session log, select a session in the upper panel and click 
Session Log.

Click Done to dismiss the Status/History window.
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Using Workflow Analytics
Use this chapter to learn how to use Workflow Designer to analyze workflows and job 
history to identify problems and improve overall system performance.

 Workflow Analytics Overview

 Using the Workflow Analytics Panel

 Performing Bottleneck Analysis

 Performing Execution Analysis

Note: Features in editions for which you do not have a license are disabled, and 
indicate that you need a license to use them.
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Workflow Analytics Overview
Workflow analytics is an optional, licensed feature in Workflow Designer, and requires a 
Reporting and Analytics license. Workflow analytics enables you to visually analyze 
workflows and job history to identify problems and improve overall system 
performance.

In Workflow Designer, workflow analytics enables you to view jobs (based on the job 
history currently in the database) on a case-by-case basis to:

• Identify performance bottlenecks by action in a workflow

• Analyze workflow execution as a result of decisions in a workflow

• Visualize the progress of multiple jobs submitted to a workflow

• Rank workflows and actions, based on processing time consumption.

Note: Because workflows may be modified over time, jobs run in the selected 
workflow prior to the last change are ignored.

Vantage administrators and personnel responsible for designing and implementing 
workflows can use this information to modify workflow design and improve Vantage 
domain performance and efficiency.

Note: In the Management Console, workflow analytics enables you to analyze 
workflows at the domain level. For details on using workflow analytics in the Vantage 
Management Console, click the Help button in the toolbar to display the Vantage 
Domain Management Guide.

Workflow analytics automatically includes new jobs that are submitted, as appropriate, 
displaying them in the Jobs table and recalculating metrics.
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Using the Workflow Analytics Panel
Click the Workflow Analytics tab (or click File > Workflow Analytics), and select the 
workflow in the Workflows panel to view job history information, which helps you 
identify performance bottlenecks and collect workflow processing statistics.

Actions display the average execution time, and stack rank time relatively by color—
green (fastest) through red (slowest).

To select a workflow to view, use the Workflows list to the left of the Workflow Analytics 
tab. Open the appropriate workflow category and click on any workflow to select it. You 
can then view all of the job history records for the selected workflow in the Workflow 
Analytics tab.

After making your job selection (see below), click the Run Analysis button to begin near 
real-time display of the analytics data. To stop calculating and updating the data (or to 
change the jobs you want to analyze), click Stop Analysis.

The following topics provide additional information:

 Using the Jobs Table Toolbar

 Using the Jobs Table

Using the Jobs Table Toolbar
The toolbar for the Jobs table displays buttons for the following commands:

Groups—Click to organize the jobs by group, based on the primary column—the one 
you have selected. Click again to turn grouping off.

Filter—Click to display (and thus determine the set) only jobs that contain specific text 
in the job name. Enter the text to begin filtering displayed jobs. Delete the text to 
display all jobs again.

Jobs Table with toolbar Analysis Options
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Using the Jobs Table
Click any column in the Jobs table to make it the primary column and sort it in 
ascending or descending order.

When you first select a workflow, no jobs are selected, so all jobs are considered in 
calculating the metrics. Select any job or jobs (shift-click or control-click) to view the 
selected set’s analytic details.

To de-select all jobs and return the table to its original state, select one record, then 
control-click to de-select it.
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Performing Bottleneck Analysis
Select Bottleneck Analysis from the popup menu on the far right. Workflow Designer 
displays elapsed time for the selected records in the job history set.

In bottleneck analysis (which is enabled by default), you can identify the longest 
running actions in a workflow, based on color and time values.

Color values are applied to each action from green to red on a sliding scale, based on a 
comparison of the average of all selected job records. The shortest average execution 
time displays the darkest shade of green; the longest displays red. Those in between 
display color values through yellow-green, yellow (average), and orange.

Numeric values on each action display the average execution time of the actions which 
ran, based on the selected job records.

When performing bottleneck analysis, choose:

• Include Waiting Time—Check to add wait time to execution time and display the 
combined total time for each action. Wait time includes time spent in a Waiting 
state and a Paused state. Uncheck to display only execution time.

• Count Non-running Actions—Check to include the execution time (0 seconds) of 
actions that did not run, thus providing a weighted bottleneck analysis based on 
which branches in a workflow executed, based on decision actions. This allows you 
to focus upon the actions which are bottlenecks in real-world operations. 

Uncheck to disregard non-running actions when calculating the execution time. This 
allows you to find the most expensive actions, regardless of whether or not they are 
commonly run.
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Performing Execution Analysis
Select Execution Analysis from the popup menu on the far right. Workflow Designer 
displays percentile and numeric values for the selected records in the job history set.

In execution analysis, you can determine which percentage and number of actions 
executed, based on the selected job history set, based on color and percentile values.

Color values are applied to each action from black to green on a sliding scale. The 
lowest average execution displays the darkest shade of black; the highest displays 
green.

Darker actions are those that have not executed yet (near zero percent). Dark green 
actions are average (near 50 percent), and the highest percentile executing actions are 
bright green (approaching 100 percent). 

For each action, the percent of executions completed is calculated against the total 
number of jobs, based on your selected job criteria.

When using execution analysis, choose your job criteria:

All Jobs | Only Completed Jobs | Only Successful Jobs—Select to include all selected jobs 
regardless of their status, only completed jobs (thus excluding running or partially 
completed jobs), or only successful jobs in the calculations.
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Using Workflow Portal
This chapter describes the Vantage Workflow Portal, a client program (also available in 
a web version) designed for customizable, operator-driven media processing. Several 
Workflow Portal configurations are provided to implement specific operational needs. 
The configurations allow you to customize functionality and the user interface and 
generate a specific output (for example, DPP configurations). 

Workflow Portal configurations are created and configured in the Vantage 
Management Console, and loaded in the Workflow Portal application when it is 
launched, to perform specific media processing tasks.

Note: Workflow Portal is an optional, licensed Vantage feature. For details about 
licenses, see Vantage Workflow Portal Licensing in the Domain Management Guide. 

The Windows client provides optimum performance and the full feature set. The web 
client can be used on any computer with a supported web browser (see Web 
Application Browser Requirements) and a network or Internet connection to your 
Vantage domain. Not all configuration types are usable in the web client. 

Most topics described here apply to both clients, except where noted.

The following topics introduce and describe the Workflow Portal:
 Workflow Portal Overview
 Workflow Design Guidelines
 Starting a Workflow Portal Session
 Changing or Reloading a Configuration
 Managing Workflow Portal Projects
 Performing Workflow Portal Tasks
 Windows Client Menus
 Web Client Menus
 Troubleshooting Workflow Portal

Note: For detailed information on how to operate each type of Workflow Portal 
configuration, see Using Workflow Portal Configurations.
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Workflow Portal Overview
Video processing workflows frequently require some form of operator intervention 
during media processing. For example, an operator might run media through an ingest 
workflow to create a proxy, scrub and set trim points, review and add/edit metadata 
and variables, and then submit media to another workflow for production processing.

Note: For basic information on using Vantage client programs, see Vantage Client 
Programs Overview.
On Windows Server 2008, you may have problems minimizing windows if you 
maximize them by dragging them to the top of the monitor (AeroSnap). To disable 
AeroSnap, go to Control Panel > Ease of Access Center > Change how your mouse works. 
Check Prevent windows from being automatically arranged when moved to the edge of 
the screen.

 Key Applications

 How Workflow Portal Works

 Key Workflow Portal Features

 Workflow Portal Configuration Types

 Implementing Workflow Portal-based Media Processing

Key Applications
Key applications of Workflow Portal include:

• Highlight Extraction From Archive Files—An operator marks in and out timecodes 
and chooses the timecode for a thumbnail, and processes the media in a workflow 
the creates the clip.

• Promo Preparation—An operator marks the voice-over and graphics entry points 
on the timeline. A subsequent workflow reprocesses the promo for multiple mar-
kets, days, and languages, based upon this input.

• Clip Stitching—An operator can select media files of various metrics and define clips 
within that media, then submit the EDL to a stitching workflow to combine the 
clips and render them into a single output file.

• VOD Distribution—An operator creates a playlist of clips and enters metadata. A subse-
quent workflow merges (stitches) the clips into a single media file and transforms meta-
data for distribution.

• VOD Digital Ad Insertion—An operator defines ad locations for dynamic ad insertion by 
the cable vendor, and submits jobs for assembly of CableLabs VOD content and pro-
visions it for dynamic ad insertion (DAI).

• TrafficManager—An operator searches catalogs, then reviews and submits commer-
cial inventory for processing to a specific publishing workflow.

• TrafficManager Syndication—An operator searches catalogs, then reviews and submits 
syndicated inventory for processing to a specific publishing workflow.
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• DPP Package Preparation—An operator enters DPP metadata, marks programme seg-
ments, and submits the assets to a workflow. Vantage adds bars, generates slates, and 
encodes to the appropriate MXF format with DPP metadata to create a DPP package.

• CML Preparation—An operator creates clips, and submits the auto-generated composi-
tion (CML file) to a Conform-based workflow to generate the specified output.

• Re-timing of assets— An operator selects a media file and submits it to a Tempo-based 
workflow for re-timing— intelligently decreasing or increasing the running time of 
shows and segments. Tempo utilizes new time compression algorithms that deliver 
superior quality and faster turn-around times.

How Workflow Portal Works
This figure depicts how Workflow Portal is typically used in a Vantage domain.

Operator-access to job variables and media metadata is a powerful feature that enables 
operators to control the operation of the next workflow. For example, operators can 
edit embedded and label metadata parameters, modify variables to control content 
routing, or select other processing options in the next workflow.

Key Workflow Portal Features
Workflow Portal provides several features for performing operator-intervention media 
processing workflows. Workflow Portal has a customizable user interface where 
components and features are controlled by a configuration file, created in the 
Management Console, and loaded in Workflow Portal when launched by an operator.

Based on your application, these features allow operators to:

• Browse Vantage catalogs and Windows servers for media (saved in binders) from 
completed jobs and submit them to workflows.

Workflow designers create 
workflows and Vantage 
administrators create Workflow 
Portal configurations to support 
Workflow Portal operators.

Operators use Vantage Workflow Portal to search 
catalogs, update metadata and trim points, 
perform review and approval, and submit media 
for processing to specific workflows.
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• Create an Edit Decision List (EDL) of clips for stitching with a Flip action workflow 
(Windows client only).

• Create a Composition (CML) file of clips for stitching with a Post Producer Conform 
action workflow (Windows client only).

• Create/review/update XML-based or label-based metadata.

• Review/edit embedded metadata.

• Preview/scrub media proxies.

• Mark in/out trim points on an asset’s timeline.

• Mark media as approved or rejected.

• Supply run-time values to variables to use in the next workflow.

Workflow Portal Configuration Types
Vantage provides several configuration types. Each type has specific functionality, 
implementing a common media processing application. Here are the configuration 
types as specified in the management console, along with their common names:

• Browse Catalogs (copy binder)—Copy Binder Portal

• Browse Catalogs (forward binder)—Forward Binder Portal

• Browse Windows Network (create binder)—Windows Portal

• Create EDL from Catalogs (create binder)—EDL Portal

• Create CML from Catalogs (create binder)—CML Portal

• Create DPP from Catalogs (create binder)—DPP Portal

• Create VOD from Catalogs (create binder)—VOD Portal

• Re-time Asset from Catalogs (create binder)—Tempo Portal

• Syndication—Syndication Portal

The names on the left match the names a domain administrator sees when creating a 
Workflow Portal configuration in the management console. The shortened names that 
appear after the dash are the common names used in this and other guides.

Note: Only the Browse Catalogs Copy Binder and Forward Binder configurations can 
be used in both the Workflow Portal web client as well as the Windows client. All other 
configurations can only be used in the Windows client.

The Copy Binder and Forward Binder, as well as the Create EDL, CML, DPP, Tempo, and 
VOD configurations allow operators to browse Vantage catalogs and select binders that 
have been registered by a previous job for processing.

The Browse Windows Network configuration allows operators to browse a Windows 
server (not a Vantage catalog) to select media files. (Binders only exist in the context of 
a Vantage catalog.)
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Each type of configuration causes Workflow Portal to operate differently, to achieve its 
intended result. The operation of the basic configurations are explained in detail in 
Using Workflow Portal Configurations. Configurations offered as Vantage editions are 
described in a separate user guide.

Each of the configuration types are summarized in these topics:

 Browse Catalogs Copy Binder and Forward Binder Configurations

 Browse Windows Network Configuration

 Create EDL from Catalogs Configuration

 Create CML from Catalogs Configuration

 Create DPP from Catalogs Configuration

 Create VOD from Catalogs Configuration

 Re-time Assets from Catalogs Configuration

 Syndication Configuration

Browse Catalogs Copy Binder and Forward Binder 
Configurations
The purpose of both Browse Catalogs configurations is to enable operator-intervention 
media processing on Vantage catalog-based media. That is, the media has already been 
processed by a Vantage workflow and registered in the catalog, potentially along with 
other job-related assets: attachment files, metadata labels, etc. The operator can enter 
and edit label-based metadata for the selected media, and also update variables as 
required for the workflow. Browse Catalogs configurations are intended for processing 
a single file; they do not support creation of a clip list and stitching.

Both types of configurations are supported in the Workflow Portal web app and the 
Workflow Portal Windows client.

In a Browse Catalog Copy Binder Portal, the operator can browse catalogs, select a 
binder and submit a job to a workflow to process the media—after clicking the Submit 
button. When the operator clicks the Submit button, the selected binder is copied—
duplicated and used only as a template for the current job—leaving the original binder 
unchanged and intact in the catalog for future use or re-submittal. The job (as always) 
creates a binder during execution; it may or may not be registered by the workflow into 
a catalog for further utilization.

In contrast, in a Browse Catalogs Forward Binder Portal, the operator browses a catalog 
and selects a binder—before clicking the Submit button. The selected binder (with any 
changes the operator makes) is submitted to the workflow—without making a copy. 

Forward binder mode allows the workflow to modify the contents of the original 
binder, and those modifications will be visible the next time the user refreshes the 
binder in the portal.
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Browse Windows Network Configuration
The general purpose of the Browse Windows configurations is to enable operator-
intervention on media processing, where the media files are stored directly on a 
Windows platform. The operator can review and edit label-based metadata for the 
selected media, and also update variables as required for the workflow. 

The Browse Windows configuration is supported only in the Windows client.

The Browse Windows Network Portal (Windows Portal for short) allows you to select 
one or more media files from servers on a Windows network and submit them to target 
workflow(s). The job (as always) creates a binder during execution; it may or may not be 
registered by the workflow into a catalog for further utilization.

Create EDL from Catalogs Configuration
The EDL Portal enables you to automatically create an Edit Decision List (EDL) which the 
operator submits to a Flip-based workflow to process the EDL. When creating an EDL, 
the operator selects the media files to submit by browsing Vantage catalogs and 
selecting one or more binders created from previously-completed jobs. 

The Create EDL from Catalogs configuration is supported only in the Workflow Portal 
Windows client.

You can mark start and end points to clip your input media files, and then stitch the 
selected clips together in the workflow to which you submit the EDL. The EDL 
configuration publishing workflow must use the Flip action to stitch and encode the 
media. The EDL Portal requires that all clips have the same frame rate, frame size and 
video codec.

The operator can also review and edit label-based metadata for the selected media, 
and also update variables as required for the workflow. The job creates a new binder 
from assets in or more source binders and updates it during execution; it may or may 
not be registered by the workflow into a catalog for further utilization.

Create CML from Catalogs Configuration
The CML (Composition Markup Language) Portal is designed to automatically create a 
Composition (CML) file that defines an EDL—the set of clips you’ve added from media 
registered in catalogs, which you submit to a Post Producer publishing workflow with a 
Conform action. The Conform action processes the composition, stitching the clips and 
renders a single media file as output, based on the specifications in the CML.

The Create CML from Catalogs configuration is supported only in the Workflow Portal 
Windows client.

While the EDL Portal requires that all clips have the same frame rate, frame size and 
video codec; the CML Portal does not have this restriction. CML processing by Conform 
also improves VANC and caption processing.

The operator can review and edit label-based and embedded metadata for the selected 
media, and also update variables as required for the workflow. The job creates a new 
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binder from assets in or more source binders and updates it during execution; it may or 
may not be registered by the workflow into a catalog for further utilization.

Create DPP from Catalogs Configuration
The purpose of the DPP Portal is to enable operators to assemble and produce media 
files that conform to the current DPP standard, for broadcast in the UK market.

The Create DPP from Catalogs configuration is supported only in the Workflow Portal 
Windows client.

You use a DPP Portal to browse catalogs and select binders from completed ingest 
workflows jobs, enter metadata and mark programme parts, then submit it to a 
publishing workflow to generate DPP-compliant media which comprises the 
programme. A DPP configuration defines each field of DPP metadata in the 
programme, may be given a default value, and may be marked as read-only. In 
addition, the portal may be configured for either SD or HD.

The job creates a new binder from assets in or more source binders and updates it 
during execution; it may or may not be registered by the workflow into a catalog for 
further utilization.

Create VOD from Catalogs Configuration
The VOD Portal is designed to enable operators to prepare VOD assets, including digital ad 
insertion, metadata, captioning, ratings, branding, and copy protection, and submit them 
to a publishing workflow that encodes VOD assets and deliver them to multi-channel video 
programming distributors (MVPDs).

The Create VOD from Catalogs configuration is supported only in the Workflow Portal 
Windows client.

You use a VOD Portal to browse catalogs and select binders from completed ingest 
workflows jobs, enter metadata and mark programme parts, then generate CableLabs-
compliant media. The operator can review and edit label-based and embedded 
metadata for the selected media, and also update variables as required for the 
workflow. The job creates a new binder from assets in or more source binders and 
updates it during execution; it may or may not be registered by the workflow into a 
catalog for further utilization.

Re-time Assets from Catalogs Configuration
Use Tempo Portal to browse catalogs and select source media that you want to re-time, 
create and mark clips to include or exclude from re-timing, and specify how much time 
expansion or compression to apply. 

The Re-time Assets from Catalogs configuration (commonly called the Tempo 
configuration) is supported only in the Workflow Portal Windows client.

When configuration of re-timing is complete, the Portal generates a composition to 
describe that processing. The operator selects a Tempo workflow to process the CML, 
and the Tempo action in the workflow implements the re-timing of the media file. The 
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job creates a new binder from assets in or more source binders and updates it during 
execution; it may or may not be registered by the workflow into a catalog for further 
utilization.

Syndication Configuration
Use the Syndication Portal to browse catalogs and select syndicated source media that you 
want to review, update, and submit for processing in TrafficManager for broadcast. 

The Syndication configuration is supported only in the Workflow Portal Windows client.

The Syndication Portal displays the selected media in a segmented view, based on the 
timing information obtained from the original syndication source (for example, PitchBlue).

When your review of segments and their attributes is complete, in Segmenting and 
Stitching modes, the Portal generates a new mezzanine metadata XML file as well as a 
composition (CML) file. The operator selects a publishing workflow to process either the 
mezzanine metadata file or the CML file for broadcast.

When using Pass-Thru mode, the Syndication Portal does not generate a CML. In Pass-
through mode, the Portal generates an XML (similar to the other modes), but in 
addition passes the source media from the ingest workflow—which must be 
nicknamed Original— to the publishing workflow, so that the program can be 
transcoded without having to change the program's timeline.

Implementing Workflow Portal-based Media Processing
Implementing Vantage workflows that are intended for use with Workflow Portal 
requires planning and coordination by your Vantage administrator and workflow 
designer. To implement a Workflow Portal-based workflow, a Vantage domain 
administrator must first use the Vantage Management Console to do the following:

• Enable the utilization of Workflow Portal.

• Configure one or more Workflow Portal configurations, which define the Workflow 
Portal feature set for the specific application, including the components, features, 
and resources available to operators. This includes metadata and variables, and 
must be coordinated with the workflow designer to utilize the metadata and vari-
ables as appropriate for your application.

Note: Administrators who are responsible for creating Workflow Portal configurations 
should refer to the Vantage Domain Management Guide for details.

Workflow designers use Workflow Designer to create and configure the required 
workflows, including required metadata and variables, and activate them when you 
want to use them in testing or production.

Typically, a given media processing application involves at least 2 Vantage workflows:

• An ingest workflow, which transcodes media as required and registers it in a catalog 
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• A publishing workflow, which processes the media the operator has selected and 
forwarded to the workflow to encode it for publication.
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Workflow Design Guidelines
This topic is for those who are designing and implementing workflows. It provides 
general guidelines for creating workflows intended for use in Workflow Portal 
applications.

Note: In addition to these general guidelines, there may be application-specific 
guidelines that must also be followed. These guidelines are noted in their respective 
topics in Using Workflow Portal Configurations for basic configurations; for product-
specific guidelines, see the Tempo User Guide or the VOD Portal User Guide.

While you can use a single workflow to produce and distribute media, there are some 
media processing applications which require operator intervention using Workflow 
Portal, thus dividing the media processing into multiple workflows. Operator 
intervention tasks include QA, building clip lists, and for adding/editing metadata and 
variables prior to job submission for further processing.

Workflows for use in conjunction with Workflow Portal typically fall into two categories: 
ingest and publishing. 

For example, an ingest workflow can automatically analyze source media and detect 
media attributes and characteristics such as frame rate, dimensions, letterboxing, and 
macroblocking. Ingest workflows often encode media into the required format for use 
in the publishing workflow. You typically use Register actions in the ingest workflow, to 
create binders in Vantage catalogs, which operators will browse for files to process.

Ingest workflows can also produce proxy media that you can view with the Workflow 
Portal media player to evaluate quality issues and quickly define timecodes for trim 
points or commercial insertion, for example.

A publishing workflow is a workflow designed to process media submitted by Workflow 
Portal operators. Publishing workflows always start with a Receive action so that 
operators can submit jobs to them (and they must be running). When your application 
calls for an ingest workflow, you use Workflow Portal to evaluate the ingest workflow 
results, take any action required, and then submit the job to a publishing workflow. 
Frequently, a given application has more than one publishing workflow. 

You can also chain publishing workflows, providing operator intervention at more than 
one point in the process.

You might use Workflow Portal in a Browse Windows Network configuration, where 
your process may not require an ingest workflow. You can use Workflow Portal to select 
media, edit metadata and variables and submit jobs to a publishing workflow, rather 
than just placing media files in a watch file for automated processing. The advantage to 
operator submission is that you can set metadata and variables during submission, 
providing more control over publishing workflow processing.

These topics provide guidelines for creating workflows for use with Workflow Portal:

 Ingest Workflow Guidelines

 Publishing Workflow Guidelines
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Ingest Workflow Guidelines
When you use any Workflow Portal configuration other than Browse Windows Network, 
an ingest workflow, you must use an ingest workflow with a Register action (which 
should be located after all transcoding, and any metadata and variable modifications in 
the workflow), to create a binder in a catalog. One binder is created for each job that 
executes. In addition to referencing each file ingested or created in the workflow, 
metadata labels which you specify are stored in the binder, along with variables. 

You can use the special nicknames Vantage EDL, Vantage Proxy, and Vantage Thumbnail 
in Workflow Portal ingest workflows Flip action for identifying specific-purpose files:

• Vantage EDL—in the Program Stream and Transport Stream encoders, for EDL con-
figurations.

• Vantage Proxy—in the QuickTime and MP4 encoders, for all configurations which 
create clip lists and/or utilize the media player to scrub media

• Vantage Thumbnail—in the Keyframe encoder for configurations where you can 
browse catalogs.

When you browse catalogs in Workflow Portal, you can view binders created by each 
job, giving you access to all resources defined in the binder, including the source media.

When building ingest workflows, observe the following general guidelines:

• Register Action Requirements—to make a binder available to Workflow Portal opera-
tors in any catalog-enabled configuration, use a Register action to save the binder 
in the appropriate catalog.

• Workflow Portal Windows Client Media Player Requirements—Use the Flip action to 
create a proxy file, using the nickname Vantage Proxy. Required format:

– QuickTime encoder, H.264 video codec, AAC audio codec, QuickTime 7.6.9 
installed

OR

– MP4 encoder, x264 video codec, AAC audio codec, QuickTime 7.7.6 installed

• Make sure that your encoded proxy file is the same frame rate and timecode nota-
tion as your production media. Configure container settings to generate a time-
code track to support the Use Clip Start Time feature. You can also burn in the 
timecode to make sure it is present.

• Workflow Portal Web Client Media Player Requirements—Use the Flip action to create 
a proxy for previewing in the HTML5 media viewer. The required format is:

Encoder: MP4 Encoder

Video Codec: x264

Audio Codec: AAC

Container: MP4 File

Make sure that your encoded proxy file is the same frame rate and timecode nota-
tion as your production media.
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• Proxy Viewing—to enable a selected binder’s media file to automatically display in 
the Workflow Portal media viewer, assign the Vantage Proxy file nickname to the 
media file. 

• Catalog Viewing—To support operator viewing of binders by thumbnail (instead of 
by name), configure a Flip action with the Keyframes encoder to create a thumbnail 
that uses the Vantage Thumbnail file nickname.

• Metadata and Variables—To make media information available to operators for ver-
ification or editing, configure an Analysis action (or a Workorder action for submit-
ting multiple jobs at one time, with metadata) to collect the information in 
variables. Use a metadata label to store this information in a binder to pass the val-
ues to another workflow indirectly. For example, an operator submits a job to a 
publishing workflow in Workflow Portal.

Publishing Workflow Guidelines
Unlike ingest workflows, publishing workflows can be designed and configured in 
almost any way you require. Few limits are imposed on the design of a publishing 
workflow that is used by Workflow Portal.

When you configure publishing workflows, follow these guidelines:

• The publishing workflow must start with a Receive action so that an operator can 
submit media to it for processing.

• The publishing workflow should be configured to accept and process any metadata 
labels and variables that an operator enters, or that pass through from the ingest 
workflow jobs.

• Choose the type of transcoding action required to produce the output media you 
want and the Workflow Portal configuration you’re using. For example, an EDL Por-
tal job requires a Flip action, while a CML Portal configuration requires a Conform 
action.

There may be additional requirements for various configurations. See the respective 
configuration topic in Using Workflow Portal Configurations or the app note or guide on 
the topic.
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Starting a Workflow Portal Session
The following topics describe how to start sessions with the Workflow Portal clients, 
and how to load a different configuration:

 Starting a Session with the Windows Client

 Starting a Session with the Web Client

Starting a Session with the Windows Client
To start a session with the Workflow Portal Windows client, do the following:

1. Start the Windows client as described in Starting Workflow Portal.

2. If you are prompted to select a Vantage domain, select a domain as described in 
Selecting the Vantage Domain.

If you do not know the Vantage domain name, contact your Vantage domain 
administrator.

3. If you are prompted to enter a Vantage user name, log in as described in Changing 
Vantage Users in Windows Client Programs.

If you do not know your Vantage user log in information, contact your Vantage 
domain administrator.

4. If you are prompted to select a Workflow Portal configuration, select the 
configuration you want to use for this session.

To change the Workflow Portal configuration, see Changing or Reloading a 
Configuration.

Starting a Session with the Web Client
To start a session with the Workflow Portal web client, do the following:

1. Start the web client as described in Starting & Stopping Vantage Web Applications.

2. If you are prompted to select a Vantage domain, select a domain as described in 
Logging In or Changing Domains from Web Applications.

If you do not know the Vantage domain name, contact your Vantage domain 
administrator.

3. If you are prompted to enter a Vantage user name, log in as described in Changing 
Vantage Users in Web Applications.

If you do not know your Vantage user log in information, contact your Vantage 
domain administrator.

4. If you are prompted to select a Workflow Portal configuration, select the 
configuration you want to use for this session.

To change the Workflow Portal configuration, see Changing or Reloading a 
Configuration, below.
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Changing or Reloading a Configuration
You can change Workflow Portal configurations while you are running Workflow Portal.

If a Vantage domain administrator updates a Workflow Portal configuration while you 
are using it, the program continues to use the configuration as it was when you 
selected it. To obtain the updated version, reload it when advised by the administrator.

 Changing/Reloading a Configuration in the Windows Client

 Changing/Reloading a Configuration in the Web Client

Changing/Reloading a Configuration in the Windows Client
To change or reload a configuration in the Windows client, do the following:

1. Select File > Change/Reload Application Configuration.

2. When the Select Configuration dialog appears, select a configuration to use and 
click OK.

Changing/Reloading a Configuration in the Web Client
To change or reload a configuration in the web client, do the following:

1. Select Portals.

2. Select the configuration to which you want to change.

3. When the confirmation dialog appears, click OK.
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Managing Workflow Portal Projects
In any Workflow Portal configuration in the Windows client, you can select media and 
set up a job (with clips, metadata, variables, etc.) and submit it, then start over with new 
media for the next job, etc. You can also start working on a new job, and then save it, 
and open it later to complete the work and submit it for processing. 

In Workflow Portal, the collective settings are referred to as a project. Using projects in 
Workflow Portal is similar to opening and working on files in Microsoft Word or Excel. 
You can create, edit, save, and re-open them any time you want.

Note: Projects are only valid for the domain they are created in and the Workflow 
Portal configuration they were saved from. You can not save projects from one domain 
and re-open the project for use in another domain. You also can not re-open a project 
if the configuration from which it was saved has been deleted from the domain.

 Creating a New Project

 Saving a Project

 Saving a Project With Another Name

 Opening a Project

Creating a New Project
To create a new project in Workflow Portal, select File > New Project.

Creating a new project is just like opening Workflow Portal and starting work. No media 
has been selected, no clips (if enabled) have been created or configured, and no 
metadata or variables have been modified. Everything is reset.

Creating a new project is handy if you are working continuously on selecting media 
and preparing it for submission to a workflow, then getting ready to select new media 
and starting another job: It clears out everything so you can start over again.

You can also create a new project when you have made an error thats not easy to fix, or 
you just want to start over with a clean slate.

You don’t have to create a new project just because you may want to save it later.

Saving a Project
To save work you are performing on a given set of media, select File > Save Project.

When you save a project, Workflow Portal displays a File Save dialog. You can name the 
XML file anything you want, and save it where ever you want.

Note: Unlike other Vantage resources—workflows, Workflow Portal configurations, 
variables, etc. which are all stored in the Vantage domain’s database—Workflow Portal 
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projects are stored as XML files in a Windows directory of your choosing, just like any 
other program’s data files.

Each time you save the project after the first time, it just updates the project file.

You can re-open it later using the Open Project command.

Saving a Project With Another Name
To save a project you have open under another name, select File > Save Project As. 
Workflow Portal displays a File Save dialog. You can rename the XML file anything you 
want, and save it where ever you want.

You can re-open it later using the Open Project command.

Opening a Project
To open a project that has been previously saved, select File > Open Project. Workflow 
Portal displays the Open File dialog. Navigate to the file and click Open.
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Performing Workflow Portal Tasks
The following topics describe how to use the components that comprise Workflow 
Portal, to perform these basic tasks:

 Browsing Catalogs for Media

 Selecting a Binder

 Previewing Proxy Media in the Media Player

 Creating Clip Lists/Segments (EDLs)

 Editing Metadata Labels

 Specifying Variable Values

 Specifying Publishing Workflows

 Submitting Jobs in the Windows Client

 Submitting Jobs in the Web Client

Browsing Catalogs for Media
You can browse catalogs and select media in binders in all configurations except 
Browse Windows Network configurations.

Note: The binder list doesn’t automatically update when binders are added or 
deleted as workflow jobs execute. To update the list, click the Refresh button at the 
top of the Binder table.

Depending on your configuration, you may be able to perform the following:

• Browse and select binders from multiple catalogs

• Select specific media in a binder for submission

• View the list of media in a selected binder

• Manually delete binders

Selecting a Binder
To select a binder, do the following:

1. If the Catalogs panel (in the top left corner of the window) displays, select the 
catalog or catalog folder you want to browse.

Note: The catalogs that you can access are specified in the configuration. The catalog 
browser may be hidden, when the configuration only allows access to one catalog, 
with no subfolders.
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2. In the Binder table (directly above the tabbed workspace—upper right—displays 
the name of the catalog you are browsing), select the binder that you want to view.

In the Windows client (see below), use the Filter menu, located directly above the 
Binder Details panel, to help you filter binders. Use the Details menu (far right) to 
select Details or Thumbnails view.

The columns that display in this table are controlled by the configuration, and may 
include Binder Name, Created, Expiration, and the Play button and Submit button, 
and others.

Catalogs Panel Binder or Thumbnail ListBinder Filter
Binder TableDelete BinderRefresh Binder
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In the web client (see below), use the Filter menu (directly above the Binder Details 
panel) to help you filter binders. To return to an unfiltered list and display all binders, 
click the Filter icon again. 

1. Select a binder. When a binder is selected, Workflow Portal display its contents in 
the Binder Details panel directly below the Catalogs panel.
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Using Binder Table Controls
The Binder table supports the following features:

Filtering

Type text in the Filter field or select a previously-entered string from the menu to filter 
the binders in the currently-selected catalog. Delete the text to display all binders in the 
catalog.

Sorting and Re-arranging Columns

Click on any column heading to sort the binder list, and click repeatedly to toggle the 
sort by ascending or descending order. Drag column headings to re-arrange the order.

Playing/Pausing Video

If enabled in the configuration, you can click the Play/Pause button in a binder row to 
preview the media. Click Repeatedly to play or pause the video.

Submitting a Binder

If enabled in the configuration, you can click the Submit button to display the Submit 
Jobs window.

Details/Thumbnails View

Select Details or Thumbnails from the menu.

Previewing Proxy Media in the Media Player
When you select a binder, Workflow Portal displays any file nicknamed Vantage Proxy in 
the media player, provided that it is encoded in a supported format. The binder 
contents may or may not display (above the media player), depending on the 
configuration.

Note: Some configurations allow you to select one or more media files, and in 
addition, create clip lists consisting of temporal segments within the media. This topic 
discusses the functionality of the media player, whether your configuration supports 
clips lists or not.

The following topics describe how to preview media:

 Previewing Proxy Media in the Windows Client

 Previewing Proxy Media in the Web Client

 Previewing Non-proxy Media
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Previewing Proxy Media in the Windows Client
When you preview proxy files in the Windows client, you are using the QuickTime 
Player. If you don’t have QuickTime Player installed, download and install the player on 
your Workflow Portal workstation before you can preview these MOV files.

When you select a binder, Workflow Portal displays any video file nicknamed Vantage 
Proxy, if present. You can use the window, keyboard, and mouse controls listed Window, 
Keyboard, and Mouse Controls to control playback. You can also preview other 
supported media in the binder.

Encoding Requirements
• You should create a proxy file or for previewing/clipping in the Windows client ver-

sion of Workflow Portal. Use one of these formats for the proxy:

– For QuickTime 7.6.9: QuickTime encoder, H.264 video codec, AAC audio codec

OR

– For QuickTime 7.7.6: MP4 encoder, x264 video codec, AAC audio codec.

Use the Flip action configured with the QuickTime encoder and configure the container 
settings to generate a timecode track. Make sure that your encoded proxy file is the 
same frame rate and timecode notation as your production media. Assign the 
nickname Vantage Proxy, so that the media player automatically loads and displays your 
proxy.

Resizable Media 
Player panel

Video frame

Audio meters (L/R)

Speaker and 
Volume

Timeline & ScrubberClock time

Clip Duration

Timecode time

Player Buttons



Using Workflow Portal
Performing Workflow Portal Tasks

320
Telestream suggests that SD proxies (4:3) be set to a 640 x 480 frame size. For HD 
proxies (16:9), Telestream suggests a 640 x 360 frame size.

Basic Media Player Features

The Media Player panel displays the video in the viewing panel, in the proper aspect 
ratio. Media Player panel is resizable horizontally and vertically; the media frame 
displays the proper aspect ratio in the available space.

You can play sound or mute it, by clicking the speaker icon just to the left of the volume 
adjustment bar. 

Audio meters display on the left and right, representing left and right channel stereo. 
When the video is playing (even when sound is muted) or as you scrub the media, the 
meters provide a visual clue representation of sound volume. The audio meters are 
designed to visually show the points of silence near where the operator is creating a 
new segment. In Tempo configurations for example, Tempo operators can choose 
points of silence to create a new segment, to avoid audio anomalies during the re-
timing process.

The timeline at the bottom enables you to scrub the media; and the player buttons 
enable you to play, stop, or go to points in the media in forward and reverse. 

Mark In tick marks display on the timeline to indicate clips (segments) in the clip list. (In 
Tempo only, overlapping segments are highlighted in red to indicate that overlaps are 
not allowed.)

Three timecodes display: HH:MM:SS.SSS time, HH:MM:SS:FF@FPS timecode at the 
bottom center; and a duration, HH:MM:SS.SSS time format. 

Window, Keyboard, and Mouse Controls
The Windows client window, keyboard, and mouse controls are listed in Window, 
Keyboard, and Mouse Controls.

Note: Clicking in the playback controls area, or on the video focuses the preview 
player controls (indicated by the blue focus border). Focusing this area is necessary for 
the “JKL” controls, and also allows you to use the Ctrl hot keys without pressing Ctrl.
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Function Controls

Play/Pause/Reverse Ctrl+P or Ctrl+Space

J (Reverse play—repeat for -1.5x, -2x, -5x, -8x)

K (Pause)

L (Play—repeat for 1.5x, 2x, 5x, 8x)

JK simultaneously (Reverse play slow motion -1/8x; repeat for 
-1/4x, -1/2x)

KL simultaneously (Forward play slow motion 1/8x; repeat for 
1/4x, 1/2x)

Stop Ctrl+S

Forward Frame Ctrl+F

Ctrl + Mouse Wheel, one frame per wheel click

K held down + L (Forward bump one frame)

L held down with K already pressed (Forward bump repeat 
1/4 speed)

Left Arrow (Reverse bump one frame)

Right Arrow (Forward bump one frame)

Forward/Reverse 10 
Frames

Up Arrow (Forward bump 10 frames)

Down Arrow (Reverse bump 10 frames)

Forward/Reverse 
One Second

Mouse Wheel (no modifier keys)—one second per wheel click

Forward/Reverse 
One Minute

Shift + Mouse Wheel—one minute per wheel click

Forward/Reverse 
One Hour

Ctrl + Shift + Mouse Wheel—one hour per wheel click

Reverse Frame Ctrl+B

Ctrl + Mouse Wheel, one frame per wheel click

K held down + J (Reverse bump one frame)

J held down with K already pressed (Reverse bump repeat 
1/4 speed)

Mark In Ctrl+I or Ctrl+E (In points are indicated by tick marks on the 
timeline.)

Mark Out Ctrl+O or Ctrl+R

Go to mark in frame Ctrl+Q
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Go to mark out 
frame

Ctrl+W

Go to start Ctrl+Home

Go to end Ctrl+End

Audio Mute (toggle) Ctrl+M 

Adjust Volume Drag volume button right or left to adjust volume.

Scroll media Drag media button right or left to scrub (scroll) media.

Duplicate selected 
clip

Ctrl+T (Selects the new clip and sets its mark in to the original 
clip’s mark out, if appropriate)

Jump to next 
segment

Alt+Left | Right Arrow Jumps to the next or previous segment, as 
noted by the white bars on the scrubber bar. Works even when 
segment markers are not displayed. 

Jump to next scene 
change marker

Shift-Alt+Left | Right Arrow Jumps to the next or previous scene 
change marker, as noted by the green bars on the scrubber bar. 
Works even when scene change markers are not displayed. 

Function Controls
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Previewing Proxy Media in the Web Client
When you view proxy files in the Workflow Portal web client, you are utilizing the native 
HTML5 Video Player in the web browser.

Note: The appearance of captions in the proxy may vary, depending on the browser 
you’re using. Try supported browsers to find one that best suits your needs.
When playing to the end of a proxy in Chrome versions 35 and 36, Telestream has 
observed that the media player may display an incorrect duration as a result of a 
round-up error. This anomaly is cosmetic. If you set this frame as a mark-out point, the 
correct timecode is entered by Workflow Portal.

Use the Flip action to produce an MP4 proxy file for previewing in the Workflow Portal 
web client’s HTML5 media viewer, using these settings:

• Encoder: MP4 Encoder

• Video Codec: x264

• Audio Codec: AAC

• Container: MP4 File

Make sure that your encoded proxy file is the same frame rate and timecode notation 
as your production media. Always use the Vantage Proxy nickname for the proxy file, so 
that the file automatically displays in the media player when you select a binder.

Telestream suggests that you generate SD proxies (4:3) at 640 x 480 frame size. For HD 
proxies (16:9), generate them at 640 x 360 frame size.

Note: You can right-click on the video to display a context menu with many player 
commands as an alternative to using the player controls or keyboard shortcuts. The 
available controls vary with the browser.

To view a proxy, select a binder and use the controls in Web Workflow Portal Keyboard 
Controls to control playback. 
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Previewing WebVTT Caption Files
Vantage can process media containing closed captions and produce a proxy media file 
and an accompanying WebVTT caption file. The proxy can be previewed with WebVTT 
captions using the HTML5 media player in Internet Explorer.

Note: Only Internet Explorer supports this playback feature. 

To create a proxy with WebVTT captions, follow these requirements in an ingest 
transcoding workflow:

• Use an Analyze action, with Ancillary Data Detection > Publish Metadata > Generate 
WebVTT Attachment implemented to create a WebVTT file. It must be nicknamed 
Vantage Caption Source. The file will be saved in a Vantage store.

Note: An HTTP alias must be set up for the web portal. See Web Application Browser 
Requirements.

• Use a Flip action to transcode the file using the MP4 x264 encoder with closed cap-
tions enabled.

• Use a Register action to add the job (for accessing the proxy and the WebVTT files) 
in a catalog. 

• Display the proxy with captions in the Workflow Portal web applications’ media 
player. Be sure to set the player caption control in the gear menu to enable Closed 
Captions. 

Listening to Individual Audio Tracks
To listen to individual audio tracks in a proxy file using the web version of Workflow 
Portal, enable multiple audio streams in the Flip action (encoding MP4) that produces 
the Vantage Proxy nicknamed proxy file in the ingest workflow.

Note: Only Internet Explorer supports this playback feature. 

Web Workflow Portal Keyboard Controls
The keyboard controls are dependent on the web browser (and the version) that you 
use. Most browsers provide fast forward, and some—such as Internet Explorer—
provide reverse as well. Workflow Portal’s playback rates aren’t generally implemented 
in every step—usually only x2 and x8 are supported. 

Note: The HTML5 Video Viewer must be in focus (you must click in the video frame) in 
order to use the player controls and keyboard shortcuts.
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Function Controls

Play

Enabled in play mode (click 
Play button or press K key).

  (appears in binder list)

Press L x 1—play 1x speed (normal).
Press L x 2—play 2x speed.
Press L x 3—play 3x speed.
Press L x 4—play 5x speed.
Press L x 5—play 8x speed.

(IE only) Tap the + (plus) key to accelerate the clip’s play 
speed to the next level. Press the - (minus) key to 
decelerate the clip’s play speed down the next level.

Reverse Play

Enabled in play mode (click 
Play button or press K key).

 

Press J x—reverse play.
Press J x 2—reverse play 2x speed.
Press J x 3—reverse play 3x speed.
Press J x 4—reverse play 5x speed.
Press J x 5—reverse play 8x speed.

(IE only) Press the + (plus) key to accelerate the clip’s play 
speed up to the next level. Press the - (minus) key to 
decelerate the clip’s play speed down the next level. 

Play/Pause

Press K—play forward or pause. Hold K down to step in 
reverse. 

Forward Frames

Press L—step forward one frame.

(IE only) Press the Right Arrow key—move forward 10 
frames. 

(Chrome and IE 11) Press the Right Arrow key—move 
forward 1 frame. Press the Up Arrow key to move forward 
10 frames. 

The arrow keys on the numbers keypad function in the 
same manner.

Reverse Frames  

Tap J—move reverse one frame.

(IE only) Press the Left Arrow key—move reverse 10 
frames. 

(Chrome and IE 11) Press the Left Arrow key—move 
reverse 1 frame. Press the Down Arrow key to move 
reverse 10 frames. 

The arrow keys on the numbers keypad function in the 
same manner.
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Go to start

(IE only) Press the Home key.

Go to end

(IE only) Press the End key.

Mute audio

(IE only) Press the M key during play. Press again to 
unmute.

Scroll media  

Full screen mode

Press this button to expand to full screen mode.

Zoom mode (IE 11 only) Press Z to zoom in. Press Z again to zoom back 
out. 

Video-safe overlay  

Click to display/hide the video safe overlay frame, for SD 
and HD proxies. 

Closed captioning  

Click to display closed captions, when provided by 
browser.

Audio track menu

When multiple audio tracks are present, the Audio menu 
displays. Click to select the track you want to hear. (IE only).

Function Controls



Using Workflow Portal
Performing Workflow Portal Tasks

327
Previewing Non-proxy Media

Note: This feature is only supported in the Windows client and only when the binder 
detail display is enabled in the configuration.

Media with a nickname other than Vantage Proxy may be played under certain 
conditions. Select the media in the binder list (directly above the media player) and try 
these methods:

1. For QuickTime (.mov) files, select the file and use the media player controls to play 
the media file.

2. To play a QuickTime file outside the embedded media player, right-click the media 
and select Open With Default Program or click the file icon directly above the 
binder list to play the media file in the default program for MOV files.

3. If you don’t have a default program assigned to handle MOV files, right-click the 
media asset, and select Open Containing Folder or click the folder icon directly 
above the binder list. The Windows folder containing the media opens, so you can 
right-click the file and play it using Open With to select a suitable program.

4. For files other than QuickTime, right-click the media and select Open With Default 
Program or click the file icon directly above the binder list to play the media file in 
the default program for the specified suffix of the file.

5. If you don’t have a default program assigned to play this file type, right-click the 
media asset, and select Open Containing Folder or click the folder icon directly 
above the binder list. The Windows folder containing the media opens, so you can 
right-click the file and play it using Open With to select a suitable program.

Creating Clip Lists/Segments (EDLs)

Note: Microsoft User Account Control, by default, prevents Windows programs (such 
as the Workflow Portal client program) from writing files in certain protected folders. If 
you receive an error message indicating that access to a particular Vantage store or 
folder is denied, contact your Vantage administrator. Solutions include changing the 
location of the store/folder or disabling UAC on computers running Vantage clients.
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Configurations that support clip/segment lists (often called Edit Decision Lists—EDLs) 
displays a clip or segment management tab in the workspace (this workspace may 
differ, depending on how the configuration is set up):

To create a clip list, do the following:

1. Browse the binders in the selected catalog, and select a binder to display its proxy 
in the media player.

2. Display the clip management tab (may be named differently by configuration)—
use the following topics to create and configure clips:

 Adding Clips

 Evaluating Clip Metadata and Attributes

 Editing Clip Start and End Times

 Updating Segment Attributes in Syndication Configurations

 Deleting Clips

 Reordering Clips

Adding Clips
You can add multiple clips to a list, and you can add the same clip multiple times. 

Note: If you do not want to combine clips in one file, you can clip the same file 
multiple times. For example, if you are extracting multiple highlights from a single 
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media file, you can mark a highlight, select Submit, and then mark a new highlight 
without affecting the first one.

To add a clip to the list from the media in the selected binder, click the Add button .

Note: In an EDL configuration, the list must be comprised of media file clips that have 
the same frame size and frame rate. In a CML configuration, this is not a requirement. 
When you add the first clip to an EDL, the frame size and rate of the EDL are set to the 
metrics of that clip. Once the frame size and rate are set for an EDL, Workflow Portal 
does not allow you to add an incompatible clip. If you select a binder with a clip that is 
incompatible, the Add button is disabled to indicate that the clip cannot be added.

Each clip you add creates a tick mark on the timeline where the Mark In point is located.

Evaluating Clip Metadata and Attributes
When you select a clip, Workflow Portal displays the clip details to the right. The 
information may include the frame size and the frame rate, as well as other information 
about the selected clip, depending on the configuration.

Editing Clip Start and End Times
The default clip start and end times are the start and end times defined in the source 
media file. To trim the clip, edit the start and end times to define the clip you want.

To change the clip start time do any of the following:

• Use the media player to select the start time and frame, then click the Mark button 
for the Mark In time.

• Click in the Mark In time setting and press CTRL-M.

• Type time or frame values in the Mark In time setting. The displayed format is: 
HH:MM:SS;FF, where HH indicates hours, MM indicates minutes, SS indicates sec-
onds, and FF indicates frames.

• In the Mark In time setting, click one of the numbers and use the up and down con-
trols to change the value.

To change the clip end time do any of the following:

• Use the media player to select the end time and frame, then click the Mark button 
for the Mark Out time.

• Click in the Mark Out time setting and press CTRL-M.

• Type time or frame values in the Mark Out time setting. The displayed format is: 
HH:MM:SS;FF, where HH indicates hours, MM indicates minutes, SS indicates sec-
onds, and FF indicates frames.

• In the Mark Out time setting, click one of the numbers and use the up and down 
controls to change the value.
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• Adjust the duration timecode, which adjusts the mark out point relative to the mark 
in point. This field indicates the duration of the media between the mark in/out 
points of the currently selected clip.

If you specify a mark in, mark out, or duration timecode that makes one or more of the 
timecodes invalid, the affected timecodes display a red background. For example if you 
select a Mark In timecode that starts after the Mark Out timecode, the Mark In and 
Duration timecodes display red. Also, if the duration timecode moves the mark out 
timecode beyond the end of the clip timeline, both the Duration and Mark Out fields 
display red to indicate the error.

The duration timecode can be dropframe or non-dropframe, depending on the setting 
of the Use dropframe notation for duration when appropriate checkbox in the Vantage 
Management Console Workflow Portal Configurations panel. By default (unchecked), 
durations are always shown in non-dropframe. When checked, durations match the 
dropframe setting of the in/out values.

Updating Segment Attributes in Syndication Configurations
A selected segment displays its original ordinal position, along with its regrouped 
position when it has been re-ordered. It also displays the type of segment, which you 
can modify by selecting a new type from the list. You can also enter a description and 
check Not Included. 

When a segment doesn’t match the type or the Not Included template setting, the clip 
is marked with a badge to alert you of the inconsistency, which may indicate a problem.

You can also modify the base name of the output files (an updated mezzanine 
metadata file and a CML file), and create a new template using the current segment 
configuration.

Reordering Clips
To change the order of a clip in the list, click on the clip and click the up  and down  
buttons to change the clip position.

Deleting Clips
To delete a clip from the list, click on the clip and click the Delete button .

Editing Metadata Labels
When the configuration permits it, you can view and update the metadata labels 
ingested, produced, updated, or passed through previous workflows in Workflow 
Portal. 

Note: In a Forward Binder configuration, you edit metadata before submitting the 
binder to a publishing workflow. Changes are made in the binder you selected in the 
catalog. In a Copy Binder configuration, you click Submit and then enter metadata for 
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the new binder you are creating. Your edits do not affect the original binder you 
selected from the catalog—only the new, copied binder.

When you submit a binder, all metadata labels are included. If the configuration 
supports metadata entry and editing, you can modify metadata labels before you 
submit. All metadata labels are applied to all media files that are being submitted.

The following topics describe how to edit metadata labels:

 Editing Metadata in the Windows Client

 Editing Metadata in the Web Client

Editing Metadata in the Windows Client
If the configuration supports metadata editing, you can edit them as follows:

1. Display the Metadata Labels tab.

2. Select the label you want to edit in the Metadata Label list.

3. In the Parameter list to the right, edit the parameter values. 

4. If the metadata label you want to configure does not display in the list and the 
configuration permits adding labels, click the new label button, select a label to 
add, and click OK.

Note: This option is not available when submitting files in a Browse Windows 
Network configuration.

Editing Timecode Values with Hot Keys

If hot keys are assigned to input, output, or duration parameters in this configuration, 
you can use them to set these values as you scrub the media in the player. Roll over the 
mark button to display the assigned hot key in the tool tip.
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Editing Timecode Values in Trim Groups

If trim groups are defined (a set of input, output, and duration parameters) in this 
configuration, the duration is automatically calculated. If you change the input value or 
output value, duration is automatically updated. If you change the duration value, the 
output value is automatically updated.

The duration timecode can be dropframe or non-dropframe, depending on the setting 
of the Use dropframe notation for duration when appropriate checkbox in the Vantage 
Management Console Workflow Portal Configurations panel. By default (unchecked), 
durations are always shown in non-dropframe. When checked, durations match the 
dropframe setting of the in/out values.
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Editing Metadata in the Web Client
If the configuration supports metadata editing, you can configure them as follows:

1. Initiate submit mode as described in Submitting Jobs in the Web Client.

2. To add a metadata label to configure, do the following:

a. Click Add Label.
b. Select a label to add from the Add Metadata Labels dialog.
c. Click Add.

3. To edit metadata label parameters, locate the tab for the label, select the tab, and 
configure the label parameters.

4. To remove a metadata label configuration, locate the tab for the label, select the 
tab, and click Remove Label.

5. Repeat metadata label selection and parameter configuration until all required 
metadata labels are configured.

6. If you need to configure variables, see Specifying Variable Values.

7. When you are done preparing for submission, click Submit.

Specifying Variable Values
You can set up Workflow Portal configuration to enable you to review and edit/add 
variable values stored in a binder from a previous job, before you submit the media 
(and the variables) to a publishing workflow.

Note: In Forward Binder configurations, you can edit variables in the main window; in 
Copy Binder configurations, you can only edit variables after you click the Submit 
button, in the Submit Jobs window. For details, see Browse Catalogs Copy Binder and 
Forward Binder Configurations.
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Edit run-time variable values as follows:

Display the Variables tab on the main window or the Submit Jobs window (depending 
on the type of configuration), as shown below:

For each variable displayed, enter or update the run-time value as required.

Specifying Publishing Workflows
Depending on your configuration setup, you may or may not be able to specify which 
workflow to submit jobs to. 

• One or more workflows have been set as required in the configuration, and they are 
displayed as checked and disabled.

• One or more workflows have been set as required in the configuration, but the 
workflows list is hidden.

• One or more workflows are displayed; you can check those that you want to pro-
cess this job. If this is the case, the Forward to Workflows panel displays:

Check the workflows you want to submit this job to and click Submit. (These workflows 
must be activated in Workflow Designer, or your jobs will fail to run.)
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Submitting Jobs in the Windows Client
When you click Submit, depending on the Workflow Portal configuration you are using, 
you may or may not have performed the following tasks at this point in the process:

 Previewing Proxy Media in the Media Player

 Editing Metadata Labels

 Specifying Variable Values

 Specifying Publishing Workflows

For each of these tasks which must be performed before you can submit the media to 
the publishing workflow for processing, the associated panel is displayed.

Click the link above to display the help topic for the task you are performing.

Submitting Jobs in the Web Client
When you initiate job submission in the web client, the Workflow Portal view changes 
from displaying media information to submitting information. 

The Workflow Portal configuration may specify one or more required workflows, or you 
might be allowed to select one or more workflows from a list. Some of these options are 
limited to a particular configuration, and some of them can be disabled. The options 
that apply to your environment are defined by the Vantage domain administrator and 
the workflow designer.

If the selected configuration allows you to view the workflows to which you can submit, 
Workflow Portal displays a Forward to Workflow tab. If the configuration does not 
support operator viewing of workflows, Workflow Portal just displays a Submit button.

To initiate submit mode, do the following:

1. If the Workflow Portal window displays a Forward to Workflows tab, do the 
following:

a. Select the Forward to Workflow tab.
b. Check or clear each workflow checkbox to specify which publishing workflows 

should process the job.
c. Click Submit to enter submit mode.

2. If Workflow Portal does not display a Forward to Workflows tab, do one of the 
following to initiate submit mode:

– Click the Submit button.

– Click the submit button  to the right of the binder name in the binder list.

If no other configuration options are available, the binder is submitted to the 
selected workflows.

3. If other configuration settings are available, Workflow Portal displays a dialog in 
which you can configure those options. For more information, refer to Editing 
Metadata Labels and Specifying Variable Values.

4. When you are done preparing for submission, click Submit.
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Windows Client Menus
This table describes the menu selections in the Workflow Portal Windows client.

Menu Selection Description

File Change Vantage Domain Enables you to log into another Vantage 
domain. See Selecting Vantage Domains 
and Logging In.

Change Vantage User Enables you to change Vantage users. See 
Changing Vantage Users in Windows Client 
Programs.

Recent Domains Lists the last few Vantage domains that 
were used in this client.

Change/Reload 
Application Configuration

Enables you to select another 
configuration, or reload a configuration 
that has been modified to pick up the 
changes. See Changing or Reloading a 
Configuration.

New Project Resets the Workflow Portal configuration to 
a new state, clearing all media and data in 
all tabs. See Creating a New Project.

Open Project Opens a project that was previously saved 
so that you can continue working or submit 
a job. See Opening a Project.

Save Project Saves the project in its current state—
media you’ve selected, and all data you’ve 
entered or set, for future use. See Saving a 
Project.

Save Project As... Saves the current project under another 
name, replicating the media and data and 
settings as another project. See Saving a 
Project With Another Name.

Exit Closes the Workflow Portal program.

Options Restore Tips & Warnings Restores the display of Workflow Portal tips 
and warnings after the feature has been 
disabled.

Hide Tips & Warnings Hides Workflow Portal tips and warnings.

Prompt for Login Next 
Time Application is 
Launched

When checked, Workflow Portal requires 
login each time the program is launched, to 
increase security.
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Use Clip Start Time Toggle this feature. When a check displays, 
the preview window uses the start time 
defined in the proxy media. If no check 
displays, the start time begins at zero.

Help Contents Display a Windows help version of this 
guide.

Index Display the index of this guide.

Search Search for key words in this guide.

Online Help Display the Vantage guides available on the 
Telestream web site.

About Display the Workflow Portal version 
information.

Menu Selection Description
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Web Client Menus
This table describes the menu selections and title bar options in the web clients.

Menu Selection Description

Title bar 
options

Change Password See Changing Passwords in Windows Client 
Programs.

Logout Log out the current Vantage user.

Change Domain See Selecting Vantage Domains and 
Logging In.

Catalogs 
menu

Refresh Catalog Listings Click to refresh the display of catalogs.

Help 
menu

About Select to display Workflow Portal product 
version information.

Help Documentation Click this entry to toggle the display of the 
submenu.

User Guide Click to display the PDF version of this 
guide in a separate browser window.

Web Help Click to display the HTML version of this 
guide in a separate browser window.
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Troubleshooting Workflow Portal
Use the following topics to help you solve certain problems with Workflow Portal:

 Opening Workflow Portal the First Time

 Difficulties Changing Configurations

 Problems Playing Proxy Files

 Configurations Don’t Display in the Web Client

 No Session Licenses Available

Opening Workflow Portal the First Time
When opening Workflow Portal for the first time, depending on the design of your 
network and the location of your client workstation and Vantage domain server, the 
Domain login dialog may not display your Vantage domain. If this is the case, you may 
be able to log in by using the name or IP address of the Vantage domain server. For 
more details, see Selecting Vantage Domains and Logging In.

Difficulties Changing Configurations
When you change domains or configurations, you may also encounter these problems:

• No Configurations Available...

Workflow Portal displays this error when you log in to a domain where no Workflow 
Portal configurations are defined or where you do not have access to any of the 
defined configurations.

Contact your Vantage domain administrator.

• No session licenses available for this application...

Either the domain is not licensed for running Workflow Portal or all available Work-
flow Portal licenses are in use. Workflow Portal will operate in unlicensed/demo 
mode, but will not allow you to submit jobs or edit metadata labels until a Work-
flow Portal license becomes available.

Contact your Vantage domain administrator.

Note: An administrator can release a license in the Vantage Management Console.

• Problem communicating with database—could not find stored procedure Select-
SessionsByExecution...

This error displays when Workflow Portal is attempting to display a list of configura-
tions from the selected domain, but the version of the domain is not compatible 
with your client. Contact your Vantage domain administrator to upgrade the Work-
flow Portal program on your computer.
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• The requested workflows are either not running or no longer exist...

This error displays when you submit an asset or media file to a workflow that has 
been deleted, or is not activated. Contact your Vantage domain administrator, who 
can activate the Vantage workflow or edit the configuration to correct the problem.

Problems Playing Proxy Files
If you can’t play proxy files in a binder, review these issues:

– In the web client, the Wait cursor displays forever: 
Your virtual directory may not be implemented in IIS

– The location path may not be specified correctly, or it may be using a letter drive 
where a UNC path is required for remote client/service access

– The alias to the directory may not be specified in the store

– The alias path may be incorrect.

It is valid to use a drive letter as part of a Virtual Directory. This imposes no restric-
tions other than requiring the Vantage store to be located on a drive attached to 
the web apps host (such as a local hard drive or more commonly a SAN).

• In Workflow Portal, make sure that you create a QuickTime H.264/AAC proxy for 
previewing media or creating clips. Use the QuickTime encoder, and configure the 
container settings to generate a timecode track. Make sure that your encoded 
proxy file is the same frame rate and timecode notation as your production media. 
Assign the nickname Vantage Proxy, so that the media player in Workflow Portal 
automatically loads and displays your proxy. 

• Alternatively, the Workflow Portal Windows Client Media Player supports MP4 with 
x264-encoded H.264/AAC, provided that QuickTime 7.7.6 or later is installed on the 
computer running the Workflow Portal Windows client. 

• For previewing media in the Workflow Portal web client’s HTML5 media viewer, 
make sure the video is encoded using the Flip action (and nicknamed Vantage 
Proxy), with these settings:

Encoder: MP4 Encoder

Video Codec: x264

Audio Codec: AAC

Container: MP4 File

• When using the Workflow Portal Web Application on a Windows Server platform, 
you must install the Desktop Experience feature in order to view proxy media in the 
HTML5 Media Player.

• When playing to the end of a proxy in Chrome, versions 35 and 36, Telestream has 
observed that the media player may display an incorrect duration as a result of a 
round-up error. This anomaly is cosmetic. If you set this frame as a mark-out point, 
the correct timecode is entered by Workflow Portal.
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Configurations Don’t Display in the Web Client
You’ve created a new configuration, but you can’t select it in the web Workflow Portal.

•  Perhaps it is not a Copy Binder or Forward Binder configuration— the other types 
are not designed to function in the web client, only the Windows client.

• Perhaps you (your Vantage user) don’t have permission to use it.

No Session Licenses Available
Workflow Portal displays this message when the number of active session licenses is 
equal to the number of authorized seats in your license, and no more are available.

Note: Open the Vantage Management console > Licenses and use the Licenses and 
Portal Sessions tabs to determine how many servers can run Workflow Portal 
concurrently, and how many sessions are currently active.

Identify the reason and resolution:

•  The maximum number of operators are concurrently using Workflow Portal. Either 
increase the number of authorized servers (concurrent instances) or wait until 
someone closes Workflow Portal and releases a license. Open the Vantage Manage-
ment Console > Licenses and display the Licenses tab to review your license.

• Workflow Portal has crashed one or more times, and the session is still active even 
though that instance of Workflow Portal is not. Open the Vantage Management 
Console > Licenses and display the Portal Sessions tab to verify each active session 
and the associated computer. If Workflow Portal is not running on that server, select 
and delete the session to release it.
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Using Workflow Portal 
Configurations

This chapter describes how to operate each of the basic Workflow Portal configurations.

Workflow Portal configurations are created in the Vantage Management Console. The 
functionality options and user interface components are specific to each type of 
configuration and are enabled in Workflow Portal when it is launched.

A Vantage administrator can make as many of each type of configuration as necessary, 
each one configured to support a specific media processing application. 
Configurations are developed in conjunction with a workflow designer, so that the 
configuration performs correctly with the associated ingest and publication workflows.

Once you’ve used a specific configuration, each time you launch Workflow Portal it uses 
it automatically. 

Note: When you are using a given type of configuration—for example, a VOD 
configuration—it is common to think of and refer to Workflow Portal simply as the 
VOD Portal. When you read about a portal by any name (VOD, DPP, etc.), just 
remember—this particular Portal is Workflow Portal using its respective configuration.

The following topics describe each basic type of Workflow Portal configuration, and 
how to use it:
 Using Browse Catalogs Copy Binder and Forward Binder Portals

 Using Windows Portals

 Using EDL Portals

 Using CML Portals

The following topic provides an overview of the DPP Portal, offered as an optional, 
licensed configuration:

 DPP Portal Overview

VOD Portal is offered as part of VOD Producer DAI and Tempo Portal is offered as part of 
Tempo, both Telestream products built on the Vantage platform. The Syndication Portal 
is offered as part of TrafficManager. The following topics provide an overview of these 
Workflow Portal configurations.

 VOD | DAI Portal Overview

 Tempo Portal Overview

 Syndication Portal Overview
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Note: These configurations are described in separate guides that accompany each 
product.
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Using Browse Catalogs Copy Binder and Forward 
Binder Portals

Note: These configuration can be used in both the Workflow Portal Windows client 
and the Workflow Portal web app.

The Browse Catalogs configurations are the most broadly-focused operator-
intervention configurations. In these configurations, the key requirement is the 
registration of media in a catalog using an ingest workflow. This enables an operator to 
select it and review a proxy, edit metadata and variable values as required, and submit 
it to one or more publishing workflows. 

Browse Catalog configurations are not designed to solve any specific media processing 
application (such as DPP or CML); they simply enable operator-intervention processing 
of media registered in a Vantage catalog.

Note: Media trimming can be implemented in Workflow Portal in both Browse 
Catalog configurations. For example workflows, go to the Vantage Support page on 
the Telestream web site, and download the Workflow Examples zip file for your version 
of Vantage.

In a Browse Catalog Copy Binder Portal, the operator browses a catalog and selects a 
binder to prepare before submitting the job to a publishing workflow. A Copy Binder 
configuration automatically duplicates the original binder and submits the duplicated 
binder (with changes made by the operator) to the publishing workflow, leaving the 
original binder intact in the catalog for future use or re-submittal. (If you may ever need 
to use the copied binder later—in case of an error, for example—you should also use a 
Register action in the publication workflow to register the new binder in a catalog).

In order to have a binder to submit, the operator clicks the Submit button to trigger the 
duplication of the original binder. Now, using the copied binder as a template, the 
operator can edit metadata and variables as required, (in the copied binder) and submit 
it to the publishing workflow.

In contrast, in a Browse Catalog Forward Binder Portal, the original binder is modified by 
the operator during metadata and variable editing, and submitted to the publication 
workflow—without making a copy. (If you don’t need the binder after processing, you 
can automatically or manually delete it.) The operator can edit metadata and variables 
(in the original binder) directly in the main window and then click Submit to submit it 
to the publishing workflow.

Here are the differences between Copy Binder and Forward Binder configurations:

• Copy Binder—the operator clicks the Submit button before editing metadata and 
variables—to create a copy of the original binder.

• Forward Binder—the operator selects a binder and edits its metadata and vari-
ables—then click Submit to process the job.
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Depending on how the configuration has been set up, there will be variations in the 
features that are enabled, and the related tasks you can perform. In both 
configurations, the operator can review, edit, and update label-based metadata and 
variables for the selected media prior to submission to a publishing workflow.

Copy Binder Job Submittal Process
As depicted in the figure below, media is submitted to an ingest workflow through a 
watch folder, which performs any processing required, and registers the output media 
(organized with any other job-specific assets—metadata labels, for example—in a 
binder) into a specific Vantage catalog.

Alternatively, media can be submitted via a workflow, manually, or any other means. 

In Workflow Portal, the operator browses catalogs and selects a binder, clicks Submit to 
generate the copied binder, and performs operator tasks as appropriate. This may 
include scrubbing a proxy, reviewing and editing metadata, and setting variable values 
for the job.

Next, the operator submits the job to a publishing workflow, which can be designed to 
perform any task required. The binder being processed is a copy of the original binder. 
The original binder and its contents remain untouched.

Job Submittal Steps
When you’re using a Copy Binder Portal to process media, an operator follows this 
general process to submit a job (for details about a task, click on the link):

1.  Make sure that the publishing workflow or workflows associated with this process 
are running (in Workflow Designer).

2. Browse catalogs to select a binder (Browsing Catalogs for Media) for processing.
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3. Preview media in the Media Player (Previewing Proxy Media in the Media Player).

4. Check the workflow(s) you want to process the media with. This varies based on 
how the configuration is set up.

5. Click the Submit button to display the Submit Jobs window and prepare the copied 
binder’s assets for processing.

6. In the Metadata Labels tab (if displayed), review/edit metadata (Editing Metadata 
Labels).

7. In the Variables tab (if displayed), enter values for each variable (Specifying Variable 
Values).

8. Click the Submit button to submit a job for processing the media and its assets in 
the target workflow(s).

Forward Binder Job Submittal Process
As depicted in the figure below, media is submitted to an ingest workflow through a 
watch folder, which performs any processing required, and registers the output media 
(organized with any other job-specific assets—metadata labels, for example—in a 
binder) into a specific Vantage catalog.

Alternatively, media can be submitted via a workflow, manually, or any other means. 

In Workflow Portal, the operator browses catalogs and selects a binder, clicks Submit, 
and performs tasks as appropriate. This includes reviewing and editing metadata, and 
setting variable values for the job as appropriate.

Next, the operator submits the job to a publishing workflow, which can be designed to 
perform any task required. The binder being processed is the original binder.
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Job Submittal Steps
When you’re using a Forward Binder Portal to process media, an operator follows this 
general process to submit a job (for details about a task, click on the link):

1.  Make sure that the publishing workflow or workflows associated with this process 
are running (in Workflow Designer).

2. Browse catalogs to select a binder (Browsing Catalogs for Media) for processing.

3. Preview media in the Media Player (Previewing Proxy Media in the Media Player).

4. In the Metadata Labels tab (if displayed), review/edit metadata (Editing Metadata 
Labels).

5. In the Variables tab (if displayed), enter values for each variable (Specifying Variable 
Values).

6. Check the workflow(s) you want to process the media with. This varies based on 
how the configuration is set up.

7. Click the Submit button to submit a job for processing the media and its assets in 
the target workflow(s).
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Using Windows Portals
Note: This configuration can only be used in the Workflow Portal Windows client.

The Browse Windows Network Portal (Windows Network Portal for short) allows you to 
select one or more media files from servers on a Windows network and submit them to 
target workflows, depending on how the configuration is set up.

Like Browse Catalog configurations, Browse Windows configurations are also broadly-
focused. If the configuration permits, you can also add metadata to labels and edit 
variables to be submitted with the media. Unlike Browse Catalog configurations, assets 
normally associated with binders—pre-processed metadata labels, proxy files, etc.—
aren’t present.

In Workflow Portal, the operator browses a Windows file system and selects media, and 
performs tasks as appropriate. This includes reviewing and editing metadata, and 
setting variable values for the job as appropriate.

Next, the operator submits the job to a publishing workflow, which can be designed to 
perform any task required. 
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Job Submittal Steps
Windows Portal displays a Browse button and a list of selected files—instead of a 
Vantage Catalog list—as shown below.

1. Click the Browse button.

Windows Portal displays the Select media file(s) to submit dialog shown here.

2. Use the Select media file(s) to submit dialog to select the file(s) to process.
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3. Click Open.

Each file that you open displays in the Select media file(s) list.

Repeat the Browse process as necessary, to select and add more files from any 
directories.

If the file list is not correct, you can edit the list manually. For example, you can 
select a given file path and delete it. Or, you can edit a path or filename, copy and 
paste file paths, or add new ones. To delete the list entirely, click Clear.

4. If multiple publish workflows are displayed in the Target Workflows list, check any 
target workflow to which you want to submit the media in the list.

If a checked box is not editable, this is a required workflow for this configuration.

5. Click Submit.

If the configuration does not provide any additional options, Windows Portal sub-
mits the selected media files to each of the selected publication workflows.

6. If the configuration supports metadata labels or variables, Windows Portal displays 
the Submit Jobs dialog with tabs for these options. Some configurations display a 
tab for metadata and variable editing.

7. When you are done preparing for submission, click Submit.
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Using EDL Portals
Note: This configuration can only be used in a Workflow Portal Windows client.

The EDL Portal enables you to create an Edit Decision List (EDL) which you submit to a 
publishing workflow to process the EDL. You select the media to use by browsing 
catalogs and selecting binders created from previously-completed ingest workflow 
jobs. You add clips to the clip list, update metadata and variables, and then stitch the 
clips together, encoding them in the publishing workflow to which you submit the EDL. 

The Telestream Edit decision list (TSEDL) files created in EDL Portal can only be 
processed by Flip action-based workflows.

 Ingest Workflow for EDL Processing

 Job Processing and Submittal Steps

Ingest Workflow for EDL Processing
To prepare media for stitching from an EDL, create an ingest workflow to encode it as 
required in a Flip action, and register it in a catalog, following these guidelines:

• All media must have the same frame rate, timecode notation, and frame size, and 
the same media essence.
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• Use a Flip action (if necessary), to encode your production media using one of these 
encoders: 

– MPEG-2 Program Stream

– VOD/MPEG-2 Transport Stream

– MXF

The output media must use the nickname Vantage EDL, so that the EDL configura-
tion can identify which media file to use for stitching.

• Use a Flip action to encode your proxy media for previewing/clipping.

– QuickTime encoder, H.264 video codec, AAC audio codec, QuickTime 7.6.9 
installed

OR

– MP4 encoder, x264 video codec, AAC audio codec, QuickTime 7.7.6 installed

 Assign the nickname Vantage Proxy, so that the media player can play it.

Note: Be sure to encode proxies at the same rate and timecode notation as your 
production media. Clips that you mark use the proxy timecode—Workflow Portal 
applies it to the Vantage EDL media.

• Use a Keyframe action to produce keyframes—configured with the Keyframe 
encoder. Assign the nickname Vantage Thumbnail.

• Register the job in your target catalog to make it available to Workflow Portal.

Note: EDL Portal configurations expect binders to have media identified as Vantage 
EDL, Vantage Proxy, and Vantage Thumbnail. If you don’t follow these guidelines, the 
binders may not display in the catalog, you won’t be able to view the proxy to create 
clips or view keyframes, and your publication workflow may fail.

Job Processing and Submittal Steps
After you have processed all of the media you want to stitch through your ingest 
workflow, open Workflow Portal with an EDL configuration to create your EDL and 
submit it for processing. When submitted, the files are clipped to the EDL settings and 
merged together into a single output file by the publishing Vantage workflow.

Follow this general process to submit a job (for details about a task, click on the link):

1.  Make sure that the publishing workflow or workflows are running (in Workflow 
Designer).

2. Browse catalogs to select a binder (Browsing Catalogs for Media) for processing.

3. For each binder you select, preview its media (Previewing Proxy Media in the Media 
Player) and use the Create EDL tab to add clips, setting mark-in/mark-out points to 
crop the media and update the metadata for each clip (Creating Clip Lists/Segments 
(EDLs)).
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4. Optionally, use the Metadata Labels tab to preview metadata. You can’t edit it in 
this panel.

5. In the Forward to Workflows (if displayed), check the workflow(s) you want to 
process the media with. This varies based on how the configuration is set up.

6. Click the Submit button to display the Submit Jobs window where you prepare the 
media’s assets for processing.

7. In the Metadata Labels tab (if displayed), review/edit metadata (Editing Metadata 
Labels).

8. In the Variables tab (if displayed), enter values for each variable (Specifying Variable 
Values).

9. Click the Submit button to submit a job for processing the media and its assets in 
the target workflow(s).
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Using CML Portals
Note: This configuration can only be used in the Workflow Portal Windows client.

The CML (Composition Markup Language) Portal configuration is designed to create a 
Composition (CML) file that defines an EDL—the set of clips you’ve added from media 
registered in catalog binders, which you submit to a Post Producer publishing workflow 
with a Conform action. The Conform action processes the composition, stitching the 
clips and renders a single media file as output, based on the specifications in the CML.

Note: Use of the Conform action requires a Post Producer license. For details on using 
Post Producer and compositions, see the Post Producer Developer’s Guide.

The Workflow Portal Create EDL configuration also supports EDL processing—using 
the Flip action—with similar functionality. However, the primary difference—and 
advantage—of using a CML Portal configuration is that you can incorporate clips from 
different media files with mixed essences. While the EDL Portal requires that all clips 
have the same frame rate, frame size and video codec; the CML Portal does not have 
this restriction. CML processing also improves VANC and caption processing.

The CML configuration is a create binder configuration—a new binder is automatically 
created and submitted to the publishing workflow.

The composition (CML file) created by the CML Portal can only be processed by 
Conform action-based workflows.

 Prototype CML Configuration Workflows

 Media Pre-processing, CML Creation, and Job Submittal
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Prototype CML Configuration Workflows
This topic describes prototype ingest and publishing workflows that you can use to set 
up a basic CML-based media processing system that involves operator-driven job 
submission using Workflow Portal. 

Before you can use Workflow Portal to operate a CML-based media processing system, 
you must create the following two workflows:

 Prototype CML Portal Ingest Workflow

 Prototype CML Portal Publishing Workflow

Prototype CML Portal Ingest Workflow
Use this topic to create an ingest workflow to create a proxy, optionally encode the 
media as required, and register it in a catalog, following these guidelines:

• Assign the output media the nickname Original so that the CML Portal can identify 
which media file to use as the source media when it generates the CML file for pro-
cessing in the publishing workflow.

• If required, use a transcode action (the Flip action, typically—not shown in the 
workflow above) to encode your media into one of the supported Post Producer 
formats (which accepts a much broader set of video, audio, and container formats 
than the Flip action does for EDL processing). See Post Producer Developer Guide For-
mats in the Post Producer Developer’s Guide or the Products > Post Producer > 
Specs page on the Telestream web site.

If you are re-encoding your media, since you can’t use the same nickname on input 
and output media in the same action, simply assign the input file a nickname other 
than Original.

• Use a Flip action to encode your proxy media for previewing/clipping.

– QuickTime encoder, H.264 video codec, AAC audio codec, QuickTime 7.6.9 
installed

OR

– MP4 encoder, x264 video codec, AAC audio codec, QuickTime 7.7.6 installed

•  Assign the nickname Vantage Proxy, so that the media player can play it.

Note: Make sure that you encode the proxy at the same rate and with the same 
timecode notation as your production media.

http://www.telestream.net/post-producer/tech-specs.htm
http://www.telestream.net/post-producer/tech-specs.htm
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• Use a Flip action to create a single thumbnail for viewing in the browser.

– Encoder: Keyframe Encoder

– Video Codec: JPEG

– Container: JPEG File

 Assign the nickname Vantage Thumbnail, to display them in Workflow Portal.

• Use a Register action to register the media in your target catalog to make it avail-
able in Workflow Portal.

Note: If you don’t follow these guidelines, the binders may not display in the catalog, 
you may not be able to set mark-in/mark-out points, and your stitch workflow may fail.

Prototype CML Portal Publishing Workflow
Use this topic to create a publishing workflow to stitch and encode your output file.

Unlike the ingest workflow, the requirements for your publishing workflow are minimal. 
In almost every case, in practice, your publishing workflow will be far more complex 
than the prototype shown here.

• The publishing workflow must start with a Receive action, so that it can accept an 
input file from Workflow Portal. The nickname of the input file is CML.

• Use a Conform action to stitch and encode your media using the specifications in 
the auto-generated CML file you submitted. Configuration details are described in 
the man pages in the Conform action.

These are the two required actions; all other actions and configurations depend on 
your publishing workflow requirements.

Media Pre-processing, CML Creation, and Job Submittal
To prepare media for stitching, copy the media (one or more files) that you want to 
comprise your final output into the ingest workflow’s watch folder. 

The ingest workflow will submit a job for each file, and (depending on the workflow 
configuration), create a proxy, a thumbnail, optionally re-encode the media to meet 
Conform-action format requirements, and register the media in a binder in the target 
catalog.
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After you have processed all of the media you want to stitch through your ingest 
workflow, open Workflow Portal with a CML configuration to create your CML and 
submit it for processing. When submitted, the files are clipped to the CML settings and 
merged together into a single output file by the publishing Vantage workflow.

When you’re using a Create CML Portal to process media, an operator follows this 
general process to submit a job (for details about a task, click on the link):

1.  Make sure that the publishing workflow or workflows associated with this process 
are running (in Workflow Designer).

2. Browse catalogs to select a binder (Browsing Catalogs for Media) for processing.

3. For each binder you select, preview the media and add clips, setting mark-in/mark-
out points to crop the media (Previewing Proxy Media in the Media Player) and 
update the metadata for each clip (Creating Clip Lists/Segments (EDLs)).

4. Check the workflow(s) you want to process the media with. This varies based on 
how the configuration is set up.

5. Click the Submit button to display the Submit Jobs window where you prepare the 
copied binder’s assets for processing.

6. In the Metadata Labels tab (if displayed), review/edit metadata (Editing Metadata 
Labels).

7. In the Variables tab (if displayed), enter values for each variable (Specifying Variable 
Values).

8. Click the Submit button to submit a job for processing the media and its assets in 
the target workflow(s).

9. Click Submit. If variables are included in this configuration, Workflow Portal displays 
the Variables window, where you can supply run-time values.
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DPP Portal Overview
Note: The DPP Packager User Guide is also provided for complete details regarding the 
production of DPP-compatible media in Vantage.

The purpose of the DPP Portal is to enable operators to assemble and produce SD or 
HD media files that conform to the current DPP standard, for broadcast in the UK 
market.

This configuration can only be used in the Workflow Portal Windows client. 

You use a DPP Portal to browse catalogs and select binders from completed ingest 
workflows jobs, enter metadata and mark programme parts, then generate DPP-
compliant media which comprises the programme. A DPP configuration defines each 
field of DPP metadata in the programme, which may be given a default value, and may 
be marked as read-only.

The DPP portal is designed to allow you to:

• Create a DPP programme containing one or more segments

• Enter DPP metadata to accompany that programme

• Create a DPP XML file and a Composition (CML) file from which to generate the 
programme’s media file (with Post Producer) and transcode to AS-11 with DPP 
metadata (with a Vantage Transcode Pro license).
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Note: You can add a DPP Validate action (located in the Analysis group) to your target 
workflow to validate metadata in a DPP package.

After you have prepared the media you want to include in the package, you open 
Workflow Portal with the proper DPP configuration to create your DPP package, enter 
metadata as required, and submit it for processing. 

The DPP Portal automatically generates a CML file that defines the media, unless the 
operator provides a custom CML. The CML file and all related media files are submitted 
to the target Vantage workflow for producing the package.
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VOD | DAI Portal Overview
Note: The VOD Producer | DAI User Guide is also provided for complete details 
regarding the encoding media for VOD markets using VOD Producer Vantage.

The purpose of the VOD | DAI Portal is to enable operators to prepare source media and 
automate:

• CableLabs-compliant stream-conditioned media generation

• Canoe/BlackArrow-compliant dynamic ad insertion (DAI) location definition CSV 
(comma-separated value) files

• Nielsen audio watermarking.

VOD Producer performs media encoding and conditioning and Nielsen watermarking, 
along with automated delivery of programs and advertisements to MVPDs, and 
metadata to ecosystem partners in supporting workflows.

This configuration can only be used in the Workflow Portal Windows client. 

Note: You can also process CML and EDL files with automated VOD Producer and 
VOD Producer DAI workflows to produce VOD assets, without using VOD Portal. These 
are implemented using Vantage automation workflows, and are covered in the Post 
Producer Developer's Guide.

Generating and delivering VOD assets in VOD Producer involves at least two Vantage 
workflows. The diagram following illustrates the general process an operator follows to 
prepare, generate, and deliver VOD assets.
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First, an operator selects a single file or a set of source media files, and submits them to 
an ingest workflow, supplying metadata as appropriate. The ingest workflow creates 
frame-accurate proxies and processes the metadata. It registers each source media file 
and its metadata, proxy, and keyframes in a catalog for access in VOD Portal.

Next, using VOD Portal, the operator selects and prepares source media for submission 
to the publication workflow. 

In VOD Portal, the operator performs the following tasks as appropriate:

• Select and identify segments in source media

• Add interstitials for promotion and cross promotion

• Define frame-accurate locations and value for dynamic ad insertion

• Brand each segment

• Add SCC file to clips as appropriate

• Configure V-chip settings and graphics

• Specify copy protection requirements

The operator then submits the job to a publishing workflow, which performs these 
operations:

• Assembles the playlist composition

• Encodes the media as a CableLabs-compliant transport stream, optionally encod-
ing to adaptive bit-rate or mezzanine formats
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• Optionally, watermarks the audio for Nielsen measurement, produces Nielsen 
metadata and creates Nielsen documents

• Optionally, produces ad metadata and creates DAI location definition files for 
Canoe/BlackArrow

• Simultaneously distributes the VOD asset to the MVPD and delivers the metadata 
associated with the asset to ecosystem partners (Nielsen and Canoe).
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Tempo Portal Overview
Note: The Tempo User Guide is also provided for complete details regarding re-timing 
media using Tempo.

The Tempo Portal enables operator-driven re-timing of media assets—intelligently 
decreasing or increasing the running time of shows and segments by up to ten percent.

This configuration can only be used in the Workflow Portal Windows client.

Re-timing assets in Tempo involves at least two Vantage workflows. The diagram 
following illustrates the general process an operator follows to prepare and re-time 
media assets.

First, an operator selects a single file or a set of source media files, and submits them to 
an ingest workflow. The ingest workflow creates frame-accurate proxies and optionally 
re-encodes the media to meet Tempo-processing requirements. It registers each source 
media file and its proxy and keyframe in a catalog for access in Tempo Portal.
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Next, using the Tempo Portal, the operator selects and prepares source media for 
submission to the publication workflow. 

In Tempo Portal, the operator performs the following tasks as appropriate:

• Browse clips in the selected Vantage catalog.

• Drag clips into a segment list and view them in a built-in video player. 

• Mark In/Out to identify clip segments and include/exclude them from re-timing.

• Add a graphic overlay (bug) and/or content rating graphic to one or more clips.

• Set exact overall clip duration, or increase/decrease clip time by a percentage.

The operator then submits the job to a publishing workflow, which re-encodes the 
media, re-timing it in the process, per the instructions specified in the XML file auto-
generated by Tempo Portal.
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Syndication Portal Overview
Note: The TrafficManager User Guide provides complete details regarding both 
automated and operator-intervention processing syndicated material for broadcast in 
TrafficManager.

The purpose of the Syndication Portal is to enable operators to review and prepare 
syndicated (long-form/episodic) media for submission to a publishing workflow to 
encode it for broadcast. This includes:

• Metadata label review and update

• Segment list review based on a template, and update as required.

This configuration can only be used in the Workflow Portal Windows client.

Generating syndicated assets in TrafficManager via Syndication Portal involves at least 
two Vantage workflows. The diagram following illustrates the general process to 
prepare, generate, and deliver syndicated assets to a broadcast server.

First, an ingest workflow is triggered by an operator submitting a file, dropping it into a 
monitored folder, or automatically, via a catch server. The ingest workflow typically 
creates a frame-accurate proxy and a thumbnail, and transforms the metadata sidecar 
file into a mezzanine file for use in other Vantage workflows. It registers each source 
media file and its metadata, proxy, and keyframe in a catalog for access in the 
Syndication Portal.
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Next, using the Syndication Portal, the operator selects and prepares source media for 
submission to the publication workflow.

In the Syndication Portal, the operator performs the following tasks:

• Select and review segments, updating attributes, adjusting timing and segment 
order, adding/modifying spots, joining/unjoining commercial segments, etc.

• Review any metadata labels, updating as necessary

• Submit the media to one or more publishing workflows.

When the operator submits the media, in Stitching and Segmenting modes, two files 
are auto-generated by the Syndication Portal: an updated mezzanine metadata XML 
file, and a CML file. However, in Pass-Thru mode generates a new XML file, but does not 
generate a CML file. Instead, it passes the source media from the ingest workflow—
which must be nicknamed Original— to the publishing workflow, so that the program 
can be transcoded without having to change the program's timeline.

A typical Automation workflow uses the metadata file to perform these essential tasks:

• Uses the Automate action to convert the mezzanine metadata XML file into the for-
mat required for a given automation system (ASDB or Bxf, for example).

• Delivers the entire payload to the automation system. 

A typical on-air server workflow uses the CML file to perform these essential tasks:

• Assembles the playlist composition into the broadcast media format required, 
using a Conform action (which requires a Post Producer license).

• Delivers the encoded media to a broadcast server.
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Your publishing workflows will undoubtedly perform many tasks other than these 
essential tasks using a variety of actions.
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Using the Job Status 
Views Web Application
Job Status Views is a web application that enables basic Vantage job management via a 
web browser. You can use Job Status Views to access job information and manage jobs 
in your Vantage domain from anywhere on the LAN, or via the Internet if you provide 
such access your Vantage domain.

Note: For information about Vantage web application requirements, starting and 
stopping web applications, and other basic topics, see Vantage Client Programs 
Overview.

This chapter presents the following topics:

 About the Job Status Views Web Application

 Job Status Views Web Application Overview

 Using Public and Private Views

 Sorting Jobs by Column

 Paging Through Job Tables & Setting Page Size

 Filtering the Job Table

 Highlighting Job States Row by Row

 Managing Jobs

 Troubleshooting
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About the Job Status Views Web Application
You can use the Job Status Views web application to do the following:

• Display information about submitted jobs

• Sort and filter job entries

• Highlight and identify jobs in different states

• Stop, restart, and delete jobs

• Troubleshoot job processing issues.

The views that you see in Job Status Views are defined by Vantage administrators, who 
control which job information displays and which job control functions (such as the 
ability to delete a job) are allowed. Views may be public or private. Public views are 
available to everyone, and private views are for use by specified Vantage users.
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Job Status Views Web Application Overview
The Job Status Views web application displays the jobs table, as shown here. 

The Job Status Views display is presented in three panels.

To display or hide the title or view panels, click the Show/Hide controls, as shown in the 
figure above.

• Title panel (top)—displays the home button, Vantage domain and user name, and 
controls to manage the user password, change domains, and to log out of the 
domain.

• View panel (left)—displays views that define which jobs are listed in the job list. This 
panel also includes controls to display product version information and this guide.

• Job list panel—Center, right—displays the job list in table format, along with the 
program’s toolbar, which contains command buttons and menus.

Note: If you do not log in with a Vantage user name, private views display None 
Available.

The following sections describe how to use the web application:

 Using Public and Private Views

 Sorting Jobs by Column

 Paging Through Job Tables & Setting Page Size

 Filtering the Job Table

 Highlighting Job States Row by Row

 Managing Jobs

 Troubleshooting
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Using Public and Private Views
All views are defined either as public or private, and are created and configured in the 
Management Console. Click on the view to select it, and display jobs for this workflow. 
Only private views that are enabled for your Vantage user name are listed.

The default view is the All Workflows public view, which displays jobs for all workflows. 
The information that All Workflows displays depends on how it is configured in the 
Management Console, and whether it is enabled or not. If no private views have been 
defined, or if you log in as Public, the Private Views list displays None Available. 

The following topics provide more information on views:

 About Public and Private Views

 About View Definitions

About Public and Private Views
Public views are views that the Vantage administrator has made available to all Vantage 
users. Anyone who connects to the Vantage domain can display public views in the Job 
Status Views web application.

Private views are views that are available only to those Vantage users for which the 
Vantage administrator has enabled access. The administrator might configure custom 
views for different departments, users by role, or customers, and limit access to those 
views to the appropriate users.

About View Definitions
All views that you create are based on a specific workflow. In addition to being public or 
private, views limit the information that is displayed and specify which job control 
features (if any) the user has to use. If no controls are enabled, the view is considered a 
read-only view. You cannot create or configure views directly in Job Status Views; views 
are created by the Vantage administrator, via the Vantage Management Console, and 
specified as public or private; enforced by which user logs in.

There are many options for views, and displaying all options usually provides too much 
information for most applications. For example, it might be more convenient to display 
fewer columns. This view might only display active jobs, and it might disable controls 
that allow jobs to be restarted, stopped, or deleted.

The following topics provide information on what can be customized (and thus, may or 
may not be present) in views

 Displaying Items in Views

 Controls in Views

Note: Administrators should refer to the Vantage Domain Management Guide for 
information on how to set up custom views.
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Displaying Items in Views
Two items of information are always displayed as columns in a view:

• Job—The name of the file submitted to start the job, and the type of submission: 
Manual Submit, for example.

• State—The current state of the job, which can be:

State—This column displays color-coded key words to identify the status of the job:

• In Process—the job is active (being processed).

• Paused—the actions in this job have been paused.

• Complete—all of the actions in this job have completed successfully.

• Failed—one or more of the actions in this job have failed.

• Waiting—the job is active, but is currently waiting for a resource (a service) to 
accept and process one of the actions in the workflow.

• Stopped by User—the job was stopped by a user.

• Waiting to Retry—the job is active, but is currently waiting for one of the actions in 
the workflow to re-execute.

These optional columns can be added to a view:

• Total Progress—The progress of the job (in percent) if still running.

• Started—The date and time the job was started.

• Updated—The date and time the job was last updated.

• Workflow—The name of the workflow that started the job.

• Run Time—Displays the total elapsed execution time for the job.

• Expires—The date and time when the job expires and both the job entry and the 
job entry is deleted.

Controls in Views
An administrator can configure the following controls in a view:

• Enable—Enables or disables use of the view.

• Show Only In Process Jobs—Displays only jobs that are currently running.

• Stop | Start | Delete—Enables or displays the ability of the operator to manage 
jobs—stopping, restarting, and deleting them.
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Sorting Jobs by Column
To sort the displayed job list according to the entries in any column, click that column 
label. Each time you click the column label, the sort changes in the following sequence: 
ascending order, descending order, and default sort order.
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Paging Through Job Tables & Setting Page Size
A job table may span multiple pages. Use the page size control at the bottom center of 
the job list to specify the number of jobs to display on a page.

The page controls on the bottom left allow you to change pages and jump to the first 
or last page of a job list. The figure below indicates where the page controls appear in 
the job panel.

Page controls Page size
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Filtering the Job Table
Job filters allow you dynamically control which jobs display in the job table. The default 
configuration displays all jobs specified in the view for the workflow. However, during 
troubleshooting, you might want to display only those jobs that are in a failure state. 
Other times, you might want to display only those jobs that are in progress.

To display the Job List filters, click Show Filters in the toolbar. The filters are displayed 
directly below the column titles in the job list table, as shown in this figure:

To hide filters, click Show Filters again.

Which jobs display in the job list is determined by all the filters working together to 
filter the list. If multiple filters are configured, the job list includes all jobs that meet the 
criteria of all configured filters.

 Setting the Job Name Filter

 Setting the Job State Filter

 Setting the Total Progress Filter

 Setting the Date and Time Filters

Setting the Job Name Filter
You can use the job name filter to limit the job list display to only those jobs with a 
name that meet criteria you specify. The following sections describe how to set and 
clear the job name filter:

 Specifying a Job Name Filter

 Clearing the Job Name Filter
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Specifying a Job Name Filter
To specify a job name filter, do the following:

1. If the filters are not visible above the job list, click the Show Filters button.

2. In the text box above the job names, enter text that is part of job names that you 
want to include or exclude from the list.

3. Click the control to the right of the filter text box and select one of the following 
filters:

– Contains—Displays all jobs that have a name that contains the text you specified.

– DoesNotContain—Displays all jobs except those that have a name that contains 
the text you specified.

– EqualTo—Displays only those jobs that have names that exactly match the text 
you specified.

– NotEqualTo—Displays all jobs except those that have a name that exactly 
matches the text you specified.

Clearing the Job Name Filter
To clear a job name filter, do the following:

1. If the filters are not visible above the job list, click the Show Filters button.

2. Click the control to the right of the filter text box and select No Filter.

Setting the Job State Filter
The job state filter allows you to selectively exclude jobs from the job list based on the 
job state. The default configuration displays jobs for all of the following job states:

• Complete

• Failed

• In Process

• Stopped By User

• Waiting

• Waiting to Retry

When the job state filter is set to display jobs in all states, the filter name for the State 
column is All States. When the job state filters disable the display for jobs in one or more 
states, the filter name for the State column changes to Custom.

To specify a state filter, do the following:

1. If the filters are not visible above the job list, click the Show Filters button.

2. Click the control below the State column head and check and clear the checkboxes 
to define the states for which you want to display jobs.
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Setting the Total Progress Filter
You can use the total progress filter to limit the job list display to only those jobs that 
meet progress criteria that you specify. The following topics describe how to set and 
clear the total progress filter:

 Specifying a Total Progress Filter

 Clearing the Total Progress Filter

Specifying a Total Progress Filter
To specify a total progress filter, do the following:

1. If the filters are not visible above the job list, click the Show Filters button.

2. In the text box below the Total Progress column name, enter the progress level you 
want to include or exclude from the list. The range is 0% to 100%. 

3. Click the control to the right of the total progress text box and select one of the 
following filters:

– Contains. Displays all jobs for which the total progress includes the value you 
specified.

– DoesNotContain. Displays all jobs except those for which the total progress 
includes the value you specified.

– EqualTo. Displays only those jobs for which the total progress matches the value 
you specified.

– NotEqualTo. Displays all jobs except those for which the total progress matches 
the value you specified.

Clearing the Total Progress Filter
To clear a job name filter, do the following:

1. If the filters are not visible above the job list, click the Show Filters button.

2. Click the control to the right of the Total Progress text box and select NoFilter.

Setting the Date and Time Filters
The date and time filters allow you to limit the job display list to jobs that started, 
updated, or expire within a specified time period. There are three separate date and 
time filters for:

• Started

• Updated

• Expires

The following topics describe how to set and clear the date and time filters:

 Specifying a Date and Time Filter

 Clearing a Date and Time Filter
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Specifying a Date and Time Filter
To set any of the date and time filters, do the following:

1. If the filters are not visible above the job list, click the Show Filters button.

2. Click the control to the right of the filter label box in the appropriate column.

If the filter label box is empty, no filter is defined. If a filter is defined, the filter label 
box displays Custom.

3. In the panel that appears, click on the calendar and clock buttons to set the date 
and time for the period start and period end.

If you omit the period From date and time, the program displays all jobs up to the 
To date and time. If you omit the period To date and time, the program displays all 
jobs after the From date and time.

4. When the period is defined, click Apply.

Clearing a Date and Time Filter
To clear a date and time filter, do the following:

1. If the filters are not visible above the job list, click the Show Filters button.

2. Click the control to the right of the filter label box.

3. Click Clear.
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Highlighting Job States Row by Row
Job state highlighting allows you to use colors to make the different job states more 
visible. Or, you can use the same color for all job states to draw less attention to the job 
states.

To toggle job state highlighting, click the Highlight State Rows button in the toolbar. 
Each time you click the button, the job state highlighting changes from the current 
state to the opposite state.
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Managing Jobs
Job management, when enabled in a view, enables you to stop, restart, and delete jobs.

The following topics describe how to stop, restart, and delete jobs:

 Stopping Jobs

 Restarting Jobs

 Deleting Jobs

Stopping Jobs
You might want to stop a job to make Vantage resources available for another job, or 
you might stop a job in preparation for system maintenance. 

To stop a job, do one of the following:

• Right-click on a job in the job list, and select Stop.

• Select a job in the job list, then click the Options menu in the toolbar, and select 
Stop.

Restarting Jobs
Jobs can be stopped by service or network interruptions, or an operator might stop a 
job to give another job priority. To restart a job, do one of the following:

• Right-click on a job in the job list, and select Restart.

• Select a job in the job list, then click the Options menu in the toolbar, and select 
Restart.

Deleting Jobs
You might want to delete a job because the job has failed, or because the output file is 
no longer needed, for example.

To delete a job, do either of the following:

• Right-click on a job in the job list and select Delete.

• Select a job in the job list, then click the Options menu in the toolbar, and select 
Delete.
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Troubleshooting
Job Status Views enables troubleshooting and correction at the job level. For more 
comprehensive troubleshooting, use the Vantage Dashboard web application.

The first step in Vantage troubleshooting with Job Status Views is to identify the jobs 
that are having problems. There are several ways to do this:

• Enable Highlight State Rows to indicate job status with colors. Failed jobs are high-
lighted in red, and other states have distinct colors. (See Highlighting Job States Row 
by Row for more information.)

• Click the State column head to sort the jobs by the current state, then locate the 
group of jobs you want to investigate.

• Use filters to display only the jobs in the state you are investigating. (See Filtering 
the Job Table for more information.)

After you locate the jobs with issues, look for common traits among those jobs. The 
following are some possible issues and suggestions for resolution:

• All jobs are failed or waiting. Look for network, database, or service issues. If all jobs 
within a certain time period had problems, there might have been a temporary 
issue that has since been corrected. Restart failed jobs as described in Restarting 
Jobs.

• All jobs for a specific workflow have failed or are waiting. Look for issues with the 
workflow. Has the workflow ever worked? Are all resources used by that workflow 
available?

• All jobs for a particular watch folder or destination have failed or are waiting. If you 
know that all the troubled jobs use the same watch folder or destination, it could 
be that the location is not available. 

After you resolve a problem, some jobs might restart on their own, and others might 
require further action from you. If your view is so enabled, you can take the following 
actions on jobs in the job list:

• Restart—Restart stopped jobs as described in Restarting Jobs.

• Delete—Delete jobs as described in Deleting Jobs.

• Stop—If a job seems unlikely to complete or stop, you can stop the job as described 
in Stopping Jobs. Once a job is stopped, you can try to restart the job or delete it.
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ABR Optimize action

The ABR Optimize action is designed to produce high-quality, adaptive-bitrate (ABR) packages which 
significantly reduce delivery bandwidth and distribution costs while ensuring perceived viewing 
quality. All Multiscreen actions are executed by the Multiscreen Service. Based on the SSIMplus quality 
measurement suite from SSIMWave, service providers and content creators can use the ABR Optimize 
action to set guaranteed quality levels using a measurement technique that closely tracks actual viewer 
perception.

action

An action is the smallest unit of work that can be specified in a Vantage workflow. Actions are 
connected together in a workflow to perform a useful task. Each action must be configured to perform 
its task in the context of the workflow, using an action Inspector. Action inspectors are specific to each 
type of action.

Actions are grouped by functional categories: communication, transcoding, file operations, metadata 
processing, etc. Each action is defined by the specific task it performs. For example, an email action, or a 
metadata label/file transformation action.

Actions have limited interdependency, and so, are very flexible. You may impose limitations on actions 
in a workflow. For example, you might require action B to depend on action A in a Vantage workflow.

During execution, actions operate on files, binders, variables, and states, and they generate an action 
state when they complete. Actions are executed by Vantage services, which perform the requirements 
of the action.

action state

The action state describes the condition of an action execution in process and after completion.

During execution, an action may be Queued | Paused | In Process | Waiting. After execution, an action's 
final state may be Success | Ignore | Fail. Certain actions (Decide/Examine/Compare/Identify, for 
example) allow the use to specify the post-execution state, including Ignore. For all other actions, the 
post-execution state is set by the service, and is either Success or Fail. These states display in the 
Vantage Workflow Designer Job Status tab.

Action states are always passed to subsequent actions. The incoming state is tested by the next actions 
to determine whether or not following actions should execute.

Some actions allow you to specify that an action should execute on a specific state (right-click the 
action, and select Perform On > Success | Fail | Ignore | Any).
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If an action fails, then the next action will inherit the Fail state and (in most cases) will not execute. If 
one action fails, the entire job fails.

Similarly, if you specify an action to set the Ignore state, the next action will inherit the Ignore state and 
will also likely not execute. Certain special actions, such as Message, can be configured to perform on 
any state (Fail, for example)—this allows workflows to send an email if they detect a failure.

Action states have precedence when an action receives states from multiple incoming actions (a merge 
of multiple branches):

- If at least one incoming state is Fail, regardless of other incoming states, the action will inherit the Fail 
state. Fail has precedence over all action states.

- If there is no Fail state, but at least one Success state, then the action will inherit the Success state. 
Success has precedence over Ignore states.

- If all incoming states are Ignore, the action will inherit the Ignore state. Ignore has lowest precedence 
of the three states. If an action receives an Ignore state and does not explicitly fail, then it emits a 
Success state. Otherwise, it emits a Fail state unless it is an action which can emit Ignore, and you have 
configured it to do so.

Agility Service

The Agility Service is the Vantage component which executes the actions relating to Agility job 
submission and interaction with Agility via the Job Profile action, Job XML action, and Process MMF 
action. Agility features are enabled by the Vantage Agility ECS license.

All-in-one domain

An all-in-one (or single-node or single-server) Vantage domain is one in which all server components of 
Vantage—the Microsoft SQL Server database, all Vantage services, and the optional Vantage web 
applications—are installed and operate on a single computer.

See also Vantage array. 

Analyze action

An Analyze action, which is executed by the Analysis Service, enables you to perform analysis on media 
using a variety of analysis tools, specifying the result of the analysis in variables, for use in downstream 
actions.

Analysis Service

The Analysis Service is the Vantage component which executes the actions relating to the analysis of 
content: Examine action, Compare action, Identify action, Analyze action, Report action, QC action, and 
MediaInfo action.

Archive action

An Archive action, which is executed by the Staging Service, uses the selected archiver (TAR, for 
example) to convert the selected input file to another format, usually in preparation for copying, 
moving, or deploying a file to a given system that has special file format requirements.

array

Another term for Vantage array. 

Aspera Service

An Aspera Service implements the Aspera software for Vantage, and provides two-way communication 
between workflows (and the Faspex Delivery action) utilizing the Aspera software itself.
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Associate action

An Associate action uses the Monitor Service to continually (and at regular periods) poll a target 
location (a directory, for example) on a device or file system (FTP, network folder, etc.) to discover new 
files, based on some permutation of the name of the file being processed by the current job.

Associate actions can be executed on any action state.

Generally, the Associate action uses the file name of an existing media file or attachment as the basis for 
discovering new files. For example, if media file Vantage.mpg is currently in the workflow, then the 
Associate action may look for Vantage.scc. This behavior can be configured in the Associate action's 
Inspector.

Associate actions begin executing when a job is submitted, and execute until a new file is discovered—
subsequent actions do not execute until the file is found. When the new file is discovered, the Associate 
action makes the file available to the other actions in the workflow.

Configuration is accomplished in the inspector, and is based on the target device/file system being 
monitored and other requirements.

attachment

An attachment is a non-media file that is associated with media during execution of a workflow. For 
example, an attachment may be an XML file that contains metadata, an SCC caption file, or an STL or 
PAC subtitle file. An attachment may also be a PDF file, Excel spreadsheet, or Word document, for 
example. Attachments are identified and processed using nicknames for simplicity. Processing is 
optional—attachments may be simply passed through a workflow for storage with the processed 
media and registered in a Vantage catalog.

attachment nickname

An attachment nickname is an alias or alternate name that is assigned to an attachment file during 
Vantage workflow execution. When an attachment file is submitted to a workflow, the actual file name 
and location is stored in a Vantage binder along with a nickname as defined in the workflow. Within the 
workflow, all references to a file are by nickname. However, when Vantage needs to access a file, 
Vantage uses the actual file name and location stored in the binder.

See media nickname and nickname.

AudioTools action

An AudioTools action is an optional, licensed feature in Vantage. It uses the AudioTools Service to enable 
Vantage workflows to utilize and interact with various AudioTools products from Minnetonka Audio 
Software. The AudioTools Custom Workflow executes a selected, pre-defined AudioTools Server 
workflow. AudioTools Loudness Control executes the typical loudness processes, including hitting 
multiple target parameters using an iterative processing pass.

AudioTools Service

The AudioTools Service implements the AudioTools Connector and enables Vantage workflows to utilize 
and interact with various AudioTools products from Minnetonka Audio Software.

Aurora action

An Aurora action is an optional, licensed feature in Vantage. It uses the Aurora Service to enable 
Vantage workflows to utilize and interact with various QC tests provided by the Digimetrics Aurora 
software. The tests provide the ability to determine whether a particular input media (specified by 
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nickname) either passes or fails a particular QC check. Each test also generates a report file that may be 
utilized during later stages of the workflow.

Aurora Service

The Aurora Service implements the Digimetrics Aurora software for Vantage, and provides two-way 
communication between workflows (and the Aurora action) utilizing Aurora and the Aurora software 
itself.

Automate action

The Automate action, which is executed by the Communicate Service, is similar to the Notify action. It 
contains system-integration extensions which are relevant to TrafficManager workflows, enabling you 
to save job or other metadata to a file and interface/integrate with external automation systems. This 
capability ranges from writing XML-based material to a file system to direct integration with specific 
automation systems.

In TrafficManager applications, this action is useful to notify automation systems that a commercial has 
been processed and is available for air. For example, a Notify action can create text or CSV dublists and 
provide them to automation systems that are capable of processing dublists in that format. 

Baton action

A Baton action is an optional, licensed feature in Vantage. It uses the Baton Service to enable Vantage 
workflows to utilize and interact with various QC tests provided by the Baton software. The tests 
provide the ability to determine whether a particular input media (specified by nickname) either passes 
or fails a particular QC check. Each test also generates a report file that may be utilized during later 
stages of the workflow.

Baton Service

The Baton Service implements the Baton software for Vantage, and provides two-way communication 
between workflows (and the Baton action) utilizing the Baton software itself.

binder

A binder is a collection of file and metadata information, created for each job that Vantage executes. A 
binder contains media and attachment file references and metadata labels that were ingested or 
created during the job. While a binder is created for every job, many binders are never used. Therefore, 
only media processing scenarios which require operator intervention should use the Register action in 
ingest workflows to create binders in a user-accessible Vantage catalog.

You use the Register action to automatically create binders during a job, and you use Exist to determine 
if a binder of a certain name has already been created. Binders are most often named by some 
permutation of the name of the file that started the job. Binders that are not explicitly registered are 
accessible to users only in Workflow Designer, in the Job Status tabs. 

Vantage catalogs and their binders are accessible in Workflow Portal. Binders are saved in the Vantage 
domain database until deleted manually or by job expiration policies. You can also view binders in the 
Vantage Management Console, and manually create them there—or delete them. 

Binders are not file folders and are not part of the Windows file system—they are records in the Vantage 
database. Thus, binders do not contain the files themselves; they only have the paths to those files. 

Camera Ingest action

A Camera action is an origin action; it uses the Monitor Service to regularly poll a target location (a 
directory, for example) on a card reader device or Windows file system to discover new camera files.
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When a new file or shot is discovered, the Camera action submits a job for the workflow which it is part 
of, for processing.

Capture action

A Capture action is an origin action; it supports Open Workflows on the outbound side and it is used to 
capture live SDI inputs and output captured media files to Live Storage using the specified output 
container and encoder. The Capture action is executed by the Live Services, and only works in a 
Vantage installation on a Lightspeed Capture Server.

catalog

Similar in concept to the folders in a file system, a Vantage catalog is a container that stores binders. 
Catalog folders are sub-containers that organize binders. To access a binder, Workflow Portal operators 
search through the visible catalogs and folders, just as they might sort through folders in a file system.

Catalog Service

The Catalog Service is the Vantage component that executes the Register action and Exist action.

Catch action

A Catch action is an origin action; it is a specialized origin action for ingesting commercials and 
syndicated media assets (including metadata) from catch servers in TrafficManager applications. It uses 
the Traffic Service to regularly poll the catch server to discover new files.

When a new file is discovered, the Catch action exposes all relevant metadata and submits a job to the 
workflow for processing. Typically, the workflow is an ingest workflow which localizes the media, 
populates a metadata label, creates proxies and thumbnails, and registers the asset in a Vantage 
catalog. For more details, see the TrafficManager User Guide.

Cerify action

A Cerify action is an optional, licensed feature in Vantage. It uses the Cerify Service to enable Vantage 
workflows to utilize the Tektronix Cerify suite of QC components. Cerify is a fully automated system for 
verifying and checking file-based content.

Cerify Service

The Cerify Service implements the Cerify software for Vantage, and provides two-way communication 
between workflows (and the Cerify action) utilizing the Baton software itself.

Chronicle action

The Chronicle action, along with Colocate, Compose, and Conform actions, are part of the optional, 
licensed Post Producer feature in Vantage. The Chronicle action uses the Edit Service to convert post-
rendered Composition XML files into formats for use in other systems—ad-insertion systems, for 
example.

Cloud Flip action

The Cloud Flip action is used to submit media to the Telestream Cloud platform from Vantage 
workflows via the Telestream Cloud API to a particular profile that a user specifies. The Cloud Flip action 
is executed by the Telestream Cloud Service. As part of the submission, the specified input file is 
uploaded and then processed according to the rules associated with the specified Telestream Cloud 
profile.
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Colocate action

The Colocate action, along with Chronicle, Compose, and Conform actions, are part of the optional, 
licensed Post Producer feature in Vantage. The Colocate action uses the Edit Service to ingest 
Composition XML files with references to non-file-based URLS (for example, Amazon S3), localize the 
files, and convert the media references in a copy of the CML into paths to the localized files. 

common action

Common actions are actions that are implemented in every Vantage Service; they are not restricted 
execution by a single service. See Receive action, Forward action, Decide action, Compute action, 
Construct action, Synchronize action.

Communicate Service

The Communicate Service is the Vantage component that executes the actions relating to electronic 
messaging: Message action, and Notify action.

Compare action

A Compare action uses the Analysis Service to compare media files based on certain metrics (for 
example, PSNR). These metrics can generally be published as variables or as metadata labels.

Compose action

A Compose action, along with Chronicle, Colocate, and Conform actions, are part of the optional, 
licensed Post Producer feature in Vantage. The Compose action uses the Edit Service to convert various 
media descriptor file formats (Anystream AN2, Final Cut Interchange XML, Simplified Avid AAF, 
QuickTime Reference, Adobe FC7XML, and Telestream TSEDL) into a Composition XML file so that it can 
be used by the Conform action to compose media) into a Composition XML file so that it can be used 
by the Conform action to compose media.

Composition (CML) file

A Composition file is an XML schema that provides the vocabulary to describe media elements and their 
temporal and spatial relationships on a video timeline. Composition files (or Composition XML objects 
in a computer program) are submitted to a Conform action in a workflow to render the media file from 
the description.

Compute action

A Compute action, which is implemented in every Vantage service, performs various arithmetic and 
string manipulation functions, permitting you to create and modify values in variables, for use in 
downstream actions. This action is open workflow capable.

Conform action

A Conform action, along with the other Edit actions, are part of the optional, licensed Post Producer 
feature in Vantage. The Compose action uses the Edit Service to assemble and optionally transcode 
multiple video and still image files into a single output file, applying filters as specified by you. The 
input files and related specifications for the output file are all defined in a Composition XML file. This 
action is open workflow capable.

Construct action

A Construct action, which is implemented in every Vantage service, enables you to construct complex 
strings, paths, and math expressions from literals, variables, and tokens, for use in downstream actions. 
This action is open workflow capable.
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Copy action

A Copy action is executed by the Transport Service and is used to replicate a file from a source target 
(file system/device and directory) to a destination target (file system/device and directory). It typically 
performs this task by copying the file to the destination. 

Copy actions can be executed on any action state. This action is open workflow capable.

database

The term database is the common term used to refer to the Vantage domain database, where all 
specifications for the domain are stored, along with workflows and job history.

Change Log

The Change Log captures changes to the Vantage domain configuration and operation and records the 
following details: date and time of change, Vantage user who made the change, host computer where 
the change occurred, change summary message.

Data Collection Utility

The Data collection utility enables you to collect relevant information about selected services for 
transmission to Telestream during a troubleshooting session. You can also log point-in-time details 
about a selected service into a log file for diagnostics purposes.

Decide action

A Decide action, which is implemented in every Vantage service, is an action which allows you to 
explicitly set the action state based upon analysis of variable values at runtime. It is most commonly 
used to determine whether or not subsequent actions (or actions in a given branch) in a workflow 
should execute.

When the Decide action is used, the state set by the Decide action is passed to the next action. 
Typically, more than one Decide action is required to support decision branches. For example, if one 
branch is for HD media, it will start with a Decide action that will set the state to Success for HD content, 
or set it to Ignore otherwise; if another branch is for all other media, it will start with a Decide action 
that performs the opposite behavior.

See variable, action state.

Delete action

A Delete action is executed by the Transport Service, and is used to permanently remove a file from a 
source target (file system/device and directory). Delete actions can be executed on any action state.

Deploy action

A Deploy action is executed by the Transport Service, and is used to save the specified files to a 
destination outside the Vantage domain. Unlike Delete, Move, or Copy actions, Deploy actions allow 
multiple files to be operated on simultaneously, and do not maintain a reference to those files in the 
binder after completion.

distributed domain

Another term for Vantage array. 

domain

See Vantage domain.
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DPP Validate Action

A DPP Validate action is executed by the Analysis Service. You can use the DPP Validate action to 
confirm compliance of a DPP metadata XML file. If the XML file passes validation, TRUE is generated; 
otherwise FALSE is generated. You can test the results of the action downstream to change the 
workflow’s actions based on the validation results. Optionally, you can also generate a report.

Dublist action

A Dublist action is a specialized origin action for ingesting dublist files from a specified server and 
directory in TrafficManager applications. It uses the Monitor Service to regularly poll the server to 
discover new files.

When a new dublist file is discovered, it is parsed by the specified scheme and new entries are added to 
the master dublist maintained by Vantage. The Dublist action simultaneously polls the selected 
Vantage catalog for any media files which match entries in the master list; when found, it submits a job 
to a TrafficManager application workflow for processing. The Dublist action uses the binder name as 
the unique identifier for the commercial, so it should be set to the Ad ID.

Typically, the workflow is an on-air processing workflow which transcodes the media, optionally trims 
the clip and alters audio for compliance. Then, it delivers the media to an on-air server and notifies an 
automation system. For more details, see the TrafficManager User Guide.

Dublist Portal

Dublist Portal is a client Windows program provided as part of a TrafficManager license. Dublist Portal 
enables customers who are performing advertisement processing to define, manage, and process 
dublists as part of their automated TrafficManager workflows.

Edit Decision List

A Vantage edit decision list (EDL) is a list of clips that will be merged together in a target clip. The list 
entries specify the start and stop of the clip, and Vantage supports list entries from multiple media files. 
Vantage operators use the Workflow Portal program to create EDLs.

Edit Service

The Edit Service executes the Playlist actions: Colocate action, Conform action, Chronicle action, and 
Compose action.

emotion Action

The emotion action is an optional, licensed feature in Vantage. The emotion action enables Vantage to 
utilize and interact with Emotion Systems Emotion Engine audio software.

Error Log

The Error Log utility captures Vantage errors and records the following details: date and time of error, 
error source (Vantage service), host computer where the error occurred, type of error (Info or Error), and 
error message.

Examine action

An Examine action uses the Analysis Service to evaluate the video and audio of a media file to measure 
certain characteristics, such as audio loudness, or to detect characteristics, such as the presence and 
size of curtains. You can configure it to publish metadata or variables containing the results of analysis.
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Exist action

An Exist action uses the Catalog Service, and allows you to determine if a binder of a given name (or 
name fragment) is present in a specified catalog.

Faspex Delivery action

A Faspex Delivery action, which is executed by the Aspera Service, is used to deliver files to Aspera 
Faspex servers. Upon delivery, recipients are notified and can download the package.

FileCatalyst action

The FileCatalyst action is an optional, licensed feature, which enables Vantage workflows to access and 
deliver files to FileCatalyst servers via integrated FileCatalyst client software. It is executed by the 
FileCatalyst Service.

FileCatalyst Service

The FileCatalyst Service implements the FileCatalyst action for Vantage.

Flip action

A Flip action is executed by the Transcode Service, and implements the specified codec, which is used 
to transcode decoded digital baseband media into another media encoding format. The Telestream 
Media Transcode and Analysis Engine performs the transcode on behalf of Vantage. The Flip action has 
an Export command, which allows you to save the configured Flip action as an XML file, for use in SDK 
applications. This action is open workflow capable.

Forward action

A Forward action, which is implemented in every Vantage service, forwards a binder and all current 
variables to another workflow, starting a new job with the target workflow. A Forward action may be 
added to the end of a workflow, and requires that the target workflow have a Receive action as its first 
action.

Typically, workflows are created with a Receive action when they are intended for execution by another 
workflow that immediately precedes this one. This ability to chain workflows enables you to create 
comprehensive, intelligent run-time switching workflows consisting of smaller workflows used as 
building blocks.

See Receive action.

Gather action

A Gather action is implemented by the Staging Service, and collects one or more files from a specified 
server and directory (and optionally, its subfolders), and brings them into the workflow as attachments. 
Use of a file matching pattern allows you to select only certain types of files.

hot folder

A hot folder is a directory on a server that has been identified as a directory for storing media to be 
processed by a workflow in Vantage. When the workflow monitor identifies new media in this folder, it 
is submitted for processing.

Identify action

An Identify action uses the Analysis Service to determine certain properties of a media file, such as 
codec type, video bit rate, or file size. This information can then be published as a metadata labels or 
variables.
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Inspector

An inspector is a series of one or more panels in Vantage Workflow Designer that facilitate the setup and 
configuration of a given action. Inspectors are unique to each action—for example, configuring a 
Watch action is very different than configuring a Flip action.

IPTV Flip action

The IPTV Flip action is included with the Cable / IPTV version of TrafficManager. IPTV Flip actions are 
executed by the IPTV VOD Transcode Service which can optionally run on a Lightspeed Server for GPU-
enhanced x264/x265 encoding and video processing. The IPTV Flip action and IPTV VOD Service 
supports the features required to handle varying IPTV, set-top box and cable encoding requirements, 
and ancillary metadata specific to cable ad splicing and cable/IPTV set-top box environments. This 
action is open workflow capable.

IPTV VOD Transcode Service

The IPTV VOD Transcode Service is the Vantage component that executes the IPTV Flip action. This 
service (which can optionally run on a Lightspeed Server for H264 and HEVC encoding and video 
processing), supports the features required to handle varying IPTV, set-top box and cable encoding 
requirements, and ancillary metadata specific to cable ad splicing and cable/IPTV set-top box 
environments.

job

A job is each execution of a Vantage workflow. Jobs have a state (separate from action states), and jobs 
are comprised of actions that are executing. Jobs, like actions, may be in-process or they may be 
complete.

As a job executes, each action may be performed by any service (on any computer) in the Vantage 
domain that is capable of performing it. The capability of a service to perform a specific job depends on 
its current operating state, its workload, and its suitability, defined by a qualification rule.

Jobs for a given workflow can be viewed in the Vantage Workflow Designer by selecting the workflow 
in the Workflow Designer panel and displaying the Job Status tab. Alternatively, all in-process and failed 
jobs within a Vantage Domain may be viewed in the Status details panel of the Management Console.

Job Profile action

Use the Job Profile action (which is executed by the Agility Service) to submit jobs to Agility for 
processing; definition of the job is provided directly in Vantage by configuring the action.

Job XML action

Use the Job XML action (which is executed by the Agility Service) to submit jobs to Agility for 
processing; definition of the job is provided in an XML file.

job routing

See qualification rule and run on rules.

job state

A job state is the current status of a job. Keyword values are In Process | Paused | Complete | Failed | 
Waiting | Stopped by User | Waiting to Retry.
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Job Status Views Web Application

The Vantage Job Status Views web application is installed on a Vantage web server and enables you to 
view real-time information about jobs in the domain from anywhere on your network with a web 
browser.

label

A label or metadata label defines a set of metadata by use of name/value pairs associated with content. 
For example, a spot label may contain Agency, Author, or Ad-ID and other metadata values; this set of 
metadata is collectively called a Spot metadata label. Metadata labels can be stored in binders with the 
associated media and attachment files.

Vantage supplies a set of default metadata labels for use in workflows. In addition, you can create and 
modify labels for your use using the Management Console (Workflow Design Items > Metadata Labels).

license

A Vantage license is stored in the Vantage domain database and enables one or more Vantage features 
within a Vantage domain. Licenses are delivered as XML files and imported into the database and 
activated via the Vantage Management Console.

Lightspeed Server

A Vantage Lightspeed Server is a 1RU, GPU-enabled, multi-core CPU server used to host Vantage services 
and accelerate video processing and x264 transcoding. Lightspeed Server accelerates compute-
intensive image processing, including scaling, deinterlacing, frame rate conversion, motion vector 
calculation, and other tasks that require computation and analysis to modify or create new video 
frames. 

Live Services

Part of the Vantage Media Processing Platform on a Lightspeed Live Server, the Vantage Live Service is 
listed in the Management Console Services list and includes the Capture action. In total, there are four 
“Live” services on the Lightspeed Live server:

• The Telestream Live Persistence Service handles the persistence of source material.

• The Telestream Live Service corresponds to the Live Manager capability and arbitrates resource 
allocation for Lightspeed Live Capture.

• The Telestream Live Source service manages the acquisition of material from a specific source 
(spawned by the Telestream Live Service).

• The Vantage Live Service which includes the Capture action, depends on the three other services 
above to achieve the full functionality of the service.

Management Console

The Management Console enables Vantage system administrators to effectively configure Vantage 
domains, and scale domains across multiple servers to meet their operating requirements and perform 
effectively in their environment.

MediaInfo action

The MediaInfo action, which is executed by the Analysis Service, performs 2 tasks, based on its analysis 
of the media file and its streams:

- Creates variables from properties, using the MediaInfo API
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- Creates a report of the properties and their values.

In each category, you can produce variables of selected metrics with the results the analysis.

media nickname

A media nickname is an alias or alternate name that is assigned to a media file during Vantage workflow 
execution. When a media file is submitted to a workflow, the actual file name and location is stored in a 
Vantage binder along with a media nickname as defined in the workflow. Within the workflow, all 
references to a file are by media nickname. However, when Vantage needs to access a file, Vantage uses 
the actual file name and location stored in the binder.

See attachment nickname and nickname.

MediaMate action

A MediaMate action uses the MediaMate Service to enable Vantage workflows to utilize and interact 
with the Subtitling capabilities of Screen MediaMate. Each subtitling option provides different 
capabilities that relate to the subtitle process.

Note: The MediaMate action is only supported on 64-bit Windows Server 2008.

MediaMate Service

The MediaMate Service implements the MediaMate Screen software for Vantage, and provides two-way 
communication between workflows (and the MediaMate action) utilizing the MediaMate Screen 
software itself.

Message action

A Message action is implemented in the Communicate Service and enables you to generate and 
transmit an electronic Message—an email, for example. A Vantage administrator must configure 
Vantage to use an SMTP server (Vantage Management Console: Settings & Options > Email) before 
email can be utilized.

Metadata Service

The Metadata Service is the Vantage component that executes the actions relating to the 
transformation of metadata between labels, variables, and XML files: Populate action, and Transform 
action.

Metric Service

The Metric Service gathers and supplies machine-level information about a specific Vantage node. It 
monitors CPU, network, and RAM utilization and reports these to Vantage. On a Lightspeed server, it 
also monitors the GPU activity. The bulk of the information that the Metric Service presents is visualized 
in the Machine Metrics section of the Vantage Console. By convention, a Metric Service should be 
installed and running on every node in a Vantage domain. If you do not have a Metric service running 
on a specific machine, then that machine will not appear (will not have an entry) in the Machine Metrics 
section of the Vantage Console.
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Monitor Service

The Monitor Service is the Vantage component that executes Watch actions and Associate actions, 
Camera Ingest action and the Workorder action, all relating to the discovery of files and starting jobs.

Move action

A Move action is executed by the Transport Service, and is used to move a file from a source target (file 
system/device and directory) to a destination target (file system/device and directory). It performs this 
task by copying the file to the destination, then deleting the source. The copy first, delete last process 
insures that the move completes normally before deleting the source file.

Move actions can be executed on any action state.

Multiscreen Flip action

Multiscreen Flip actions are an optional, licensed feature. Multiscreen Flip actions are executed by the 
Multiscreen Service, which is used to perform adaptive bit-rate encoding and simultaneous packaging 
of decoded digital baseband media into multiple bit-rate variants of H.264/HEVC video and containers 
in adaptive rate streaming formats, including Adobe HDS, Apple HLS, Microsoft HSS, and players the 
support MPEG DASH. Transcoding is performed by the Telestream Media Transcode and Analysis 
Engine on behalf of Vantage. You can configure the Multiscreen action to perform transcoding on a 
standard Vantage server or on a Lightspeed Server. This action is open workflow capable.

Multiscreen Service

The Multiscreen Service is the Vantage component that executes the Multiscreen Flip action. This service 
(which can optionally run on a Lightspeed Server for H264 and HEVC encoding and video processing), 
supports the features required to handle varying adaptive bit-rate encoding and packaging 
requirements.

Nexidia Action

The Nexidia action is an optional, licensed feature in Vantage. It uses the Nexidia Service to interact 
with Nexidia QC servers running Nexidia QC software. The specified input files are passed to the Nexidia 
QC software where they are analyzed using the test profile selected.

Nexidia Service

The Nexidia service is an optional, licensed feature in Vantage. It executes Nexidia actions.

nickname

A nickname is an alias or alternate name that is assigned to a media or attachment file during Vantage 
workflow execution. When a media or attachment file is submitted to a workflow, the actual file name 
and location is stored in a Vantage binder along with a nickname as defined in the workflow. Within the 
workflow, all references to a file are by nickname. However, when Vantage needs to access a file, 
Vantage uses the actual file name and location stored in the binder.

Nicknames may refer to either media files or attachment files. Certain actions only allow the use of 
certain nickname types. For example, a Flip action only allows media file nicknames to be used as the 
inputs and outputs. However, other actions (such as the Move and Copy actions) operate on any type of 
file and allow the use of any nickname.

See attachment nickname and media nickname.
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Notify action

A Notify action is implemented in the Communicate Service, and is an action which saves job 
information to a file to interface with an external system. You can configure a Notify action to produce 
an XML file, and you can also use it to invoke a Web Service. 

TrafficManager-centric extensions are presented here for backward compatibility. 

origin action

An origin action is a specific type of action, which must be used to start a workflow. A workflow without 
an origin action as its first action is not properly designed, and cannot be activated. The origin actions 
include the Capture action, Watch action, Workorder action, and Receive action, as well as the Catch 
action and Dublist actions (optional TrafficManager actions).

Original nickname

The media nickname Original is a reserved nickname that is typically assigned to media files in a 
workflow by the origin action.

See media nickname.

Pipeline

Pipeline is a network-based video capture and playout device for moving SD & HD SDI video & audio in 
and out of MacOS X and Windows file-based workflows, with a wide variety of industry-standard 
encoders.

Populate action

A Populate action uses the Metadata Service to read and write metadata labels. During ingest, metadata 
labels can be added to ingested media and generally include trim information, audio levels, file 
properties, and commercial metadata. The metadata labels can then be reviewed and modified by 
operators using Workflow Portal. At any stage of a workflow, Vantage can extract information from 
labels using the Populate action, allowing Vantage for example to use trim points during a transcode, 
or audio level information when creating the final broadcast asset. This action is open workflow 
capable.

Post Producer

Post Producer is a specially-licensed set of actions and functionality in Vantage that enables iterative, 
template-driven assembly and encoding of assets for publication. Post Producer workflows automate 
assembly and reduce production costs by producing multi-layer video deliverables with transition and 
image effects, graphic overlays, and conformed for  IPTV and cable VOD production, news or weather 
updates, international localization, promo assembly and insertion and advertisement insertion.

Process MMF action

A Process MMF action (which is executed by the Agility Service) processes an attachment as an MMF file 
and generates variables from it.

Pulsar Action

The Pulsar action is an optional, licensed feature which enables broadcasters to integrate the Pulsar 
suite of content verification components directly in Vantage workflows. It is executed by the Pulsar 
Service.

Pulsar Service

The Pulsar service implements the Pulsar action for Vantage.
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QC action

A QC action, which is executed by the Analysis Service, enables you to perform analysis on media using 
a variety of analysis tools, and optionally, produce a report of the analysis. The QC action is similar to the 
Analyze action, with additional features in addition to generating variables for each property.

In each tool, you can test various properties for True/False, min/max values, allowable values, or ranges, 
and then set pass/fail and other variables based on the results of the analysis. You can use these 
variables in downstream actions.

qualification rule

A qualification rule influences or controls the routing and execution of actions among Vantage services 
of the same type in a distributed Vantage domain. Qualification rules can be used to ensure that jobs 
are routed to services that are best suited for the task. Vantage uses values contained in variables to 
determine the suitability of a given service to execute the action.

Qualification rules are exclusively based on variables; they are not based on any actual machine 
analysis. As a result, it is up to the system administrator to correctly set up variables and qualification 
rules, and apply variables to the appropriate actions to ensure that jobs are routed correctly.

Qualification rules are created and managed in the Vantage Management Console: Services.

See also run on rules.

Receive action

A Receive action is an origin action which is implemented in every Vantage service. Receive actions are 
designed to receive files from other systems: workflows, SDK-based applications, and Workflow Portal, 
for example. Files can also be automatically submitted to a workflow starting with a Receive action 
from another workflow using the Forward action.

See Forward action.

Register action

A Register action uses the Catalog Service to add the binder created by each job to a Vantage catalog. 
Register actions can be executed on any action state.

See also Vantage catalog.

Remove action

A Remove action is executed by the Catalog Service, and is used to permanently remove a binder from 
the catalog and set the associated file resources to expired. If the action succeeds, it emits an action 
state of Success; otherwise, Failure.

Report action

A Report action, which is executed by the Analysis Service, generates a list of variables and their values 
and saves them in a file format specified by you.

resource cost

A resource cost is an integer value, implemented in the Vantage Management Console on each action 
type to specify a relative computer resource consumption value in relation to all other action types. This 
value enables Vantage to maximize resources and optimize transactions, so that you can tune your 
Vantage system for the highest possible throughput on your particular hardware.
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retry rules

Retry rules are rules that you can specify on certain actions, to re-execute actions that fail primarily due 
to platform access and network latency problems. The retry rules you set on a given action override the 
default retry rules established in the Management Console.

run on rules

Run on rules are rules that you specify on a given action, to qualify which services have the 
characteristics that enable them to execute this action. Rules are set up by specifying variables which 
have been bound to a given Vantage service and values set. After configuration, the action can test 
each rule by comparing its run time value to the value in the service’s copy and determine if there is a 
match before attempting to execute it. 

See also qualification rule.

SDK Service

The SDK Service is the Vantage component which enables integration with third-party or custom-
developed client programs, for submitting jobs, tracking status, etc.

Session Log

The session log is a function of the Job Status and Domain Job Status panels in the Workflow Designer. 
This log displays session activity entries, if any, including which variables have been provided to each 
action and which ComponentPac was used to run an action. This information can be helpful when 
debugging the use of variable, or when working on an issue with Telestream Customer Service.

Signiant Delivery action

A Signiant Delivery action, which is executed by the Signiant Service, is used to deliver files to servers 
controlled by Signiant file transfer products.

Signiant Service

The Signiant Service is the Vantage component which enables integration with third-party or custom-
developed client programs, for submitting jobs, tracking status, etc.

The Signiant Service implements the Signiant file transfer product for Vantage, and provides two-way 
communication between workflows (and the Signiant Delivery action) utilizing the Signiant software 
itself.

Staging Service

The Staging Service is the Vantage component which executes Archive actions and Gather actions.

service

See Vantage services.

Secured Version Control

The Secured Version Control feature provides the ability to install the latest software and begin 
building workflows that utilize new ComponentPac libraries (software libraries), while keeping the 
existing workflows untouched and operating off a previous ComponentPac version. When the user 
desires to upgrade a workflow or action within a workflow, it can be done at a convenient time. For a 
detailed description of Secured Version Control, search the Vantage Domain Management Guide.
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Synchronize action

A Synchronize action is a connector action, for the sole purpose of uncluttering workflow connectors. In 
workflows where there is a many-to-many relationship (for example, 6 Flip actions connecting to 6 
Deploy actions, which connect to 6 Deletes), instead of drawing connection between them all, you 
simply connect them to a common Synchronize action. There is no Inspector for the Synchronize 
action, because no configuration is required.

Syndicate Action

The Syndicate action processes and can apply a template to metadata accompanying syndicated 
content from providers like Pitchblue and generic providers. It is executed by the Traffic Service. The 
purpose of this is to automatically rearrange segments according to the template, or to mark specific 
segments as “not included” in the final program. Use the Syndicate action in syndicated media ingest 
workflows to convert sidecar metadata XML files to a mezzanine format for use in downstream actions 
in the workflow, or for use in Syndication Workflow Portal applications. The Syndicate action is part of 
TrafficManager, an optional, licensed feature of Vantage.

Telestream Cloud Service

The Telestream Cloud Service is the Vantage component which executes the Telestream Cloud Flip 
action.

Timed Text Flip action

A Timed Text Flip action is part of the Timed Text group. It is executed by the Timed Text Service. The 
Timed Text action is executed by the Timed Text service. The Timed Text Flip action automates caption 
file-type conversions, extracts caption data from media with embedded captions, creates subtitle 
overlay graphics, and manipulates the timecode of caption data to match media. 

Timed Text Service

The Timed Text Service is the Vantage component which executes the Timed Text Flip action.

Tempo action

A Tempo action is part of the Edit group. All actions in the Edit group are executed by the Edit Service. 
The Tempo action is included in Tempo, a time-adjusting encoding solution built on the Vantage 
platform. The Tempo action uses the Edit Service for re-timing file-based content and intelligently 
decreasing or increasing the running time of shows and segments. This action is open workflow 
capable.

Traffic Service

The Traffic Service is the Vantage component which executes the Catch action and Dublist action.

TrafficManager

TrafficManager is an optional, licensed feature which enables automated advertisement and syndicated 
media processing from catch server to automation systems and on-air servers, serving both the 
broadcast and cable industry. It includes the Catch action for catch servers and the Dublist action for 
dublist management. It also includes the Syndicate Action for processing syndicated media.

transcode

Transcode means the process of decoding media in one format (MPEG2, for example) down to digital 
baseband and then encoding it in another media format (MPEG4, for example). 
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Transcode Service

The Transcode Service is the Vantage component that executes the Flip action—transforming media 
from one format to another. Transcoding for the Flip action is performed by the Telestream Media 
Transcode and Analysis Engine on behalf of Vantage.

Transform action

A Transform action uses the Metadata Service to transform metadata between XML files (attachments) 
and labels. XSL style sheets are used to perform these transformations; style sheets can be managed in 
the Vantage Management Console: Workflow Design Items > Style Sheets. This action is open workflow 
capable.

Transport Service

The Transport Service is the Vantage component that executes the actions relating to file operations: 
Move action, Delete action, Copy action, and Deploy action.

Vantage array

A Vantage array is a domain whose software components are distributed among multiple computers 
for durability and scalability, instead of installed and operating on a single computer (often referred to 
as a distributed domain). A typical array has the Vantage domain database installed on a dedicated 
server, and all Vantage services installed on another computer, and additional Transcode services each 
installed on other computers for high-performance, parallel transcoding.

Vantage catalog

Formal name for catalog. Similar in concept to the folders in a file system, a Vantage catalog is a 
container that stores binders. Catalog folders are sub-containers that organize binders. To access a 
binder, Workflow Portal operators search through the visible catalogs and folders, just as they might 
sort through folders in a file system.

Vantage Cloud Manager

The Vantage Cloud Manager enables Vantage system administrators to effectively configure cloud 
service provider accounts, start, stop, and configure domains, and monitor domain status.

Vantage domain database

A Vantage domain database is a Microsoft SQL Server database which contains all workflows, actions, 
jobs, binders, licenses, and configuration information for a Vantage domain.

Vantage domain

A Vantage domain is a collection of computers, Vantage workflows, actions, Vantage services, jobs, 
binders, and configuration settings, all known to and interacting with each other, stored in a database. 
This collection constitutes a Vantage domain. Vantage domains may exist on a single computer or they 
may be distributed across many computers for durability and scalability.

The name of a Vantage domain is the same as the name of the server that hosts the Vantage domain 
database.

Multiple Vantage domains may exist on a network, but they are independent entities that do not 
communicate with each other. They are not bound together and do not share resources or work. The 
purpose of storing an entire domain in a database is to provide an easy way to create and manage the 
domain and to provide access to all the details about each resource in the domain to any other resource 
that needs it.



Glossary 401
Vantage EDL nickname

The nickname Vantage EDL is a reserved nickname that is typically assigned to media files that are 
created in catalog ingest workflows, to identify the ingest files of an Edit Decision List in Workflow 
Portal, during Stitch and Trim operations. See media nickname.

Vantage folder address

A Vantage folder address is an alias to a local or remote file folder. You can create and manage Vantage 
folder addresses in the Vantage Folder Address Book dialog, in Copy and Move actions in Vantage 
Workflow Designer, and in the Vantage Management Console.

After you create a Vantage folder address, you can specify the destination directory in any workflow 
simply by selecting the Vantage folder address. Changes to a Vantage folder address—such as 
updating an IP address or a password—immediately affect all workflows that use that Vantage folder.

Unlike Vantage stores, temporary files that are created during workflow execution are not 
automatically deleted from Vantage folders according to job expiration settings. 

Vantage Proxy nickname

The media nickname Vantage Proxy is a reserved nickname that may be assigned to media files 
encoded using the QuickTime encoder in H.264/AAC as QuickTime movies or MP4 files with x264/AAC, 
which enables previewing with the media viewers provided in Vantage programs such as Workflow 
Designer, Workflow Portal, and the Vantage Management Console.

Alternatively, the Workflow Portal Windows Client QuickTime Media Player supports MP4 with x264-
encoded H.264/AAC, provided that QuickTime 7.7.6 or later is installed.

See media nickname.

Vantage services

The term Vantage services refers to the collection of Windows services in a Vantage domain, which are 
responsible for executing all of the actions in a workflow as it executes.

Vantage store

A Vantage store is a directory on a Windows file system that stores temporary files. Stores are managed 
by the Vantage domain for the purpose of centralizing large directories for reading and writing files. 
Unlike a Vantage folder, temporary files placed in a Vantage store are deleted when the binder is 
deleted. Vantage stores are generally used to hold temporary files for the duration that a job is 
executing.

Vantage stores are managed in the Vantage Management Console: Storage. Services that create 
temporary files, such as the Transcode Service, can be configured to use specific stores.

Vantage Thumbnail nickname

The media nickname Vantage Thumbnail is a reserved nickname that is typically assigned to output 
media files that are created to display thumbnail images instead of binder names in Vantage programs 
such as Workflow Portal.

See media nickname.

variable

In Vantage, a variable is a container for temporary job information—a symbolic name (or identifier) 
which contains some known or unknown quantity or element of information; a value. You use the 
variable name to reference the current value; this separation of name and content allows the name to 
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be used independently of the exact information it represents. The variable can be bound to a value 
(that is, you can set a variable to a given value) during run time, and the value of the variable may 
change during the course of workflow execution. 

A variable identifies temporary job metadata. Variables have a name (such as Number of Audio 
Channels), a type (such as Integer Number) and a default value (such as 50). Variables values can be set 
inside a job in a variety of ways: through analysis, through metadata population, in the Watch and 
Associate actions, as a property of an action, or by a service as it executes an action.

Variables are used by Vantage services and actions to control workflow execution. Many settings in 
actions can be bound (or attached) to variables, allowing the workflow to dynamically update values on 
a job-by-job basis. 

For example, a variable may be assigned a value by an Analysis action to determine how many lines of 
black are at the top of a video frame; a crop filter later in the workflow can bind to that variable, 
ensuring that every crop in every job is appropriate to the workflow requirements.

Variables in services may be also be used for job routing. For example, an action with a 
FibreRequired=TRUE variable must pass this condition to a service which evaluates the condition to 
determine if it can successfully perform the action.

Variables can be created in Vantage Management Console (Workflow Design Items > Variables) or in 
Vantage Workflow Designer, and assigned for use in workflows and services.

VidChecker action

A VidChecker action is an optional, licensed feature in Vantage. It uses the VidChecker Service to enable 
Vantage workflows to utilize and interact with various QC tests provided by the VidChecker software.

VidChecker Service

The VidChecker Service implements the VidChecker QC software for Vantage, and provides two-way 
communication between workflows (and the VidChecker action actions) utilizing the VidChecker 
software itself.

Watch action

A Watch action is an origin action; it uses the Monitor Service to regularly poll a target location (a 
directory, for example) on a device or file system (FTP, Windows network folder, etc.) to discover new 
files. This action is open workflow capable.

When a new file is discovered, the Watch action submits a job for the workflow which it is part of, for 
processing the file—typically, a media file.

Web Dashboard

The Web Dashboard is an optional, licensed web app which displays important domain information 
from anywhere on your network in a web browser. The Web Dashboard is installed on the IIS server on 
your Vantage domain database server. 

workflow

A workflow in Vantage is a set of actions designed to perform an automated process. Vantage 
workflows are created using the Vantage Workflow Designer by adding and configuring actions and 
connecting them together. Workflows are stored in the Vantage domain database, and executed by 
Vantage services.
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Workflow Designer

Vantage Workflow Designer is a client program that enables you to create and edit workflows, activate 
and deactivate workflows, monitor job status, and review and delete jobs that have completed.

Workflow Portal

Workflow Portal is a client program that features a customizable set of functionality to support various 
operator-related tasks: selecting media and submitting jobs, updating variables and metadata, 
forwarding jobs, creating EDL-based jobs, etc.

Customization is implemented in the Vantage Management Console, when Vantage administrators 
construct the user interface and functionality they want for a given task, then save it. When operators 
launch Workflow Portal, they select the configuration appropriate to the task at hand, and Workflow 
Portal dynamically display the user interface components specified in the configuration file.

Workflow Portal Web Application

The Workflow Portal web app is a limited implementation of Workflow Portal, for use in a web browser 
over a network or Internet connection.

Workorder action

A Workorder action is an origin action; it uses the Monitor Service to regularly poll a target Windows 
directory for new workorder files to process. The Workorder action provides a simple and highly 
effective method of submitting multiple similar jobs without using the SDK. 

When a new file is discovered, the Workorder action submits one job for each row in the file.

workorder file

A workorder file is a comma-separated value (CSV) text file containing one or more work orders, or job 
descriptions. Each row in the CSV file specifies a job, and each column specifies either an input file for 
the job, or value for run-time use; typically assigned to a variable in the workflow. Workorder file 
configurations are specified in the Domain Management Console. At least one workorder scheme must 
be created in order to use a Workorder action.
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